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1 GETTING STARTED 1.1 IMPORTANT PROCEDURES

1
1 GETTING STARTED 1.1IMPORTANT PROCEDURES 1.1.1 CAUTIONS AND WARNINGS

To help ensure years of trouble free operation, please read through the following chapter for information to help guide you
through the initial installation procedures of your new relay.

BEFORE ATTEMPTING TO INSTALL OR USE THE RELAY, IT IS IMPERATIVE THAT ALL WARNINGS AND CAUTIONS
IN THIS MANUAL ARE REVIEWED TO HELP PREVENT PERSONAL INJURY, EQUIPMENT DAMAGE, AND/OR
DOWNTIME.

CAUTION: THE OPERATOR OF THIS INSTRUMENT IS ADVISED THAT IF THE EQUIPMENT IS USED IN A MANNER
NOT SPECIFIED IN THIS MANUAL, THE PROTECTION PROVIDED BY THE EQUIPMENT MAY BE IMPAIRED.

Figure 1–1: FRONT VIEW OF F650 UNITS
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1
1.1.1.1   COMMUNICATION BOARDS WITHDRAWAL / INSERTION

The modular design of the relayallows for the withdrawal and insertion of the communication module.

Figure 1–2: shows the location of communication modules on the rear part of the relay. Qualified personnel must carry out
the insertion or extraction of the communication boards only after interrupting the relay auxiliary voltage and ensuring that
all the rear terminals are potential free.

Communication boards are installed on the rear of the unit, the upper port being reserved for the asynchronous
communications board and CAN, and the lower port for the ETHERNET board in any of its configurations.

Figure 1–2: MODULE WITHDRAWAL/INSERTION

WARNING: MODULE WITHDRAWAL AND INSERTION SHALL ONLY BE PERFORMED BY DULY QUALIFIED
SERVICE PERSONNEL. FOR PERSONAL SECURITY PURPOSES, BEFORE ACCOMPLISHING ANY
WITHDRAWAL OR INSERTION OPERATION, THE RELAY MUST BE POWERED OFF AND ALL THE REAR
TERMINALS MUST BE POTENTIAL FREE. THE RELAY MUST BE GROUNDED USING THE REAR GROUNDING
SCREW.

Before performing any of these actions, control power must be removed from the relay and all the rear terminals
must be potential free. A grounded antistatic wristband must be used when manipulating the module in order to avoid
electrostatic discharges that may cause damage to the electronic components.

WITHDRAWAL: Loosen the small screws that keep the faceplate in place and extract the module. 

INSERTION: Insert the module and press it firmly in the case, until it is completely fixed. After this, bolt the faceplate
screws and replace the control power. Check that the relay is fully operative.

GE Multilin will not be responsible for any damage of the relay, connected equipment or personnel whenever
these safety rules are not followed.
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1
1.1.1.2   MAGNETIC MODULE TERMINALS

The transformer module for the VTs and CTs is already connected to a female connector screwed to the case.  The
current inputs incorporate shorting bars, so that the module can be extracted without the need to short-circuit the
currents externally. It is very important, for safety reasons not to change or switch the terminals for CTs and VTs.

Figure 1–3: REAR VIEW OF F650 UNIT

GE Multilin will not be responsible for any damage of the relay, connected equipment or personnel 
whenever these safety rules are not followed.

AC Input Terminals 
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1
1.1.2 INSPECTION CHECKLIST

Unwrap the relay and inspect the relay for physical damage.

Verify that the model on the label on the side of the relay matches the model ordered.

Figure 1–4: IDENTIFICATION LABEL (A4455P6)
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1Please ensure that you received the following items with your relay:

• Mounting screws for fixing the relay to a cabinet

• CD containing EnerVista 650 Setup software

• Wiring diagram

• Certificate of Compliance

For product information, instruction manual updates, and the latest software updates, please visit the GE Multilin Home
Page www.geindustrial.com/multilin.

Note: If there is any physical damage detected on the relay, or any of the contents listed are missing, please
contact GE Multilin immediately at:

EUROPE, MIDDLE EAST AND AFRICA:

GE Digital Energy

Av. Pinoa, 10

48170 Zamudio, Vizcaya (SPAIN)

Tel.: (34) 94-485 88 54, Fax: (34) 94-485 88 38

E-mail: multilin.tech.euro@ge.com

AMERICA, ASIA AND AUSTRALIA:

GE Digital Energy

215, Anderson Avenue

L6E 1B3 Markham, ON (CANADA)

Tel.: +1 905 294 6222, Fax: +1 905 201 2098

E-mail: multilin.tech@ge.com

The information provided herein is not intended to cover all the details of the variations of the equipment, nor does
it take into account the circumstances that may be present in your installation, operating or maintenance
activities.

Should you wish to receive additional information, or for any particular problem that cannot be solved by referring
to the information contained herein, please contact GENERAL ELECTRIC DIGITAL ENERGY.
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1
1.1.3 SAFETY INSTRUCTIONS

The F650 ground screw shown in Figure 1–5: must be correctly grounded.

Figure 1–5: LOCATION OF GROUNDING SCREW

Before communicating with a F650 unit through the front serial port, please ensure that the computer is grounded.

In case of using a laptop, it is recommended not to have it connected to its power supply. In many cases it might not be
correctly grounded either due to the power supply or to the connector cables used. 

This is required not only for personal protection, but also to avoid a potential voltage difference between the
relay’s serial port and the computer’s port, which could produce permanent damage to the computer or the relay.

GE Multilin will not be responsible for any damage to the relay or connected equipment whenever this elemental
safety rule is not followed. 
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1
1.1.3.1   WARNING SYMBOLS

The following table explains the meaning of warning symbols that may appear on the device or in this manual

Symbol Meaning 

 
The relevant c ircuit is direct current. 

 
The relevant c ircuit is alternating current. 

 

CAU TION: Refer to the documentation for importan t operating  
and  maintenance ins truc tions. Failure to take or a void a specified 
ac tion could result in loss of data or  physical damage. 

 

WARNING! Dangerous voltage constituting a risk  of electric shock 
is present within th e unit. Fa ilure to take or avoid a  spec ified 
ac tion could result in physical harm to the user. 

 

CAU TION: Class 1M Laser (IEC 60825-1 Safety of laser 
products) 
DO  NOT VIEW D IRECTLY WITH OPTIC AL 
INSTRUMENTS 
 

 
CAU TION: Hot surface 

 

Earth (Ground) Terminal 

 

Protective Earth Terminal 
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1
1.2OVERVIEW 1.2.1 INTRODUCTION TO 650 FAMILY OF RELAYS

Historically, substation protection, control and metering functions were performed with electromechanical equipment. This
first generation of equipment was gradually replaced by analog electronic equipment (called static devices), most of which
emulated the single-function approach of their electromechanical precursors. Both of these technologies required
expensive cabling and auxiliary equipment to produce functioning systems.

Recently, digital electronic equipment has begun to provide protection, control and metering functions. Initially, this
equipment was either single function or had very limited multi-function capability, and did not significantly reduce the
cabling and auxiliary equipment required. However, recent digital relays have become quite multi-functional, reducing
cabling and auxiliaries significantly. These devices also transfer data to central control facilities and Human Machine
Interfaces using electronic communications. The functions performed by these products have become so broad that many
users prefer the term IED (Intelligent Electronic Device).

It is obvious to station designers that the amount of cabling and auxiliary equipment installed in stations can be even further
reduced, to 20% to 70% of the levels common in 1990, to achieve large cost reductions. This requires placing even more
functions within the IEDs.

Users of power equipment are also interested in reducing cost by improving power quality and personnel productivity, and
as always, in increasing system reliability and efficiency. These objectives are realized through software which is used to
perform functions at both the station and supervisory levels. The use of these systems is growing rapidly.

High speed communications are required to meet the data transfer rates required by modern automatic control and
monitoring systems. In the near future, very high speed communications will be required to perform protection signalling.
This has been established by the IEC 61850 standard.

IEDs with capabilities outlined above will also provided significantly more power system data than is presently available,
enhance operations and maintenance, and permit the use of adaptive system configuration for protection and control
systems. This new generation of equipment must also be easily incorporated into automation systems, at both the station
and enterprise levels.

1.2.2 HARDWARE ARCHITECTURE

650 family of relays has been designed to meet the goals described above that are appearing nowadays in the environment
of new substations.

The 650 is a digital-based device containing a central processing unit (CPU) that handles multiple types of input and output
signals. The 650 family can communicate over a local area network (LAN) with an operator interface, a programming
device, or another 650 or UR device.

The CPU module contains firmware that provides protection elements in the form of logic algorithms, as well as
programming logic gates, timers, and latches for control features. It incorporates two internal processors, one for generic
use and a second one dedicated for communications.

Input Elements accept a variety of analog or digital signals from the field. The 650 isolates and converts these signals into
logic signals used by the relay. 

Output Elements convert and isolate the logic signals generated by the relay into digital signals that can be used to control
field devices.
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1

Figure 1–6: 650 CONCEPT BLOCK DIAGRAM

Contact Inputs/Outputs are signals associated to the physical input/output contacts in the relay

CT and VT inputs are signals coming from the inputs of current and voltage transformers, used for monitoring the power
system signals. CAN Bus Inputs/Outputs: are signals associated to physical input/output contacts from independent
modules connected to the 650 unit via a CAN Bus. Not available for W650 models.

PLC: Programmable Logic Controller. Control module that enables the unit configuration (assignment of inputs/outputs)
and the implementation of logic circuits.

Protection Elements: Relay protection elements, for example: Overcurrent, overvoltage, etc. Not available for C650
models.

Remote inputs and outputs provide a means of sharing digital point state information between remote devices using IEC
61850 GSSE and GOOSE messages. Not available for G650 models.

Analog Inputs are signals associated with transducers.
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1
1.2.3 SOFTWARE ARCHITECTURE

The firmware (software embedded in the relay) has been designed using object oriented programming techniques (OOP).
These techniques are based on the use of objects and classes, and provide the software architecture with the same
characteristics as the hardware architecture, i.e., modularity, scalability and flexibility.

1.2.4 COMMUNICATIONS ARCHITECTURE

The main processor performs protection, control, and communication functions, incorporating two internal processors, one
for generic use and a second one dedicated for communications.

A dedicated serial port is used for communication between the main processor and the human-machine interface. The
serial connection provides great immunity against electromagnetic disturbances, thus increasing system safety.

All 650 units incorporate an RS232  serial port on the front of the relay. There is also a possibility to incorporate up to two
additional communication modules on the rear.

One of the modules provides asynchronous serial communications, using different physical media (RS485 + cable remote
CAN bus I/O, plastic or glass fiber optic) depending on the selected model. The module incorporates  two identical ports,
COM1 and COM2. The COM2 port is multiplexed with the front port. Additionally, this module may incorporate a port for
CAN BUS communications, used for the connection to the Remote CAN BUS I/O module. This feature allows increasing up
to 100% the I/O capability, when the maximum number of I/Os available inside the relay is not enough for a specific
application.  Available options are:

Table 1–1:   REAR SERIAL COMMUNICATIONS BOARD 1

The other module provides Ethernet communications (COM3 port), using 10/100BaseTX (self-negotiable speed) or
100BaseFX connectors, depending on the selected model. The most complete models include a double redundant
100BaseFX fiber optic port. Redundancy is provided at the physical level; the unit incorporates internally duplicated and
independent controllers for extended system reliability and accessibility.

Available Options are:

Table 1–2:  REAR ETHERNET COMMUNICATIONS BOARD 2

For options C and D it is required to select the active physical media, by means of an internal selector inside the module.
The factory configuration for this selection is the 10/100BaseTX port. 

BOARD CODE FUNCTIONALITY

F Without additional communication ports

A Two RS485 ports

P Two Plastic F.O. ports

G Two Glass F.O. ports

X Two RS485 ports and a CAN port for remote CAN Bus Inputs/Outputs 

Y Two Plastic F.O. ports and a CAN port for remote CAN Bus Inputs/Outputs (fiber)

Z Two Glass F.O. ports and a CAN port for remote CAN Bus Inputs/Outputs (fiber)

C CAN port for remote CAN Bus I/O (cable)

M RS485   + RS485 port and a CAN port for remote CAN bus I/O (cable)

BOARD CODE FUNCTIONALITY

B One 10/100BaseTX port (self-negotiable speed)

C One 10/100BaseTX port and one 100BaseFX port.

D One 10/100BaseTX port and redundant 100BaseFX ports

E Redundant 10/100BaseTX ports
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1
Finally, internal communication with input and output modules is performed via an internal CAN bus, independent from the
one used for remote CAN BUS I/Os. This fact provides increased communication speed, as well as the possibility of
acknowledgement of modules, abnormalities, etc. As this is a serial port supporting a communications protocol, it provides
extraordinary immunity against external or internal disturbances.

Figure 1–7: COMMUNICATIONS ARCHITECTURE (B6816F1)
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1.3ENERVISTA 650 SETUP SOFTWARE 1.3.1 SYSTEM REQUIREMENTS

The EnerVista 650 Setup software interface is the preferred method to edit settings and view actual values because the PC
monitor can display more information in a simple comprehensible format.

The following minimum requirements must be met for the EnerVista 650 Setup software to properly operate on a PC: 

• Pentium® class or higher processor (Pentium® II 300 MHz or higher recommended)

• Windows® NT 4.0 (Service Pack 3 or higher), Windows® 2000, Windows® XP

• Internet Explorer® 5.0 or higher

• 64 MB of RAM (128 MB recommended)

• 40 MB of available space on system drive and 40 MB of available space on installation drive

• RS232C serial and/or Ethernet port for communications to the relay

1.3.2 INSTALLATION

After ensuring the minimum requirements for using EnerVista 650 Setup are met (see previous section), use the following
procedure to install the EnerVista 650 Setup from the GE EnerVista  CD.

1. Insert the GE EnerVista  CD into your CD-ROM drive.

2. Click the Install Now button and follow the installation instructions to install the no-charge EnerVista software.

3. When installation is complete, start the EnerVista Launchpad application.

4. Click the IED Setup section of the Launch Pad window.

Figure 1–8: LAUNCHPAD WINDOW
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1
5. In the EnerVista Launch Pad window, click the Add Product button and select the “F650 Bay Controller” relay from the

Install Software window as shown below. Select the “Web” option to ensure the most recent software release, or select
“CD” if you do not have a web connection, then click the Add Now button to list software items for the F650.

Figure 1–9: ADD PRODUCT WINDOW

6. If “Web” option is selected, choose the F650 software program and release notes (if desired) from the list and click the
Download Now button to obtain the installation program. 

Figure 1–10: WEB UPGRADE WINDOW
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7. EnerVista Launchpad will obtain the installation program from the Web or CD. Once the download is complete, double-

click the installation program to install the EnerVista 650 Setup software.

8. Select the complete path, including the new directory name, where the EnerVista 650 Setup will be installed.

9. Click on Next to begin the installation. The files will be installed in the directory indicated and the installation program
will automatically create icons and add EnerVista 650 Setup to the Windows start menu.

10. Follow the on-screen instructions to install the EnerVista 650 Setup software. When the Welcome window appears,
click on Next to continue with the installation procedure. 

Figure 1–11: ENERVISTA 650 SETUP INSTALLATION

11. When the Choose Destination Location window appears, and if the software is not to be located in the default
directory, click Change… and type in the complete path name including the new directory name and click Next to
continue with the installation procedure.

Figure 1–12: ENERVISTA 650 SETUP INSTALLATION CONT.
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12. The default program group where the application will be added to is shown in the Selected Program Folder window.

Click Next to begin the installation process, and all the necessary program files will be copied into the chosen directory. 

Figure 1–13: SELECT PROGRAM FOLDER

13. To finish with the installation process, select the desired language for startup.

Figure 1–14: LANGUAGE WINDOW
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14. Click Finish to end the installation. The F650 device will be added to the list of installed IEDs in the EnerVista

Launchpad window, as shown below.

Figure 1–15: ENERVISTA LAUNCHPAD

1.3.3 CONNECTING ENERVISTA 650 SETUP WITH F650

This section is intended as a quick start guide to using the EnerVista 650 Setup software. Please refer to section 4.1 in this
manual for more information about the EnerVista 650 Setup software interface.

a) CONFIGURING AN ETHERNET CONNECTION

Before starting, verify that the Ethernet network cable is properly connected to the Ethernet port on the back of the relay. 

1. Install and start the latest version of the EnerVista 650 Setup software (available from the GE EnerVista CD or online
from http://www.GEindustrial.com/multilin (see previous section for installation instructions).

2. Go to “Communication>Computer” and enter the following data referring to communications:

3. Select Control Type as MODBUS TCP/IP from the drop-down list. This option will display a number of interface
parameters that must be entered for proper Ethernet communications.

4. Enter the relay IP address (from “Setpoint>Product Setup >Communication Settings>Network>IP ADDRESS”) in
the IP Address field in MODBUS TCP/IP SETUP.

5. Enter the relay ModBus address (from “Setpoint>Product Setup >Communication Settings>ModBus
Protocol>ModBus Address COM1/COM2 setting”) in the Unit Identifier (Slave Address) field.

6. Enter the ModBus port address (from “Setpoint>Product Setup >Communication Settings>ModBus
Protocol>ModBus Port Number” setting) in the ModBus Port field.

7. The Device has now been configured for Ethernet communications. Proceed to press the ON button to begin
communicating.
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1b) CONFIGURING AN RS232  CONNECTION

Before starting, verify that the RS232 serial cable, or the USB Cable, is properly connected to the RS232 port or the USB
port on the front panel of the relay.

1. Install and start the latest version of the EnerVista 650 Setup software (available from the GE EnerVista CD or online
from http://www.GEindustrial.com/multilin (see previous section for installation instructions).

2. Go to “Communication>Computer” and enter the following data referred to communications:

3. Select Control Type as No Control Type from the drop-down list. This option will display a number of interface
parameters that must be entered for proper serial communications.

4. Enter the relay Slave Address (“Setpoint>Product Setup >Communication Settings>ModBus Protocol” menu) in
the Slave Address field. The default value is 254.

5. Enter the physical communications parameters (Baudrate and parity settings) from the “Setpoint>Product Setup
>Communication Settings>Serial Ports” menu, in their respective fields. Default values are 19200 for baudrate and
none for parity.

6. The Device has now been configured for RS232  communications. Proceed to press the ON button to begin
communicating.
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1.4650 HARDWARE 1.4.1 MOUNTING & WIRING

Please refer to Chapter 3. Hardware for detailed mounting and wiring instructions.

1.4.2 650 COMMUNICATIONS

The Enervista 650 Setup software communicates to the relay via the faceplate  USB port in hardware 04(E in ordering
code) or  RS232port or the rear RS485/Ethernet ports. To communicate via the faceplate , RS232 port, a standard “straight-
through” serial cable is used. The DB-9 male  end is connected to the relay and the DB-9 or DB-25 female  end is
connected to the PC COM1 or COM2  port as described in Figure 1–16:. To communicate via USB port a male A / male B
USB shielded wire is needed

To communicate through the F650 rear RS485 port from a PC RS232 port, the GE Multilin RS232/RS485 converter box is
required. This device (catalog number F485) connects to the computer using a “straight-through” serial cable. A shielded
twisted-pair (20, 22 or 24 AWG according to American standards; 0.25, 0.34 or 0.5 mm2 according to European standards)
connects the F485 converter to the F650 rear communication port.

In order to minimize communication errors that could be caused by external noise, it is recommended to use a shielded
twist pair. In order to avoid loops where external currents could flow, the cable shield must be grounded only at one end.

The converter box (-, +, GND) terminals are connected to the relay (SDA, SDB, GND) terminals respectively. For long
communications cables (longer than 1 km), the RS485 circuit must be terminated in an RC network (i.e. 120 ohm, 1 nF).
This circuit is shown on Figure 1–17: RS485 CONNECTION FOR 650 UNITS, associated to text Zt(*).

Figure 1–16: RELAY- PC CONNECTION FOR RS232 FRONT PORT

To minimize errors from noise, the use of shielded twisted pair wire is recommended. For correct operation, polarity must
be respected, although a different polarity will not damage the unit. For instance, the relays must be connected with all
RS485 SDA terminals connected together, and all SDB terminals connected together. This may result confusing
sometimes, as the RS485 standard refers only to terminals named “A” and “B”, although many devices use terminals
named “+” and “-“. 

As a general rule, terminals “A” should be connected to terminals “-“, and terminals “B” to “+”. The GND terminal should be
connected to the common wire inside the shield, when provided. Otherwise, it should be connected to the shield. Each
relay should also be daisy chained to the next one in the link. A maximum of 32 relays can be connected in this manner



GEK-113000Z F650 Digital Bay Controller 1-19

1 GETTING STARTED 1.4 650 HARDWARE

1
without exceeding driver capability. For larger systems, additional serial channels must be added. It is also possible to use
commercially available repeaters to increase the number of relays on a single channel to more than 32. Do not use other
connection configurations different to the recommended.

Lightening strikes and ground surge currents can cause large momentary voltage differences between remote ends of the
communication link. For this reason, surge protection devices are internally provided. To ensure maximum reliability, all
equipment should have similar transient protection devices installed.

Figure 1–17: RS485 CONNECTION FOR 650 UNITS

To communicate through the F650 rear Ethernet port from a PC a crossover cable is required. If the connection is
performed through a hub or a switch, a direct Ethernet cable is required.

1.4.3 FACEPLATE DISPLAY

All messages are displayed on a 20x4 character LCD display. An optional graphic display is also available. Messages are
displayed in different languages according to selected model.

1.4.4 MAINTENANCE

F650 requires a minimum amount of maintenance when it is commissioned into service. F650 is a microprocessor based
relay and its characteristics do not change over time. As such no further functional tests are required. However, it is
recommended that maintenance on the F650 be scheduled with other system maintenance. The maintenance may involve
the following:

In-service maintenance:

1. Visual verification of the analog values integrity such as voltage and current (in comparison to other devices on the
corresponding system).

2. Visual verification of active alarms, relay display messages and LED indications.

3. Visual inspection for any damage, corrosion, dust or loose wires.
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4. Event recorder file download with further event analysis.

Out-of-service maintenance:

1. Check wiring connections for firmness.

2. Analog values (current, voltages, analog inputs) injection test and metering accuracy verification. Calibrated test
equipment is required.

3. Protection elements setpoints verification (analog values injection or visual verification of setting file entries against
relay settings schedule).

4. Contact inputs and outputs verification. This test can be conducted by direct change of state forcing or as part of the
system functional testing.

5. Visual inspection for any damage, corrosion or dust.

6. Event recorder file download with further events analysis.

Unscheduled maintenance such as during a disturbance causing system interruption:

1. View the event recorder and oscillography or fault report for correct operation of inputs,outputs and elements.

If it is concluded that the relay or one of its modules is of concern, contact GE Multilin or one of its representative for prompt
service.
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2 PRODUCT DESCRIPTION 2.1OVERVIEW 2.1.1 F650 OVERVIEW

F650 is a protection, control, monitoring, metering and registering unit, suitable for many different applications, such as

main protection for distribution feeders and transmission lines, as well as backup protection for transformers, busbars,

capacitor banks, etc. 

Overvoltage and undervoltage protection, overfrequency and underfrequency protection, breaker failure protection,
directional current supervision fault diagnostics and programmable logic functions are provided. 

This relay also provides phase, neutral, ground and sensitive ground, instantaneous and time overcurrent protection. The
time overcurrent function provides multiple curve shapes or FlexCurves™ for optimum co-ordination. Automatic reclosing,
synchrocheck, and line fault locator features are also provided.

Voltage, current, power, and energy metering is built into the relay as a standard  feature. Current parameters are available
as total waveform RMS magnitude, or as fundamental frequency only RMS magnitude and angle (phasor).

Diagnostic features include a sequence of records. The internal clock used for time-tagging can be synchronized with an
IRIG-B signal or via the SNTP protocol over the Ethernet port. This precise time stamping allows the sequence of events to
be determined throughout the system. Oscillography data capture may be set to record the measured parameters before
and after the event for viewing on a personal computer (PC). These tools significantly reduce troubleshooting time and
simplify report generation in the event of a system fault.

A faceplate RS232 or USB port may be used to connect to a PC for the programming of settings and the monitoring of
actual values.

A variety of communications modules are available. Two rear RS485 ports allow independent access by operating and
engineering staff. All serial ports use the Modbus® RTU protocol. Optional communications modules include a 100BaseFX
Ethernet interface which can be used to provide fast, reliable communications in noisy environments.

Another option provides two 100BaseFX fiber optic ports for redundancy. The Ethernet port supports IEC 61850, Modbus®/
TCP, DNP 3.0 and TFTP protocols, and allows access to the relay via any standard web browser. The IEC 60870-5-104
protocol is supported on the Ethernet port. 

Rear port COM1 could be set to support IEC60870-5-103 protocol

The F650 IEDs use flash memory technology which allows field upgrading as new features are added:

Figure 2–1:  FUNCTIONAL BLOCK DIAGRAM
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2.2SUMMARY 2.2.1 ANSI DEVICE NUMBERS AND FUNCTIONS

DEVICE NUMBER FUNCTION

25 Synchronism Check

27P Phase Undervoltage

27X Auxiliary Undervoltage

32 Directional Power

32FP Forward Power

32N Wattmetric Zero-Sequence Directional

46 Negative Sequence Time Overcurrent

47 Negative Sequence Overvoltage

48 Locked Rotor

49 Protection against Overload by thermal model

50BF Breaker Failure 

50G Ground Instantaneous Overcurrent (measured from 4th current transformer)

50N Neutral Instantaneous Overcurrent (calculated from the phase currents)

50P Phase Instantaneous Overcurrent (two elements, High and Low)

50SG Ground Instantaneous Overcurrent for sensitive ground systems (measured from 5th current 
transformer)

50ISG Isolated Ground Instantaneous Overcurrent (measured from 5th current transformer)

51G Ground Time Overcurrent (measured from 4th current transformer)

51N Neutral Time Overcurrent (calculated from the phase currents)

51P Phase Time Overcurrent with Voltage Restraint (two elements, High and Low)

51SG Ground Time Overcurrent for sensitive ground systems (measured from 5th current transformer)

59N Neutral Overvoltage (two elements, High and Low)

59P Phase Overvoltage

59X Auxiliary Overvoltage

67P Phase Directional

67N Neutral directional

67G Ground Directional

67SG Sensitive Ground Directional

79 Autoreclose (Four shot recloser)

810 Overfrequency

81U Underfrequency

81R Frequency Rate of Change

I2/I1 Broken Conductor

VTFF  VT Fuse Failure

Load Encroachment
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2.2.2 OTHER  DEVICE FUNCTIONS

INPUTS/OUTPUTS METERING COMMUNICATIONS

9 Analog Inputs: 5 current inputs (3 for phases,
1 for ground, 1 for sensitive ground), 4 voltage
inputs (3 for phases, 1 for busbar or auxiliary
voltage) 

Metering Current for phases, ground and
sensitive ground inputs

Front RS232  port, Two rear RS485/
fibre optic ports, 10/100 TX and 100 FX
Mbps Ethernet port

Digital Programmable Contact Inputs (up to 64) Voltages phase to phase and phase to
ground

ModBus Communications RTU and
over TCP/IP

Digital Programmable Contact Outputs (up to
16)

Real, Reactive and Apparent Power and
Power Factor

DNP Multimaster (3.0 Level 2)

32 Latched Virtual Inputs
32 Self-Reset Virtual Inputs

Three Phase Energy IEC 870-5-104

Virtual Outputs (up to 512) Frequency ModBus User Map

Tripping and closing circuit supervision Sequence components of currents and
voltages

IEC 61850

Remote Inputs/Outputs (GSSE and GOOSE
messages)

Pulse Counters IEC 870-5-103 protocol

Analog Inputs (dCmA) Analog Comparators

USER INTERFACE RECORDS OTHERS

Alphanumerical display (4x20) Data Logger Breaking Arcing Current (I2t)

Graphic display (16 x 40) Demand Breaker Control

User Programmable LEDs (15) Event Recorder (up to 128 configurable
events)

IRIG-B synchronization/SNTP

User Programmable Keys (up to 5) Fault Locator and Fault report     (up to 10
records)

Logic Equations (PLC Editor)

Easy menu management thanks to shuttle key Oscillography (up to 20 records) Settings Groups (up to 3)

Configurable One-Line Diagram (Graphic
model only)

Snapshot Events (up to 479) Operations (up to 24)

Phasor Diagram (available in EnerVista 650
Setup)

Web Server Application
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2.3F650 units are supplied as ½ 19” rack, 6 units high, containing the following modules: power supply, CPU, I/O modules, 
communication modules. The required information to completely define an F650 model is shown on Table 2–1:

Table 2–1:  ORDERING CODE 

F650 - - - F - G - - - - - DESCRIPTION

B Basic Display (See note 2)

M Graphic Display  with Standard Symbols  (See note 2)

N Graphic Display with IEC symbols  (See note 2)

REAR SERIAL COMMUNICATIONS BOARD 1

F None

A Redundant RS485 

P Redundant plastic fiber optic 

G Redundant glass fiber optic

X Redundant RS485 + fiber remote CAN bus I/O

Y Redundant plastic fiber optic + fiber remote CAN bus I/O

Z Redundant glass fiber optic + fiber remote CAN bus I/O

C Cable Remote CAN Bus I/O

M RS485 + cable Remote CAN Bus I/O

REAR ETHERNET COMMUNICATIONS BOARD 2 

B 10/100 Base TX

C 10/100 Base TX + 100 Base FX

D 10/100 Base TX + Redundant 100 Base FX

E Redundant 10/100 Base TX

I/O BOARD IN SLOT F

1 16 Digital Inputs + 8 Outputs

2 8 Digital Inputs + 8 Outputs + 2 trip/close circuit supervision circuits

4 32 Digital Inputs

5 16 Digital Inputs + 8 Analog Inputs

I/O BOARD IN SLOT G

0 None

4 32 Digital Inputs (see Note 1)

5 16 Digital Inputs + 8 Analog Inputs (See Note 1)

AUXILIARY VOLTAGE

LO 24-48 Vdc (range 19.2 – 57.6)

HI 110-250 Vdc (range 88 – 300). 
120-230 Vac (range 96 – 250)

LOR Redundant LO 

HIR Redundant HI 

LANGUAGE

- English/English

C Chinese/English (See Note 2)

F French/English

P Russian/English (See Note 2)

S Spanish/English

COMMUNICATION PROTOCOL

- Modbus® RTU, TCP/IP, DNP 3.0 Level 2, IEC 60870-5-104

3 IEC 60870-5-103, Modbus® RTU,TCP/IP

6 IEC 61850, Modbus® RTU and TCP/IP,DNP 3.0 Level 2, 
IEC 60870-5-104

ENVIRONMENTAL PROTECTION

- Without Harsh (Chemical) Environment Conformal Coating

H Harsh (Chemical) Environment Conformal Coating

ENHANCED DISPLAY 

- Display with RS232

E Enhanced Display with USB
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SPECIAL MODELS: MOD001: 6A output contacts instead of 16A.

Notes:

(1)  The digit selected for option G must be equal or higher than the digit selected for option F for models including boards 4 and 5.

F1G5 is a valid selection and F5G1 is and invalid selection. 

(2)   Display options with language selection:

Graphic display: available for English, French, Spanish and Chinese languages. For chinese only IEC symbols option is
available (N in ordering code).

Basic display: available for all languages

For those applications requiring a high number of inputs and outputs, F650 units can be connected to a CIO module
(Remote CAN Bus I/O module) for using up to 2 additional boards. 

F650 units allow monitoring and configuring these I/O boards as if they were internal boards, located on slots F and G. In
this case, slots are labeled as H y J.

 The required information to completely define a CIO Module is shown on Table 2–2:.

Table 2–2:  ORDERING CODE FOR CIO MODULE

(1) The digit selected for option J must be equal or higher than the digit selected for option H for models including boards 4 and 5.

       CIOH1J5**: is a valid selection CIOH5J1**: is an invalid selection

CIO H - J - - DESCRIPTION

I/O BOARD IN SLOT H

1 16 Digital inputs + 8 outputs

2 8 Digital Inputs + 8 Outputs + 2 trip/close circuit supervision circuits

4 32 Digital Inputs

5 16 Digital Inputs + 8 Analog Inputs

I/O BOARD IN SLOT J

0 None

1 16 Digital inputs + 8 outputs

4 32 Digital Inputs (See Note 1)

5 16 Digital Inputs + 8 Analog Inputs (See Note 1)

AUXILIARY VOLTAGE

LO 24-48 Vdc (range 19.2 – 57.6)

HI 110-250 Vdc (range 88 – 300)
120-230 Vac (range 96 – 250)

ENVIRONMENTAL PROTECTION

H Harsh (Chemical) Environment Conformal Coating
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2.4TECHNICAL SPECIFICATIONS

NOTE: TECHNICAL SPECIFICATIONS ARE SUBJECT TO CHANGE WITHOUT NOTICE

2.4.1 PROTECTION ELEMENTS

Phase and ground units use as operation magnitude the current value received by the unit in current inputs, while the
neutral unit uses the calculated current value from the three phase currents.

The isolated ground unit will be used only for those applications where the neutral is completely isolated, and it uses the
fifth CT of the unit. This CT has a sensitivity that is 10 times higher than the universal model (connected to 1A or 5A
transformers). Therefore, it does not admit such a high permanent overload.

2.4.1.1   PHASE TIME OVERCURRENT (51PH/51PL)

Current Input Phasor (without harmonics) or RMS

Rated current For connection to 1 or 5 A CTs.

Pickup level 0.05 to 160.00 A in steps of 0.01 A

Dropout level 97% to 98% of the pickup level

Level Accuracy Values at nominal frequency:

±0.5% of the reading ± 10 mA from 0.05 to 10 A
±1.5% of the reading for higher values.

Curve Shapes IEEE extremely / very / moderately inverse 
IEC A/B/C/long-time inverse/short time inverse curve
IAC extremely / very / moderately inverse
ANSI extremely / very / normally / moderately inverse

I2t
Definite time
Rectifier curve
FlexCurve™ A/B/C/D user curve

Curve Multiplier (Time Dial) 0.00 to 900.00 s in steps of 0.01 s

Reset type Instantaneous or time delayed according to IEEE

Timing accuracy Operate at > 1.03 times the pickup ±3% of operate time or
50 ms. (whichever is greater)

Voltage restraint Selectable by setting 

Saturation Level 48 times the pickup level

Snapshot Events Selectable by setting 
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2.4.1.2   GROUND TIME OVERCURRENT (51G)

2.4.1.3   NEUTRAL TIME OVERCURRENT (51N)

Current Input Phasor (without harmonics) or RMS

Rated current For connection to 1 or 5 A CTs.

Pickup level 0.05 to 160.00 A in steps of 0.01 A

Dropout level 97% to 98% of the pickup level

Level Accuracy Values at nominal frequency:

±0.5% of the reading ± 10 mA from 0.05 to 10 A

±1.5% of the reading for higher values.

Curve Shapes IEEE extremely / very / moderately inverse 
IEC A/B/C/long-time inverse/short time inverse curve
IAC extremely / very / moderately inverse
ANSI extremely / very / normally / moderately inverse

I2t
Definite time
Rectifier curve
FlexCurve™ A/B/C/D user curve

Curve Multiplier (Time Dial) 0.00 to 900.00 s in steps of 0.01 s

Reset type Instantaneous or time delayed according to IEEE

Timing accuracy Operate at > 1.03 times the pickup ±3% of operate time or
50 ms. (whichever is greater)

Saturation Level 48 times the pickup level

Snapshot Events Selectable by setting 

Current Input Fundamental Phasor (without harmonics)

Pickup level 0.05 to 160.00 A in steps of 0.01 A

Dropout level 97% to 98% of the pickup level

Level Accuracy Values at nominal frequency:

±0.5% of the reading ± 10 mA from 0.05 to 10 A
±1.5% of the reading for higher values.

Curve Shapes IEEE extremely / very / moderately inverse 
IEC A/B/C/long-time inverse/short time inverse curve
IAC extremely / very / moderately inverse
ANSI extremely / very / normally / moderately inverse

I2t
Definite time
Rectifier curve
FlexCurve™ A/B/C/D user curve

Curve Multiplier (Time Dial) 0.00 to 900.00 s in steps of 0.01 s

Reset type Instantaneous or time delayed according to IEEE

Timing accuracy Operate at > 1.03 times the pickup ±3% of operate time or
50 ms. (whichever is greater)

Saturation Level 48 times the pickup level

Snapshot Events Selectable by setting 
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2.4.1.4   SENSITIVE GROUND TIME OVERCURRENT (51SG)

2.4.1.5   PHASE AND GROUND INSTANTANEOUS OVERCURRENT (50PH/50PL/50G)

Current Input Phasor (without harmonics) or RMS

Rated current For connection to 1 or 5 A CTs.

Pickup level 0.005 to 16.000 A in steps of 0.001 A

Dropout level 97% to 98% of the pickup level

Level Accuracy Values at nominal frequency:

±1.5% of the reading ± 1 mA from 0.005 to 16 A

Curve Shapes IEEE extremely / very / moderately inverse 
IEC A/B/C/long-time inverse/short time inverse curve
IAC extremely / very / moderately inverse
ANSI extremely / very / normally / moderately inverse

I2t
Definite time
Rectifier curve
FlexCurve™ A/B/C/D user curve

Curve Multiplier (Time Dial) 0.00 to 900.00 s in steps of 0.01 s

Reset type Instantaneous or time delayed according to IEEE

Timing accuracy Operate at > 1.03 times the pickup ±3% of operate time
or 50 ms. (whichever is greater)

Saturation Level 48 times the pickup level

Snapshot Events Selectable by setting 

Current Input Phasor (without harmonics) or RMS

Rated current For connection to 1 or 5 A CTs.

Pickup level 0.05 to 160.00 A in steps of 0.01 A

Dropout level 97% to 98% of the pickup level

Level Accuracy Values at nominal frequency:

±0.5% of the reading ± 10 mA from 0.05 to 10 A

±1.5% of the reading for higher values

Overreach < 2%

Trip delay 0.00 to 900.00 s. in steps of 0.01 s.

Reset delay 0.00 to 900.00 s. in steps of 0.01 s.

Operate time <50 ms at 3 x Pickup at 50 Hz, typically

Timing accuracy at 0 ms time delay (no intentional delay): 50ms 
at non-zero time delay: ±3% of operate time or 50 ms
(whichever is greater)

Snapshot Events Selectable by setting 
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2.4.1.6   NEUTRAL INSTANTANEOUS OVERCURRENT (50N)

2.4.1.7   SENSITIVE GROUND INSTANTANEOUS OVERCURRENT (50SG)

Current Input Fundamental Phasor (without harmonics)

Pickup level 0.05 to 160.00 A in steps of 0.01 A

Dropout level 97% to 98% of the pickup level

Level Accuracy Values at nominal frequency:

±0.5% of the reading ± 10 mA from 0.05 to 10 A

±1.5% of the reading for higher values

Overreach < 2%

Trip delay 0.00 to 900.00 s. in steps of 0.01 s.

Reset delay 0.00 to 900.00 s. in steps of 0.01 s.

Operate time <50 ms at 3 x Pickup at 50 Hz, typically

Timing accuracy at 0 ms time delay (no intentional delay): 50ms
at non-zero time delay: ±3% of operate time or 50 ms
(whichever is greater)

Snapshot Events Selectable by setting 

Current Input Phasor (without harmonics) or RMS

Rated current For connection to 1 or 5 A CTs.

Pickup level 0.005 to 16.000 A in steps of 0.001 A

Dropout level 97% to 98% of the pickup level

Level Accuracy Values at nominal frequency:

±1.5% of the reading ± 1 mA from 0.005 to 16 A

Overreach < 2%

Trip delay 0.00 to 900.00 s. in steps of 0.01 s.

Reset delay 0.00 to 900.00 s. in steps of 0.01 s.

Operate time <50 ms at 3 x Pickup at 50 Hz, typically

Timing accuracy at 0 ms time delay (no intentional delay): 50ms
at non-zero time delay: ±3% of operate time or 50 ms
(whichever is greater)

Snapshot Events Selectable by setting 
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2.4.1.8   ISOLATED GROUND INSTANTANEOUS OVERCURRENT (50IG)

2.4.1.9   NEGATIVE SEQUENCE CURRENT (46)

Current Input Fundamental Phasor (without harmonics)

Voltage Input Fundamental Phasor (without harmonics)

Current Pickup level 0.005 to 0.400 A in steps of 0.001 A

Voltage Pickup level 2 to 70 V in steps of 1 V

Dropout level 97 to 98% of the pickup level

Level Accuracy ±1.5% of the reading ± 1 mA from 0.005 to 16 A

Trip delay 0.00 to 900.00 s. in steps of 0.01 s.

Time to instantaneous 0.00 to 900.00 s. in steps of 0.01 s.

Operate time <50 ms at 3 x Pickup at 50 Hz, typically

Timing accuracy at 0 ms time delay (no intentional delay): 50ms
at non-zero time delay: ±3% of operate time or 50 ms
(whichever is greater)

Snapshot Events Selectable by setting 

Current Input Fundamental Phasor (without harmonics)

Pickup level 0.05 to 160.0 A in steps of 0.01 A

Dropout level 97% to 98% of the pickup level

Level Accuracy Values at nominal frequency:

±0.5% of the reading ± 10 mA from 0.05 to 10 A
±1.5% of the reading for higher values

Curve Shapes IEEE extremely / very / moderately inverse 
IEC A/B/C/long-time inverse/short time inverse curve
IAC extremely / very / moderately inverse
ANSI extremely / very / normally / moderately inverse

I2t
Definite time
Rectifier curve
FlexCurve™ A/B/C/D user curve

Curve Multiplier (Time Dial) 0.00 to 900.00 s in steps of 0.01 s

Reset type Instantaneous or time delayed according to IEEE

Timing accuracy Operate at > 1.03 times the pickup ±3% of operate time
or 50 ms. (whichever is greater)

Saturation Level 48 times the pickup level

Snapshot Events Selectable by setting 
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2.4.1.10   PHASE DIRECTIONAL (67P)

2.4.1.11   GROUND DIRECTIONAL (67G)

2.4.1.12   NEUTRAL DIRECTIONAL (67N)

Directionality Forward and reverse selectable by setting

Polarizing Quadrature Voltage:
ABC seq: Phase A (VBC), Phase B (VCA), Phase C 
(VAB)
ACB seq: Phase A (VCB), Phase B (VAC), Phase C 
(VBA)

Polarizing voltage threshold 0 to 300 Vac in steps of 1 V

Current Sensitivity Threshold 50 mA

Characteristic angle -90º to +90º in steps of 1º

Block Logic Permission or Block selectable by setting

Angle accuracy ±3º for I>0.1 A and V>5 Vac

Operate time <30ms, typically 

Directionality Forward and reverse selectable by setting

Polarizing Voltage, current, dual

Polarizing Voltage VN (measured or calculated, selected by setting)

Polarizing Current Isg (measured from 5th current transformer)

Operating Current Ig (measured from 4th current transformer)

Polarizing Voltage threshold 0 to 300 Vac in steps of 1 V

Polarizing Current threshold 0.005 A

Characteristic angle -90º to +90º in steps of 1º

Block Logic Permission or Block selectable by setting

Angle accuracy ±3º for I>0.1 A and V>5 Vac

Operate time <30ms, typically 

Directionality Forward and reverse selectable by setting

Polarizing Voltage, current, dual

Polarizing Voltage VN (measured or calculated, selected by setting)

Polarizing Current Isg (measured from 5th current transformer)

Operating Current IN

Polarizing Voltage threshold 0 to 300 Vac in steps of 1 V

Polarizing Current threshold 0.005 A

Characteristic angle -90º to +90º in steps of 1º

Block Logic Permission or Block selectable by setting

Angle accuracy ±3º for I>0.1 A and V>5 Vac

Operate time <30ms, typically 
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2.4.1.13   SENSITIVE GROUND DIRECTIONAL (67SG)

2.4.1.14   THERMAL MODEL (49)

2.4.1.15   PHASE OVERVOLTAGE (59P)

Directionality Forward and reverse selectable by setting

Polarizing Voltage

Polarizing Voltage VN (measured or calculated, selected by setting)

Operating Current Isg (measured from 5th current transformer)

Polarizing Voltage threshold 0 to 300 Vac in steps of 1 V

Characteristic angle -90º to +90º in steps of 1º

Block Logic Permission or Block selectable by setting

Angle accuracy ±2º for I>0.1 A and V>5 Vac

Operate time <30ms, typically 

Current Input Fundamental Phasor (without harmonics)

Rated current For connection to 1 or 5 A CTs.

Pickup level 0.05 to 160.0 A in steps of 0.01 A

Dropout level 97% to 98% of the pickup level

Level Accuracy Values at nominal frequency:

±0.5% of the reading ± 10 mA from 0.05 to 10 A
±1.5% of the reading for higher values

Timing accuracy ±3.5% of operate time or 50 ms. (whichever is greater)

Heating constant 3.0 to 600.0 minutes in steps of 0.1 minute

Cooling constant 1.00 to 6.00 times the heating constant in steps of 0.01

Snapshot Events Selectable by setting 

Voltage Input Fundamental Phasor (without harmonics) of phase-to-
phase voltages

Pickup level 3 to 300 in steps of 1 V

Dropout level 97% to 98% of the pickup level

Level Accuracy ±1% of reading from 10 to 208 V at Nominal Frequency

Trip delay 0.00 to 900.00 s. in steps of 0.01 s.

Reset delay 0.00 to 900.00 s. in steps of 0.01 s.

Timing accuracy ±3.5% of operate time or 50 ms. (whichever is greater)

Logic Any/Two/All phases logic selectable by setting

Snapshot Events Selectable by setting 
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2.4.1.16   PHASE UNDERVOLTAGE (27P)

2.4.1.17   NEUTRAL OVERVOLTAGE (59NH/59NL)

2.4.1.18   NEGATIVE SEQUENCE OVERVOLTAGE (47)

Voltage Input Fundamental Phasor of phase-to-ground or phase-to-
phase voltages (selectable by setting)

Pickup level 3 to 300 in steps of 1 V

Dropout level 102% to 103% of the pickup level

Level accuracy ±1% of reading from 10 to 208 V at nominal frequency

Curve Shapes Fixed time or inverse curve

Reset type Instantaneous 

Curve Multiplier (Time Dial) 0.00 to 900.00 s. in steps of 0.01 s.

Timing accuracy ±3.5% of operate time or 50 ms. (whichever is greater)

Minimum Voltage Threshold 0 to 300 in steps of 1 V

Logic Any/Two/All phases logic selectable by setting

Supervised by Breaker Selectable by setting

Snapshot Events Selectable by setting

Voltage Input Fundamental Phasor of the neutral voltage 

Pickup level 3 to 300 in steps of 1 V

Dropout level 97% to 98% of the pickup level

Level accuracy ±1% of reading from 10 to 208 V at nominal frequency

Trip delay 0.00 to 900.00 s. in steps of 0.01 s

Reset delay 0.00 to 900.00 s. in steps of 0.01 s

Timing accuracy ±3.5% of operate time or 50 ms. (whichever is greater)

Snapshot Events Selectable by setting

Voltage Input Fundamental Phasor

Pickup level 3 to 300 in steps of 1 V

Dropout level 97% to 98% of the pickup level

Level accuracy ±1% of reading from 10 to 208 V

Trip delay 0.00 to 900.00 s. in steps of 0.01 s

Reset delay 0.00 to 900.00 s. in steps of 0.01 s

Timing accuracy ±3.5% of operate time or 50 ms. (whichever is greater)

Snapshot Events Selectable by setting
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2.4.1.19   AUXILIARY OVERVOLTAGE (59X)

2.4.1.20   AUXILIARY UNDERVOLTAGE (27X)

2.4.1.21   UNDERFREQUENCY (81U)

Voltage Input Fundamental Phasor of the auxiliary voltage

Pickup level 3 to 300 in steps of 1 V

Dropout level 97% to 98% of the pickup level

Level accuracy ±1% of reading from 10 to 208 V at nominal frequency

Trip delay 0.00 to 900.00 s. in steps of 0.01 s

Reset delay 0.00 to 900.00 s. in steps of 0.01 s

Timing accuracy ±3.5% of operate time or 50 ms. (whichever is greater)

Snapshot Events Selectable by setting

Voltage Input Fundamental Phasor of the auxiliary voltage

Pickup level 3 to 300 V in steps of 1 V

Dropout level 97% to 98% of the pickup level

Level accuracy ±1% of reading from 10 to 208 V at nominal frequency

Curve Shapes Fixed time or inverse curve

Reset type Instantaneous 

Curve Multiplier (Time Dial) 0.00 to 900.00 s. in steps of 0.01 s

Timing accuracy ±3.5% of operate time or 50 ms. (whichever is greater)

Snapshot Events Selectable by setting

Pickup level 20.00 to 65.00 Hz in steps of 0.01 Hz

Dropout level Pickup + 0.03 Hz

Level accuracy ±0.05 Hz of the reading

Trip delay 0.00 to 900.00 s. in steps of 0.01 s

Reset delay 0.00 to 900.00 s. in steps of 0.01 s

Minimum voltage threshold 20 to 300V in steps of 1 V

Timing accuracy ±3.5% of operate time or 100 ms. (whichever is greater)

Snapshot Events Selectable by setting
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2.4.1.22   OVERFREQUENCY (81O)

2.4.1.23   FORWARD POWER (32FP)

2.4.1.24   DIRECTIONAL POWER (32)

Pickup level 20.00 to 65.00 Hz in steps of 0.01 Hz

Dropout level Pickup - 0.03 Hz

Level accuracy ±0.05 Hz of the reading

Trip delay 0.00 to 900.00 s. in steps of 0.01 s

Reset delay 0.00 to 900.00 s. in steps of 0.01 s

Minimum voltage threshold 20 to 300V in steps of 1 V

Timing accuracy ±3.5% of operate time or 100 ms. (whichever is greater)

Snapshot Events Selectable by setting

Current, Voltage Fundamental Phasor (primary values)

Number of stages 2

Pickup level (two stages) 0.00-10000.00 MW in steps of 0.01 MW

Dropout level 97% to 98% of the pickup level

Level accuracy for primary magnitudes ±3% complete range.

Trip delay (two stages) 0.00 to 900.00 s in steps of 0.01 s

Timing accuracy ±3.5% of operate time or 50 ms. (whichever is greater)

Block Time after close 0.00 to 900.00 s in steps of 0.01 s

Snapshot Events Selectable by setting

Current, Voltage Fundamental Phasor (primary values)

Number of stages 2

Pickup level (two stages) -10000.00 to 10000.00 MW (primary values) in steps of
0.01 MW

Characteristic Angle (two stages) 0.00 to 359.99 in steps of 0.01

Accuracy for primary magnitudes ±3% complete range

Trip delay (two stages) 0.00 to 900.00 s in steps of 0.01 s

Timing accuracy ±3.5% of operate time or 50 ms. (whichever is greater)

Block Time after close 0.00 to 900.00 s in steps of 0.01 s

Snapshot Events Selectable by setting

Operate time: < 45 ms at 50 Hz, typically
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2.4.1.25   WATTMETRIC ZERO-SEQUENCE DIRECTIONAL (32N)

2.4.2 CONTROL

2.4.2.1   AUTORECLOSE (79)

Measured Power Zero sequence

Number of elements 6 (3 High level, 3 Low level)

Voltage Pickup Level (VN) 2.00 to 70.00 Volts in steps of 0.01
Voltage calculated from phases if Auxiliary voltage is set
to Vx
Voltage Measured directly from the fourth voltage
transformer if Auxiliary voltage is set to VN.

Level Accuracy for Voltage ±1% of reading from 10 to 208 V

Current Selection IN (calculated from phases)
IG (measured directly from the fourth current
transformer)

OC Pickup Level 0.005 to 0.400 Amps in steps of 0.001

Level Accuracy for current ±0.5% of the reading ± 10 mA from 0.05 to 10 A
±1.5% of the reading for higher values

OC Pickup Delay 0.00 to 600.00 seconds in steps of 0.01

Power Pickup Level 0.01 to 4.50 Watts in steps of 0.01

Characteristic Angle (MTA) 0 to 360º in steps of 1

Power Pickup Delay 0.00 to 600.00 seconds in steps of 0.01

Level Accuracy for Power ±2.5% of the reading at -0.8 = PF = -1 and 0.8 <PF=1

Curve Shapes Inverse Curve
Definite time
FlexCurve™ A/B/C/D user curve

Curve Multiplier (Time Dial) 0.02 to 2.00 s in steps of 0.01 s

Tripping time accuracy ±3.5% of operate time or 50 ms whichever is greater

Snapshot Events Selectable by setting

Operate time < 45 ms at 50 Hz, typically

Schemes Three-pole tripping schemes

Number of shots Up to 4 reclose attempts before lockout

Dead time Independent dead time setting before each shot
adjustable between 0 and 900 s in steps of 0.01 s

Reclaim time 0.00 to 900.00 s in steps of 0.01 s

Condition permission Selectable by setting

Hold time 0.00 to 900.00 s in steps of 0.01 s

Reset time 0.00 to 900.00 s in steps of 0.01 s

Snapshot Events Selectable by setting

Possibility to modify protection settings after each shot programmable through PLC (block signals available after each
shot)
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2.4.2.2   SYNCHROCHECK (25)

2.4.2.3   FUSE FAILURE

2.4.2.4   BREAKER FAILURE (50BF)

2.4.2.5   BROKEN CONDUCTOR (I2/I1)

Dead/live levels for line and bus 0.00 to 300.00 in steps of 0.01 V

Maximum voltage difference 2.00 to 300.00 V in steps of 0.01 V

Maximum angle difference 2.0º to 80.0º in steps of 0.1º

Maximum frequency slip 10 to 5000 mHz in steps of 10 mHz

Synchronism time 0.01 to 600.00 s in steps of 0.01 s

Angle accuracy 3º

Dead Source function None
(DL-DB) Dead Line - Dead Bus
(LL-DB) Live Line-Dead Bus
(DL-LB) Dead Line – Live Bus 

Snapshot Events Selectable by setting

Algorithm based on positive sequence of voltage and current

Activation by V2/V1 ratio

Current Input Fundamental Phasor (without harmonics)

Rated current For connection to 1 or 5 A CTs.

Pickup level for supervision 0.05 to 160.00 A in steps of 0.01 A

Pickup level for high level 0.05 to 160.00 A in steps of 0.01 A

Pickup level for low level 0.05 to 160.00 A in steps of 0.01 A

Pickup level for internal arcing 0.05 to 160.00 A in steps of 0.01 A

Dropout level 97% to 98% of the pickup level

Level Accuracy ±0.5% of the reading ± 10 mA from 0.05 to 10 A

±1.5% of the reading for higher values.

Timing accuracy ±3.5% of operate time or 50 ms. (whichever is greater)

Snapshot Events Selectable by setting 

Pickup level 20.0-100.0% (I2/I1 ratio) in steps of 0.1% 

Dropout level 97% to 98% of the pickup level

Trip delay 0.00 to 900.00 s in steps of 0.01 s

Timing accuracy ±3.5% of operate time or 50 ms. (whichever is greater)

Snapshot Events Selectable by setting

Operation Threshold 0.000 to 1.000 A in steps of 0.001 A

I2/I1 current inhibition level Selectable by setting from 0.000 to 1.000 in steps of
0.001 A
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2.4.2.6   LOCKED ROTOR (48)

2.4.2.7   PULSE COUNTERS

2.4.2.8   ANALOG COMPARATORS

Current Input Phasor (without harmonics) or RMS

Rated current For connection to 1 or 5 A CTs.

Full Load Current 0.10 to 10.00 kA in steps of 0.01 kA

Pickup level 1.01 to 109.00 in steps of 0.01 x FLC

Dropout level 97% to 98% of the pickup level

Level accuracy for primary magnitudes ±3% complete range.

Trip delay 0.00 to 900.00 s. in steps of 0.01 s.

Reset delay 0.00 to 900.00 s. in steps of 0.01 s.

Operate time 20 ms at 3 x Pickup at 50 Hz, typically

Timing accuracy ±3% of operate time or 50 ms. (whichever is greater)

Snapshot Events Selectable by setting 

Number of Pulse counters available Up to 8

Multiplier factor 0.000 to 65000.000 in steps of 0.001

Overload factor 0 to 1000000 in steps of 1 

Board Origin All available input/outputs boards in the device. See
ordering code [F, G, H, J]

Input origin up to 32 [depending on the board type selection]

Analog Input Any analog value available in the device

Analog Maximum Threshold value -100000.000 to 100000.000 in steps of 0.001

Analog Minimum Threshold value -100000.000 to 100000.000 in steps of 0.001

Analog Delay 0.00 to 900.00 in steps of 0.01

Analog Hysteresis 0.0 to 50.00 in steps of 0.1

Analog Direction (for activation inside or outside the
deadband)

IN or OUT
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2.4.2.9   FREQUENCY RATE OF CHANGE 

2.4.2.10   LOAD ENCROACHMENT

2.4.2.11   BREAKER SETTINGS

df/dt trend increasing, decreasing, bi-directional

df/dt pickup level 0.10 to 10.00 Hz/s in steps of 0.01

df/dt level accuracy 80 mHz/s or 3.5%, whichever is greater 

Overvoltage supv. 0.00 to 110.00 % in steps of 0.01

95% settling time for df/dt < 24 cycles 

Operate time: 

at 2 x pickup 12 cycles 

at 3 x pickup 8 cycles 

at 5 x pickup 6 cycles 

Frequency Rate min. 20.00 to 80.00 Hz in steps of 0.01 

Frequency Rate max. 20.00 to 80.00 Hz in steps of 0.01

Frequency Rate delay 0.00 to 60.00 s in steps of 0.01

Snapshot Events Selectable by setting

Responds to: Positive-sequence quantities

Minimum voltage: 0.00 to 300.00 V in steps of 0.01

Reach (sec. Ω): 0.02 to 250.00 Ω in steps of 0.01

Impedance accuracy: ±3% 

Angle: 5 to 50º in steps of 1

Angle accuracy: ±3º

Pickup delay: 0.000 to 65.535 s in steps of 0.001

Reset delay: 0.000 to 65.535 s in steps of 0.001

Time accuracy: ±3.5% or ±60 ms, whichever is greater 

Operate time: <60 ms at 50 Hz typically

Snapshot Events Selectable by setting

Number of Switchgear 1 to 16 (selection of switchgear for breaker control)

Maximum KI2t 0.00 to 9999.99 in steps of 0.01 (kA)2 s

KI2t integration Time 0.03 to 0.25 s in steps of 0.01 s

Maximum openings 0 to 9999 in steps of 1

Maximum Openings in one hour 1 to 60 in steps of 1

Snapshot Events Selectable by setting 
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2.4.2.12   BREAKER MAINTENANCE

2.4.2.13   SWITCHGEAR

2.4.3 MONITORING

2.4.3.1   OSCILLOGRAPHY

2.4.3.2   FAULT LOCATOR

KI2t Breaker Counters for Phases A, B, C 0.00 to 9999.99 in steps of 0.01 (kA)2 s

Breaker Openings Counter 0 to 9999 in steps of 1

Breaker Closings Counter 0 to 9999 in steps of 1

Switchgear 1 to16 (configurable in “relay configuration” screen).

Snapshot Events Selectable by setting (for each switchgear in “system setup”) 

Maximum Records: Up to 20 Oscillography records.

Sampling rate: Programmable to 4, 8, 16, 32 or 64 samples per power cycle
Capacity per record: 27592 samples

No of Oscillos * No of samples/cycle

Trigger position: 5% to 95% of total length

Trigger: Programmable via PLC

Data: 5 current channels and 4 voltage channels

Up to 16 digital channels programmable through PLC

Data Storage: In non volatile memory (flash) without battery

Format: International Standard COMTRADE ASCII - IEEE C37.111-1999.

Automatic Overwrite: Selectable by setting. (Oscillography records can be concatenated)

Snapshot Events: Selectable by setting

Method: Single-ended

Positive Sequence Module: 0.01 to 250.00 Ohm in steps of 0.01 Ohms

Positive Sequence Angle: 25 to 90º in steps of 1º

Zero Sequence Module: 0.01 to 750.00 Ohms in steps of 0.01 Ohm

Zero Sequence Angle: 25 to 90º in steps of 1º

Line Length: 0.0 to 2000.0 in steps of 0.1 (miles or km)

Accuracy: 5% (typical)

Show Fault on HMI: Selectable by setting

Snapshot Events: Selectable by setting

Maximum Records: Up to 10 fault report records.

Data: Fault date and time, pre-fault currents and voltages, fault currents and voltages, 
fault type, distance to the fault (fault location), line parameters, recloser and 
breaker status information.
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2.4.3.3   SNAPSHOT EVENTS

2.4.3.4   CONTROL EVENTS

2.4.3.5   DEMAND

Data Storage: In non volatile memory (flash) without battery available through communications

In volatile memory (ram) available through HMI (if selectable by setting)

Format: Text in ASCII format

Capacity: 479 scrolling events
Time-tag 1 ms using an internal clock of 100 μs
Timing Accuracy: 1 ms (using the IRIG-B synchronization input)

Triggers: Any element pickup, dropout or operation
Digital input /output change of state
By virtual inputs and control events

Data Storage In non volatile memory (flash) without battery
The snapshot event recording procedure can be enabled or disabled by setting for each protection function

Capacity: 128 events programmable through PLC

Time-tag: 1 ms plus one plc cycle using an internal clock of 100 μs. For Digital Inputs, the
debounce time of these digital inputs must be added.

Timing Accuracy: 1 ms (using the IRIG-B synchronization input)

Triggers: By any digital signal programmable through PLC 

Alarm Possibility to display the event as an alarm on the alarms panel. 
Information available always through Communications for all models and also in 
HMI for models with graphical display (M in ordering code).

Data Storage: In non volatile memory (flash) without battery

Control events are also displayed in the snapshot events recording

Channels: 9

Parameters: Ia (kA RMS), Ib (kA RMS), Ic (kA RMS), Ig (kA RMS), Isg (kA RMS), I2 (kA), P
(MW), Q (MVAr) and S (MVA)

Current and Power Method Thermal Exponential, Block Interval, Rolling Demand

Measurements: Each channel shows the present and maximum measured value, with date and
time for the maximum recorded value. 

Samples: 5, 10, 15, 20, 30, 60 minutes.

Accuracy: ±2%

Trigger Input Selectable by setting (operation mode selection for the Block Interval calculation
method)

Snapshot Events: Selectable by setting
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2.4.3.6   DATA LOGGER

2.4.4 USER-PROGRAMMABLE ELEMENTS

2.4.4.1   PLC LOGIC

2.4.4.2   FLEXCURVES

2.4.4.3   USER-PROGRAMMABLE LEDS

Number of Channels: 1 to 16

Parameters Any available analog actual value

Samples 1 sec., 1, 5, 10, 15, 20, 30, 60 min.

Storage Capacity Fixed, 32768 measures

Programming language: The logical configuration is performed using graphical functions based on the 
IEC 61131-3 standard.

Lines of code: 512

Supported operations: NOT, XOR, OR (2 to 8 inputs), AND (2 to 8 inputs), NOR (2 to 8 inputs), 
NAND (2 to 8 inputs), Latch (Reset Dominant), Edge Detectors, Timers.
2 inputs default gates, from 3 to 8 inputs provided in library format.

Libraries: Logical gates fully programmable by user. To create user-programmable logic to
be distributed as a single object.

Inputs: Any logical variable, contact or virtual input

Number of timers: 8 maximum in each logic scheme (provided in library format)

Number: 4 (A through D)

Reset points: 40 (0 through 1 of pickup)

Operate points: 80 (1 through 20 of pickup)

Time delay: 0 to 65535 ms in steps of 1

Saturation Level 20 times the pickup level

Number: 15 configurable LEDs plus a ready non configurable LED

Programmability: from any logical variable, contact, or virtual input

Reset mode: Self-reset or Latched. 
The first 5 LED’s are latched by hardware (red color ones), usually configured for
trip signals.
The following 10 ones (yellow and green) are self-reset but can be latched
through PLC configuration.

Reset Signal: The LED’s can be reset by hardware, pressing the front “esc” key during more
than 3 seconds or using the LED reset signal through PLC configuration.
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2.4.4.4   USER-DEFINABLE DISPLAYS

2.4.4.5   USER-PROGRAMMABLE FRONT KEYS

2.4.5 METERING

2.4.5.1   CURRENT

2.4.5.2   VOLTAGE

2.4.5.3   REAL POWER (WATTS)

2.4.5.4   REACTIVE POWER (VARS)

2.4.5.5   APPARENT POWER (VA)

2.4.5.6   WATT-HOURS (POSITIVE AND NEGATIVE)

Number of configurable displays: 1 (one line diagram fully configurable). In graphical displays only

Number of fixed displays: 6, Metering (in primary values), Snapshot events (all and new), Alarms, Inputs 
and outputs screen with test functionality for inputs and outputs. In graphical 
displays only

Number of selectable displays: Logotype, metering or both in scrolling mode, can be selectable as default 
screen in text display for all models (basic and mimic). The metering screen 
contains current and voltages for phases and ground in primary values.

Number of configurable Keys: 5

Operation: drive PLC operands

Accuracy: ±0.5% of the reading ± 10 mA from 0.05 to 10 A (for phases and ground)
(at nominal frequency) ±1.5% of the reading ± 1 mA from 0.005 to 5 A (for sensitive ground)

±1.5% of the reading for higher values
% of load-to-trip accuracy: ±0.5% of full-scale

Accuracy: ±1% of reading from 10 to 208 V

Accuracy: ±2.0% of the reading at -0.8 ≤ PF ≤ -1.0 and 0.8 <PF≤1.0

Accuracy: ±2.0% of the reading at-0.2 ≤ PF ≤ 0.2

Accuracy: ±2.0% of the reading

Accuracy: ±2.0% of the reading

Range: ±0 to 2147 MWh

Parameters: 3-phase only

Update rate: 100 ms
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2.4.5.7   WAR-HOURS (POSITIVE AND NEGATIVE)

2.4.5.8   FREQUENCY

2.4.5.9   ANGLE

2.4.6 INPUTS

2.4.6.1   AC CURRENT INPUTS

Accuracy: ±2.0% of the reading

Range: ±0 to 2147 MVArh

Parameters: 3-phase only

Update rate: 100 ms

Accuracy: +/- 0.03Hz

Accuracy: ±3º

CT Ratio: 1.0 to 6000.0 in steps of 0.1

Rated currents: Appropriate for 1 or 5 A. F650 has universal range for CT (valid for 1 or 5 A to
only one terminal).

Relay Burden: < 0.04 Ohm

Current Withstand Continuous at 20 A

1 second at 500 A for phases and ground
1 second at 50 A for sensitive ground
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2.4.6.2   AC VOLTAGE INPUTS

2.4.6.3   CONTACT INPUTS

2.4.6.4   REMOTE INPUTS (IEC61850 GSSE/GOOSE)

2.4.6.5   ANALOG INPUTS

VT Ratio 1.0 to 6000.0 in steps of 0.1

Rated Voltages 275 Vac

Metering range: From 2 to 275 Vac

Relay Burden: 0.05 VA at 120 Vac (50 or 60 Hz)

Voltage Withstand: Continuous at 275 V to neutral

1 min/hr at 420 to neutral

VAC inputs do not need varistors, as the impulse test is applied to 100% of the transformers

Input Activation Voltage Threshold: 10 to 230 Vdc in steps of 1 V (selectable by setting)

Impedance: > 100 kOhm

Maximum error: ±10% setting or ± 5 V

Load for voltage supervision inputs: 2 mA + V/100 kOhm

Voltage threshold for voltage 
supervision inputs:

< 10 V (fixed)

Debounce Time: 1 to 50 in steps of 1 ms

Recognition time: < 1ms

Timing resolution: 1 ms
For Input Activation Voltage Threshold and Debounce Time there is a single setting for all inputs in the same group (inputs
sharing the same common).

Input Type and Delay Input Time are not grouped; there is a different setting for each input.

Input Type Positive-Edge / Negative-Edge / Positive/ Negative

Delay Input Time 0 to 60000 ms in steps of 1 ms (Input signal time delay)

Number of input points: 32, configured from 64 incoming bit pairs
Number of remote devices: 16

Default states on loss of comms: On, Off, Latest/on, Latest/off

Input impedance 116Ω
Current Input (mADC): 0 to -1; 0 to +1; -1 to +1; 0 to 5; 0 to 10; 0 to 20; 4 to 20 (programmable)

Conversion Range: -1 to +20mA

Accuracy: ±0.2% of full scale

Type: Passive
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2.4.6.6   IRIG-B INPUT

2.4.7 REAL TIME CLOCK

2.4.8 OUTPUTS

2.4.8.1   REMOTE OUTPUTS (IEC61850 GSSE/GOOSE)

Amplitude modulation: DC SHIFT = Demodulated input (no carrier) 

Input Voltage: TTL

Input Burden: 1.5 mA

Input Impedance: 3.3 kOhm

Minimum Input Voltage: 2.4 V

Maximum Input Voltage: ± 24 V

Formats: B000 (*) B001, B002 and B003 (*)
(*) Signal combinations recognized in accordance with IRIG Standard 200-95

Isolation: 2 kV

Accuracy: Typical ±20 ppm

Backup energy: More than 1 week

Single Contact Carry continuous: 16 A 

Make and Carry for 1 sec. 60 A

Break at L/R of 40 ms: 0.3 A DC max. at 125 Vdc
0.25 A DC max. at 250 Vdc

Operate Time: < 8 ms

Contact material: Silver Alloy

Output Logic Type, Output Type and Pulse Output Time are selectable by setting for each output

Output Logic Type Positive / Negative

Output Type Normal / Pulse / Latch (Selectable by setting for each output)

Pulse Output Time 0 to 60000 ms in steps of 1 ms (applicable only to signals set as pulse type)

Separate operate and reset signal can be configured by any digital signal programmable through PLC

Contact Outputs (F31-F33, F34-F36) for
board type 2 (supervision) in slot F:

The current seal-in circuit is used for verifying the current condition in a circuit
during the time that the tripping contact remains closed. If the current in the
tripping circuit is maintained over 500 mA, the function is sealed independently of
the status of the function that caused the trip.

Standard output points 32

User output points      32
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2.4.9 CONTROL POWER SUPPLY

2.4.10 COMMUNICATIONS

LOW RANGE (LO)

Nominal DC Voltage: 24 to 48 V

Min/Max DC Voltage 19.2 / 57.6 V

Note: Low range is DC only

HIGH RANGE (HI)

Nominal DC Voltage: 110 to 250 V

Min/Max DC Voltage 88 / 300 V

Nominal AC Voltage: 120 to 230 V

Min/Max AC Voltage 102 / 250 V

ALL RANGES

Voltage Loss hold-up time 200 ms typical, worst case 100 ms without unit reset

Power consumption Typical =25 VA, Maximum =45 VA
Display backlight auto power-off mode after 15 minutes without touching any key, in order to ensure long life and minimum
consumption.

FRONT PORT:

Front port: COM2

Type RS232/USB

Baud Rate 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600 y 115200 bauds

Default Baud Rate 19200

Protocols available: ModBus® RTU / DNP 3.0

Typical distance: 3 m

Isolation: 2 kV

ASYNCHRONOUS REAR PORTS:

None or two rear ports (depending on 
model):

COM1, COM2 (rear COM2 multiplexed with front port)

Type (depending on model):

Model F None

Model A Redundant RS485

Model X Redundant RS485 + fiber CAN for inputs/outputs module 

Model P Redundant 1mm-plastic F.O.

Model Y Redundant 1mm-plastic F.O. + fiber CAN for inputs/outputs module 

Model G Redundant multimode glass F.O. 

Model Z Redundant multimode glass F.O. + fiber CAN for inputs/outputs module 

Model C Cable CAN port for I/O module 

Model M Cable CAN port for I/O module (cable) + RS485 (ModBus RTU)

Optic Features for ST connectors 
devices:

Wave length: 1300nm

Fiber type: multimode 62.5/125 μm or 50/125 μm

Baud Rate: 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600 y 115200 bauds

Default Baud Rate 19200
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Protocols available: ModBus® RTU / DNP 3.0/IEC103

Typical distance:  1200 m for cooper cable, 1000 m for glass fiber and 50 m for plastic 
fiber

Isolation: 2 kV

CAN PORT: 

Rear port: CAN port in models C, M, X, Y, Z for asynchronous rear ports

Type: Multimode glass F.O. port with ST connectors

Fiber Wave length: 820 nm

Fiber type: multimode 62.5/125 μm or 50/125 μm

Maximum recommended length 300m  for cooper cable and glass fiber

Isolation: 2 kV

ETHERNET PORT:

Rear port: COM3

Type (depending on model):

Model B: 10/100BaseTX self-negotiable

Model C: 10/100BaseTX + 100Base FX 

Model D: 10/100BaseTX + redundant 100BaseFX (Physical media redundancy)

Model E: Redundant 10/100BaseTX self-negotiable ports

10/100BaseTX RJ45 connector

100BaseFX ST connectors

Wave length: 1300 nm

Fiber type: multimode 62.5/125 μm or 50/125 μm

Protocols available: ModBus® TCP/IP

DNP over TCP/IP and UDP/IP

IEC 61850

Http, ftp, tftp (allow the use of a standard Internet browser)

Typical distance: 1000 m for glass fiber and 300 m for RJ45 cable

Response time to ModBus commands: 10 ms Typical

Isolation: 2 kV

In Models C and D, the 10/100BaseTX port is selected by an internal switch (see 3.3.3)

Two witness LED’s for transmission and reception are included
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2.4.11 OPTIC FEATURES

Wave length: 1300nm

Connector types: ST package style 

Fiber type: multimode 62.5/125 μm or 50/125 μm

Notes:

1. These optical power values are measured with the following conditions:

The Beginning of Live (BOL) to the End of Life (EOL) optical power degradation is typically 1.5 dB per industry
convention for long wavelength LEDs. The actual degradation observed in Agilent’s 1300nm LED products is <1 dB, as
specified in this data sheet.

Over the specified operating voltage and temperature ranges.

With HALT Line State, (12.5 MHz square-wave), input signal.

At the end of one meter of noted optical fiber with cladding modes removed.

The average power value can be converted to a peak power value by adding 3 dB. Higher output optical power
transmitters are available on special request.

2. The transmitter provides compliance with the need for Transmit_Disable commands from the FDDI SMT layer by
providing an Output Optical Power level of <-45 dBm average in response to a logic “0” input. This specification applies
to either 62.5/125 μm or 50/125 μm fiber cables.

3. This specification is intended to indicate the performance of the receiver section of the transceiver when Input Optical
Power signal characteristics are present per the following definitions. The Input Optical Power dynamic range from the
minimum level (with a window time-width) to the maximum level is the range over which the receiver is guaranteed to
provide output data with a Bit Error Ratio (BER) better than or equal to 2.5e-10.

At the Beginning of Life (BOL).

Over the specified operating temperature and voltage ranges.

4. All conditions for Note 3 apply except that the measurement is made at the center of the symbol with no window time-
width.

TRANSMITTER CHARACTERISTICS

Parameter Min. Typ. Max. Unit Reference

Output Optical Power                   BOL
62.5/125 μm, NA = 0.275 Fiber    EOL

-19
-20

-14 dBm avg. Note 1

Output Optical Power                   BOL
   50/125 μm, NA = 0.275 Fiber    EOL

-22.5
-23.5

-14 dBm avg. Note 1

Output Optical Power at
Logic “0” State

-45 dBm avg. Note 2

RECEIVER CHARACTERISTICS

Parameter Min. Typ. Max. Unit Reference

Input Optical Power
Minimum at Window Edge

-33.9 -31 dBm avg. Note 3

Input Optical Power
Minimum at Eye Center

-35.2 -31.8 dBm avg. Note 4

Input Optical Power Maximum -14 dBm avg. Note 3
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2.4.12 ENVIRONMENTAL CHARACTERISTICS

2.4.13 PACKAGING AND WEIGHT

2.4.14 TYPE TESTS

Type test report available upon request.

F650 has been designed to comply with the highest existing requirements. More specifically, UNIPEDE recommendations
for high voltage substations are followed, even if for most applications such high classes are not required.

The relay complies with ANSI C37.90 standards, and has been designed to comply with international standards.

2.4.15 APPROVALS

Operating temperature: - 10°C to + 60°C
Storage temperature: - 40°C to + 80°C
Humidity (non condensing): 95%

Altitude Up to 2000 m

Installation category II

Net weight: 5 kg

Packaged: 6 kg

Package dimensions: 30x40x40 cm (DxWxH)

CATEGORY STANDARD CLASS TEST

EMC IEC 61000-4-1 IEC 60255-22-1 III Oscillatory waves immunity

IEC 61000-4-2 IEC 60255-22-2 IV Electrostatic discharge immunity test

IEC 61000-4-3 IEC 60255-22-3 III Radiated electromagnetic field disturbance test

IEC 61000-4-4 IEC 60255-22-4 IV Electrical fast transient

IEC 61000-4-5 IEC 60255-22-5 IV Surge immunity test

IEC 61000-4-6 IEC 60255-22-6 III Conducted electromagnetic field disturbance test

IEC 61000-4-8 EN 61000-4-8 IV Power frequency magnetic field immunity

ENV50204 III Radiated electromagnetic field disturbance test – 
1890 MHz.

EMC Emisivity IEC 60255-25 EN 61000-6-4 A Conducted and radiated emissions

Product IEC 60255-5 2 kV Insulation resistance – dielectric test

IEC 60255-5 6kV .5J Impulse test

IEC 60255-11 100 ms Power supply Voltage dips/interruptions/variations:

Mechanical IEC 60255-21-1 I Vibration test (sinusoidal)

IEC 60255-21-2
IEC 60255-21-3

I
II

Shock and bump 
Seismic 

ISO9001 Registered system.

CE marking: Meets the CE standards relevant for protections.

UL 508 Certified
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2.5EXTERNAL CONNECTIONS

Figure 2–2: F650 WIRING DIAGRAM (189C4216H2)
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Figure 2–3: INPUT/OUTPUT CONFIGURATIONS FOR BOARDS F1 AND F2 (189C4216H1)

F1 + CC1 52b F19
F2 + CC2 50P BLOCK F20
F3 + CC3 51P BLOCK F21
F4 + CC4 67P BLOCK F22
F5 + CC5 50G BLOCK F23
F6 + CC6 51G BLOCK F24
F7 + CC7 79 INITIATE F25
F8 + CC8 79 BLOCK F26
F9 - COMMON 1/8 COMMON 1/8 F27
F10 - COMMON 9/16 COMMON 9/16 F28
F11 + CC9 NOT USED F29
F12 + CC10 NOT USED F30
F13 + CC11 NOT USED F31
F14 + CC12 NOT USED F32
F15 + CC13 NOT USED F33
F16 + CC14 NOT USED F34
F17 + CC15 NOT USED F35
F18 + CC16 NOT USED F36

F1 + COIL 1 F19
F2 - 52/a F20
F3 + COIL 1 F21
F4 - 52/b F22
F5 + CC1 52b F23
F6 + CC2 50P BLOCK F24
F7 + CC3 51P BLOCK F25
F8 + CC4 67P BLOCK F26
F9 - COMMON 1/4 COMMON 1/4 F27
F10 - COMMON 5/8 COMMON 5/8 F28
F11 + CC5 50G BLOCK F29
F12 + CC6 51G BLOCK F30
F13 + CC7 79 INITIATE I SENS F31
F14 + CC8 79 BLOCK F32
F15 + COIL 2 F33
F16 - 52/a I SENS F34
F17 + COIL 2 F35
F18 - 52/b F36

INPUTS / OUTPUTS CONFIGURATION FOR BOARDS F1 AND F2
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3 HUMAN INTERFACES. SETTINGS & ACTUAL VALUES  3.1ENERVISTA 650 SETUP SOFTWARE INTERFACE

3.1.1 INTRODUCTION

The EnerVista 650 Setup software provides a graphical user interface (GUI) as one of two human interfaces to a 650
device. The alternate human interface is implemented via the device faceplate keypad and display (see Human Machine
Interface section in this chapter).

The EnerVista 650 Setup software provides a single facility to configure, monitor, maintain, and trouble-shoot the operation
of relay functions, connected over local or wide area communication networks. It can be used while disconnected (i.e.
offline) or connected (i.e. on-line) to a 650 device. In off-line mode, settings files can be created for eventual downloading to
the device. In on-line mode, you can communicate with the device in real-time.

The EnerVista 650 Setup software, provided with every F650 relay, can be run from any computer supporting Microsoft
Windows¬Æ 95, 98, NT, 2000, ME, and XP. This chapter provides a summary of the basic EnerVista 650 Setup software
interface features. The EnerVista 650 Setup Help File provides details for getting started and using the EnerVista 650
Setup software interface.

3.1.2 ENERVISTA 650 SETUP SOFTWARE OVERVIEW

This software package uses ModBus protocol, and it is designed to communicate with a single relay at a time. GE offers
different communication software packages, such as GE-POWER, which can be used to communicate simultaneously with
several relays.

EnerVista 650 Setup software provides an easy way to configure, monitor and manage all F650 features.

3.1.2.1   ENGAGING A DEVICE

The EnerVista 650 Setup software may be used in on-line mode (relay connected) to directly communicate with a 650
device.

3.1.2.2   USING SETTINGS FILES

The EnerVista 650 Setup software interface supports three ways of handling changes to relay settings:

1. In off-line mode (relay disconnected) to create or edit relay settings files for later download to communicating relays.

2. While connected to a communicating relay to directly modify any relay settings via relay data view windows, and then
save the settings to the relay.

3. You can create/edit settings files and then write them to the relay while the interface is connected to the relay.

Settings files are organized on the basis of file names assigned by the user. A settings file contains data pertaining to the
following types of relay settings:

•Product Setup

•System Setup

•Protection Elements

•Control Elements

•Inputs/Outputs

•Relay Configuration

•Logic Configuration

3.1.2.3   VIEWING ACTUAL VALUES

You can view real-time relay data such as input/output status and measured parameters.
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3.1.2.4   VIEWING TRIGGERED EVENTS

While the interface is in either on-line or off-line mode, you can view and analyze data generated by triggered specified
parameters, via one of the following:

• Event Recorder facility: The event recorder captures contextual data associated with the last 479 events, listed in
chronological order from most recent to oldest.

• Oscillography facility: The oscillography waveform traces and digital states are used to provide a visual display of
power system and relay operation data captured during specific triggered events.

3.1.2.5   FIRMWARE UPGRADES

The firmware of a F650 device can be upgraded, locally or remotely, via the EnerVista 650 Setup software. The
corresponding instructions are provided by the EnerVista 650 Setup Help file under the topic ‚"Upgrading Firmware".

Modbus addresses assigned to firmware modules, features, settings, and corresponding data items (i.e. default values,
minimum/maximum values, data type, and item size) may change slightly from version to version of firmware.

The addresses are rearranged when new features are added or existing features are enhanced or modified.

3.1.2.6   ONE LINE DIAGRAMS

You can configure an one line diagram (bay mimic) to be used in relays with graphical display.
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3.1.3 MAIN SCREEN

The EnerVista 650 Setup software main window supports the following primary display components:

• Title bar

• Main menu bar

• Main icon bar

• Working area

• Status bar

Figure 3.1: ENERVISTA 650 SETUP MAIN SCREEN

Working Area

 Title
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3.1.4 COMMUNICATION MENU

To start communicating with the relay go to ‚"Communication>Computer>Computer settings" section in the main
EnerVista 650 Setup menu. 

Safety instructions must be followed before connecting the computer to the relay. Safety instructions are detailed in section
1.1.3. Connect the relay ground terminal and the communicating computer to a good grounding. Otherwise, communication
may not be viable, or even, in worst cases, the relay and/or the computer could result damaged by overvoltages.

For on-line working, previously ensure that all relay communication parameters, such as baudrate, slave ModBus address,
etc., match the computer settings. 

Figure 3.2: COMMUNICATION PARAMETERS MENU

The ‚"Communication > computer" screen is divided in several subsections:

•      Computer settings: Main communication parameters for serial communication and control type selection.

•      ModBus/TCP Setup (if ModBus /TCP is selected as control type): Communication parameters for ModBus TCP
communication.

•      Communication control: Device communication status (communicating or not communicating).

•      Communication optimization: allows optimizing the communication time outs and failure establishing.
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3.1.4.1   COMPUTER SETTINGS: 

Shows the communication parameters necessary in order to establish communication with the unit. Such as slave address,
communication port, baud rate, parity, control type and startup mode.

Baud rate, parity, data bits, stop bits and ModBus slave address for com2 (RS232 front port and second serial port in the
rear communication board) are displayed in the default text logotype main screen.

ModBus Slave Address: ModBus addresses used for serial and Ethernet communication.

Communication ports: port used in the computer for serial communication.

Baud Rate: Baud rate for serial communication (from 1200 up to 115200 bauds in EnerVista 650 Setup, from 300 to
115200 in relay). 

Parity: parity for serial communication. None, odd or even can be selected.

Control Type: The available control modes are:

• No Control Type, this option selects the serial communication mode, for use with serial communication ports (front
port, RS485, or plastic or glass fiber optic).

• MODBUS/TCP, this option selects ModBus TCP/IP communication mode, for communication through the Ethernet
port. In this case, the top right window will show the typical parameters to be programmed; IP address, port address
and unit identifier in the MODBUS TCP SETUP section.

• MODEM, this option displays the parameter to set in case of using a modem for the communication, such as Phone
number, Time out (sec.), init. command, type of dialing (tones or pulses).

3.1.4.2   COMMUNICATION CONTROL:

Located at the bottom of the screen, it shows the status of the communication with the relay. With relay not communicating,
a message "650 Setup is not talking to an 650" will be shown and ON button will be enable. Pressing this button, 650 Setup
start communicating with the relay.

With relay communicating a message "650 Setup is now talking to an 650" will be shown and OFF will be enable. Pressing
this button, communications between relay and PC will be closed.

3.1.4.3   COMMUNICATION OPTIMIZATION:

The parameters shown on the bottom right window (Communication optimization) can improve communication, although it
is recommended to leave the default values indicated by the EnerVista 650 Setup. These parameters are the maximum
time to wait for a response in the relay (in ms) and the maximum attempts to perform before assuming communications
failure.
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3.1.5 FILE MANAGEMENT

File management with EnerVista 650 Setup software:

3.1.5.1   OFF LINE MODE

Figure 3.3: OFF-LINE MODE FILE MANAGEMENT

Run EnerVista 650 Setup

Open a *.650 file 
(“File>Open” menu)

Modify  Settings and relay 
configuration

Is it necessary to 
program 

additional logic?

Launch the Logic Configuration tool in EnerVista 
650 Setup (“Setpoint>Logic Configuration”)

Create new or modify the existing logic: 
(“File>Open Project”)

Compile and save logic file (*.pep) and drawing 
design (*.aut) in Logic Configuration tool

Exit PLC Graphic Editor and save the *.650 file 
from the main application menu

Is the relay 
completely 
configured? 

Save *.650 settings & configuration file 

Store in the computer the Logic configuration files (*.pep, *.aut, *.lib) as 
well as the *.650 for further logic changes. 

YES

YES

NO NO 
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Table 3.1:  TYPES OF FILES GENERATED BY ENERVISTA 650 SETUP SOFTWARE OPERATION MODE OFF-LINE: 

In case of using element libraries (either existing ("File Library>Open Library") or created by the user ("File Library>New
Library"), the program will create and manage the corresponding files (*.lib) in a folder named FDB (Functional Block
Diagram). These files are used for the PLC project compilation. It is necessary to store them with the other logic
configuration files that built the PLC project (*.pep, *.aut, *.lib).

Besides sending basic information to the relay (Settings + configuration) in *.650 format, it is recommended to store *.650,
*.pep, *.aut and *.lib files inside the relay ("Communication>Upload info files to relay"), to ensure that logic configuration
files will be available in the future for further logic modifications; either if these files are not used by the relay, they are
required for connecting to a relay and analyzing its configuration. The program manages the logic configuration files
globally, so that when the user selects to save file *.pep in the relay, the associated *.aut and *.lib files are also stored.

SETTINGS & CONFIGURATION FILE *.650
LOGIC CONFIGURATION FILES (*.PEP, *AUT, *.LIB)

*.PEP *.AUT *.LIB

Description Settings and Configuration Section Header for Logic 
project

Graphical edition 
container. Logic 
equations (Virtual 
Outputs) in FDB 
format.

User programmable 
logic objects

Created by EnerVista 650 Setup
Logic configuration 
graphic editor (PLC 
Editor)

Logic configuration 
graphic editor (PLC 
Editor)

Logic configuration 
graphic editor (PLC 
Editor)

Contents

Relay configuration file containing all  elements
Settings, input/output and LEDs configuration, graphic
display configuration, etc.
Equations corresponding to the logic created and
compiled in the PLC Editor

PLC project file 
containing the 
necessary 
information relative 
to the relay model, 
logic libraries 
included in the 
project (*.lib), 
graphic file name 
(*.aut), etc.

PLC Project file 
containing all the 
drawings used by 
the logic, required by 
650 relay based on 
IEC 61131-3 
standard. Functional 
block diagram 
(FDB).

Library file to be 
included as an 
object in a PLC 
project. Logic 
packages that can 
be stored into 
libraries and be 
distributed in 
different PLC 
projects.

How to save EnerVista 650 Setup:
"File>Save *"

PLC Editor:
"File>Save 
Project"

PLC Editor:
"File>Save 
Project"

PLC Editor: 
"File>Save 
Library"

How to open EnerVista 650 Setup:
"File>Open *"

PLC Editor:
"File>Open 
Project"

PLC Editor:
"File>Open 
Project"

PLC Editor:
"File>Library>New 
Library"

How to 
transfer to 
relay

Connect with the relay 
("Communications>Computer")
Open the created file ("File>Open *")
Send to relay from the menu: "File>Send info to relay"
Note that texts used in the configuration of inputs,
outputs, etc. are not sent to the relay. The only texts
sent to relay are operations, events, and LEDs.

Connect with the relay ("Communications>Computer")
Launch Logic equations Editor ("Setpoint>Logic 
Configuration")
Open the created PLC project ("File>Open Project")
Compile the project ("Run>Compile")
Now the logic (virtual outputs) can be sent directly to relay
("Run>Send Equations to Relay"). Texts of virtual outputs are
not stored in the relay, only in the logic configuration files to be
edited.

File storage inside the relay 
(RECOMMENDED) "Communication > Upload info files to relay" through Ethernet 

Retrieval of files stored in the relay 
(RECOMMENDED) "Communication > Download info files from relay" through Ethernet
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3.1.5.2   ON LINE MODE 

Figure 3.4:  ON LINE MODE FILE MANAGEMENT

NO

Run  EnerVista 650 Setup

Connect to the relay 
(“Communication>Computer>ON”)

Modify and send to the 
relay protection Settings 
and relay configuration

Is it necessary to 
program 

additional logic?

Launch the Logic Configuration tool in EnerVista 
650 Setup (“Setpoint>Logic Configuration”)

Create new or modify the existing logic 
(“File>Open Project”)

Compile (“Run>Compile”)
and save logic file (*.pep) and drawing design 
(*.aut) in Logic Configuration tool (“File>Save 

Project”)

Send logic to relay (“Run>Send Equations to 
Relay”) and Exit PLC Graphic Editor

Is the relay 
completely 
configured? 

Save all settings & configuration (“File>Get info from relay”)

Store in the relay the Logic configuration files (*.pep, *.aut, *.lib) as well as the 
*.650 for further logic changes. (“Communication>Upload info files to relay”)

NO

YES

YES



GEK-113000Z F650 Digital Bay Controller 3-9

3 HUMAN INTERFACES. SETTINGS & ACTUAL VALUES 3.1 ENERVISTA 650 SETUP SOFTWARE INTERFACE

3

Table 3.2:   TYPES OF FILES CREATED BY ENERVISTA 650 SETUP‚ÄÌ ONLINE OPERATION MODE 

SETTINGS & CONFIGURATION FILE *.650
LOGIC CONFIGURATION FILES (*.PEP, *.AUT, *.LIB)

*.PEP *.AUT *.LIB

Description Settings and Configuration Section Header for Logic 
project

Graphical edition 
container. Logic 
equations (Virtual 
Outputs) in FDB 
format.

User programmable 
logic objects

Created by EnerVista 650 Setup
Logic configuration 
graphic editor (PLC 
Editor)

Logic configuration 
graphic editor (PLC 
Editor)

Logic configuration 
graphic editor (PLC 
Editor)

Contents

Relay configuration file containing all  elements, settings,
input/output and LEDs configuration, graphic display
configuration, etc.
Equations corresponding to the logic created and
compiled in the PLC Editor

PLC project file 
containing the 
necessary 
information relative 
to the relay model, 
logic libraries 
included in the 
project (*.lib), 
graphic file name 
(*.aut), etc.

PLC Project file 
containing all the 
drawings used by 
the logic, required 
by 650 relay based 
on IEC 61131-3 
standard. 
Functional block 
diagram (FDB).

Library file to be 
included as an object 
in a PLC project. 
Logic packages that 
can be stored into 
libraries and be 
distributed in different 
PLC projects.

How to 
transfer to 
relay

Connect with the relay ("Communications>Computer") Connect with the relay ("Communications>Computer")

Send settings and configuration from file

Launch 650 Logic equations editor ("Setpoint>Logic 
Configuration")

Open the created PLC project ("File>Open Project")

Compile the project ("Run>Compile")

Now the logic (virtual outputs) can be sent directly to relay
("Run>Send Equations to Relay"). Texts of virtual outputs are
not stored in the relay, only in the logic configuration files to be
edited.

Modify settings and configuration directly in the relay:

How to save
EnerVista 650 Setup:
"File>Get info from relay". User definable texts
retrieved are operations, events, and LEDs.

PLC Editor:

"File>Save Project" "File>Save Library"

The relay will not 
provide this 
information unless 
the *.pep file is 
stored in the relay 

The relay will not 
provide this 
information unless 
the *.pep file is 
stored in the relay.

The relay will not 
provide this 
information unless 
the *.pep file is stored 
in the relay.

To store the logic configuration files in the relay use the 
"Communication>Upload info files to relay" option

How to store in the relay "Communication>Upload info files to relay" through 
Ethernet 

How to retrieve from the relay "Communication/Download info files from relay" through 
Ethernet

REMINDER:

Logic programming support files (*.pep, *.aut, *.lib) CANNOT be retrieved directly from the relay.

It is necessary 

* Either to have stored these files in the PC 

* Or to have uploaded previously the files into the relay ("Communication>Upload info files to relay")
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3.1.6 ENERVISTA 650 SETUP MENU STRUCTURE

The EnerVista 650 Setup menus structure is shown in Table 3.3:. 

Unless specified, options are available in both On-line and Off-line mode.

Options enabled only in On-line mode are marked as (*)

Options enabled only in Off-line mode are marked as (**)

The "View > Language" submenu allows the user to change the default language for the EnerVista 650 Setup program
and it is only enabled when the relay is not communicating and no file has been opened.

Table 3.3:  ENERVISTA 650 SETUP MENUS STRUCTURE

FILE SETPOINT ACTUAL OPERATIONS(*) COMMUNICATION
IEC 61850 
CONFIGURAT
OR

SECURITY VIEW HELP

New (**) Product Setup Front Panel NA Computer Login user Traces Instruction 
Manual

Open (**) System Setup Status NA Modem (*) Change 
Password

ModBus 
Memory 
Map

GE Multilin
on the web

Save (**) Protection 
Elements Metering NA Troubleshooting (*) User 

Management
Languages 
(**)

About 
EnerVista 
650 Setup

Save As 
(**)

Control 
Elements

Inputs/
Outputs NA Calibration (*)

Close (**) Inputs/
Outputs Records (*) NA Upgrade firmware 

version (*)

Config 
File 
Converter

Relay 
Configuration NA Upgrade operating 

system (*)

Compare 
to settings 
file

Properties 
(**)

Logic 
Configuration NA Upgrade 650 Web 

Server

Procome 
Configuration

IEC103 
Configuration

Get info 
from relay 
(*)

Clock (*) NA Upload info files to 
relay

Send info 
to relay (*) NA Download info files 

from relay

Print 
Setup (**) NA

Print 
Preview 
(**)

NA

Print (**) NA

Print to 
file (**)

Exit
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3.1.7 FILE MENU OVERVIEW

Table 3.4:   GENERAL OVERVIEW OF FILE MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only in Off-line mode are marked as (**)

FILE

New (**) Create a new settings and configuration file, with the default relay 
settings and no configuration 

Open (**) Open a settings and configuration file for off-line working. 

Save (**) Save *.650 settings and configuration file 

Save As (**) Save as *.650 settings and configuration file.

Close (**) Close the opened *.650 file in EnerVista 650 Setup. 

Config File (*.650) 
Converter Tool to convert the *.650 files from one version to another

Compare to settings 
file  Compare online unit or opened settings file to another settings file

Properties (**) File properties for *.650.

Get info from relay (*) Retrieve the *.650 settings and relay configuration compiled equations 
from the relay.

Send info to relay (*) Send and write the *.650 settings and configuration to the relay. 

Print Setup (**) To configure printer settings.

Print Preview (**) Preview of settings and configuration file printing format.

Print (**) Launch the *.650 file to be printed.

Print to file (*.xls) (**) *.650 printed to file in excel format. 

Exit Quit the application closing all the open windows.
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3.1.7.1    NEW, OPEN, SAVE, SAVE AS AND CLOSE

In these options, the program opens a dialog box (with default path to Files>Config program folder) where the setting and
configuration files can be selected for their "off-line" edition. For enabling access to this menu, there must be no
communication between the PC program and the relay.

Figure 3.5: OPEN FILE MENU

Once the *.650 file with the appropriated relay model (FXGX) is selected, the program will enable the off-line options to fully
program the unit. The enabled menus in the EnerVista 650 Setup program are: File, Setpoint, Actual, Communication, View
and Help.

The off-line mode displays the File, Setpoint, Actual, Communication, Security, View and Help submenus to program the
unit. 

The Actual values submenus are for structure purposes only Values are not refreshed while the relay is not communicating.

The "Save as" and "Close" submenus are used to save the *.650 file into the computer and to close the current file. To work
in off line mode for settings and configuration edition it is not necessary to use the "Close" option, a new *.650 can be
opened without closing the previous one. The "Close" option is used to clear all data in EnerVista 650 Setup program,
enabling "Language", "Upgrade firmware version" and "Upgrade Operating system" options.
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3.1.7.2   CONFIG FILE (*650) CONVERTER

Figure 3.6: CONFIG FILE (*650) CONVERTER MENU

This tool provides automatic conversion of configuration files from a firmware version to a previous or later version.

Open the source *.650 file and select the version and model to be converted to.

It is possible to change the model type (FXGX) using the conversion tool. It must be taken into account that part of the logic
can be readjusted to fit the new input and output boards selection. Notice also that the external wiring of inputs and outputs
board are different for type 1, 2, 4 and 5.

3.1.7.3   PROPERTIES

When this option is selected, the program will show a screen including the relay model information, firmware version, etc. of
the file being edited, as shown on Figure 3.7:

Figure 3.7: FILE PROPERTIES MENU
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3.1.7.4   PRINTING OPTIONS (PRINT SETUP/PRINT PREVIEW/PRINT/PRINT TO FILE)

The printing options are active only in off-line mode, in "File edition", and not in on-line mode, connected with the relay.

a) PRINT SETUP

Option to configure the printing options and settings for the printing device.

b) PRINT PREVIEW

Option to preview the whole settings and configuration file (*.650) in paper format to be printed as shown in Figure 3.8:

Figure 3.8: PRINT PREVIEW OF SETTINGS FILE

c) PRINT

In this option, the program will print the relay configuration using the PC default (active) printer on port COMx or LPT. This
option is active only in off-line mode, in file edition, and not in on-line mode, connected with the relay.

d) PRINT TO FILE (*XLS)

Possibility to export the configuration file to an Excel file using the "Print to file (*.xls)" option.



GEK-113000Z F650 Digital Bay Controller 3-15

3 HUMAN INTERFACES. SETTINGS & ACTUAL VALUES 3.1 ENERVISTA 650 SETUP SOFTWARE INTERFACE

3

3.1.7.5   COMPARE TO SETTINGS FILE

This tool provides automatic comparison of two different configuration files, or online unit to one settings file.

Open the source *.650 file and select the version and model to be compared to.

Figure 3.9: COMPARE TO SETTINGS FILE

It will appear the Figure 3.9: with the differences.
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3.1.8 SETPOINT MENU OVERVIEW

Table 3.5:  GENERAL OVERVIEW OF SETPOINT MENU IN ENERVISTA 650 SETUP:

Options enabled only in On-line mode are marked as (*). Options enabled only in Off-line mode are marked as (**)

3.1.8.1   PRODUCT SETUP 

Table 3.6:  GENERAL OVERVIEW OF PRODUCT SETUP MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only in Off-line mode are marked as (**)

a) COMMUNICATION SETTINGS

This section details the settings related to communication parameters for the different protocols available in the F650.

SETPOINT

Product Setup
Communications settings for all protocols and physical mediums.
ModBus user map definition, fault report, oscillography, data logger and
demand settings.

System Setup General Settings, Flex Curves Definition, Breaker settings and
maintenance, and switchgear snapshot events management.

Protection Elements
Phase, Neutral, Ground, Sensitive Ground and Negative Sequence 
Current Settings. Voltage Elements settings and Power Settings 
management.

Control Elements
Setting groups, under and overfrequency settings, synchrocheck,
autoreclose, breaker failure, VT fuse failure, broken conductor and
locked rotor settings management.  

Inputs/Outputs Contact I/O settings for all boards available in device, Remote Comms.

Relay Configuration

Configuration of Outputs, LEDs, Operations, Protection Elements,
Oscillography, Control Events, Switchgear, Inputs, Virtual Inputs,
Operations and HMI. Whole relay configuration with internal relay signals
or user-definable ones as logic (virtual outputs).

Logic Configuration

Logic configuration graphic editor (PLC Editor). It is a PLC Project file
editor that contains all the internal drawings used to make the logic
(virtual outputs) based on IEC 61131-3 standard. Functional block
diagram (FDB).

61850 Configuration 61850 Configuration tool. Only available for IEC61850 models (6) when 
communicating through Ethernet with EnerVista 650 Setup.

Procome Configuration Procome Configuration tool. Only available for Procome models (5) 
when communicating through Ethernet with EnerVista 650 Setup

IEC103 Configuration  IEC103 settings for available IEC103 models (3) when communicating 
through COM1 RS232 port with Enervista 650 Setup

Clock (*) Relay synchronization to computer clock or to user-definable date and
time. On-line mode only.

PRODUCT 
SETUP

Communication 
Settings

Serial Ports, Network (Ethernet), ModBus Protocol, DNP Slave, IEC 870-
5-104,  SNTP settings and procome (if available on model selection).

ModBus User Map ModBus user map definition. The ModBus user map is formed by 256
records, selectable from the complete relay ModBus map.

Fault Report Fault report settings. Possibility to show fault reports on HMI screen.

Oscillography
Oscillography settings (trigger position, samples per cycle, etc.). The 
trigger and digital channels (up to 16) must be configured in 
"Setpoint>Relay configuration".

Data Logger Data logger configuration

Demand Demand settings. The demand trigger and demand reset signals must be 
configured in "Setpoint>Relay configuration"

Time Settings Time settings for SNTP & IRIG-B
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Table 3.7:  GENERAL OVERVIEW OF COMMUNICATION SETTINGS MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only in Off-line mode are marked as (**)

3.1.8.2   SYSTEM SETUP 

This section shows the settings related to the system setup definition such as shown in the following table.

Table 3.8:  GENERAL OVERVIEW OF SYSTEM SETUP MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only in Off-line mode are marked as (**)

COMMUNICATION 
SETTINGS

Serial Ports Baud rate and parity for COM1 and COM2 serial communication ports.

Network (Ethernet)

Ethernet communication parameters for COM3 (IP Address, Netmask,
Gateway IP)
NOTE: The ModBus Slave address used by Ethernet ports is the one set
for COM2.EnerVista 650 Setup software allows programming two
different Ethernet addresses, but the first IP has always to be set as the
second IP Address is an Alias.

ModBus Protocol ModBus Slave Addresses for serial and Ethernet communication and the
ModBus port number used for ModBus TCP/IP

DNP3 Slave

Physical port, Slave Address for DNP, IP Addresses for Masters, TCP/
UDP Port, Unsolicited Response parameters, Analog scale factors and 
deadbands, message fragment size, Binary input block.Available for 
standard and IEC61850 models.

IEC 870-5-104 
TCP Port, Common Addr of ASDU, Cyclic Meter Period and, 
Synchronization Event settings.Available for standard and IEC61850 
models.

SNTP (*) Synchronization over Ethernet settings

PROCOME Comm port and slave number for procome protocol. Only available for 
procome models (5).

 IEC 870-5-103 Com port, slave number and synchronization time out for IEC 103 
protocol

SYSTEM 
SETUP

General Settings

This screen describes and enables the settings of the power system
where the relay will operate. Some of these settings will be used only for
metering values presentation purposes; however, some of them apply
directly to the sampling and analog-digital conversion process (rated
frequency setting). Therefore, these settings need to be adjusted so that
they fit the system settings.  

Flex Curves

Flex Curves ‚Äì Programmable user curves: The relay incorporates 4 
user curves called Flex Curve A, B, C and D. The points for these curves 
are defined by the user in "Setpoint>System Setup>Flex Curves>Edit 
Curve" menu in EnerVista 650 Setup. User defined flex curves can be 
selected as an operation curve in all the time overcurrent functions in the 
relay.

Breaker settings

Breaker settings, maintenance and switchgear selection of the device
configured as breaker in the F650. The selected switchgear will be used
in recloser, breaker failure and synchronism functions. The settings are
Number of Switchgear, Maximum KI2t, KI2t Integ. Time, Maximum
Openings, Max.Openings 1 hour and Snapshot Events.

Breaker maintenance

These settings correspond to the initialization of (KI)2t counters, and the 
counting of number of openings and closings of the switchgear 
configured as breaker. These Counters allow the breaker Maintenance. 
They are used to cumulate the breaker ageing produced by a trip or a 
breaker opening. In order to incorporate the breaker historic, in case of 
existing breakers, the system allows assigning an initial value to 
accumulated amperes, and to the number of opening and closing 
operations.

Switchgear Configuration of snapshot events for each switchgear (enable or disable)
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3.1.8.3   PROTECTION ELEMENTS

This option shows all the protection-grouped elements available in the relay as shown in Table 3.9:. Each of these groups
includes the specific protection units of the same type. For example phase currents group includes TOC, IOC, directional
units, etc. There are three groups available, so there are three protection units of each function that can work in grouped
mode or ungrouped (altogether).

Table 3.9:  GENERAL OVERVIEW OF PROTECTION ELEMENTS MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only in Off-line mode are marked as (**)

Table 3.10:  PROTECTION ELEMENTS INCLUDED

PROTECTION 
ELEMENTS

Phase Current All overcurrent grouped functions for phase current.

Neutral Current All overcurrent grouped functions for neutral current. (Calculated from 
phases, not measured)

Ground Current All overcurrent grouped functions for ground current. (Measured from 4th 
current input)

Sensitive Ground 
Current

All overcurrent grouped functions for sensitive ground current. 
(Measured from 5th current input)

Negative Sequence 
Current All Negative sequence overcurrent grouped functions.

Voltage Elements All voltage grouped functions for phases, neutral, ground and auxiliary 
voltage

Power Forward power, directional power and wattmetric ground fault (High and 
Low) grouped protection functions.

PHASE 
CURRENT

Phase TOC High Phase time overcurrent, high level (51PH)

Phase TOC Low Phase time overcurrent, low level (51PL)

Phase IOC High Phase instantaneous overcurrent, high level (50PH)

Phase IOC Low Phase instantaneous overcurrent, low level (50PL)

Phase Directional Phase directional unit (67P). Quadrature Voltage for polarization

Thermal Model Thermal model or Thermal image unit for phases (49)

NEUTRAL 
CURRENT

Neutral TOC Neutral time overcurrent (51N)

Neutral IOC Neutral instantaneous overcurrent (50N)

Neutral Directional Neutral directional unit (67N). Voltage, current and dual polarization.

GROUND 
CURRENT

Ground TOC Ground time overcurrent (51G)

Ground IOC Ground instantaneous overcurrent (50G)

Ground Directional Ground directional unit (67G). Voltage, current and dual polarization.

SENSITIVE 
GROUND 
CURRENT

Sensitive Ground TOC Sensitive ground time overcurrent (51SG).

Sensitive Ground IOC Sensitive ground instantaneous overcurrent (50SG). 

Isolated Ground IOC Isolated ground overcurrent (50IG)
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3.1.8.4   CONTROL ELEMENTS

This option shows all the control elements available in the relay as shown in Table 3.11:. Some of the elements are grouped
ones such as underfrequency, overfrequency and broken conductor. 

Table 3.11:  GENERAL OVERVIEW OF CONTROL ELEMENTS MENU:

Sensitive Ground 
Directional Sensitive ground directional unit (67SG)

NEGATIVE 
SEQUENCE 
CURRENT

Negative Sequence 
TOC Negative sequence time overcurrent (46P)

VOLTAGE 
ELEMENTS

Phase UV Phase undervoltage (27P)

Phase OV Phase overvoltage (59P)

Neutral OV High Neutral overvoltage, high level (59NH)

Neutral OV Low Neutral overvoltage, low level (59NL)

Negative Sequence 
OV Negative sequence overvoltage (47)

Auxiliary OV Auxiliary overvoltage (59X)

Auxiliary UV Auxiliary undervoltage (27X)

POWER

Forward Power Forward power (32FP), in primary values.

Directional Power Directional power (32), in primary values.

Watt Gnd Flt High Wattmetric ground fault high (32N High), in secondary values

Watt Gnd Flt Low Wattmetric ground fault low (32N Low), in secondary values

CONTROL 
ELEMENTS

Setting Group

F650 units incorporate a flexible grouping capability for protection units.
This means that protection units can be used in either single setting
group (default mode-all units can operate simultaneously) or three
setting groups (in this mode, protection units are grouped in three
independent tables, with only one of them active at a given time).
Protection element grouping involves only Protection elements together
with broken conductor detection and over and under frequency, which
are usually considered as control elements. The rest of control elements
such as recloser, fuse failure, breaker failure, synchronism, and breaker
settings are not involved in the tabled groups concept.

Underfrequency Underfrequency unit (81U). Grouped element

Overfrequency Overfrequency unit (81O). Grouped element

Synchrocheck Synchronism check unit (25). Not grouped, a single unit provided

Autoreclose Recloser (79). Not grouped, a single unit provided

Breaker Failure Breaker failure (50BF). Not grouped, a single unit provided.  

VT Fuse Failure Fuse Failure (VTFF). Not grouped, a single unit provided.  

Broken Conductor

Broken or fallen conductor detection function (I2/I1). Grouped element.
Ratio between the negative sequence current, I2, and the positive
sequence current I1. In normal and balanced load situations, this ratio is
zero, while in severe load fault conditions, an unbalance is produced and
this ratio is increased.

Locked Rotor Locked rotor detection function (48). Grouped element.

Pulse Counters Pulse counters function. 8 counters provided.

Analog Comparators Analog comparator function. 20 analog comparators provided.
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3.1.8.5   INPUT/OUTPUTS

Section that contains the settings for all input and output boards and the Force Outputs and Virtual inputs activation tools. 

Table 3.12:  GENERAL OVERVIEW OF "INPUTS/OUTPUTS" SETTINGS MENU. 

Options enabled only in On-line mode are marked as (*). Options enabled only in Off-line mode are marked as (**)

This section shows the settings related to inputs and outputs for the different boards available in F650 (F, G, H, J).

Table 3.13:  GENERAL OVERVIEW OF "INPUTS/OUTPUTS>CONTACT I/O" SETTINGS MENU. 

3.1.8.6   RELAY CONFIGURATION

This is the relay configuration section in which the relay can be configured using internal states or already compiled
equation on PLC Editor.

Table 3.14:  GENERAL OVERVIEW OF RELAY CONFIGURATION MENU:

Frequency rate of 
change Frequency rate of change function (81R).Grouped element.

Load Encroachment Load Encroachment function. Grouped element.

INPUTS/
OUTPUTS

Contact I/O
Inputs and outputs settings for all boards in F650. The I/O settings
configuration can only be performed through EnerVista 650 Setup, not
HMI available.

Force Outputs (*) This menu allows activating each contact output in the relay, to facilitate
maintenance testing. On line mode only. 

Virtual Inputs (*)

This menu allows operating virtual inputs. These variables are used as
inputs to logic schemes configured in the relay. Virtual inputs can be
operated in a latched mode (32 latched virtual inputs) or in Self-reset
mode (32 self reset virtual inputs).

Remote Comms. This menu allows configuring remote inputs coming from other devices
through GSSE messages. Available for IEC61850 (6) models only.

CONTACT I/O

Board F Board located in first slot, always connected.

Board G Board located in second slot, depends on model definition. If model is 
type G0 there is no board in second slot.

Board H Board located in first slot of CIO Module (external inputs/outputs module)

Board J Board located in second slot of CIO Module (external inputs/outputs
module)

RELAY CONFIG

Outputs Configuration of contact output operate and reset signals for all boards.

LEDs

15 LEDs fully configurable from any logical variable, contact or virtual
input. First 5 LEDs are latched by hardware, the rest are self-reset but
can be latched through PLC configuration. From the LED configuration
screen, it is possible to print the vertical LED label for the relay.

Operations Configurable operations up to 24. Operation texts, interlocks, final states,
frontal keys, time outs and masters.

Protection Elements
This tab allows assigning operands (logic signals) as inputs to different
protection elements. To block, reset, initiate the different protection
elements inputs. 

Oscillography

Trigger and up to 16 digital channels to be included in oscillography
records, are programmable from any logical variable, contact or virtual
input. Text configuration is only for off-line mode.
NOTE: This screen is used for the configuration of digital channels and
oscillography trigger. The rest of parameters, such as function enabling/
disabling, sampling rate, number of oscillography files, etc. must be set
on the Setpoint>Product Setup>Oscillography menu.
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Control Events

Up to 128 user programmable events from any logical variable, contact
or virtual input. Possibility to display the event as an alarm on the alarms
panel. Control events are also displayed in the snapshot events
recording. 1 ms time tagging.
A control event is a logic signal associated to an operand or combination
of operands, that allows following the status of that signal. 

Switchgear

Up to 16 configurable switchgear elements. A switchgear element can be
a breaker, a line selector switch, a grounding selector switch, a busbar
selector switch, etc. This screen allows configuration of type of contacts,
opening and closing time, contact assignation and text for events related
to switchgear. There are 64 pre-established events for switchgear, which
correspond to opening, closing, Error01 and Error11 of the 16
programmable switchgear elements.

Remote outputs Up to 32 DNA bits and 64 user St bits to be transmitted to remote devices
over CAN using GSSE messages

Inputs Text configuration for off-line mode file management for all the contact
inputs available in device.

Virtual Inputs Text configuration for off-line mode file management. 32 latched and 32
self reset virtual inputs.

MMI (HMI-Human 
Machine Interface)

Screen one line diagram configuration. This menu shows a scenario to
draw a simplified one-line diagram of a bay in a feeder, line, transformer,
etc. The menu includes a library for power elements, metering elements,
text and drawings. See an example in
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The following figures show an example of the default factory configuration for F650. The F650 has no default factory
configuration, but a possible example could be the following:

Figure 3.10: RELAY CONFIGURATION

Figure 3.11: HMI CONFIGURATION
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3.1.8.7    IEC103 CONFIGURATION

This menu allows to update the IEC 103 configuration of the unit.

Figure 3.12:  IEC103 CONFIGURATOR

See chapter 5.13

3.1.8.8   LOGIC CONFIGURATION

This logic configuration allows creating more complex configurations, using the graphical PLC, than using the tables from
Relay Configuration. For file management detailed information go to section 3.1.5.

File description:

*.pep: Header for Logic project: PLC project file containing the necessary information relative to the relay model, logic
libraries included in the project (*.lib), graphic file name (*.aut), etc.

*.aut: PLC Project file containing all the drawings used by the logic, required by 650 relay based on IEC 61131-3
standard. Functional block diagram (FDB).

*.lib: User programmable logic objects: Library file to be included as an object in a PLC project. Logic packages that
can be stored into libraries and be distributed in different PLC projects.

3.1.8.9   CLOCK

This menu allows to update the date and time of the relay, either synchronizing them with the PC clock, or entering the
information manually. 
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Figure 3.13: CLOCK
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3.1.9 ACTUAL VALUES MENU OVERVIEW

The menu bar in the main screen of EnerVista 650 Setup software shows the ACTUAL menu option. This option
concentrates and displays all the status of protection, control elements, metering, counters information, oscillography,
events, fault locator, etc. This section shows only the structure of menus in EnerVista 650 Setup.

Table 3.15:  GENERAL OVERVIEW OF ACTUAL VALUES MAIN MENU:

3.1.9.1   FRONT PANEL

The front panel menu shows only the LEDs submenu where all the front LEDs can be monitored.

3.1.9.2   STATUS

The following menu includes all the available protection status in the device.

Table 3.16:  GENERAL OVERVIEW OF STATUS MENU:

ACTUAL

Front Panel The relay front LEDs status is shown on this menu.

Status Protection and control status signals for all available protection functions
in device.

Metering All metering values available in device. Primary and secondary values,
frequency and phasor diagram provided.

Inputs/Outputs All input and output status provided. For contact inputs and contact
outputs as well as virtual input and virtual output signals.

Records Only enabled in on line mode, retrieval of all the available records in
device. Snapshot events, control events, oscillography and fault reports.

STATUS

Operation bits
Up to 24 elements. OPERATION BIT XX is (0) when the configured time
out for the operation XX expires or when success conditions are met.
And it is (1) if operation XX is executed and interlocks are fulfilled.

Breaker
Breaker status (open, closed or undefined). The rest of the status signals
corresponding to the switchgear XX configured as breaker are in the
"Status>Switchgear Status>Switchgear XX" menu.

Protection Status of all the protection units in the device.

Control Elements Status of all the control units available in the device. 

Protection Summary This screen shows a complete list of all protection and control elements
in the relay, showing their status (enabled or not). 

Snapshots events 
summary

Summary of the snapshot events status (enabled or disabled) for
protection, control, inputs and outputs boards and switchgear. 

ModBus User Map
Up to 256 elements. Value in SIGNED INT 16 BIT format of the reading
for the selected address configured in "Setpoint>Product
Setup>ModBus User Map"

Switchgear Status

Up to 16 blocks of switchgear status signals for the 16 configurable
devices. Status signals such as inputs for A and B contacts, status for A
and B, open and close status, error 00 and error 11, open init and close
init, fail to open and fail to close signals.

Calibration Internal states for calibration. Factory calibration and calibration error
signals.

Flex Curves
Flex curve status for A, B, C and D user curves. (0) if it is not configured,
(1) if it is configured. To configure a flex curve go to "Setpoint>System
Setup>Flex Curves" menu.

System Info This screen can monitor the system parameters and the internal status of
the Relay operative system. Not enabled by default, password required

Records Status
Information related to the different records stored in the Relay, such as:
Fault reports, control events, oscillography, data logger, demand, energy,
and breaker maintenance.

SNTP-IRIG-B Information related to synchronization via IRIG_B or SNTP
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Table 3.17:  ACTUAL VALUES INCLUDED IN THE PROTECTION MENU

Table 3.18:  DIFFERENT CONTROL ACTUAL VALUES INCLUDED IN THE CONTROL ELEMENTS MENU

Table 3.19:  ACTUAL VALUES RELATED TO RECORDING FUNCTIONS IN THE RECORDS STATUS MENU:

PROTECTION

Protection Blocks This screen shows all the protection element blocks available. Protection
elements block signals can be configured at "Setpoint>Relay
Configuration > Protection Elements".

Phase Current Protection status signals (pickups and operations) for time overcurrent,
instantaneous overcurrent and directional protection functions for phase
current.

Neutral Current Protection status signals (pickups and operations) for time overcurrent,
instantaneous overcurrent and directional protection functions for neutral
current (calculated from phases).

Ground Current Protection status signals (pickups and operations) for time overcurrent,
instantaneous overcurrent and directional protection functions for ground
current (measured from 4th current input).

Sensitive Ground 
Current

Protection status signals (pickups and operations) for time overcurrent,
instantaneous overcurrent, isolated and directional protection functions
for ground current (measured from 5th current input).

Negative Sequence 
Current

Protection status signals (pickups and operations) for negative sequence
time overcurrent function.

Thermal Model Protection status signals for thermal model. Reset, alarm and operation
signals for phases and for unit, besides the thermal image values in
percentage for all phases and units.

Voltage Protection status signals (pickups and operations) for all voltage
functions, undervoltage, overvoltage, neutral overvoltage, negative
sequence overvoltage and auxiliary under and over voltage.

Power Protection status signals (pickups and operations) for forward, directional
and wattmetric ground fault (high and low) power units, and power factor
status. Power values for 32N High and Low functions (in watts).

CONTROL 
ELEMENTS

Frequency Status signals (pickups and operations) for under, overfrequency and
frequency rate of change units.

Synchrocheck Status signals for synchrocheck function (25).

Autoreclose Status signals for autoreclose function (79). Close signal, recloser status
(ready, lockout, etc.), block signals after each shot.

Breaker Failure Status signals for breaker failure function (50BF).  

VT Fuse Failure Fuse failure detection signal.

Broken Conductor Status signals (pickups and operations) for broken conductor (I2/I1).

Setting Groups Status signals (activations and blocks) for the relay setting group change.
By default the "setting group" setting is disabled and all the grouped
elements can be enabled at the same time.

Locked Rotor Status signals (pickups and operations) for locked rotor units.

Pulse Counters Status signals for pulse counters units.

Analog Comparator Status signals for analog comparator units.

Load Encroachment Status signals (pickups and operations) for load encroachment units.

RECORD 
STATUS

Fault Reports This menu shows the fault report status signals, as fault report trigger,
fault date, fault type and location, besides the fault report number.

Control Events Status of the control events (if the signal configured to launch the control
event is active or not).

Oscillography Status of signals related to oscillography recording, such as status or
digital channels, oscillography trigger, number of records available, etc.
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3.1.9.3   METERING

The Metering menu includes all the measurements available in the device. Primary and secondary values, and also the
data related to the recording functions in the relay.

Table 3.20:  GENERAL OVERVIEW OF METERING MENU:

3.1.9.4   INPUTS/OUTPUTS

The Inputs/Outputs menu includes all the inputs and outputs signals available in the device. Contact and virtual type.

Table 3.21:  GENERAL OVERVIEW OF INPUTS/OUTPUTS MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only in Off-line mode are marked as (**)

Data Logger Data logger information about oldest and newest sample time stamp,
and number of channels and days configured in data logger settings.

Demand Demand trigger and reset inputs status.

Energy Freeze, unfreeze and reset input signals for energy counters.

Breaker Maintenance All signals related to breaker maintenance, such as number of openings,
closings, (KI)2t counters, alarm signal for (KI)2t, etc.

METERING

Primary Values Primary values measurements for currents, voltages, power, energy and
demand

Secondary Values Secondary values measurements for currents, voltages and power.

Phasor Diagram Current, voltage and sequence components.

Frequency Line and Bus frequencies.

INPUTS/
OUTPUTS

Contact Inputs Status of digital inputs in the Relay for each board according to the relay
model.

Contact Output Status Status of digital outputs in the Relay for each board according to the relay
model.

Contact Outputs 
Operates

Status (activated or not) of the variables used to operate a contact
output. To configure these signals go to "Setpoint>Relay
Configuration>Outputs" menu.

Contact Outputs 
Resets

Status (activated or not) of the variables used to reset a contact output.
To configure these signals go to "Setpoint>Relay Configuration>Outputs"
menu. This output reset Command will only be effective if the "latch"
option has been Selected for the "Output Type" setting on the I/O board,
thus when the contact output has been configured to emulate function 86
(latching relay).

IO Board Status Status of I/O boards. This status provides if the hardware it is OK (boards
matching relay model, correctly inserted in their tracks, in good state and
communicating through the internal CAN Bus).

Virtual Inputs Status of Virtual inputs latched (32) and self-reset (32).

Virtual Outputs Status of virtual outputs (configured in PLC Editor). Up to 512.

Remote Outputs States of remote outputs for IEC61850 models.

Remote Inputs Status of remote device and remote inputs  for IEC61850 models.

Analog Inputs (*) Measurements coming from analog inputs (DCMA)
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3.1.9.5   RECORDS

The Records menu is only available in on line mode and includes the possibility to retrieve all the records available in the
device. By serial or Ethernet.

Table 3.22:  GENERAL OVERVIEW OF RECORDS MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only in Off-line mode are marked as (**)

3.1.10 OPERATIONS MENU OVERVIEW

Option only available in on line mode, showing all the operations previously configured in the relay with their corresponding
texts. 

Table 3.23:  GENERAL OVERVIEW OF OPERATIONS MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only in Off-line mode are marked as (**)

RECORDS (*)

Event recorder (*) Retrieval and visualization of snapshot event (all and new), control 
events and alarm panel. By serial or Ethernet (ModBus RTU or TCP/IP)

Waveform capture (*) Retrieval of oscillography files, by serial or Ethernet.

Fault Report (*) Retrieval and visualization of fault report files, by serial or Ethernet.

Data logger (*) Retrieval and visualization of data logger files. Only by Ethernet.

OPERATIONS

Operation 1 (*) Entry to first operation (with its corresponding text)

... ...

Operation 24 (*) Entry to 24th operation (with its corresponding text)
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3.1.11 COMMUNICATION MENU OVERVIEW

The communication menu includes the computer screen to start communicating with the relay, the different update
procedures available in device: firmware, operative system, web server and other file storing capabilities (upload and
download info files to/from relay).

For more detail information go to section 3.1.4 for communication menus description and to section 5 for flash memory
update procedures.

Table 3.24:  GENERAL OVERVIEW OF COMMUNICATION MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only in Off-line mode are marked as (**)

The rest of options available in the Communication menu in EnerVista 650 Setup are:

- Modem: Allows configuring the unit for remote communications via modem, using telephonic line. It is only available if
the relay is not communicating and if modem has been select on Communication>computer control type selection. Go
to "Communication>Modem"

- Troubleshooting (Serial or Ethernet connection): Lets the user to perform reading or writing in ModBus addresses, for
verifying communications and access to different positions in the ModBus memory map. Only available if the
communication has already been established. Go to "Communication>Troubleshooting". An example is provided in
Figure 3.14:

COMMUNICATION

Computer Menu to start communication with the relay.

Modem (**) Menu to set modem communication parameters (only available if control
type is set to modem in computer menu).

Troubleshooting (*) Menu that Lets the user to perform reading or writing in ModBus
addresses, for verifying communications and access to different
positions in the ModBus memory map.

Calibration (*) Retrieval and store calibration settings from/to relay.

Upgrade firmware 
version (**)

Menu to update the relay firmware version through Ethernet

Upgrade operating 
system (**)

Menu to update the relay boot code (front RS232 and Ethernet
connection)

Upgrade 650 web 
server

Menu to update the web server application (if available)

Upload info files to 
relay

Hard disk storage of settings and configuration files on the relay.Option
only performed through Ethernet, not available in C650 models.

Download info files 
from relay

Retrieval of settings and configuration files that had been previously
stored in the relay hard disk.Option only performed through Ethernet, not
available in C650 models.
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Figure 3.14: COMMUNICATION TROUBLESHOOTING SCREEN

- Calibration (Serial or Ethernet connection): Allows retrieving the unit calibration settings and storing them in a file (with
extension *.cal). For reading or storing the calibration settings in the relay go to "Communications>Calibration>Get
or Set calibration settings" and select the intended calibration file. The calibration retrieval process is necessary to
be performed before updating the unit operative system, when the operating system is updated all the data in the relay
is deleted, including the factory calibration settings. When only the firmware is updated (for versions higher than 1.50),
the calibration settings are automatically saved in the relay.

- Upgrade firmware version (Ethernet connection): Go to "Communications>Upgrade firmware version", this menu
allows the user to update the firmware version of the relay through Ethernet communication. Firmware is related to the
relay internal program, designed by GE Multilin, which performs the protection and control functions, and which is run
by the relay main microprocessor.

- Upgrade operating system (Serial and Ethernet connection): Go to "Communications>Upgrade operating system".
This option allows the user to update the relay operative system. The operative system or OS is the program that
supports the firmware and provides auxiliary services for access to electronic devices included in the relay.

IMPORTANT NOTE: 

READ CAREFULLY THE FLASH MEMORY UPDATE PROCEDURE DESCRIBED IN
SECTION "BOOT CODE AND FIRMWARE" AND CLOSE ALL THE RUNNING
APPLICATIONS BEFORE PERFORMING FIRMWARE AND OPERATIVE SYSTEM
UPDATING PROCESS

Before updating firmware check that the firmware version that is going to be updated
match the operative system version of the relay. Otherwise it is necessary to update the
operative system before proceeding to update the firmware. Other combinations of
firmware and operative system different from the listed in section 5 will not be operative

The operative system version is available in the logotype main screen in HMI; it is the
number between brackets in the first line, e.g. F650 1.70 (2.35). The operative system
version is 2.35
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Thanks to the use of a double flash memory, one with the Bootcode startup program and the operative system, and a
second one with the application program (firmware), a high reliability is guaranteed when updating the unit firmware, as
even if the case of a communication breakdown during the firmware upgrade process, we can retry the process for an
unlimited number of times.

‚Ä¢ Upgrade 650 web server (Ethernet connection):Go to "Communications> Upgrade 650 web server". The relay web
server application can be updated to further versions (if available) using this menu without modifying the relay
operative system.

- Upload info files to relay (Ethernet connection): Go to "Communications>Upload info files to relay". This
functionality is used to store setting files (*.650) inside the relay, as well as auxiliary files used by the programmable
logic graphical editor (*.pep, *.aut, *.lib).

- Download info files from relay (Ethernet connection):  Go to "Communications>Download info files from relay".
This functionality is used for retrieving the files (*.650 and *.pep, *.aut, *.lib) that have been previously stored in the
relay flash memory.

Important Note: 

*.650 files contain protection, control settings, relay configuration and compiled logic
equations. This file can be retrieved from the relay, using the "File>Get info from
relay" option in EnerVista 650 Setup (through serial or Ethernet communication).
"File>Send info to relay" option stores this *.650 file in the relay.

*.pep, *.aut and *.lib files contain the logic configuration projects necessary to modify the
logic (virtual outputs) in the relay. These files can be stored in the relay, using the
"Communication>Upload info files to relay" option in EnerVista 650 Setup (through
Ethernet communication). They can be retrieved using "Communication>Download
info files to relay" option in EnerVista 650 Setup program (Ethernet communication).
Take into account that the *.pep, *.aut and library files are necessary to modify the PLC
logic (virtual outputs). Without these files setting and configuration can be modified but
not logic equations (virtual outputs). It is advisable to use the
"Communication>Upload info files to relay" option to store these logic configuration
files into the relay.

It is important to distinguish between "Send / Get info to relay" and "Upload /
Download info files to/from relay". "File>Send/Get info to relay" sends/gets
settings and configuration and compiled logic equation to/from the relay (*.650 format),
and the relay automatically starts working with the new settings once they are stored.
"Communications>Upload/Download info files to relay", stores/retrieves in the
relay hard disk: settings, configuration and compiled logic equations (*.650) besides the
PLC files (*.pep, *.aut, *.lib). This is only a physical storage (file backup).
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3.1.12 SECURITY MENU OVERVIEW

The security menu includes all the menus related to security control in EnerVista 650 Setup. EnerVista 650 Setup security
users and passwords are not related to passwords in HMI. Each security level has its own access for HMI management
and EnerVista 650 Setup management.

Table 3.25:  GENERAL OVERVIEW OF SECURITY MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only in Off-line mode are marked as (**)

3.1.13 VIEW MENU OVERVIEW

The view menu includes the  computer screen to start communicating with the relay, the different update procedures
available in device: firmware, operative system, web server and other file storing capabilities (upload and download info
files to/from relay).

The ModBus memory map is detailed in the complete instruction manual (English only) and can be obtained from EnerVista
650 Setup program.

Table 3.26:  GENERAL OVERVIEW OF VIEW MENU:

Options enabled only in On-line mode are marked as (*). Options enabled only in Off-line mode are marked as (**)

3.1.14 HELP MENU OVERVIEW

Complete instructions manual and data about EnerVista 650 Setup release.

Table 3.27:  GENERAL OVERVIEW OF HELP MENU:

SECURITY

Login User (*) Log on menu for EnerVista 650 Setup. Enabled after security control has
been enabled in user management menu.

Change Password (*) Menu to change passwords and establish password recovering
questions.

User Management (*) User management dialog box.

VIEW

Traces (*) To inspect ModBus communication traces between the EnerVista 650
Setup and the relay.

ModBus Memory map Complete ModBus memory map description.

Languages (**) Option to change the EnerVista 650 Setup default language. Only
available if the relay is not communicating and no file (*650) is open.

HELP

Instructions Manual Instructions manual in the language selected in "View>Languages"
menu.

GE Mulitlin on the Web GE Multilin web page link.

About EnerVista 650 
Setup

Release version and date of EnerVista 650 Setup program.
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3.2 HUMAN MACHINE INTERFACE (HMI)T

The HMI interface consists of several functional panels. The faceplate can be unscrewed to allow easy access to the
removable modules. There is also a removable dust cover that fits over the display and other cover that protects the front
RS232 Communications port and the commands buttons that can be sealed. The following figure shows the HMI in F650

Figure 3.15.1: HMI INTERFACE

Ergonomic programmable keys 
Shuttle control for easy navigation  
ESC key, built-in ENTER function and audio feedback 
Local / Remote / Off pushbutton with LEDs 

HMI Interface

Graphic 16x40 or text 4x20 LCD display 
Fluorescent backlight  to improve visibility 
Multicolor programmable LEDs with label panel

DISPLAY & LEDS

KEYPAD & SHUTTLE 

Electrically isolated front RS232 communication port 
Transparent cover can be sealed for security

FRONT PORT
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Figure 3.15.2: ENHANCED HMI INTERFACE

3.2.1 DISPLAY

F650 units are available with two different options for the front display. The first option is an alphanumerical display of 4
lines with 20 characters each, and the second option is a graphical display of 16 lines with 40 characters each (128x240
pixels), being B the ordering code option for the text display model (basic), and M the code for the mimic display
(graphical).

The boot code and firmware versions can be seen in the relay text main screen, this screen is the default screen in the text
menu for all models: After the text "F650", appears the relay firmware version (3.44in the example), and between brackets
the boot program version (4.10 in the example), followed by "General Electric", the relay model and the default front  port
(COM2) communication parameters. 

Figure 3.16: TEXT MAIN SCREEN
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3.2.2 FRONT LED INDICATORS

The relay provides 16 LED indicators, 15 user programmable plus one non-configurable LED (READY) that shows if the
relay is in service.

Programmable LEDs are divided into groups of 5 LEDs, each of the groups having a different color. The first group of LED
indicators is latched by hardware (red color ones), usually configured for trip signals. The second group (yellow color) and
third group (green color) of LED indicators are self-reset type and will be reset once the condition has been cleared, but can
be latched using logic through PLC configuration.

The ESC key is used to reset any latched led indicator, once the condition has been cleared. Keep the ESC button pressed
for more than 3 seconds; all LEDs will light up, verifying their correct operation. When releasing the ESC key, all indicators
programmed with memory, such as tripping LEDs, will be reset.

The latched conditions can also be reset via communications using the LED reset input (to configure this signal go to
"Setpoint>Relay Configuration>Protection elements>LED RESET INPUT"). By default this LED reset input signal is set
to LEDS RESET operation.

3.2.3 PUSHBUTTONS

The front panel provides:

Push buttons: keypad (5 user programmable plus ESC/ESCAPE non configurable), shuttle key or shuttle key for easy
navigation, command pushbutton to select operations mode.

RS232/USB port: intended for connection to a portable PC.

3.2.3.1   KEYPAD AND SHUTTLE KEY

Figure 3.17.1: KEYPAD AND SHUTTLE KEY DESCRIPTION

This button can be used for closing the user programmable switchgear. It is fully
programmable by the user.

This button can be used for closing the user programmable switchgear. It is fully
programmable by the user.

User programmable.

User programmable.

User programmable.

(ESC) Escape key. When pressed during more than 3 seconds, it will test all LEDs and
reset the trip LEDs.

Rotary knob or Shuttle Key (it can be both rotated and pressed): Used for selecting
menus, submenus, settings and for confirmation. Press or rotate the shuttle key to enter
the text main menu from the text standby screen.

 O 

*

F1

I

F2

ESC



3-36 F650 Digital Bay Controller GEK-113000Z

3.2 HUMAN MACHINE INTERFACE (HMI) 3 HUMAN INTERFACES. SETTINGS & ACTUAL VALUES

3

Figure 3.17.2: ENHANCED KEYPAD DESCRIPTION

 

 

 

 

 

 

 

 

 

 

This button can be used for closing the 
user programmable switchgear. It is fully 
programmable by the user. 

This button can be used for closing the 
user programmable switchgear. It is fully 
programmable by the user. 

F1. User programmable. 

F2. User programmable. 

F3 / *. User programmable. 

Up Key. Used for selecting menus, 
submenus, settings 

Down Key. Used for selecting menus, 
submenus, and change values of settings 

Enter Key. Press key to enter to submenus 
or to change values. 

Escape key. Press key to exit from menus 
 

Reset key. When pressed it will test all 
LEDs and reset the trip LEDs. 
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3.2.3.2   COMMAND PUSH BUTTON

The unit incorporates a command pushbutton located at the bottom right side of the faceplate, with three options: local,
remote, and off. The first option (LOCAL) allows executing operations in local mode (HMI, front  port, and rear COM2 port).
The second option (REMOTE) allows operation execution only through remote communications (COM1 and COM3 -
Ethernet). The third option (OFF) blocks the execution of operations. Each position is identified with an LED indicator, as
follows:

LOCAL operations (green)

REMOTE operations (green) 

OFF (red)

Press the command button to switch from local to remote operations mode and vice versa. OFF status (operation inhibited
for maintenance and safety) can be reach pressing the commands pushbutton during several seconds (local-remote-off
sequence).

The local-remote-off sequence can be also available through communications (see chapter 5.8), with a configurable signal
that can be set in the "Setpoint>Relay Configuration>Protection Elements" screen.

3.2.4 FRONT PORT AND COVER SEALING SYSTEM

Figure 3.18: shows the detail of the front RS232 communication port and local/remote button access cover sealing system.
The sealing system is similar to the one used in energy meters, using wire and plumb seal.

High quality plastic have been used in the design to withstand extreme environmental conditions, both mechanical and
electrical, sun radiation, humidity, etc. in order to guarantee a long life for the unit. 

Figure 3.18: DETAIL OF FRONT PORT AND COVER SEALING SYSTEM 

Screen contrast regulator 

Cover sealing system  

Electrically isolated RS232 port 

Local/remote Operations access
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3.2.5 TEXT MENUS

3.2.5.1   NAVIGATION IN TEXT MENU

Text menu is available for all models, this is the main menu for visualizing actual values, metering, changing settings, etc.
through the HMI. In models with graphical display (M in ordering code) besides this text main menu there are several
screens providing more performance for control purposes.

Press (or rotate left or right) the shuttle key to enter the main menu, starting from the standby screen (default main screen).
The default main screen can be accessed pressing ESC key till it appears. In all the navigation press the shuttle key to
select the desired header display (top-level menu). Each press of the shuttle key advances through the main heading
pages as illustrated below. To return to previous menus press the ESC key. To move inside the top-level menu without
changing to other low levels, rotate the shuttle key left to move up and right to move down. 

When rotating the shuttle key the selected menu is marked by a single scroll bar character. The mark (>) in the right part of
any menu means that contains more than one level.

Figure 3.19: Shows an example of main menu navigation:

Figure 3.19: NAVIGATION IN MAIN TEXT MENU
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3.2.5.2   TEXT MENU HIERARCHY

The structure of HMI text menu is similar to the EnerVista 650 Setup in the actual values and settings (view and change)
menus. 

The main menu shows the following options:

Table 3.28:  GENERAL OVERVIEW OF MAIN TEXT MENU:

NAME DESCRIPTION NAVIGATION IN MENU

Actual Values Actual values of all the signals available in device.
Status of protection and control elements,
measurements, inputs and outputs, etc.

Press shuttle key or enter key to enter next level.
Press ESC to return to default main screen.

Snapshot events Visualization of all snapshot events in text mode (two
screens for each snapshot event). In graphical displays
there can be seen in a dedicated screen.

Press shuttle key or enter key to visualize snapshot
events in text menu. Press ESC to return to default
main screen.

Fault Report Fault reports information available in HMI (two screens
for each fault report)

Press shuttle key or enter key to enter next level.
Move Up/Downto see all the available fault reports
in device. Press shuttle key or enter key to enter
particular information for fault report selected.

View Settings Visualization of all protection and control settings
available in device.

Press shuttle key or enter keyto enter next level.
Move Up/Down to select submenu. Press ESC to
return to previous level.

Change Settings Menu that allows changing all protection and control
settings available in device. Inputs and outputs settings,
relay configuration and logic configuration are not
available in HMI, only via EnerVista 650 Setup
software.

Press shuttle key or enter key to enter next level.
Move Up/Down to select submenu. Press esc to
return to previous level.

Date & Time Date and time visualization and modification by user. First mode is visualization. Press again shuttle key
or enter key to start modification in date and time.
Press ESC to return to previous level.

Commands Operations execution in local mode. Move Up/Down to pre select operation. Press
shuttle key or enter key to select and confirm. Press
ESC to return to previous level.

Password Password menu for settings and commands Move Up/Down to select submenu. Press shuttle
key or enter key to enter next level. Press ESC to
return to previous level.

Select Main Screen Selection of default main screen in text menu. Move Up/Down to select the default main screen
type. Pressshuttle key or enter key to confirm.

Select Language Language selection. Between default language (see
ordering code) and English.

Move Up/Down to select the default language.
Press shuttle key or enter key to confirm selection.
Switch the relay off and on.

< - return Return to previous level Press shuttle key or enter key to return to previous
level.
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3.2.5.3   ACTUAL VALUES

The Actual Values menu option in HMI concentrates and displays all the status of protection, control elements, metering,
counters information, oscillography, events, fault locator, etc. 

Table 3.29:  GENERAL OVERVIEW OF ACTUAL VALUES MAIN MENU:

Front Panel   >

LEDs

Status            >

Operation Bits

Breaker

Protection >

Protection Blocks

Phase Current

Neutral Current

Ground Current

Sens. Ground Current

Neg. Seq. Current

Thermal Model

Voltage

Power

Control Elements >

Frequency

Synchrocheck 

Autoreclose

Breaker Failure

VT Fuse Failure 

Broken Conductor

Setting Groups

Locked Rotor

Pulse Counters

Analog Comparators

Load Encroachment

Switchgear Status >

Switchgear 1

Switchgear...

Switchgear 16

Calibration

Flex Curves

System Info

Records Status >

Fault Reports

Control Events

Oscillography

Data logger

Demand

Energy

Breaker Maintenan.

SNTP-IRIG_B
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To enter this menu press the shuttle key or enter key when the option Actual Values is selected in main menu. A secondary
level will be displayed with different sublevels as shown on Table 3.29:. Pressing Up/down keys or rotating the shuttle key,
(left for moving up and right for moving down) select the next level to be displayed, press the enter/shuttle key again to
enter in next level and press ESC key to return to previous level if desired. This navigation will be performed the same for
all the menus in Actual Values. Once the last sublevel is reached, move up and down to visualize the actual values
selected. 

Metering          >

Primary Values >

Current

Voltage

Power

Energy

Demand

Secondary Values >

Current

Voltage

Power

Frequency

Inputs/Outputs    >

Contact Inputs    >

Board F/ Board G/ Board H/ Board J

Cont. Output St. >

Board F/ Board G/ Board H/ Board J

Cont. Output Op. >

Board F/ Board G/ Board H/ Board J

Cont. Output Rs. >

Board F/ Board G/ Board H/ Board J

IO Board Status

Virtual Inputs    >

Virtual Inp.Latched

Virtual Inp.SR

Virtual Outputs

Remote Outputs (for IEC61850 models 
only) >

DNA

User St

GOOSE Dig Outputs

Remote Inputs for IEC61850 models 
only)>

Remote Input

Remote Devices

GOOSE Dig Inputs

GOOSE Analog Inputs

Analog Inputs >

Board F/ Board G/ Board H/ Board J
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One example of data screen for actual values is shown in Figure 3.20:. 

First Line: Header of last level in actual values (Phase Current in the example)

Second Line: Data identifier (in the example PH IOC1 HIGH A, is the pickup signal for the first instantaneous
overcurrent function level high for phase A). 

Third line: Status of the displayed actual value.

Fourth Line: Relative position in the menu (it is the first value of 114)

Figure 3.20: ACTUAL VALUES SCREEN DATA

In the Actual Values menus are different types of data, each type of data will display its particular status type (on and off, 0
or 1, ok or fail, analog values, etc.)

Phase Current 
PH IOC1 HIGH A PKP 

OFF
(1/114) 
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3.2.5.4   SNAPSHOT EVENTS

To enter this menu press the enter/shuttle key when the option Snapshot events is selected in main menu (). In this menu
all the snapshot events stored can be displayed.

Snapshot events are changes in the relay internal status. 

One snapshot event is displayed in two text screens:

The first screen display the status, date and time of the snapshot event: the snapshot event identifier, its status,
event number and the date and time of the occurrence. If the snapshot event identifier does not fit the first line, the
whole text will be shown using as well the second line alternating with the status and event number.

The second screen displays currents and voltages in primary values for that particular snapshot event. Ia, Ib, Ic
and Ig for currents and Vab, Vbc, Vca and V0 for voltages. To access the metering screen in snapshot events
menu, press shuttle key from the snapshot event first screen. To exit from the metering screen press ESC. 

To select different snapshot events to be displayed, press the up-down keys orrotate the shuttle key to select the snapshot
event and then press the enter/shuttle key to enter the metering screen. Press esc to exit the metering screen and return to
snapshot events menu.

Figure 3.21: shows an example of snapshot events navigation:

Press enter/shuttle key from the default main screen and enter in the main text
menu.

Move the shuttle key  or press up-down keys until a single scroll bar character
() appears in the left part of Snapshot event header.

Press enter/shuttle key to enter in the snapshot events menu)

Select the snapshot event to display using the up/down keys or  shuttle key (left
and right to move up and down inside the recorded snapshot events).

Once selected the snapshot event, identifier, status, date and time will be
displayed.

In the second line St: is showing the status and the relative snapshot index from
the whole recorded number. Third and fourth lines are used to display the time
and date of the snapshot event.

Pressing the enter/shuttle key the metering screen for the snapshot event will
be displayed.

To exit from this screen press the ESC key and return to the snapshot events
menu.

Figure 3.21: SNAPSHOT EVENTS NAVIGATION IN HMI
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3.2.5.5   FAULT REPORT

To enter this menu press the enter/shuttle key when the option Fault report is selected in main menu (). This menu displays
information about the last ten faults recorded in the relay.

The Relay HMI allows two types of visualization for the fault reports stored in the Relay:

1. Showing the fault warning messages in the text display when the fault is produced. This option has to be enabled
by setting. To change from the HMI go to the menu "Change Settings >Product Setup > Fault Report > Show
Fault On HMI" and enable it.

2.Only saving and allowing viewing the information from the last ten faults recorded in the relay.

In the first option, when a fault occurs a warning message is displayed, including information about the fault in two screens,
one with general fault information, and a second one with the measured values in the moment of the fault.

The fault-warning message must be acknowledged by the user; this means that the user must press the enter/shuttle key
for this screen to disappear, The HMI will not allow to perform any other operation until the screen is acknowledged. In the
event of several consecutive faults, the HMI will always show the most recent fault, and the user will need to acknowledge
all of them, up to a maximum of ten faults.

In the second option, viewing the fault reports in the menu available in the HMI, the Fault Report menu in the main text
screen must be accessed by pressing the enter/shuttle key. The display will show the information about the last ten faults
produced, and both the general information and the metering screens can be viewed for each fault. Displayed information
starts in the most recent fault, and the user can switch to another fault by rotating the shuttle key.

Displayed information is stored in the relay volatile memory, so if the relay is turned off this information will be lost, as well
as if a "Clear Fault Report" command is executed. However, fault reports stored in the relay non-volatile memory will remain
after the Fault reset, and they can be obtained from the relay using EnerVista 650 Setup software, at the
"Actual>Records>Fault report" menu.

If there is no fault report available through the display, the relay will show a "Fault report not available" message.
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The format of the displayed screens is as follows:

Select the Fault report menu in text menu

If there is more than one fault record press the up-down keys or  rotate the shuttle
key and select the desired record to be displayed.

First screen with general fault information: Fault report #number, fault type, distance
and date and time.

Second screen with metering data for that fault record. All this data is a summary
from the fault report file that can be retrieved via EnerVista 650 Setup software.

Figure 3.22:  FAULT REPORT NAVIGATION IN HMI 

Possible fault types are as follows:

GROUND Ground faults

AG      phase A to ground

ABG   phase AB to ground

BG     phase BG to ground

BCG phase BCG to ground

CG    phase CG to ground

CAG phase CAG to ground

PHASE Phase to phase faults
AB     phase A to phase B

BC    phase B to phase C

CA    phase C to phase A
3PHASE Three-phase faults (shown on the display as 3PH)

NAF Fault type not calculated
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3.2.5.6   VIEW SETTINGS

To enter this menu press the enter/shuttle key when the option "View Settings" is selected in main menu (). A secondary
level will be displayed with different sublevels as shown on Table 3.30:. Pressing up-down keys or rotating the shuttle key,
(left for moving up and right for moving down) select the next level to be displayed (), press the enter/shuttle key again to
enter in next level and press esc key to return to previous level if desired. This navigation will be performed the same for all
the menus in "View Settings". Once the last sublevel is reached, move up and down to visualize the settings selected. 

Table 3.30:  GENERAL OVERVIEW OF "VIEW/CHANGE SETTINGS" MAIN MENU

MAIN SETTINGS MENU FIRST LEVEL SECOND LEVEL THIRD LEVEL
Product Setup     >

Communication     >

Serial Ports

Ethernet          >

Ethernet 1

Ethernet 2

ModBus Protocol

DNP3 Slave (Available for 
standard and IEC61850 
models)>

DNP3 Slave 1

DNP3 Slave 2

DNP3 Slave 3

IEC 870-5-104(Available for 
standard and IEC61850 
models)>

SNTP

PROCOME (Available for 
procome models only).

Fault Report

Oscillography

Demand

Time Settings

System Setup      >

General Settings

Breaker           >

Breaker Settings

Breaker Maintenance

Protection Element >

Phase Current     >

Phase TOC High    >

Phase TOC High 1

Phase TOC High 2

Phase TOC High 3

Phase TOC Low     >

Phase TOC Low 1

Phase TOC Low 2

Phase TOC Low 3

Phase IOC High    >

Phase IOC High 1

Phase IOC High 2

Phase IOC High 3

Phase IOC Low     >

Phase IOC Low 1

Phase IOC Low 2

Phase IOC Low 3
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Phase Directional >

Phase Directional 1

Phase Directional 2

Phase Directional 3

Thermal Model     >

Thermal Model 1

Thermal Model 2

Thermal Model 3

Neutral Current   >

Neutral TOC       >

Neutral TOC 1

Neutral TOC 2

Neutral TOC 3

Neutral IOC       >

Neutral IOC 1

Neutral IOC 2

Neutral IOC 3

Neutral Dir        >

Neutral Dir 1

Neutral Dir 2

Neutral Dir 3

Ground Current    >

Ground TOC        >

Ground TOC 1

Ground TOC 2

Ground TOC 3

Ground IOC        >

Ground IOC 1

Ground IOC 2

Ground IOC 3

Ground Dir         >

Ground Dir 1

Ground Dir 2

Ground Dir 3

Sens. Ground Curr >

Sens. Ground TOC. >

Sens. Ground TOC 1

Sens. Ground TOC 2

Sens. Ground TOC 3

Sens. Ground IOC >

Sens. Ground IOC 1

Sens. Ground IOC 2

Sens. Ground IOC 3

Isolated Gnd IOC   >

Isolated Gnd IOC 1

Isolated Gnd IOC 2

Isolated Gnd IOC 3

Sens. Ground Dir. >

Sens. Ground Dir. 1

Sens. Ground Dir. 2

Sens. Ground Dir. 3

Neg. Seq. Current >

MAIN SETTINGS MENU FIRST LEVEL SECOND LEVEL THIRD LEVEL
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Neg. Seq. TOC     >

Neg. Seq. TOC 1

Neg. Seq. TOC 2

Neg. Seq. TOC 3

Voltage Elements >

Phase UV          >

Phase UV 1

Phase UV 2

Phase UV 3

Phase OV          >

Phase OV 1

Phase OV 2

Phase OV 3

Neutral OV High   >

Neutral OV High 1

Neutral OV High 2

Neutral OV High 3

Neutral OV Low    >

Neutral OV Low 1

Neutral OV Low 2

Neutral OV Low 3

Neg. Seq. OV      >

Neg. Seq. OV 1

Neg. Seq. OV 2

Neg. Seq. OV 3

Auxiliary OV      >

Auxiliary OV 1

Auxiliary OV 2

Auxiliary OV 3

Auxiliary UV      >

Auxiliary UV 1

Auxiliary UV 2

Auxiliary UV 3

Power>

Forward Power     >

Forward Power 1

Forward Power 2

Forward Power 3

Directional Power >

Directional Power 1

Directional Power 2

Directional Power 3

Watt Gnd Flt High >

Watt Gnd Flt High 1

Watt Gnd Flt High 2

Watt Gnd Flt High 3

Watt Gnd Flt Low >

Watt Gnd Flt Low 1

Watt Gnd Flt Low 2

Watt Gnd Flt Low 3

Control Elements >

MAIN SETTINGS MENU FIRST LEVEL SECOND LEVEL THIRD LEVEL



GEK-113000Z F650 Digital Bay Controller 3-49

3 HUMAN INTERFACES. SETTINGS & ACTUAL VALUES 3.2 HUMAN MACHINE INTERFACE (HMI)

3

Setting Group

Underfrequency    >

Underfrequency 1

Underfrequency 2

Underfrequency 3

Overfrequency     >

Overfrequency 1

Overfrequency 2

Overfrequency 3

Synchrocheck

Autoreclose

Breaker Failure

VT Fuse Failure. 

Broken Conductor >

Broken Conductor 1

Broken Conductor 2

Broken Conductor 3

Locked Rotor >

Locked Rotor 1

Locked Rotor 2

Locked Rotor 3

Fq Rate of Change

Fq Rate of Change 1

Fq Rate of Change 2

Fq Rate of Change 3

Load Encroachment

Load Encroachment 1

Load Encroachment 2

Load Encroachment 3

MAIN SETTINGS MENU FIRST LEVEL SECOND LEVEL THIRD LEVEL
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3.2.5.7   CHANGE SETTINGS

To enter this menu press the enter/shuttle key when the option "Change Settings" is selected in main menu. A secondary
level will be displayed with different sublevels as shown on Table 3.30:. Press up-down key or rotating the shuttle key, (left
for moving up and right for moving down) select the next level to be displayed, press the enter/shuttle key again to enter in
next level and press ESC key to return to previous level if desired. This navigation will be performed the same for all the
menus in "Change Settings". Once the last sublevel is reached, move up and down to visualize the settings selected. 

To change a particular setting, press the enter/shuttle key on the setting to be modified. After selecting the setting, the value
for that setting will appear between brackets. Choose the new value moving up and down . After selecting the appropriate
value press again the enter/shuttle key to fix that value. To save the new settings, go to the end of the menu  pressing down
key or rotating the shuttle key right, and select the menu "Press Enter to save settings". When pressing the shuttle key
inside this menu the new settings will be saved. 

Select the menu Change settings and press the enter/shuttle key to enter in the next
sublevel.

 

If there is more than one sublevel, select the next sublevel by pressing the up-down
keys or  rotating and pressing the enter/shuttle key till the last level is reached.

Press the enter/shuttle key in the function to be modified

-> Group of settings

-> Setting to be modified

-> Value

-> Range and step

Pressing the enter/shuttle key, value appears between brackets and can be modified
pressing the up-down keys or rotating the shuttle key. Pressing again the enter/
shuttle key, the new value will be accepted.

Once all settings inside the group have been modified, go to the last screen pressing
the down key or  rotating the shuttle key and press Enter. At this moment of time, the
new settings will be active in the relay.

Figure 3.23: CHANGE SETTINGS PROCEDURE IN HMI 
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3.2.5.8   DATE & TIME

The "Date & Time" menu will show the relay date and time information in the following format: 

Date:Day/Month/Year

Time:Hour:Minutes:Seconds

To modify date and time, press the enter/shuttle key. The relay will show the year between brackets at the top of the screen.
By pressing the up-down keys or rotating the shuttle key, reach the desired value for the year, and press the enter/shuttle
key to select and store that value. After the year, the relay will show the month. Proceed as in the case of the year. The date
& time modification sequence is as follows:

Press the up-down key or rotate the shuttle key to select the "Date and Time" menu
and press to enter in it

The date and time data will appear in the format related above. 

Pressing the enter/shuttle key the year can be modified pressing up-down key or
rotating the shuttle key, after selecting the desired value, press again the enter/
shuttle key to store the value.

"Year"

Date: Day/Month/<Year>
Time: Hour:Minutes:Seconds

After storing the value for Year, Month will appear between brackets and can be
modified

"Month"

Date: Day/<Month>/Year
Time: Hour:Minutes:Seconds

After storing the value for Month, Day will appear between brackets and can be
modified

"Day"

Date: <Day>/Month/Year
Time: Hour:Minutes:Seconds

After storing the value for Day, Hour will appear between brackets and can be
modified

"Hour"

Date: Day/Month/Year
Time: <Hour>:Minutes:Seconds

After storing the value for Hour, Minutes will appear between brackets and can be
modified

"Minute"

Date: Day/Month/Year
Time: Hour:<Minute>:Seconds

After storing the value for Minutes, Seconds will appear between brackets and can
be modified

"Second"

Date: Day/Month/Year
Time: Hour: Minute:<Seconds>

Once this sequence is completed, these values will remain stored in the relay, and
the display will show again the date at the bottom of the text screen.

Figure 3.24: CHANGE DATE AND TIME PROCEDURE IN HMI
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3.2.5.9   COMMANDS

Commands are configured using EnerVista 650 Setup, and they can be executed using the pushbuttons on the relay front.

Using EnerVista 650 Setup software, the user can configure up to 24 commands with a descriptive text. When executing
the operation from the relay front, the operation description text will be displayed.

Example of commands (operations) executions via HMI

Press the enter/shuttle key in the menu commands when it is selected in the display
().

All the previously configured commands will be displayed. Press up-down keys or
rotate the shuttle key move through the available commands. Press ESC to return to
previous level.

Press enter/shuttle key to pre-select the operation to be executed

When the message "Push Enter for Confirmation" appears, press the enter/shuttle
key to confirm the commands that will be performed.

Once the commands has been performed or the time out has expired the
"Command completed" message will appear in the display.

Figure 3.25: COMMANDS IN HMI
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3.2.5.10   PASSWORDS

F650 units incorporate independent passwords for protection and control, in order to prevent unauthorized keypad and
display access to the relay.

Settings Password:

This password allows restricting access to settings changes in the relay protection elements.

Commands Password:

This password is required for executing operation commands through the keypad and display.

If the Commands Password is activated, when the user tries to execute an operation, the relay will request this password,
and in case of using the single-line diagram for graphical display models, all objects will not be operational until this
password is entered, either logging in Login Pwd Commands, or entering the password in the Commands menu.

Relay settings view, measures, and other monitored information are not password-protected, and they can be accessed by
all users.

Access to the password menu is located at the Password option in the relay text menu. This menu includes the following
options:

   "Login Pwd Settings"

   "Logout Pwd Settings"   

   "Change Pwd Settings"

   "Login Pwd Commands"

   "Logout Pwd Commands"

   "Change Pwd Commands"

   "Forgot Password?"   

Among the available options in this menu, there are three types of functionality:

Login: For entering the password, either for settings or commands, and enable access to settings
or commands. Once entering the password the relay is no longer password protected, and
access is enabled to settings modification or commands execution.

Logout: Once the necessary setting changes or operation commands have been executed, the
user can log out, so that the relay is password protected again.

Change: This menu allows setting or modifying the desired password.

Forgot Password: This menu provides the encrypted password, so that it can be recovered if the user loses or
forgets it. 

Passwords are restricted for Settings change and Commands execution. To password-protect the relay, it is first necessary
to set the desired password, using the corresponding "Change Pwd..." menu. The default password is 0000. This password
provides access to the whole relay functionality. 

Once a new password has been set, the user must log in to access the protected functionality; otherwise, the relay will
request the password when trying to change settings or execute commands. Once the password is entered the relay is
unprotected (as if the user had logged in), and the user must log out to protect again the relay.

a) PASSWORD RANGE

The valid range for F650 passwords is a number from 0000 to 9999. 

The default password is 0000, which provides access to the whole relay functionality. This is the default option for enabling
relay use without using passwords.
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b) ENTERING THE PASSWORD (LOGIN PWD)

This operation is the same for both the settings and commands passwords. The only difference will be the access menu.
For entering the password, the user must access the Login menus inside the Password menu.

Login Pwd Settings or Login Pwd Commands:

The relay requests the password with the following message on the screen:

Setting passwd.

Login: < 1000 >

For entering the desired password, the user must press up-down key or rotate the shuttle key to the left (decrease) or to the
right (increase), and establish the desired number. Once entered, the selected password between brackets has been
entered, the relay will show the message "Processing passwd. Wait...". If the password is correct, the relay will allow
access to the settings change or command execution. It is not necessary to enter the password every time a change is to
be performed. The relay will request the password 15 minutes after the last keypad action has taken place. This period of
time is the same that takes the relay to turn off the display backlighting. 

c) LOGGING OUT (LOGOUT PWD)

To disable access to settings and commands, the user must logout.

Logout Pwd Settings or Logout Pwd Commands:

For safety reasons, if the user does not log out, the relay will do it automatically 15 minutes after the last keypad
action.

d) CHANGING THE PASSWORD (CHANGE PWD COMMANDS)

To set a password in the relay, both for settings and commands, the corresponding menu must be accessed inside the
Password menu:

Change Pwd Settings or Change Pwd Commands:

To modify the password, the user must first introduce the existing password; if the relay has the default factory password,
this would be 0000.

For modifying the password, the relay requests the existing password with the following message:

(Setting or Command) passwd.

Login: < 0000 >

Once the entered password has been acknowledged, the new password must be entered:

(Setting o Command) passwd.

New passwd: < 1000 >

Once the new password has been entered, the relay returns to the general Passwords menu.

e) PASSWORD RECOVERY (FORGOT PASSWORD?)

If the relay passwords need to be recovered, the "Forgot Password?" menu must be accessed. This menu is the last
option inside the text Passwords menu.

This menu will show two passwords, which correspond to the encrypted protection settings, and commands passwords, as
shown in the following example:

Cod Settings:      [35c0]

Cod Commands: [35c0]

<Push Enter>

In order to obtain the decoded password from the encrypted codes provided by the relay, it is necessary to contact GE
Multilin and provide these encrypted codes.
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3.2.5.11   SELECT MAIN SCREEN

The relay display offers the possibility to select the default main screen. For this purpose, the user must access the "Select
Main Screen" menu through the HMI. This menu includes the following options:

Logotype

This option selects as main screen the relay logotype including the firmware and boot code versions, the relay model and
the communication parameters for local port COM2.

Figure 3.26: DEFAULT LOGOTYPE SCREEN

Metering

This option shows a Metering screen including the phase and ground currents as well as phase-to-phase voltage, and zero
sequence voltage values, all of them in primary values.

Figure 3.27: DEFAULT METERING SCREEN

All

This option alternates in time the two previous options.

Ia   0.000  Vab   0.000
Ib   0.000  Vbc   0.000
Ic   0.000  Vca   0.000 
Ig   0.000  V0     0.000
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3.2.5.12   SELECT LANGUAGE

Option only available for versions 1.70 or higher than 5.20.

The relay display offers the possibility to select the default language for the relay. For this purpose, the user must access
the "Select language" menu located at the end of the main menu through the HMI. This menu allows the user to set the
default language of the relay between English (always available) and second language selected in the relay model. 

For example one relay in French language (e.g. FC650MZDF2G1HIRF) can be displayed in French or in English only by
changing the language setting in HMI. It is necessary to switch off and on the relay to start working with the new language
configuration in the relay. In EnerVista 650 Setup it is possible to select the language for the software (View>Languages).

Example of language selection in HMI

Press the enter/shuttle key to enter the select language menu.

Depending on the relay model there will be available different kind of language
selections: English/French, English/ Russian, etc.

Press up-down keys or rotate the shuttle key to select the desired language and
press enter to store the selection in the relay

Once the new language has been selected it is necessary to reboot the relay in
order to start working with the new language in the device.

Figure 3.28: LANGUAGE SELECTION IN HMI
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3.2.6 GRAPHIC DISPLAY

3.2.6.1   ONE-LINE DIAGRAM

In models with graphic display (F650M) default main screen is the single-line diagram. This single-line diagram can be
configured using EnerVista 650 Setup software by choosing the HMI menu inside Relay Configuration (Setpoint>Relay
Configuration>HMI).

Figure 3.29: ONE-LINE DIAGRAM

The bottom of the display shows a legend that indicates the possible selections that can be made from this screen.

Esc: Menu.                           Enter: Next.                               : Select.

The meaning of these options is as follows:

Esc: Menu.

Pressing the ESC key, the user will access the relay main menu, similar to the one displayed by the text-display model
(F650B).

Pressing again the ESC key; the menu selection screen (Actual Values, Snapshot events, etc.) will be displayed. This main
menu screen is identical to the one described for the text display. Its functionality is described in section 3.2.5 in this
manual. 

Intro: Next.

Pressing the enter/shuttle key, the user access the next graphical screen, which in this case corresponds to the primary
metering values screen.

: Select

Once the different switchgear elements to be operated have been configured using EnerVista 650 Setup, the user will be
able to operate them from the graphic display. 

If a single-line diagram has been previously configured in the EnerVista 650 Setup, in the HMI option inside the Relay
Configuration menu, the different switchgear elements configured for the display will be operative from the graphic
display. By pressing up-down key or  rotating the shuttle key to the left and right, the cursor moves among the elements and
blinks on each of them. When an element is selected by pressing the enter/shuttle key, the relay will indicate the command
to be executed, and the user will need to confirm it by pressing again the enter/shuttle key.

The following sections describe only the operation of screens that are specific for the graphic display models.

F650 DIGITAL BAY CONTROLLER 

 Ia = 0.000 kA  Vab =0.000 kV 

 Ib = 0.000 kA  Vbc =0.000 kV 

 Ic = 0.000 kA   Vca =0.000 kV 

Freq = 0.00 Hz 

Esc: Menu.  Enter:Next.  :Select 
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3.2.6.2   METERING SCREEN

The Metering screen displays relay analog measures in their primary values. Available metering values are as follows:

Figure 3.30: METERING SCREEN

As in the rest of graphical display screens, the bottom part shows a legend that indicates the possible options for the user.
In this case, the options are:

Enter: Next. Esc: Prev. : Scroll.

Intro: Next.

Pressing the enter shuttle key the user accesses the next screen, in this case the ALL EVENTS screen.

Esc: Prev.

Pressing the ESC key the user returns to the previous screen (One-line diagram)

: Scroll.

Pressing the up-down key or rotating the shuttle key to the left (L) or right (R) the user can access all the Metering values in
the screen. 

METERING SCREEN ANALOG MEASURES IN PRIMARY VALUES

Phasor Ia Primary V0 Primary Phase A Real Pwr Line Frequency Primary

Phasor Ib Primary V1 Primary Phase B Reactive Pwr Bus Frequency Primary

Phasor Ic Primary V2 Primary Phase B Apparent Pwr Vx Primary

Phasor Ig Primary Vab Primary Phase B Real Pwr Pos MVarhour Freeze

Phasor Isg Primary Vbc Primary Phase C Reactive Pwr NegMVarhour Freeze

Phasor In Primary Vca Primary Phase C Apparent Pwr PosMWatthour Freeze

RMS Ia Primary Vn Primary Phase C Real Pwr Neg MWatthour Freeze

RMS Ib Primary Va Primary 3 Phase Reactive Pwr Positive MVarhour 

RMS Ic Primary Vb Primary 3 Phase Apparent Pwr Negative MVarhour 

RMS Ig Primary Vc Primary 3 Phase Real Pwr Positive MWatthour

RMS Isg Primary VL Primary Phase A Power Factor Negative MWatthour 

I0 Primary VBB Primary Phase B Power Factor

I1 Primary Phase A Reactive Pwr Phase C Power Factor

I2 Primary Phase A Apparent Pwr 3 Phase Power Factor

Metering Screen.   Total metering 53 

 Phasor Ia Primary   0.000 KA 
 Phasor Ib Primary   0.000 KA 
 Phasor Ic Primary   0.000 KA 
 Phasor Ig Primary   0.000 KA 
 Phasor Isg Primary   0.000 KA 
 RMS Ia Primary   0.000 KA 
 RMS Ib Primary   0.000 KA 
 RMS Ic Primary   0.000 KA 
 RMS Ig Primary   0.000 KA 
 RMS Isg Primary   0.000 KA 

I0 Primary    0.000 KA 

Enter: Next.  ESC: Prev :Scroll.
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3.2.6.3   ALL EVENTS SCREEN

This screen shows all events that have been produced in the relay. The top of the screen shows its name (All Events), and
the relative and total number of events contained in the screen.

All Events (1/479)

This legend means that there are a total of 479 events stored in the relay, and that the cursor is located on event number 1.
The information shown on this screen for each event is as follows:

"Hour:Minute:Second:Millisecond" "Event text" "Event status (ON/OFF)"

Figure 3.31: ALL EVENTS SCREEN

The screen legend options are:

Esc: Prev.                        Enter: Menu.                     : Scroll.

Esc: Prev.

Pressing the ESC key, the user returns to the previous screen (Metering screen) 

Intro: Menu.

Pressing the enter/shuttle key, the user accesses the Events menu that offers the following options at the bottom of the
screen: 

next prev reload details At

To access the different options in the snapshot events graphic menu the user must move the cursor from up to down or
from left to right. The selected option will be displayed in upper case and between brackets. To access the selected option,
the user must press again the enter/shuttle key.

<NEXT>

The user accesses the next available graphic screen (Events ‚Äì New) 

<PREV>

This option returns to the general events graphic menu (All Events)

<RELOAD>

This option updates all events stored in the relay and returns to the general events screen.

All Events (1/479). 
- [ Ready LED ON ] - 

16:11:08.035 Ready LED ON    ON 
16:11:08.017 Breaker Closed ON   ON 
16:11:08.005 Isolated Gnd3 Block OFF  OFF 
16:11:08.005 Isolated Gnd2 Block OFF  OFF 
16:11:08.005 Isolated Gnd1 Block OFF  OFF 
16:11:08.005 Sens Gnd TOC3 Block OFF  OFF 
16:11:08.005 Sens Gnd TOC2 Block OFF  OFF 
16:11:08.005 Sens Gnd TOC1 Block OFF  OFF 
16:11:08.005 Ground TOC3 Block OFF  OFF 
16:11:08.005 Ground TOC2 Block OFF  OFF 
16:11:08.005 Ground TOC1 Block OFF  OFF 

Esc: Prev.  Enter: Menu. : Scroll. 
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<DETAILS>

The Details screen provides access to metering values, and date and time related with the event.

The top of the screen displays a legend with the event text, followed by the date and time, the event status (ON or
OFF), and the event index number related to the complete list of events in the relay, for example (1/479). The rest of
information provided by the Details screen corresponds to the relay measures in the moment of the event. Metering
values provided in the events are secondary, and voltage values correspond to phase-to-ground voltage.

Figure 3.32: SNAPSHOT EVENTS DETAIL SCREEN

To navigate this screen the user must follow the legend at the bottom of the screen:

Enter: Meters.                             ESC: Prev.                       : Scroll.

Intro: Meters.

To access the metering values in the moment of the event, the user must press the enter/shuttle key. A new metering
screen will be displayed, containing the primary metering values in the snapshot event, such as:

Once inside the Metering screen, a new legend will be shown for each event (Intro or ESC: Prev. U-D (L-R: Scroll); this
legend indicates that by pressing ESC or the shuttle key, the system will return to the Event Detail screen, and
pressing the up-down key or  rotating the shuttle key the user will access all the metering values contained in the
metering screen of the considered event.

ESC: Prev.

If the user presses the ESC key from the event detail screen, the system will return to the all events screen.

Phasor Ia Primary I2 Primary

Phasor Ib Primary Vab Primary
Phasor Ic Primary Vbc Primary 
Line Frequency Primary Vca Primary

Phasor Ig Primary V1 Primary
Phasor Isg Primary V2 Primary
I0 Primary V0 Primary

I1 Primary 3 Phase Power Factor

Ready LED ON  
Date: 07/Nov/2004    St:ON 
Time: 16:11:08.035    (1/479) 
 
Phasor Ia Primary    0.000 
Phasor Ib Primary    0.000 
Phasor Ic Primary    0.000 
Line Frequency    0.000 
Phasor Ig Primary    0.000 
Phasor Isg Primary    0.000 
I0 Primary     0.000 
I1 Primary     0.000 
 
 

Enter: Meters.    ESC: Prev  : Scroll. 
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: Scroll.

Pressing the up-down key or rotating the shuttle key left (L) or right (R) moves among all the events contained in the all
events screen, allowing a preview of the details for each of them.

<AT>

When this option is selected, the system marks the event where the cursor is located. A relative time stamp is
performed, in such a way that the selected event, marked with an asterisk (*) between the time and the event name is
set with a relative time of 00:00:00:000 on the top line of the event screen, together with its relative index, and the rest
of events in the screen will show a date/time that relates to the marked event. This operation mode allows a quick
inspection of the relative time passed between several events, which is very useful for analyzing events in the field.
The corresponding legend to this relative event-marking screen is as follows:

Esc: Out At. Enter: Tag event.

Esc: Out At.

The relative event marking is eliminated and the system returns to the general events screen.

Enter: Tag event.

If the user places the cursor on a different event by pressing the up-down key or rotating the shuttle key left or
right, pressing the enter/shuttle key will change the relative mark to that new event.

3.2.6.4   NEW EVENTS SCREEN

This screen shows the new events that have been produced in the relay since the last time the New Events screen was
read. The top of the screen shows a "New Events" legend, and the relative and total number of events contained.

Navigation through the different menus in this New Events screen is similar to the one described in the previous section for
All Events. The main difference is that in the case of new events it is necessary to select the RELOAD submenu to update
the screen with new events that have been produced, while in the All Events screen, this refreshment is automatic.

After the new events have been read, if the user selects again the Reload menu, the system will show a <No new events
available.> message, indicating that there are no more new events available since the last reading.
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3.2.6.5   ALARMS PANEL

Alarms panel can be viewed in all F650 models using communication software EnerVista 650 Setup, however, only models
with graphic display allow access to the alarms panel from the HMI.

First line shows the relative and total number of alarms existing in that screen. The relative number refers to the alarm on
which the cursor is located, and the total number refers to the total amount of alarms available. The second line on this
screen shows an index that indicates the number of the configured control event that corresponds to the displayed alarm,
followed by the alarm text configured in the Control Events menu inside the Relay Configuration option
("Setpoint>Relay Configuration>Control Events"). 

Figure 3.33: ALARMS PANEL IN HMI

The rest of the screen shows the different alarms produced in the relay with the date and time when the corresponding
event was produced, followed by the alarm identification text, and its status, active (ON) or inactive (OFF).

In the previous example, the produced alarm is the change to local of the execution of operations (OPERATIONS IN
LOCAL MODE), the date and time when this event has been produced, and its status (ON):

The bottom of the screen shows the legend that indicates how to navigate through the different options available in the
screen.

ESC: Prev. Enter: Next.

ESC: Prev.

Pressing the ESC key, the system returns to the previous New Events screen.

Enter: Next.

Pressing the enter/shuttle key, the user accessed the available alarms menu, which includes the following options.

next prev ack ack all

To access the different options provided by the alarms graphic menu, the user must press the up-down key or move   the
shuttle key left to right. The selected option will be displayed in upper case and between brackets. To access the selected
option, the enter/shuttle key must be pressed.

<NEXT>

This option provides access to the next available graphic screen (I/O boards) 

<PREV>

The system returns to the previous New Events screen. 

<ACK>

This option acknowledges the alarm on which the cursor is located.

Alarm Panel (1/3). 
#1 OPERATIONS IN LOCAL MODE 

 
7/11/04 16:54:16 OPERATIONS IN LO.  ON 
7/11/04 16:54:16 GENERAL PICKUP  ON 
7/11/04 16:54:16 GENERAL TRIP  ON 

 
 
 
 
 
 
 
 

Esc: Prev.  Enter: Next 
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<ACK ALL>

This option acknowledges all alarms. Alarm acknowledgement through the graphic HMI is considered as through
communication port COM2, as it is considered to be Local in both cases.

When an alarm has been acknowledged, a selection mark will appear to the right of its status. Inactive alarms will
disappear from the screen once they are acknowledged.

3.2.6.6   INPUT/OUTPUT MONITORING SCREEN

This is the last screen available in the graphic display. This screen allows viewing the status of the relay inputs and outputs,
as well as emulate inputs (for verification of the logic, or related functions), and contact outputs (to verify wiring). 

The format of this screen is shown on the figure below.

The first line shows the name of the screen "I/O Cards", followed by the type and description of the board where the cursor
is located, which will appear between selection marks > < and blinking.

Figure 3.34: INPUTS/OUTPUTS GENERAL SCREEN

The navigation legend on this screen is as follows: 

Esc: Prev.             Enter: Menu.        :  Chg Card

Esc: Prev.

This option returns to the previous screen (Alarms Panel).

Enter: Menu.

This option provides access to the selected I/O board menu:

This menu includes the following options.

next view test input test output

As in previous screens, to access the different options provided by the inputs/outputs graphic menu, the user must press
the up-down key or  move the shuttle key left to right. The selected option will be displayed in upper case and between
brackets. To access the selected option, the enter/shuttle key must be pressed.

IO Card. 
Type: 2, Nº IN 8,  Nº OUT 8 

 
  >F< 

  G 
  H 
  J  

 
 
 
 
 
 

Esc: Prev.  Enter: Menu.  : Chg Card. 
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Figure 3.35: INPUT/OUTPUT VIEWING SCREEN

<NEXT>

This option brings the system back to the one-line diagram.

<VIEW>

This option shows the real status of all inputs and outputs in the selected board. Depending on the type of board, with
or without supervision, the screen will vary to get adapted to the characteristics of each board.

The first line of this screen shows the slot where the board is located, F, G, H or J, and the type of board. The view
menu differentiates inputs and outputs; the active status (ON) is represented by the lighting of the corresponding input
or output.

The legend at the bottom of the screen indicates how to navigate:

Esc: Prev. Enter: Menu. : Chg Card

Esc: Prev.

Returns to the general I/O screen

Enter: Menu.

Provides access to the I/O menu (next, view, test input, test output). 

: Chg Card

Pressing the up-down key or Moving the shuttle key to the left or right provides access to the status of inputs/
outputs for the different boards available in the relay.

<TEST INPUT>

This option allows testing the input activation (in emulation mode). The displayed screen is similar to the viewing
screen, but in this case the user can operate the different relay inputs.

This screen shows the Input name lit up, showing that this is an Input emulation mode.

The first relay input will appear blinking and between brackets; the user can select a different input by pressing up-
down key or rotating the enter/shuttle key. When the shuttle key is pressed, the selected input will be activated.
Navigation through this screen is indicated by the following legend:

Esc: Exit Text. Enter: Chg Input.

IO Card F. Type: 2, # IN 8,  # OUT 8 
 

Input  (ON OFF)  Output 
 
 
 
 
 
 
 
 
 
 
 

next  >VIEW< test input test output 

 0 CC1   8 Va COIL1 
 1 CC2   9 Vb COIL1 
 2 CC3  10 Va COIL2 
 3 CC4  11 Vb COIL2 
 4 CC5  12 Isense1 
 5 CC6  13 Isense1 
 6 CC7  14 SUP21 
 7 CC8  15 SUP22

 0 OUT1 �� 
 1 OUT2 �� 
 2 OUT3 �� 
 3 OUT4 �� 
 4 OUT5 �� 
 5 OUT6 �� 
 6 OUT7 �� 
 7 OUT8 �� 
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Esc: Exit Text.

The ESC option returns to the general I/O board menu.

Enter: Chg Input.

Pressing the enter/shuttle key on the blinking input, this input will be activated in emulation mode.

Note: input emulation can only be executed through the TEST INPUT tool on the graphic display.

<TEST OUTPUT>

This option allows testing the output activation in emulation mode. The displayed screen is similar to the viewing
screen, but in this case the user can operate the different relay contact outputs to test the wiring.

This screen shows the Output name lit up, showing that this is an output emulation mode.

The first relay output will appear blinking and between brackets; the user can select a different output by pressing the
up-down key or  rotating the shuttle key. When the enter/shuttle key is pressed, the selected output will be activated.
Navigation through this screen is indicated by the following legend:

Esc: Exit Text. Enter: Chg Output.

Esc: Exit Text.

The ESC option returns to the general I/O board menu.

Enter: Chg Output.

Pressing the enter/shuttle key on the blinking output, this output will be activated in emulation mode.

Note: Output emulation can be executed through the TEST OUTPUT tool on the graphic display, and also
through communications using EnerVista 650 Setup software for all F650 models.

: Chg Card

Pressing the up-down key or rotating the shuttle key allows to change the selected I/O board in the main I/O screen.
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3.3 WEB SERVER 3.3.1 HOME

The web server in the F650 can be accessed running the Windows explorer, and typing http://xxx.xxx.xx.xxx, being
xxx.xxx.xxx.xxx the relay IP address, which must be configured in Setpoint > Product Setup > Communication Settings
> Ethernet. 

The main screen of the F650 web server shows the different monitoring possibilities for snapshot events, events, alarms,
oscillography, fault reports, data logger and metering values provided by the relay through the web.

In order to access the different functions provided by the web server, the user must simply click on the list name on the left
side of the screen.

The web server (for version 1.70 and higher ones) allows the user to visualize the different web server screen languages:
English, French, Spanish and Russian by pressing the language button on the top right corner of the main window. Take
into account that this selection only changes the language in the web server screen, all the relay texts, such as snapshot
events, control events, etc. will be the in the language selected in the relay (see section 3.2.5.12 in this manual).

Figure 3.36: WEB SERVER MAIN SCREEN
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3.3.2 SNAPSHOT EVENTS

The Snapshot events screen shows all Snapshot events produced in the relay. This screen is refreshed automatically every
minute.

The information provided in this screen includes: first, the relative event index, the lowest index corresponding to the most
recent event; next, the event text that shows the reason for the event, its status, active (ON) or inactive (OFF), and finally
the date and time when the event was produced.

The bottom of the screen shows a Metering screen; clicking on one of the events, the associated metering values will be
shown on that screen.

Figure 3.37: SNAPSHOT EVENTS SCREEN
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3.3.3 CONTROL EVENTS

The control events screen provides access to all events that have been configured in the Control Events screen inside the
Relay Configuration menu of EnerVista 650 Setup.

Figure 3.38: CONTROL EVENTS SCREEN

Unlike the case of Snapshot events, in this screen the highest index corresponds to the most recent event. The information
provided is the control event index, the text that has been associated to such event when configured, its status, active (ON)
or inactive (OFF), and its date and time.
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3.3.4 ALARMS

The alarms screen provides access to alarms configured in the relay. As in the case of snapshot events and control events,
this screen allows only to view the alarms, but not to acknowledge them.

Figure 3.39: ALARMS SCREEN
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3.3.5 OSCILLOGRAPHY

The oscillography screen allows obtaining from the relay available oscillography records in that moment.

This screen includes two windows. The first window shows oscillography records available in the relay, identified by an
index, being the highest index the most recent record (oscillography record No 6 in the example below).

Figure 3.40: OSCILLOGRAPHY SCREEN

If the user clicks on the oscillo record he wants to retrieve, the window on the right will show a description of the record
header, indicating its date, time, and the most relevant parameters of the record. Once a record is selected, it is required to
press the Download button. The system will then open a window to allow saving the files in Comtrade format in the PC
hard drive. Once the records have been saved, the system will ask if the user wants to open GE-OSC tool (Comtrade
record viewer) to view the downloaded files.

Figure 3.41: GE-OSC LAUNCH SCREEN

Clicking on the Home option, the system will return to the web server main screen.
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3.3.6 FAULT REPORT

The fault report screen provides access to the last 10 fault reports obtained by the relay. These records are stored
according to an index that marks their position among all records produced in the relay, with a range from 1 to 999,
returning to 1 in case of exceeding the limit of 999. As in the case of oscillography records, the highest index corresponds
to the most recent record.

In the fault report, oscillography and data logger screens, the system will request acceptance of a safety-warning message.

Figure 3.42: FAULT REPORT SCREEN

The information provided in this screen includes the date and time when the fault was registered, fault calculations such as
distance to the fault, type of fault, date and time, and the line parameters, as well as the recloser and breaker status during
the fault.

This screen shows also prefault and fault voltage and current primary values. At the top of the screen, associated to the
trigger event number there is a button labeled as INFO. This button displays at the bottom of the screen the events
produced before and after the fault report trigger, so that the user has very useful information about the moment when the
fault was produced.

To obtain a text file with all the fault report information, press the Download option and save the file in the computer.
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3.3.7 DATA LOGGER

The data logger screen allows viewing the data logger first and last value retrieval date and allows downloading the data
record files in Comtrade format, by pressing the Download option. Stored files can be viewed later using any Comtrade
format viewer.

Figure 3.43: DATA LOGGER SCREEN
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3.3.8 METERING

This screen includes the 53 primary metering values provided by the relay display.

Figure 3.44: METERING SCREEN
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4 SECURITY 4.1 ADDING USERS

New users can only be added by users that have Administrator Access (or Admin Rights) . The Enable Security check
box located in the Security->User Management window must be enabled.

Remember: (In order to add new users and assign user rights ) 

• must be logged in with Administrator Permission 

• and  Enable Security checkbox must be enabled   

4.1.1 USER RIGHTS

NOTE: Only Administrators have access to the User Management dialog box.
Following is a list of all of the User Rights Options available to be granted to users, and their functions. 

Table 4–1:  USER RIGHTS AND FUNCTIONS

By default, Administrator and Service users are created with "password" as default password.

RIGHT FUNCTION

Delete Entry
If this box is checked when the Administrator exits the User Management dialog box, the program will ask you to 
confirm the delete and if the Administrator chooses "yes", then the user whose "Delete Entry" box was checked 
will be permanently deleted from the list. 

Admin. WARNING: When this box is checked, the user will become an EnerVista 650 Setup Administrator, therefore 
receiving all of the Administrative rights.

Actual Values When this box is checked, the user will have the ability to view Actual Values and all records excluding event 
recorder.

Settings When this box is checked, the user will have access to view and modify Settings (Protection, control, inputs/
outputs and calibration).

Commands When this box is checked, the user will be able to use Commands.

Event Recorder When this box is checked, the user will have access to use Event Recorder.

Force IO When this box is checked, the user will be able to use Force IO application.

Logic Configuration When this box is checked, the user will have the ability to view and modify  Relay Configuration and Logic 
Configuration. 

Upgrade When this box is checked, the user will have the ability to upgrade firmware, bootware and to upload and 
download info files to/from relay. 



4-2 F650 Digital Bay Controller GEK-113000Z

4.2 CHANGING PASSWORDS 4 SECURITY

4

4.2CHANGING PASSWORDS

Users will be prompted to change their password after the first successful log in or through clicking Security from the
toolbar, and choose Change Password.

Figure 4–1: CHANGE SECURITY

When the operator enters a new password for the first time, he/she should also enter a personal question that only they
could answer. There is a limit of 50 characters available to enter the personal question. One example, as in the above
diagram, would be "What is my mother's maiden name?". This question will be posed to the user if the user forgets their
password and would like to know what their password was. 
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4.3ENABLING SECURITY

EnerVista 650 Setup Security Control is disabled by default. Users don't have to log in through user name and password
after installation and are granted access as Administrator. 

Security Control can be enabled through Security from the tool bar when logged on as an Administrator. Click on User
Management and a dialog box will show up. 

Figure 4–2: SECURITY ENABLING

Security Control is enabled by checking the ENABLE SECURITY check box. The first time the enable security option is
selected is necessary to close and open EnerVista 650 Setup to start working under security management.
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4.4LOGING INTO ENERVISTA 650 SETUP

Users have to log on in order to use EnerVista 650 Setup program after Security Control has been enabled. After the start
up of EnerVista 650 Setup, a dialog will pop up asking for user name and password. 

Figure 4–3: LOGIN USER

The user name field will display the last log in user name as default, in this example, TestUser. For the first log in session of
any user name, the default password will be "password". User will be prompt to change the password to something else
after the first successfully log in. 

Log on can also be done by clicking Security from the toolbar and choose Login New User. User will be prompted with the
same log in dialog box for a different user name and password combination. 

In case a user has forgotten about the log in password, the Forgot Password function can be used to retrieve the
password. 

Figure 4–4: FORGOT YOUR PASSWORD?

A question, which is pre-set by the user, will be asked. The password will be retrieved for entering the right answer.
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5 BOOTCODE AND FIRMWARE UPGRADE 5.1INTRODUCTION 

This section explains how to upgrade the F650 boot code and firmware. 

The boot code and firmware versions can be seen in the relay main screen: The relay firmware version appears after the
text "F650" (1.20 in the example) with the boot program version (2.20 in the example) followed by “GENERAL ELECTRIC”,
the relay model and the default front RS232 port communication parameters. 

Figure 5–1: MAIN SCREEN

BOOT CODE RELEASE NOTES

It is mandatory to maintain version compatibility between firmware and boot code in the upgrade procedure, otherwise the
relay will not start after upgrading.

WARNING

BEFORE PERFORMING THE UPGRADE PROCEDURE CHECK THAT BOOT AND FIRMWARE VERSION MATCH 

FIRMWARE, BOOTWARE AND F650 PC PROGRAM VERSIONS 
COMPATIBILITY

FIRMWARE CODE BOOT CODE ENERVISTA 650 PC

5.00 5.00 5.00

2.20 5.00 5.00

NOTE

A STEP LIST SUMMARY that will allow the user to control the upgrading process is included at the end of this section.
It is necessary to read paragraphs 9.2.1 to 9.4.2 of chapter 5  of manual GEK-106310 before accomplishing the F650
UPGRADE PROCEDURE.

Be aware that boot program and firmware upgrades will erase all the data contained in the relay, thus it is advisable to
save all the data, oscillography, events, settings and configuration files previously.

RELAYS WITH FIBER OPTIC ETHERNET

The upgrade of the boot program (BOOTCODE) must be performed by crossed Ethernet copper cable connected to the

PC. It is not necessary to change the internal switch from fiber to RJ45, because the upgrade is made at 10Mb/s.

This does not apply to the firmware upgrade, which can be done either via Ethernet Fiber connection, or through the

RJ45 cable connection.

For upgrading firmware versions lower than 3.20 or upgrading bootware, be aware to calibrate the unit offset, after
upgrading it,  on Communication --> Calibration --> Offset Calibration . No analog currents nor analog voltages must be
injected in the unit during this process.
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4.2 COMMUNICATION PARAMETERS

Before proceeding with the upgrade process, it is mandatory to check the following:

1. Since F650 Setup Program acts as a TFTP sever, any other TFTP server installed in the PC must be disabled.
Check if any other TFTP server is installed in the PC and/or if any other device is using Port 69 that it might be
installed by default during the PC startup. To disable it please proceed as follows in the PC:

• At STARTUP>MY PC>Right Mouse key>MANAGE>SERVICES & APPLICATIONS> SERVICES

• Select the operative TFTP server

• Right Mouse key>MANUAL or STOP

• Reboot PC (if MANUAL)

2. Ethernet Connection/Type - Both boot code and firmware upgrade processes require Ethernet communications.  It is
strongly recommended to use a direct connection between the PC and the relay using a Cross-Over RJ45 Ethernet
cable, instead a direct connection through a hub or switch.  In no one case upgrading will be done using a Local Area
Network (LAN).

Serial RS232 Communication -  Serial communication is necessary only to perform the bootware upgrade.

3. Relay IP Address - It must be assigned a IP address to the relay in the Ethernet parameters via HMI at PRODUCT
SETUP>COMMUNICATION>ETHERNET>ETHERNET1 menu or via Enervista 650 Setup at  SETPOINT>PRODUCT
SETUP>COMMUNICATION SETTINGS>NETWORK (Ethernet) 1 as shown in the Table 5–1:

Table 5–1:  ETHERNET PARAMETERS

4. PC IP Address - In the case the relay has been boot code previously upgraded (section 9.2), the IP address and other
parameters already assigned in the process will be:

IP Address:192.168.37.177

Netmask:255.255.255.0

Gateway:192.168.37.10

PRODUCT SETUP>COMMUNICATION SETTINGS >NETWORK (ETHERNET) 1

NAME VALUE UNITS RANGE

IP Address Oct1 192 [0 : 255]

IP Address Oct2 168 [0 : 255]

IP Address Oct3 37 [0 : 255]

IP Address Oct4 177 [0 : 255]

Netmask Oct1 255 [0 : 255]

Netmask Oct2 255 [0 : 255]

Netmask Oct3 255 [0 : 255]

Netmask Oct4 0 [0 : 255]

Gateway IP Oct1 192 [0 : 255]

Gateway IP Oct2 168 [0 : 255]

Gateway IP Oct3 37 [0 : 255]

Gateway IP Oct4 10 [0 : 255]
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Then the PC settings should be the same pattern as follows:

IP Address:192.168.37.xxx

Netmask:255.255.255.0

Gateway:192.168.37.10 (if desired)

Where XXX is a number between 0 and 255 that is not assigned to any other device to avoid collisions.

If there are not TCP/IP settings according to this pattern in the computer, it should be added (in order to communicate with
the relay) following these steps:

In the PC go to STARTUP>CONTROL PANEL>NETWORK CONNECTIONS option:

.

Figure 5–2: NETWORK MENU IN PC CONTROL PANEL

Choose NETWORK CONNECTION option and with Right mouse key select Properties.  Then in CONNECTION ITEMS
window, select Internet Protocol (TCP/IP) and click Properties button (see Figure 5–3:)
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Figure 5–3: INTERNET PROTOCOL

Figure 5–4: ACTUAL TCP/IP PROPERTIES

The new window open (Figure 5–4:) will show the actual PC IP address and other parameters.  Click Advanced button to
add or modify the actual address.
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The new window  (Figure 5–5:) will show all IP addresses configured in the PC.

Figure 5–5:  IP ADDRESS FOR COMPUTER 

In case no one the existing IP addresses and Subnet mask shown in Figure 5–5:  does not match the actual relay LAN
pattern, click the Add button.

The new window (Figure 5–6:) allows to add  a new address in the PC corresponding to the same relay LAN pattern.

Figure 5–6:  NEW IP AND SUBNET MASK ADDRESSES FOR PC 

Windows allows Multihosting, so it permits having as many IP addresses as desired.  It is necessary to turn OFF and ON
the computer to activate the new address that has been assigned to the PC.
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5. Other Network, Communications and Data Flow checks  

• According to the model number of the relay, to enable the 10/100 BASE TX-CABLE option in the relay communication
board, a specific jumper in this board must be changed. See detailed instructions in paragraph 3.4.3 of Instruction
Manual GEK-113000Z.

• IP address, netmask, gateway are correct and match the parameters used in the computer to perform the procedure.
See chapter 9.1.1 of Manual GEK-113000Z COMMUNICATION PARAMETERS.

• In the computer check that:

a)WIFI connection is disabled.  Check it at STARTUP>CONTROL PANEL>NETWORK CONNECTION>WIRELESS
NETWORK (it must be disabled).

b)·There is only one communication board.  Check it at STARTUP>CONTROL PANEL>NETWORK
CONNECTION>LOCAL NETWORK>Right mouse key>Properties.

c)·There is only one IP address.   Check it at STARTUP>CONTROL PANEL>NETWORK CONNECTION>LOCAL
NETWORK>Right mouse key>Properties>TCP/IP>Properties button>Advance Options button

d)·Ethernet board parameters selection. Check them at STARTUP>CONTROL PANEL>NETWORK
CONNECTION>LOCAL NETWORK>Right mouse key>Properties>Comm. Board Configure button>Advance
Options Tab

o 802.1p QOS is Enabled

o Flow control is Auto

o Speed & Duplex is Auto (or 10 Mb Full)
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5.2BOOTWARE UPGRADE

Boot code upgrade is performed using EnerVista 650 Setup. Please kindly use Enervista 650 Setup last version.  It is
required that there is no active communication between the program and the relay, and that no configuration file is open.

During the boot code upgrading process, all the data stored in the relay will be lost, so it is required to save all calibration,
settings, oscillography, etc. from the relay before the upgrade. It is extremely important to save the relay settings and
calibration before continuing with the process.

1. Window NT SP6, Windows 2000 SP4 and Windows XP SP2 must be used for installation and the reliable operation
of Enervista 650 Setup program and bootware/firmware relay upgrade.

2. To upgrade the boot code, it is required to connect an RS232 cable to the front of the relay, and an Ethernet cable to
the rear port (COM3).

3. If it is being used a USB-to-Serial RS232 Cable Converter, it must be a RS-232C standard compliant, powered by the
User computer's USB bus and with DB9 male connector. To ensure the correct state of communication between the
computer and the relay along the whole upgrading process, all other USB devices must be unplugged.  Due to the
extended variety of USB-to-Serial Cable Converters existing nowadays in the market, with different characteristics,
even different charge imposed to the USB bus of the PC, it is strongly recommended to use the GE USB-to-Serial
RS232 Cable Converter, part number 0100-0001.

4. When using USB-to-Serial RS232 cable it is necessary first to know the COM Port number the Laptop will use through
the USB device.  Depending in the actual F650 upgrade task under operation, the procedure is as follows:

4.1 Firmware upgrade: It is not necessary the use of serial cable

4.2 Bootware and firmware upgrade being the relay fully operative with the actual F/W version: The COM port number must be
determined by using the 650 Setup program.  With USB device disconnected from the Laptop and from the relay, start the 650 Setup
program.  At the  top menu bar choose COMMUNICATION>COMPUTER>COMMUNICATION PORT menu and check the allowable
serial ports displayed.Return to the main 650 Setup screen and connect the USB device to PC and select again at the top menu bar
COMMUNICATION>COMPUTER>COMMUNICATION PORT menu the allowable serial ports now displayed.  The new one port
number shown is the USB port number to be used  for the upgrade process.

4.3 Bootware and firmware upgrade being the relay blocked at startup (no preliminary communication PC-Relay allowable): Repeat
the process described in 4.2 above to know the COM PORT number and continue with upgrade process. 

5. Once known the COM PORT number, set it at  COMMUNICATION>COMPUTER menu and the BAUD RATE and
PARITY parameters as well.  Click Store key

6. Start Enervista F650 Setup program and  at the top menu bar choose "COMMUNICATION>UPGRADE OPERATING
SYSTEM".

Figure 5–7:  WARNING MESSAGE BEFORE BOOT CODE UPGRADE 

If calibration files were saved click Yes (Si), otherwise click No to cancel the upgrade process and save first the calibration
files according to manual section 4.1.11.
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Figure 5–8: WARNING MESSAGE TO SAVE SETTING AND CONFIGURE FILES

Parameters already set in step 5 will be operative during serial communications.

7. As mentioned in step 2 above if the connection is made directly from the PC to the relay it is necessary to use a 10/100
Base T crossover cable. During the upgrade, the system will show the following message indicating the procedure to
be followed.

Figure 5–9: ETHERNET AND SERIAL CONNECTIONS MESSAGE

If click Yes (Si), the next window will allow you to choose the Network adapter for your Ethernet connection to the relay.
Select the correct one in case you have more than one.
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Figure 5–10: NETWORK ADAPTER

After selecting the Network adapter, a window to choose a temporary IP address will be shown. It is advisable to set the
same IP address that is going to be used lately in the relay for Ethernet connection.

Figure 5–11: SETTING ADDRESS

8. After entering the temporary IP Address, the next new window will require the bootware file retrieved from
www.gedigitalenergy.com and previously stored someplace in the PC. 
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Figure 5–12:  BOOT CODE FILE SELECTION

9. Choose the bootware file and click Open button (Abrir).  The next screen will pop up:

:

Figure 5–13: LOADING BOOT CODE FILE

10. Then the program shows a message requiring switch OFF and ON the relay while the progress bar is in course, to start
the upgrading process.

Figure 5–14: RELAY SWITCH OFF-ON MESSAGE



GEK-113000Z F650 Digital Bay Controller 5-11

5 BOOTCODE AND FIRMWARE UPGRADE 5.2 BOOTWARE UPGRADE

5

11. It is important to switch the Relay OFF and ON again during the time shown by the progress bar; in case this time
expires, the program will offer the option to continue with the process or to postpone, verify the correct RS232
connections and try again later. Notice that the serial COM PORT used in the boot upgrade procedure is the one
selected in step 4 above.

Figure 5–15: LOADING UPDATE FILE ERROR MESSAGE 

12. If the relay gets stuck during the upgrading process after switching OFF and ON the relay, giving error message
shown, it is due to no serial communication via the front RS232 port. Please check serial cable and serial settings
connection. At this point the relay will not be upgraded.  

After switching it OFF and ON it will continue working with the former firmware and bootware versions.

13. After switching the relay OFF and ON, if the serial communication between EnerVista 650 Setup and the relay is
correct the program shows the following message (Figure 5–14:):

Figure 5–16: CONFIGURATION PROCESS IN PROGRESS 

Then it requires the confirmation to proceed to upgrade:
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Figure 5–17: UPDATE CONFIRM

14. If click “YES” ("Sí" in the figure) the process will start, beginning with the relay flash memory deletion, so at this point
all the information stored in the relay will be lost. Until now, no important change has been made to the relay, the boot
memory upgrading process has just been prepared. 

The process of flash memory erasing and boot code downloading can take some minutes, during which a progress bar
is displayed.

Figure 5–18: FLASH MEMORY ERASE PROGRESS BAR

15. If the process is successful, continue with step 16 hereafter.  If not and the relay gets stuck during at "Sending file
imagen_kernel…" (Figure 5–20:) 

Figure 5–19: DOWNLOAD PROCESS ADVISORY
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It may be due there is no communication via Ethernet port. At this moment, serial communications works properly, the relay
flash memory has been erased and the upgrade procedure must be completed to start working with the unit. If the
procedure is not completed, the HMI will show the message "Os Loading..." and the relay will not start up. 

Then please check statements of point 4 above

If all the above points are correct but the problem persists: 

-Disable and Enable the Ethernet connection while the files are being sent (during the "Sending file..." message -
Figure 5–19:).  To do this, go to STARTUP>CONTROL PANEL>NETWORK CONNECTION>LOCAL
NETWORK>Right mouse key>Disable.  Now the Local Network status Icon will be shown as  Disabled.  In the same
screen with Right mouse key over LOCAL NETWORK click Enable and wait until Enabled status is shown.

16. Once the memory has been erased and the files upgraded in the relay, the parameters for the Ethernet
communications must be set. The requested values are the IP address and the gateway. 

Figure 5–20: IP ADDRESS SETPOINT WINDOW

These values should match the LAN structure where the relay will be connected.

  The relay IP address should have the first three octets corresponding with the gateway and the last octet must be a
free IP address reserved to the relay to avoid possible collisions with other devices.

  The  gateway must be the one used in the LAN structure connecting the relay

17. After assigned the Ethernet parameters, the upgrade of the boot code will be completed successfully (Figure 5–21:).

18. New momentarily window will display: "Setting Default IP address", and then it follows with:

Figure 5–21: BOOTWARE UPGRADE SUCCESSFUL PROCESS

After boot code upgrade, the equipment firmware must also be upgraded (hereafter).
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5.3FIRMWARE VERSION UPGRADE 

5.3.1 INTRODUCTION

1. The relay settings and configuration will be lost, so it is advisable to save them to a file. 

2. For firmware revisions lower than 1.50, it is required to save calibration settings in a file before upgrading the F650 to a
new firmware version. 

3. For firmware revision higher than 1.50 and only if just firmware upgrading (not bootware upgrade), it is not necessary
to save the calibration files since they will not be modified.

4. Special care when boot code has been previously upgraded: all the data (including calibration settings) is lost.

5. In case of error during the firmware upgrading process, the user could repeat the whole process as many times as
necessary, this is possible thanks to an independent boot memory (bootcode).

6. Pure firmware upgrading process should be done using the EnerVista 650 Setup software and Ethernet connection
(COM3) via Cross-Over RJ45 Ethernet cable.

5.3.2 FIRMWARE UPGRADE

1. Once the communication with the relay through Ethernet connection has been verified, enter the EnerVista 650 Setup
program, select Communication and the Upgrade Firmware Version option on the top menu bar.

At this point, proceeding with the upgrade will erase all the data stored in the equipment, including the calibration
settings in firmware version previous to 1.50. Therefore, it is necessary to save all settings to a file before following
with the process (Figure 5–22:).

Figure 5–22: FIRMWARE UPGRADE STARTUP

If click Yes (Si) to proceed a window will open up to upgrade parameters. 
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• In firmware version previous to 1.70 the Enervista 650 Setup program requires the IP address of the relay under
upgraded and its serial number. 

• In versions 1.70 and higher it is also necessary to enter the ordering code for the relay. See Figure 5–23:

Figure 5–23: RELAY SERIAL NUMBER

2. If  the relay under is not a enhanced model or control functionality then click the Upgrade Firmware button to continue
the process (Figure 5–24:)  Then the process will continue as per step 9.3.2.4 forward.
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Figure 5–24: FIRMWARE UPGRADE ACCEPTANCE WINDOW

Figure 5–25: ADVISORY FOR LOCAL NETWORK REBOOT



GEK-113000Z F650 Digital Bay Controller 5-17

5 BOOTCODE AND FIRMWARE UPGRADE 5.3 FIRMWARE VERSION UPGRADE

5

3. If when click on Upgrade Firmware button (Figure 5–24:)  an advise message is given (Figure 5–25:), local network
reboot is necessary.  Then please proceed as follows:

-Go to STARTUP>CONTROL PANEL>NETWORK CONNECTION>LOCAL NETWORK> Right mouse
key>Disable.  Now the Local Network status will be shown as  Disabled.In the same screen with Right mouse key
over LOCAL NETWORK click Enable and wait until Enabled status is shown.  Then press Upgrade Firmware button
to continue the process (Figure 5–24:).

4. When upgrading models with Enhanced protection or control functionality (see model selection), the program will
request a password to continue (Figure 5–26:)

Figure 5–26: PASSWORD REQUIREMENT (SPECIAL MODELS)

In case special functionality model with password requirement please contact GE Multilin.

The following parameters must be clearly indicated in the order:

•  Unit serial number

•  Current model option (before memory upgrade)

•  Desired model option (after memory upgrade)

•  Unit MAC address (available in the identification label)

5. Once the upgrade parameters have been entered, press the “Upgrade Firmware” button. When communication has
been established, the program will show a message requesting to turn OFF and back ON the relay to continue with the
upgrade process.(Figure 5–30:)
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Figure 5–27: RELAY REBOOT STEP

6. Once the relay has been turned off and on, a new screen (Figure 5–30:) will require the firmware upgrade files
(“upgrade.txt”). Wherever from this Upgrade.txt file would be obtained (www.gedigitalenergy.com or from TS Dept. at
any GE Multilin facility), then it must be saved in some directory in the root drive or in the desktop of teh PC. 

Figure 5–28: FIRMWARE FILE ACCEPTANCE

If the files are downloaded from the web, they are compressed in a zip file. Proceed to extract all files and save them in the
directory just created.
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Selection of Upgrade.txt is shown in Figure 5–30:. Select the desired "Upgrade.txt" file and click Open (Abrir) button. 

Figure 5–29: FIRMWARE FILE SELECTION

7. Now a voltage range selection window will appear (Figure 5–30:). This voltage range is closely related to the serial
number of the relay. The EnerVista 650 Setup program automatically pre-selects the appropriate voltage range for the
unit based on the serial number, showing the selection with a step line square over the proper option. Click OK button.

Do not use the other option (option not square signaled) since it is dedicated to other lower firmware versions.

Figure 5–30: AC VOLTAGE RANGE SELECTION
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Once OK button has been pressed a confirmation window will pop-up as shown in Figure 5–31: 

Figure 5–31: UPGRADE INITIALIZATION

8. Press Yes (Si) button.

9. Now the new window will show the Upgrade Firmware button ready to be enabled (Figure 5–32:). Press it to start
upgrade.
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Figure 5–32: UPGRADE INITIATION

During the process, the program displays the files that are being upgraded. 
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Figure 5–33: FIRMWARE FILE SELECTION

10. When the files transfer is finished, a message appears informing that it is necessary to wait sometime before resetting
the unit, in order to start working with the new firmware version in the relay (Figure 5–33:). 

11. When the whole process has finished a message will be displayed asking to switch the F650 on and off (Figure 5–34:).

Figure 5–34: FIRMWARE FILE SELECTION
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12. Click Ok (Aceptar). At this point, the firmware upgrade procedure is finished and the relay is ready to be powered OFF
and ON to check that the firmware has been upgraded properly. 

13. User settings and logic files downloading

When upgrading the firmware the entire settings and relay configuration are reset to factory default values. Then
the User is committed to download the settings, configuration and logic files to the relay in order to get it fully
operative. 

Calibration settings and configuration must be loaded to the relay the relay was bootware upgraded also.  If not calibration
files were maintained during the firmware upgrading process.

To recover and download the different files to the relay go to Enervista 650 Setup and at the top menu bar choose:

• COMMUNCATION>CALIBRATION>SET CALIBRATION FILES: to restore in the relay the calibration settings if
necessary.

• FILE>CONFIG FILE (*.650) Converter: to convert the setting and configuration file *.650 for the relay (if it was in a
previous version format).

• FILE>SEND INFO TO RELAY: to send the new settings and configuration file to the unit.
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5.4SUMMARY OF MAIN STEPS

5.4.1 BOOT CODE UPGRADE (*)

1. INSTALL THE PROPER VERSION OF THE ENERVISTA 650 SETUP PROGRAM.

2. CONNECT ONE RS-232CABLE IN THE FRONT PORT OF THE RELAY AND ONE ETHERNET CABLE AT THE
REAR ETHERNET PORT (CROSSOVER CABLE FOR BACK-TO-BACK CONNECTION AND STRAIGHT-THROUGH
ETHERNET CABLE FOR HUB OR SWITCH) .

3. GET CALIBRATION SETTINGS (AND SAVE IT TO A FILE).

4. SAVE ALL THE DATA FROM THE RELAY (SETTINGS, OSCILLOGRAPHY, EVENTS).

5. FROM THE ENERVISTA 650 SETUP PROGRAM SELECT "Communication > Upgrade Boot Code".

6. FOLLOW THE INDICATIONS OF THE PROGRAM AND SELECT THE BOOT PROGRAM BIN FILE.

7. WHEN REQUIRED BY THE PROGRAM SWITCH OFF AND BACK ON THE RELAY.

8. CONTINUE WITH THE PROCESS AND SET THE IP ADDRESS AND GATEWAY WHEN REQUIRED.

5.4.2 FIRMWARE UPGRADE (*)

1. INSTALL THE PROPER VERSION OF THE ENERVISTA 650 SETUP PROGRAM.

2. CONNECT ONE ETHERNET CABLE AT THE REAR ETHERNET PORT (CROSSOVER CABLE FOR BACK-TO-
BACK CONNECTION AND STRAIGHT-THROUGH ETHERNET CABLE FOR HUB OR SWITCH).

3. SET THE APPROPRIATE IP ADDRESS IN THE RELAY.

4. SET THE APPROPRIATE IP ADDRESS IN THE PC.

5. FROM THE ENERVISTA 650 SETUP PROGRAM SELECT “Communications > Upgrade Firmware Version”.

6. ENTER THE IP ADDRESS, SERIAL NUMBER AND ORDERING CODE OF THE RELAY TO UPGRADE.

7. WHEN REQUIRED BY THE PROGRAM SWITCH OFF AND BACK ON THE RELAY.

8. LOCATE THE UPGRADE.TXT FILE ACCORDING TO THE MODEL OF THE RELAY.

9. PRESS UPGRADE FIRMWARE AND INITIATE THE UPGRADE PROCESS.

10. TO COMPLETE THE PROCEDURE, SWITCH OFF AND BACK ON THE RELAY WHEN REQUIRED BY THE
PROGRAM.

11. SET CALIBRATION SETTINGS (FROM THE PC TO THE RELAY) (for versions lower than 1.50).

12. THE SETTINGS AND CONFIGURATION ARE NOW SET TO FACTORY DEFAULT.

13. SEND THE NEW SETTINGS AND CONFIGURATION FILES TO THE RELAY IF NECESSARY.

 (*) The boot code upgrade must be performed using a crossed copper cable (RJ45) connected to the PC. It is not
necessary to modify the internal fiber/cable switch, as the upgrade is carried out at 10 Mb/s, and thus there is not cable/
fiber conflict.This fact does not apply to the firmware upgrade, which can be performed either with the Ethernet fiber
connection, or with the cable connection.

Note: Please see chapter 8 F650TROUBLESHOOTING GUIDE if there is any problem during the upgrading
process.
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6 COMMISSIONING 6.1VISUAL INSPECTION

Verify that the relay has not suffered any damage during transportation, and that all screws are correctly fixed, and all relay
terminal boards are in good condition.

Verify that the information shown on the relay front plate corresponds to the data shown on the display, and to the
requested relay model.

Display information:

Firmware version 

Kernel version F650 X.XX(K.KK) 
GENERAL ELECTRIC 
F650XXXXXXXXX
19200N81 MODBUS:254

Model
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6.2OUT OF SERVICE SETTING

The unit has the Relay Out Of Service setting only configured at the general settings element. The unit has also an Out
Of service Status that it is only configured at Relay configuration  > Protection elements tab. These states act stopping
all the changes on PLC equations and functions, even stopping all the changes in the input/output boards, so if there is a
change in any of the input or output the unit will not show this change until the unit has been set again in ready mode. For
example if an output is closed and the unit goes to out of service state, the output will be kept closed even though the state,
that makes it to close, change to open the output. When the unit goes out of the out of service state the output will be
opened if it was a change.

When the Out of Service status goes to ON, or the setting has been changed to Enabled, the ready led will also change to
red color. Be careful if ready led is linked to an output, because the output will not change its state. To set outputs to ready
state see factory default Logic & Configuration in the detailed manual. Take notice that, in the default configuration, the
general setting out of service is set to enable so it is necessary to change to disabled to start working with the unit

The following figure shows the flow chart of these states
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6.3GENERAL CONSIDERATIONS ON THE POWER SUPPLY NETWORK

All devices running on AC current are affected by frequency. As a non-sine wave is the result of a fundamental wave plus a
series of harmonics from this fundamental wave, we can infer that devices running on AC current are influenced by the
applied waveform.

For a correct testing of relays running on AC current, it is fundamental to use a current and/or voltage senoidal waveform.
The pureness of a senoidal wave (lack of harmonics) cannot be expressed specifically for a specific relay. However, any
relay incorporating sintonized circuits, R-L and R-C circuits, will be affected by non-senoidal waveforms, as in the case of
F650. 

These relays respond to the voltage waveform in a different way to the majority of AC current voltmeters. If the power
supply network used for the testing contains wide harmonics, the voltmeter and relay responses will be different.

Relays have been calibrated in factory using a Network of 50 or 60 Hz with a minimum harmonic content. When the relay is
tested, a power supply network with no harmonics in its waveform must be used.

The ammeters and chronometers used for testing the pickup current and relay operation time must be calibrated and their
accuracy must be better than the relay’s. The power supply used in the tests must remain stable, mainly in the levels near
the operation thresholds.

It is important to point out that the accuracy with which the test is performed depends on the network and on the
instruments used. Functional tests performed with unsuitable power supply network and instruments are useful to check
that the relay operates properly and therefore its operating characteristics are verified in an approximate manner. However,
if the relay would be calibrated in these conditions, its operational characteristics would be outside the tolerance range
values.

The following sections detail the list of tests for verifying the complete relay functionality.
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6.4ISOLATION TESTS

During all tests, the screw located on the rear of the relay must be grounded.

For verifying isolation, independent groups will be created, and voltage will be applied as follows: 

2200 RMS volts will be applied progressively among all terminals in a group, short-circuited between them and the
case, during one second.

2200 RMS volts will be applied progressively between groups, during one second.

WARNING: No communication circuit shall be tested for isolation.

Groups to be created will depend on the type of modules included in F650, selectable according to the model.

The following table shows the different groups depending on the module type:

SOURCE 1:
G1: H10, H18

G2: H13, H14, H15

SOURCE 2:
G1: H1, H9

G2: H4, H5, H6

MAGNETIC MODULE.
G1: A5..A12

G2: B1..B12

I/O F1 (MIXED)

G1 (Inp. 1): F1..9

G2 (Inp. 2): F10..18

G3 (Out.): F19..36

I/O F2 (SUPERVISION)

G1 (Spv 1): F1..4

G2 (Inp. 1): F5..9

G3 (Inp. 2): F10..14

G4 (Spv 2): F15..18

G5 (Out.): F19..30

G6 (Out.): F31.36

I/O G1 (MIXED)

G1 (Inp. 1): G1..9

G2 (Inp. 2): G10..18

G3 (Out.): G19..36

I/O G4 (32DI)

G1 (Inp. 1): G1..9

G2 (Inp. 2): G10..18

G3 (Inp. 3): G19..28

G4 (Inp. 3): G29..36

I/O G5 (ANALOG)
G1 (Inp. 1): G1..9

G2 (Inp. 2): G10..18
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6.5INDICATORS

Feed the relay and verify that when commanding a LED reset operation, all LED indicators light up and they are turned off
when pressing the ESC key for more than 3 seconds.
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6.6POWER SUPPLY TESTING

Feed the relay with the minimum and maximum voltage. For each voltage value, verify that the alarm relay is activated
when there is voltage, and it is deactivated when there is no feed. If the power supply source incorporates AC feed, this test
will be performed also for VAC.

If the relay incorporates a redundant power supply, these tests shall be performed on both power supplies.

Voltage values to be applied will be the ones indicated below according to the relay model:

NOTE: Codes HIR and LOR correspond to a redundant power supply

SUPPLY V MIN. V MAX.

HI/HIR
110-250 Vdc
120-230 Vac

88 Vdc
96 Vac

300 Vdc
250 Vac

LO/LOR
24-48 Vdc 20 Vdc 57.6 Vdc
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6.7COMMUNICATIONS

Verify that available communication ports allow communication with the relay.

Ports to be checked are as follows:

Front:RS232 

Rear:2 x RS485, 2 x Fiber Optic - Serial, 2 x Fiber Optic - Ethernet, 1 x RJ45 - Ethernet  .

A computer with EnerVista 650 Setup software and an appropriate connector must be used.
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6.8VERIFICATION OF MEASUREMENT    

Set the relay as follows

NOTE:

ALL ANGLES INDICATED ARE LAGGING ANGLES 

ALL VALUES OBTAINED IN THIS TEST MUST BE THE ONES CORRESPONDING TO THE PHASOR ONES

6.8.1 VOLTAGES

Apply the following voltage and frequency values to the relay:

Verify that the relay measures the values with an error of ±1 % of the applied value from 10V to 208V.

6.8.2 PHASE CURRENTS

Apply the following current and frequency values to the relay:

Verify that the relay measures the values with an error lower than ±0.5% of the test value or ± 10 mA, whichever is greater,
for phases and ground.

Verify that the relay measures the values with an error lower than ±1.5% of the test value or ± 1 mA, whichever is greater,
for sensitive ground (SG).

GENERAL SETTINGS

NAME VALUE UNITS RANGE

PHASE CT RATIO 1.0 0.1 1.0-6000.0

GROUND CT RATIO 1.0 0.1 1.0-6000.0

STV GROUND CT RATIO 1.0 0.1 1.0-6000.0

PHASE VT RATIO 1.0 0.1 1.0-6000.0

PHASE VT CONNECTION WYE N/A WYE – DELTA

NOMINAL VOLTAGE 100 V 0.1 1-2250 V

NOMINAL FREQUENCY 50 Hz 1 Hz 50-60 Hz

PHASE ROTATION ABC N/A ABC – ACB

FREQUENCY REFERENCE VI N/A VI-VII-VIII

AUXILIARY VOLTAGE VX N/A VX – VN

CHANNEL ANGLE FREQUENCY

50 Hz 60 Hz 50 Hz 60 Hz 50 Hz 60 Hz

VI 0º 0 5 50 100 150 200

VII 120º 0 5 50 100 150 200

VIII 240º 0 5 50 100 150 200

VX 0º 0 5 50 100 150 200

CHANNEL ANGLE FREQUENCY

50 Hz 60 Hz 50 Hz 60 Hz 50 Hz 60 Hz

Ia (A) 45º 0 15 10 5 1 0.1

Ib (A) 165º 0 15 10 5 1 0.1

Ic (A) 285º 0 15 10 5 1 0.1

IG (A) 0º 0 15 10 5 1 0.1

ISG (A) 0º 0 5 1 0.1 0.01 0.005
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Percent of Load-to-Trip

The relevant actual values displays are shown below:

ACUAL -> METERING -> PRIMARY VALUES -> CURRENT -> % OF LOAD-TO-TRIP

Note Percent of load-to-trip is calculated from the phase with the highest current reading. It is

the ratio of this current to the lowest pickup setting among the phase time and instantaneous overcurrent protection
features. If all of these features are disabled, the

value displayed will be “0”.

- Inject current of various values into Phase A.

- Verify that percent load-to-trip is calculated as the correct

percentage of the most sensitive operational Phase Overcurrent

element and displayed.

- Repeat for phases B and C.

6.8.3 ACTIVE, REACTIVE POWER, AND COSϑ METERING

Equations to be applied for powers in a wye connection are as follows:

Apply the following current and voltage values:

With the indicated voltage and current values, verify that the power measure corresponds to expected values indicated in
the following table:

Maximum admissible error is ± 1% of the test value for P and Q, and 0.02 for cosϕ.

6.8.4 FREQUENCY

Frequency measure on channel VII (terminals A7-A8):

Apply 50 Vac at 50 Hz on channel VII. Maximum admissible error:± 10 mHz.

Apply 50 Vac at 60 Hz on channel VII. Maximum admissible error: ± 12 mHz.

Frequency measure on channel Vx (terminals A11-A12):

POWER PER PHASE THREE-PHASE POWER

P=V*I*Cosϕ P=Pa+Pb+Pc

Q=V*I*Senϕ Q=Qa+Qb+Qc

APPLIED VOLTAGE AND CURRENT VALUES PER PHASE

PHASE A PHASE B PHASE C V-I ANGLES

VI = 50 V, 0º VII = 50 V , 120º VIII = 50V, 240º ϕ=45º

Ia = 10∠45º Ib= 10∠165º Ic = 10∠285º Cosϕ= 0.707

EXPECTED POWER VALUES

PHASE A PHASE B PHASE C THREE-PHASE

Pa = 353.55 MW Pb = 353.55 MW Pc = 353.55 MW P = 1060.66 MW

Qa = 353.55 MVAr Qb = 353.55 MVAr Qc = 353.55 MVAr Q = 1060.66 MVAr
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Apply 50 Vac at 50 Hz on channel Vx. Maximum admissible error:± 10 mHz.

Apply 50 Vac at 60 Hz on channel Vx. Maximum admissible error: ± 12 mHz.

Results:

CHANNEL VOLTAGE (V) SET FREQUENCY (HZ) MEASURED FREQUENCY (HZ)

VII 50 50 Hz

60 Hz

VX 50 50 Hz

60 Hz
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6.9INPUTS AND OUTPUTS

During all tests, the screw on the rear of the relay must be grounded.

6.9.1 DIGITAL INPUTS

During this test, the user will determine the activation/deactivation points for every input in the relay for the set voltage value
of 30 Volts.

Verify that the error does not exceed ± 10% (+10% on activation, -10% on deactivation).

Default board settings for the input test can be modified in EnerVista 650 Setup software in:

Setpoint>Inputs/Outputs>Contact I/O>Board X

X, will be substituted by the corresponding board:

F for board in first slot

G for board in second slot

H for board in first slot of CIO module

J for board in second slot of CIO module

Test settings for mixed board (type 1:16 inputs and 8 outputs):

The inputs test is completed by groups of 8 inputs, as this type of board has 2 groups of 8 inputs with the same common.
For the first 8 inputs, the voltage threshold setting is determined by Voltage Threshold A. For the next 8 inputs, the setting
is Voltage Threshold B. Inputs (or contact converters, CC1 – CC16) must also be set to POSITIVE.

Test settings for mixed board (type 2: 8 digital inputs, 4 blocks for supervision and 8 outputs):

The inputs test is completed by groups of 4 inputs, as this type of board has 2 groups of 4 inputs with the same common.
For the first 4 inputs, the voltage threshold setting is determined by Voltage Threshold A. For the next 4 inputs, the setting
is Voltage Threshold B. Inputs (or contact converters, CC1 – CC8) must also be set to POSITIVE.

If the relay incorporates more input modules, these tests must also be applied to them.

I/O BOARD TYPE 1 (MIXED)

Voltage Threshold A_X 30 V

Voltage Threshold B_X 40 V

Debounce Time A_X 5 ms

Debounce Time B_X 5 ms

Input Type_X_CC1 (CC1) POSITIVE

... ...

Input Type_X_CC16 (CC16) POSITIVE

I/O BOARD TYPE 2 (SUPERVISION)

Voltage Threshold A_X 30 V

Voltage Threshold B_X 40 V

Debounce Time A_X 5 ms

Debounce Time B_X 5 ms

Input Type_X_CC1 (CC1) POSITIVE

... ...

Input Type_X_CC8 (CC8) POSITIVE
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6.9.2 CONTACT OUTPUTS

The correct activation of every output will be verified.

For every output, activation command of a single contact must be given, and then verify that only that contact is activated.
Go to EnerVista 650 Setup Software (Setpoint>Inputs/Outputs>Force Outputs).

For switched contacts, the change of state of both contacts shall be verified.

6.9.3 CIRCUIT CONTINUITY SUPERVISION INPUTS

Supervision inputs will be tested as normal inputs, revising the voltage level that will be 19 Volts.

Coil 1:

Apply 19 Vdc to both 52/a (terminals F1-F2) and 52/b (terminals F3-F4)”Coil 1” circuit supervision inputs and verify that
they are activated.

Apply -19 Vdc to both 52/a (terminals F1-F2) and 52/b (terminals F3-F4)”Coil 1” circuit supervision inputs and verify
that they are activated.

Remove voltage from both inputs and verify that it takes them 500 ms to change state (deactivate).

Coil 2:

Apply 19 Vdc to both 52/a (terminals F15-F16) and 52/b (terminals F17-F18)”Coil 2” circuit supervision inputs and
verify that they are activated.

Apply -19 Vdc to both 52/a (terminals F15-F16) and 52/b (terminals F17-F18)”Coil 2”  circuit supervision inputs and
verify that they are activated.

Remove voltage from both inputs and verify that it takes them 500 ms to change state (deactivate).

6.9.4 LATCHING CIRCUITS

Send a closing command to the latched contact (F31-F33).

Make circulate a current of 500 mA through the contact in series with the sensing terminal.

Send an opening command and verify that the contact does not open.

Interrupt current and check that the contact is released.

Repeat the test for the other latched contact (F34-F36).

I

500
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6.10CONNECTIONS FOR TESTING PROTECTION ELEMENTS

Connect current sources to the relay according to the wiring diagram. Current and voltage input terminals are as follows:

PHASE CONNECTIONS

Current

IA B1-B2

IB B3-B4

IC B5-B6

IG B9-B10

ISG B11-B12

Voltage

VI A5-A6

VII A7-A8

VIII A9-A10

VX A11-A12
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6.11INSTANTANEOUS OVERCURRENT (50PH, 50PL, 50N, 50G Y 50SG)

Set the relay to trip for the protection element being tested. Configure any of the outputs to be enabled only by the
protection element being tested.

Apply 0.9 times the Pickup current and check that the relay does not trip.

Gradually increase the current value and verify that the relay operates between 1 and 1.1 times the set pickup current. The
relay must trip by instantaneous in a time frame of 10 to 55 ms. All the relay trip contacts must operate, as well as the
contact set as 50.

Remove current and apply it again suddenly to a value of 4 times the pickup current. The relay should trip instantaneously
in a time frame of 10 to 45 ms.

Test one point for each phase and group of the protection element.

Note (*): Only available for Enhanced models

50 ELEMENTS TEST PARAMETERS

Element Settings (50PH, 50PL, 50G y 50SG)

Setting Value Units

Function Enabled

Input RMS NA

Pickup Level 3 A

Delay time 0 Seconds

Test Execution

Configure one output for 50 Trip

Apply times I pickup Element Trip Tripping times (ms)

0.9 x Pickup NO NA

1.1 x Pickup YES 10-55

4 x Pickup YES 10-45

Elements Phase Group

50PH and 50PL IA 0

IB 0

IC 0

50G IG 0

50SG (*) ISG 0
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6.12 TIME OVERCURRENT (51PH, 51PL, 51N, 51G AND 46)

Set the relay to trip for the protection element being tested. Configure any of the outputs to be activated only by the
protection element being tested.

Apply 0.9 times the Pickup current and check that the relay does not trip.

Apply 1.5 times the Pickup current. The relay should trip according to the time corresponding to its set curve.

Apply 5 times the Pickup current. The relay should trip according to the time corresponding to its set curve.

PROTECTION ELEMENT SETTINGS (51PH, 51PL, 51N, 51G AND 46)

SETTING VALUE UNIT

FUNCTION ENABLED

INPUT PHASOR (DFT)

PICKUP LEVEL 1 A

CURVE MODIFY FOR EACH TEST

TD MULTIPLIER MODIFY FOR EACH TEST

VOLTAGE RESTRAINT DISABLED

ELEMENT PHASE CURVE TYPE DIAL TIMES 
IPICKUP

TRIPPING TIMES (SEC)

EXPECTED ADMISSIBLE

51PH IA IEEE Ext Inv 0.5 0.9 NA

1.5 11.34 [11.00 – 11.90]

5 0.648 [0.600 – 0.710]

IB IEC Curve A 0.05 0.9 NA

1.5 0.860 [0.750 – 0.950]

5 0.214 [0.200 – 0.300]

51PL IC IEEE Ext Inv 0.5 0.9 NA

1.5 11.34 [11.00 – 11.60]

5 0.648 [0.600 – 0.710]

IB IEC Curve A 0.05 0.9 NA

1.5 0.860 [0.750 – 0.950]

5 0.214 [0.200 – 0.300]

51N IC IEEE Ext Inv 0.5 0.9 NA

1.5 11.34 [11.00 – 11.60]

5 0.648 [0.600 – 0.710]

51G IG Definite Time 2 0.9 NA

5 2.000 [1.900 – 2.100]

46 I2 IEC Curve A 0.05 0.9 NA

1.5 0.860 [0.750 – 0.950]

5 0.214 [0.200 – 0.300]
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6.13DIRECTIONAL ELEMENTS (67P, 67N, 67G, 67SG)

In order to test directional units in the relay, instantaneous trips will be commanded.

Two points will be tested, per phase, test element.

In order to test the directional units, configure (in the "Setpoint > Relay Configuration > Protection Elements" screen of
the EnerVista 650 Setup program), some overcurrent element to be supervised by a directional unit. This way, if the
directional element is enabled and detects the fault in the block direction, then the overcurrent unit will not operate. If the
directional element is not enabled or if it is enabled and it detects a fault in a trip direction, then the overcurrent unit will
operate if the set current level is exceeded.

6.13.1 67P ELEMENT

Activate only protection elements 50PH and 67P and set the relay as follows:

Configure one of the outputs to be activated only by unit 50PH.

Apply the following tests:

6.13.2 67N ELEMENT

Activate only protection elements 50N and 67N and set the relay as follows:

Configure one of the outputs to be activated only by unit 50G.

67P SETTINGS 50PH SETTINGS

Function ENABLED Function ENABLED

MTA 45 Deg Input PHASOR (DFT)

Direction FORWARD Pickup Level 0.50 A

Block Logic PERMISSION Trip Delay 0.30

Pol V Threshold 30 V Reset Delay 0.00

ELEMENTS PHASE UNDER TEST POLARIZATION PHASE ELEMENT TRIP

CHANNEL MAGNITUDE CHANNEL MAGNITUDE

MOD ARG MOD ARG

50PH/67P IA 2 A 0º VIII 60 V 0º NO

60 V 180º YES

IB 2 A 0º VI 60 V 0º NO

60 V 180º YES

IC 2 A 0º VII 60 V 0º NO

60 V 180º YES

67N SETTINGS 50N SETTINGS

Function ENABLED Function ENABLED

MTA -45 Deg Input PHASOR (DFT)

Direction FORWARD Pickup Level 0.50 A

Polarization VO Trip Delay 0.30

Block Logic PERMISSION Reset Delay 0.00

Pol V Threshold 10 V
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Apply the following tests:

ELEMENTS PHASE UNDER TEST POLARIZATION PHASE ELEMENT TRIP

CHANNEL MAGNITUDE CHANNEL MAGNITUDE

MOD ARG MOD ARG

50N/67N IA 2 A 0º VI 60 V 0º NO

60 V 180º YES

IB 0 A 0º VII 0 V 0º

IC 0 A 0º VIII 0 V 0º
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6.13.3 67G ELEMENT

Activate only protection elements 50G and 67G and set the relay as follows:

Configure one of the outputs to be activated only by unit 50G.

Apply the following tests:

67G SETTINGS 50G SETTINGS

Function ENABLED Function ENABLED

MTA -45 Deg Input PHASOR (DFT)

Direction FORWARD Pickup Level 0.50 A

Polarization VO Trip Delay 0.30

Block Logic PERMISSION Reset Delay 0.00

Pol V Threshold 10 V

ELEMENTS PHASE UNDER TEST POLARIZATION PHASE ELEMENT TRIP

CHANNE
L

MAGNITUDE CHANNEL MAGNITUDE

MOD ARG MOD ARG

50G/67G IG 2 A 0º VI 60V 0º NO

60V 180º YES

VII 0º

VIII 0º
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6.13.4 67SG ELEMENT

Activate only protection elements 50SG and 67SG and set the relay as follows:

Configure one of the outputs to be activated only by unit 50SG.

Apply the following tests:

67SG SETTINGS 50SG SETTINGS

Function ENABLED Function ENABLED

MTA -45 Deg Input PHASOR (DFT)

Direction FORWARD Pickup Level 0.50 A

Polarization VO Trip Delay 0.30

Block Logic PERMISSION Reset Delay 0.00

Pol V Threshold 10 V

ELEMENTS PHASE UNDER TEST POLARIZATION PHASE ELEMENT TRIP

CHANNEL MAGNITUDE CHANNEL MAGNITUDE

MOD ARG MOD ARG

50SG/67SG ISG 2 A 0º VI 60 V 0º NO

60 V 180º YES

VII 0 V 0º

VIII 0 V 0º
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6.14UNDERVOLTAGE ELEMENTS (27P, 27X) 6.14.1 27P ELEMENT

Set the relay to trip for the protection element being tested. Configure any of the outputs to be activated only by the
protection element being tested.

Set the relay as follows:

Apply voltage as indicated on the table over the undervoltage setting level and verify that the relay does not trip.

Decrease voltage level gradually and verify that the relay trips for the set voltage (with an admissible error of 5%).

6.14.2 27X ELEMENT

Set the relay to trip for the protection element being tested. Configure any of the outputs to be activated only by the
protection element being tested.

Set the relay as follows

Apply voltage as indicated on the table over the undervoltage setting level and verify that the relay does not trip.

Decrease voltage level gradually and verify that the relay trips for the set voltage (with an admissible error of 5%).

PHASE UV (27P)

Function ENABLED

Mode PHASE-GROUND

Pickup Level 50 V

Curve DEFINITE TIME

Delay 2.00 sec

Minimum Voltage 30 V

Logic ANY PHASE

Supervised by 52 DISABLED

ELEMENT PHASE CURVE PICKUP 
LEVEL

DELAY APPLIED 
VOLTAGE

TRIPPING TIMES (S)

EXPECTED ADMISSIBLE

27P VI DEFINITE 
TIME

50 V 2 55 V NO TRIP NA

45 V 2.000 sec [2.000 – 2.100]

GENERAL SETTINGS

Auxiliary Voltage VX

AUXILIARY UV (27X)

Function ENABLED

Pickup Level 50 V

Curve DEFINITE TIME

Delay 2.00 sec

ELEMENT INPUT CURVE PICKUP 
LEVEL

DELAY APPLIED 
VOLTAGE

TRIPPING TIME (S)

EXPECTED ADMISSIBLE

27X VX DEFINITE 
TIME

50 V 2 55 V NO TRIP NA

45 V 2.000 sec [2.000 – 2.100]
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6.15OVERVOLTAGE ELEMENTS (59P, 59X, 59NH, 59NL, 47) 6.15.1 59P ELEMENT

Set the relay to trip for the protection element being tested. Configure any of the outputs to be activated only by the
protection element being tested.

Set the relay as follows:

Apply voltage as indicated on the table under the overvoltage setting level and verify that the relay does not trip.

Verify that the relay trips for the set voltage (with an admissible error of 5%).

6.15.2 59X ELEMENT

Set the relay as follows:

Apply voltage as indicated on the table under the overvoltage setting level and verify that the relay does not trip.

Verify that the relay trips for the set voltage (with an admissible error of 5%).

PHSE OV (59P)

Function ENABLED

Pickup Level 120 V

Trip Delay 2.00

Reset Delay 0.00

Logic ANY PHASE

ELEMENT PHASE PICKUP LEVEL 
(VOLTS)

TRIP DELAY
(SECONDS)

APPLIED 
VOLTAGE (V)

TRIPPING TIME (S)

EXPECTED ADMISSIBLE

59P VII 120 2 114 NO TRIP NA

132 2 [1.9–2.1 ]

132 2 [1.9 – 2.1]

GENERAL SETTINGS

Auxiliary Voltage VX

AUXILIARY OV (59P)

Function ENABLED

Pickup Level 120 V

Trip Delay 2.00

Reset Delay 0.00

Logic ANY PHASE

ELEMENT INPUT PICKUP LEVEL 
(VOLTS)

TRIP DELAY
(SECONDS)

APPLIED 
VOLTAGE (V)

TRIPPING TIME (S)

EXPECTED ADMISSIBLE

59X VX 120 2 114 NO TRIP NA

132 2 [1.9–2.1]

132 2 [1.9 – 2.1]
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6.15.3 59NH AND 59NL ELEMENTS

Set the relay as follows

Apply voltage as indicated on the table under the overvoltage setting level and verify that the relay does not trip.

Verify that the relay trips for the set voltage (with an admissible error of 5%).

This element can also be tested by applying only phase voltages. For this purpose, it is necessary to set Auxiliary Voltage =
VX. In this condition, Vn voltage is calculated as a sum of the phase voltages.

GENERAL SETTINGS

Auxiliary Voltage VN

NEUTRAL OV HIGH/LOW (59NH/59NL)

Function ENABLED

Pickup Level 120 V

Trip Delay 2.00

Reset Delay 0.00

ELEMENTS INPUT PICKUP LEVEL 
(VOLTS)

TRIP DELAY
(SECONDS)

APPLIED 
VOLTAGE (V)

TRIPPING TIME (S)

EXPECTED ADMISSIBLE

59NH/59NL VX 120 2 114 NO TRIP NA

132 2 [1.9–2.1 ]

132 2 [1.9 – 2.1]
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6.15.4 47 ELEMENT - NEG SEQ OV

Set the relay as follows:

Apply voltage as indicated on the table under the overvoltage setting level and verify that the relay does not trip.

Verify that the relay trips for the set voltage (with an admissible error of 5%).

NOTE: All angles mentioned on the tables are delay angles, where a balanced ABC system would be composed by: 

NEG SEQ OV (47)

Function ENABLED

Pickup Level 50 V

Trip Delay 2.00

Reset Delay 0.00

CHANNEL APPLIED VOLTAGE (V) ANGLE TRIPPING TIME (S)

EXPECTED ADMISSIBLE

VI 65 0º NO TRIP NA

VII 65 120º

VIII 65 240º

VI 55 0º 2 [1.9–2.1]

VII 55 240º

VIII 55 120º

VI 45 0º NO TRIP NA

VII 45 240º

VIII 45 120º

CHANNEL APPLIED VOLTAGE (V) ANGLE

VI 65 0º

VII 65 120º

VIII 65 240º
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6.16 FREQUENCY ELEMENTS (81O/81U)

Set the relay to trip for the protection element being tested. Configure any of the outputs to be activated only by the
protection element being tested.

Set the relay as follows:

Apply voltage as indicated on the table, modifying frequency from the maximum threshold (48 Hz) to the minimum (46 Hz)
for 81U, and from the minimum (52 Hz) to the maximum (54 Hz) for 81O, in steps of 10 mHz.

Verify that the relay trips at the set frequency in the corresponding element with an error of 3% ó ±50 mHz.

Apply a voltage that is lower than the “Minimum Voltage” setting, with a frequency under (81U) or over (81O) the setting,
and verify that the relay does not trip.

GENERAL SETTINGS

Nominal Frequency 50 Hz

ELEMENT SETTINGS

FREQUENCY (81) 81U 81O

Function ENABLED ENABLED

Pickup Level 47.50 Hz 52.50 Hz

Trip Delay 2.00 sec 2.00 sec

Reset Delay 0.00 sec 0.00 sec

Minimum Voltage 30 V 30 V

ELEMENTS PHASE PICKUP LEVEL 
(HZ)

TRIP DELAY
(SECONDS)

APPLIED 
VOLTAGE (V)

FREQUENCY 
THRESHOLDS

TRIPPING TIME (S)

EXPECTED ADMISSIBLE

81U VII 47.5 2 80 48 Hz No trip NA

46 Hz 2 [1.9 –2.2]

25 46 Hz No trip NA

81 O VII 52.5 2 80 52 Hz No trip NA

54 Hz 2 [1.9 –2.2]

25 54 Hz No trip NA
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6.17 RECLOSER (79)

Set protection element 79 as follows:

Set the relay to trip by 50PH, and configure the signals necessary to test the 79 element:
Configure one output as AR RECLOSE
Configure the AR INITIATE signal with the 50PH trip
Configure the AR LEVEL BLOCK signal with a digital input

Configure the AR CONDS INPUT with the digital signal desired

6.17.1 RECLOSING CYCLE

Connect a latching relay simulating the breaker managed by the F650 unit.

Once the relay is set, close the breaker and wait for 5 seconds.

After this time, the recloser is ready to initiate the reclosing cycle.

Command a 50PH trip and verify that the breaker opens and the relay recloses in 2.1 seconds.

Command a 50PH trip and verify that the breaker opens and the relay recloses in 4.1 seconds.

Command a 50PH trip and verify that the breaker opens and the relay recloses in 6.1 seconds.

Command a 50PH trip and verify that the breaker opens and the relay recloses in 8.1 seconds.

Command a 50PH trip and verify that the breaker opens and the recloser passes to Lockout.

Verify the correct operation of programmed outputs

Tripping times must be within the following values:

RECLOSER

Function ENABLED

Max Number Shots 4

Dead Time 1 2.10 sec

Dead Time 2 4.10 sec

Dead Time 3 6.10 sec

Dead Time 4 8.10 sec

Reclaim Time 3.00 sec

Cond. Permission ENABLED

Hold Time 7.00 sec

Reset Time 5.00 sec

50PH SETTINGS

Function ENABLED

Input RMS

Pickup Level 3 A

Trip Delay 0.00 s

Reset Delay 0.00 s

RECLOSING CYCLE

Nº shot  Expected time Admissible time

1 2.1 sec [1.8 – 2.3]

2 4.1 sec [3.8 – 4.3]

3 6.1 sec [5.8 – 6.3]

4 8.1 sec [7.8 – 8.3]
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6.17.2 RECLOSER STATUS

BLOCK

Activate the block input and verify that the recloser is in BLOCK status.

Close the breaker and wait for 5 seconds.

Command a trip and verify that the breaker opens but there is no reclose.

INHIBITION BY RECLOSING CONDITIONS

Close the breaker and wait for 5 seconds.

Command a trip, verify that the breaker opens and wait for the first shot.

Activate the inhibition input and command a new trip.

Verify that the breaker opens, wait for 8 seconds and verify that the relay does not reclose.

6.17.3 EXTERNAL RECLOSE INITIATION

Close the breaker and wait for 5 seconds.

Activate the reclose initiation input and open the breaker, verify that the relay executes the first shot
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6.18 THERMAL IMAGE ELEMENT (49)

Disable all protection elements except for Thermal Model (49).

Set the pickup level to 2 A.

Set the time constant τ1 to 3 minutes and τ2 to one time τ1.

Apply currents of 2, 5, and 10 times the tap and ensure that the operation times are within the range described on the
following table:

After each measuring, the thermal element must be reset to zero in order to start the next test at a zero thermal status
condition.

Repeat the test selecting a time constant τ1 of 60 minutes. Verify that the operation time is within the range described on
the following table:

After each measuring, the thermal element must be reset to zero in order to start the next test at a zero thermal status
condition.

RATED CURRENT (A) APPLIED CURRENT (A) TIMES DE SET TAP OPERATION TIME (S)

4.0 2 48.5 - 53.6

5 10.0 5 7.06 - 7.80

20.0 10 1.77 - 1.95

RATED CURRENT (A) APPLIED CURRENT (A) TIMES DE SET TAP OPERATION TIME (S)

4.0 2 960 - 1072

5 10.0 5 141 - 156

20.0 10 35.4 - 39
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7 FREQUENTLY ASKED QUESTIONS 7.1COMMUNICATIONS

Q1. Does the F650 support DNP and ModBus over the Ethernet port?

A1. F650 units support both protocols over both the asynchronous serial ports and the Ethernet LAN synchronous port
using TCP/IP and UDP/IP layers over the Ethernet. 

Q2. Does this equipment support dual IP access?

A2. Yes, it supports two independent IP addresses in aliasing mode. Those address go in the communications settings
Network0 and Network1.

Q3. Is the protocol IEC 870-103 supported by the F650?

A3. Yes, IEC 870-103 is supported by the F650 in firmware version 5.00 and higher.

Q4. Can the F650 be used as a DNP master station?

A4. Not at this moment. It works as a slave IED station for all protocols.

Q5. How many communication ports are included in the F650?

A5. The equipment has 2 different boards, one for asynchronous serial ports and another for a high-speed synchronous
Ethernet port. The first board has 2 comm ports, COM1 and COM2. COM2 is multiplexed with the front serial RS232
port, whereas the COM1 port is completely independent from COM2.

The synchronous LAN port is COM3. 

Q6. Are there one or two Ethernet ports?

A6. The equipment has only 1 Ethernet port. For redundant fiber optic versions, redundancy is done at the physical level
(fiber optic) but there is just one port. 

Q7. How many different communication Ethernet sessions can be opened through the LAN port?

A7. ModBus TCP/IP:4 sockets 

DNP TCP/IP:3 sessions (from version 1.72 on) 

Q8. May I use the cooper 10/100 BaseTX connection included in the basic model with all protocols?

A8. Yes, it may be used with all protocols. In noisy substation environments and/or long distances, it is recommended to
use fiber optic options due to much better EMC performance and immunity. For fiber optic models, it is necessary to
adjust an internal jumper to use the copper port.

Q9. Remote I/O CAN bus. Does it support DeviceNet protocol?

A9. No it does not support DeviceNet.

Q10. Which functions are available in the relay web server? 

A10. Currently, it includes several functions for viewing measures and retrieving information.

Q11. Q11 May I use URPC to program the relay? 

A11. Only oscillography records may be viewed with URPC once downloaded to a file using the ENERVISTA 650 Setup
software.
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Q12. May I connect URs and F650s to the same Ethernet?

A12. Yes, either in cable as in fiber, or even mix them. 

Q13. How do I connect with fiber 10-BASE-FL UR relays with 100-BASE-FX F650 relays?

A13. Take into account that an UR is never connected directly to a F650 (neither two UR nor two F650 with each other)
but they are always connected through a hub or switch. The hub or switch where the URs are connected must be
10-BASE-FL and the hub or switch for the F650 must be 100-BASE-FX.

Q14. How do I connect with cable 10_BASE-T UR relays with 10/100-BASE-TX F650 relays?

A14. The answer to this question is as described before but also in this case there is an advantage added, because the
hub 10-BASE-TX port is able to understand a 10-BASE-T port. This means that a hub 10-BASE-T port may be
connected to an UR or a F650, and a hub 10/100-BASE-TX port may be connected either to an UR or F650.

Q15. What happens with fiber optic connectors compatibility, because the hub that I have has a different
connector to the one of the F650, although both are 100-BASE-FX?

A15. Just buy fiber cables with the appropriate male connectors. For the UR and F650 side we need the same
connectors, ST type, for the hub side, the correspondent ones. And in what concerns to the fiber type, it is used the
same for 10 as for 100, it is the 50/125 or 62.5/125 multimode, this last one allows longer distances.

Q16. What is the difference between a hub and a switch?

A16. In a repeater type hub (shared hub), one unit talks and the rest listen. If all the units are talking at the same time
there may be collisions in the messages, what may produce certain communication delays.

The switch (switched hub) has very powerful processors and a lot of memory and it is much more expensive than
the hub. It directs messages to the proper destination avoiding collisions and allowing a much more efficient
communication.

Q17. Why do we have 10/100 compatibility for cable but not for fiber?

A17. The cable has some advantages that the fiber does not have, and it is that the signal attenuation in short and
medium distances, is worthless and this is truth for low and high frequency signals. By the contrary, the light in one
fiber optic is highly attenuated, being much worse in case of high frequencies than in the low ones. The 10-BASE-FL
fiber transmission is performed in a wavelength of 850nm, what allows a less expensive electronic than the 1300 nm
used in 100-BASE-FX fiber transmission. Using, in both cases, the same glass multimode fiber type, the attenuation
to 1300 nm is lower than the 850 nm ones, this way the greater attenuation of the 100 Mbits is compensated. There
is another fiber standard, the 100-BASE-SX, which uses 850 nm to 100 Mbits, being compatible with the 10-BASE-
FL one, although it sacrifices the maximum distance to 300 m. Nowadays, this standard has not had success among
Ethernet equipment manufacturers and suppliers.
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7.2PROTECTION

Q1. Does the F650 support IRIG-B signals? Which type and accuracy? How many units may be connected to the
same source?

A1. Yes, the F650 includes an IRIG-B input for all models, including the basic ones.

It uses DC level format B. Formats used are B0000, B0002 and B0003.

Actual accuracy is 1 millisecond. Internal sampling rate allows true 1 ms accuracy time tagging.

The input burden is very low. The maximum number of units that may be connected to a generator depends on its
output driving capability. Up to 60 units have been successfully connected with equipments commonly used in the
market.

Q2. Does the equipment work with dry inputs in both AC and DC?

A2. The equipment works only with DC inputs.

Inputs should be driven with externally generated DC current. No special 48 Vdc or other outputs are included in the
equipment to drive these inputs; therefore, contacts connected to the equipment should be connected to a DC
source.

Q3. Is it oscillography programmable?

A3. Yes, the sampling rate is programmable (4, 8, 16, 32 or 64 samples per input). The depth will depend on the
sampling rate.

Q4. Do I have to select a different model for 1 or 5 A?

A4. No. The same model is able to work with either /1 A or /5 A rated secondary currents. There are high accuracy
sensing transformers that allow the use of any current input through the same terminals to reduce the spares and
simplify wiring.

Q5. In my installation, several digital inputs become active when I energize the transformer. How can I reduce
sensitivity?

A5. By selecting debounce time and/or voltage threshold, the relay may adapt its sensitivity to different applications.
Please select the maximum voltage threshold and debounce time (recommended 15 ms) to minimize AC coupling
effects.
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7.3CONTROL AND HMI

Q1. What is the difference between Get/Send info from/to relay and Upload/Download info files to/from relay?

A1. Get/Send are used for settings and configuration storage that although both are in a unique file, are sent separately
in two times. Upload/Download are used for project or PLC files group storage. These files are the
setting_configuration file source. To operate, the F650 does not need the source files; the Upload/Download tool is
destined to serve as historic file.

Q2. Could I program interlocks?

A2. Yes, via ENERVISTA 650 Setup interlocks may be programmed from very simple to advanced schemes.

Q3. Can we rotate the display 90 degrees to show feeders vertically?

A3. No. The product has been designed to view it in horizontal mode (landscape) due to the following reasons:

It is easier to read the LCD display because it has been designed for horizontal positions.

Compatibility between text display (4x20 characters) and LCD display (16x40 characters or 128x240 pixels).

Refresh speed is better in horizontal than vertical format.

Q4. Do I need a laptop or handheld to program the unit?

A4. No, all main operations can easily be performed with just the incorporated HMI. Handheld or laptops may be
required to download large quantities of information (such as oscillograms, etc.) but they are not mandatory for a
conventional user that just needs to change settings, view measurements, states, etc.

Q5. Is there password security for protection and control?

A5. Yes, there are two passwords. An independent password for protection changes and control operations is available
since version 1.44

Q6. Is it possible to have a remote HMI installed in the front of the panel with the rest of the relay in the rear
side?

A6. Not in the present version.

Q7. Is it possible to program a default screen for the HMI?

A7. In graphic display versions the user may program a custom screen with the single-line diagram, measurements, etc.
In text display models, there is a choice of logo, measurements, or scrolling both screens.

Q8. May I force inputs and outputs to ease commissioning and testing?

A8. Yes.

Q9. How can I disable the rotary knob buzzer?

A9. Press ESC key for more than 3 seconds and then press the knob during a short pulse.

Q10. Why do appear strange texts on the display when switching on the relay?

A10. You will have pressed any button and the HMI has entered in a test mode. 

The display messages are updated after a few minutes, once the relay has completed the starting sequence.
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7.4RELAY CONFIGURATION

Q1. Does the "Service" contact on the Power Supply board cover all possible failures or do I have to create an
output on the I/O board that includes all the internal errors I can access in the logic?

A1. The power supply ready contact only monitor hardware failures in the power supply, to monitor the internal error of
the unit it is necessary to configure a virtual output to and the assign it to the device desired (contact output, LED,
etc.).

Q2. I set an output contact as "Latched". If I do not set a "reset" condition, will it reset from the "ESC" key?

A2. No, you have to configure the contact output reset signal (in Setpoint>Relay Configuration>Outputs). 

      The ESC key only reset the LED indicators.
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8 F650TROUBLESHOOTING GUIDE 8.1SYMPTOMS AND RECOMMENDED ACTIONS

F650 units have been designed and verified using the most advanced and reliable equipment. Mounting and
testing automation ensure a high consistency of the final product. Before sending a unit back to the factory, we
strongly recommend you follow the recommendations below. Even if it will not always solve the problem, at least
they will help define it better for a quicker repair.

If you need to send a unit back to the factory for repair, please use the appropriate RETURN MATERIAL AUTHORIZATION
process, and follow the shipping instructions provided by our Service Department, especially in the case of international
shipments. This will lead to a faster and efficient solution of your problem.

CATEGORY SYMPTOM POSSIBLE CAUSE RECOMMENDED ACTION

Protection The relay does not trip -Function not permitted

- Function blocked

- Output not assigned

- The unit is not set to ready

-Set the function permission to
ENABLED

-Check Protection units block screen

-Program the output to the desired
function using ENERVISTA 650 Setup
logic configuration

- Verify that the general setting is set to
disable and the out of service state is
not active

General When feeding the unit,
no indicator is lit up

-Insufficient power supply

- Wrong versions

-Fuse failure

- Loose fuse

-Incorrect wiring

-Verify the voltage level using a
multimeter in the power supply
terminals, and check that it is within
the model range

-Check relay and ENERVISTA 650
Setup versions are the same

-Remove power supply, dismount the
power supply module and replace the
fuse

-Same as above with same fuse

-Make sure that terminals labeled +
and – are connected to the 9-pin
connector corresponding to the power
source

Communication The relay does not
communicate via the
front RS232 port

-Incorrect cable

-Damaged cable

-Relay or PC not grounded

-Incorrect baudrate, port, address, etc. 

-Make sure you are using a straight
cable

-Replace the cable

-Ensure ground connection

-Test other ports, other baudrates, etc.
Make sure that the communication
parameters in the computer match the
ones in the relay.

General After Updating the
firmware the relay
does not start up and
always shows the
message “Os
Loading…”.

Check that the bootware version
match with the firmware version

-If there is an incompatibility between
boot and firmware version, update to
the corresponding boot and after that
update the firmware version

-If the boot and firmware versions are
correct, perform the firmware update
procedure again.
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CATEGORY SYMPTOM POSSIBLE CAUSE RECOMMENDED ACTION

Communications Cannot see properly
the web server in F650
with Windows XP. 

Some windows are in
grey with a red cross
mark.

Disabled Java options in Advanced
Internet Explorer properties or high
level of security

1.- Go to Advanced in Internet options
for Internet explorer and select the
three selections in Microsoft VM (Java
Virtual Machine) and deselect any
other virtual machine not Microsoft, for
example SUN.

In case Microsoft VM is not installed in
the computer, the user must install it
using the Microsoft VM installation
program msjavx86.exe

For internet explorer 6.0 or higher it is
not included by default.

2.- Try to set a lower level of security in
internet explorer options.

3.-Delete temporary internet files in
“General” screen in internet explorer
options.

Communication Enervista 650 Setup
does not retrieve osc,
fault reports and Data
Logger files

Bad communication in TFTP using
Windows 2000

Disable and Enable the Ethernet
connection on Control Panel inside
Windows 2000. Try again to retrieve
files from relay

Firmware and bootware upgrade

Bootware The relay gets stuck
during the upgrading
process after switching
off and on the relay,
giving the following
error message:
“ERROR Setting relay
in configuration mode.
Retry?

- The relay does not communicate via
the front RS232 port

To perform the bootware upgrading
process it is necessary to connect the
unit thought the front RS232 port.
check:
•  Serial cable correct(straightthrouhg)
and undamaged.
•  Settings selection in Enervista 650
Setup Communication>Computer
Settings”:

o Com port selected must be the 
one that is being used to perform 
this procedure
o  Parity set to NONE
o  Baudrate set to 19200 
o Control type: No control type
o Modbus slave number: any

Note: if the bootware upgrading
procedure got stuck at this point
the relay will not be upgraded. After
switching it off and on will continue
working with the former firmware
and bootware versions.
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CATEGORY SYMPTOM POSSIBLE CAUSE RECOMMENDED ACTION

Bootware The relay gets stuck at 
“Sending file 
imagen_kernel...”

-The Ethernet connection does not
work properly.

Serial communications work properly
and the flash memory has been
erased but ethernet communication
does not work properly, check:
•  RJ45 cable used (crossover cable
for back-to-back connection and
straightthrough Ethernet cable for hub
or switch)
•  IP address, netmask, gateway are
correct and corresponding to the ones
used in the computer used to perform
the procedure. See chapter 5.2.1
COMMUNICATION SETTINGS
• Ethernet board parameters selection,
check that:

o 802.1p QOS is Enabled
o Flow control is Auto
o Speed & Duplex is Auto (or 
10     Mb Full)

•  If all the above points are correct but
the problem persists: 

o Force the Speed & Duplex to 
10 Mb Full
o  Disable and enable the 
Ethernet connection while the 
files are being sent (during the 
“sending file...” message

Note: if the bootware upgrading
procedure got stuck at this point,
the relay flash memory has been
erased and the upgrade procedure
must be completed to start working
with the unit. If the procedure is not
completed, the HMI will show the
message “Os Loading...” and the
relay will not start up.

Firmware The procedure can not
start due to ethernet
problems

-The Ethernet connection does not
work properly.

• Check the same as in the point
above for bootware.
Note: if the firmware upgrading
procedure got stuck at this point the
relay will not be upgraded. After
switching it off and on will continue
working with the former firmware and
bootware versions.

Firmware Program messages
“file” do not exist in
local drive

- File path is too long
- File has no file attributes

•  Check the path length, copy the files
in a shorter path and start again the
upgrade procedure.
•  Check the unzip process to see if the
file properties are properly set to “File”.
• Note: if the firmware upgrading
procedure got stuck after having
been started, the former firmware
has been erased and the upgrade
procedure must be completed to
start working with the unit. If the
procedure is not completed, the HMI
will show the message “Os
Loading...” and the relay will not
start up.

Firmware It is not possible to to
upgrade models
without IEC 61850 to
models with IEC
61850 automatically

- IEC 61850 upgrade from standard
models is password protected.

• If the customer wants to upgrade
from a standard model to a 6 one, ask
the factory for a Upgrade package,
depending on the former hardware the
unit has, if hardware 00 they will need
hardware and firmware change
(passwored protected), if hardware 01
or above they will need only firmware
change (passwored protected).
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Firmware During the upgrading
procces for models
with IEC 61850
sometimes it ask for
password and
sometimes not.

- Communication problems during the
upgrade procecure.
-The procedure has been not
performed in a continuous way.

• EnerVista 650 Setup program do not
ask for a password if the relay model is
IEC61850 and the procedure is
completed.
•  If during the process there is any
problem and has to be started again,
this second time the program will ask
to confirm the IEC password.
•  If the EnerVista 650 Setup program
is closed and started again during the
bootware and firmware upgrade
process, the program will ask to
confirm the IEC password.

Firmware Password for 
IEC61850 incorrect

- Model change
- Incorrect mac or serial number

•  The password is tied to the model,
MAC Address and serial number, any
change in any of the following will need
a password change.
•  If the model has been modified to
add or replace any boards or
communication protocol, the IEC
61850 passwords will need to be
updated (contact the factory).

EnerVista 650 Setup InstallShield Setup 
Initialization Error 
6001

A previous installation of any product 
using InstallShield for installation may 
have corrupted some of the 
InstallShield files used in the EnerVista 
650 Setup installation

Delete (or rename) the 0701 folder 
located in  "C:\Program Files\Common 
Files\InstallShield\Professional\RunTi
me\" and retry installation
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OPERANDS - F650 - MODEL FX - GX

INTERNAL SYSTEM STATUS

AUTOCHECK INTERNAL STATES (CRITICAL)

DSP Internal States (Critical to metering and 
protection)

DSP COMM ERROR
DSP Communication Error: (0) Rignt communications 
between DSP and main processor; (1) Communication 
Error between DSP and main processor

MAGNETIC MODULE 
ERROR

Magnetic Module Error: (0) Right Communication 
between DSP and magnetic module processor; (1) 
Communication Error between DSP and magnetic 
module processor

CALIBRATION ERROR
Calibration Error: (0) Right calibration values stored; (1) 
The calibration values stored are out of the calibration 
limits.

Flash Internal States (Critical to Relay configuration 
and stored data) E2PROM STATUS E2prom status :(0) Not configured or problems during 

writing process ; (1) Configured and OK

IO Board States (Critical to operation and 
protection)

BOARD F STATUS
Board F status: (0) Inactive - There is no communication 
with the board (1) Active - There is communication with 
the board. 

BOARD G STATUS Board G status: (0) Inactive - There is no communication 
with the board (1) Active - There is communication with 
the board. 

BOARD H STATUS
Board H status: (0) Inactive - There is no communication 
with the board (1) Active - There is communication with 
the board. 

BOARD J STATUS
Board J status: (0) Inactive - There is no communication 
with the board (1) Active - There is communication with 
the board. 

IEC61850 INTERNAL STATES (NON CRITICAL)

IEC61850 Internal States ICD STATUS

UNKNOWN: when the relay has not the IEC61850 proto-
col in the relay model the ICD status is unknow to the 
unit

ICD ERROR: There is an error in the ICD file and the 
relay ICD is not operative. To solve this issue it is neces-
sary to send a correct ICD to the relay using the 
IEC61850 configurator tool. When the ICD error is raised 
the IEC 61850 will not be operative (the IEC 61850 cli-
ent, reports and gooses will not work). It is advisable to 
include the ICD ERROR in the main error signal config-
ured by the customers in their applications.

MODIFIED: The settings have been changed in the icd 
but they are still not wrtten in the icd file in the relay

IN PROGRESS: The icd setting are being written to the 
file in the relay

OK WITHOUT DAIS: The relay has not got the "Use DOI 
&DAI" setting enabled (true) and it is working properly 
with the ICD file.

OK: The relay has got the "Use DOI &DAI" setting 
enabled (true) and it is working properly with the ICD file. 
When that setting is set to true the icd setting will prevail 
over the relay settings.

OTHER INTERNAL STATES (NON CRITICAL)
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Other internal states

USER MAP STATUS User map status:  (0) Not configured ; (1) Configured

FACTORY 
CALIBRATION Calibration status (0) Not calibrated ; (1) Relay calibrated

FLEXCURVE A STATUS User curve A: (0) Not configured (1) Configured

FLEXCURVE B STATUS User curve B: (0) Not configured (1) Configured

FLEXCURVE C STATUS User curve C: (0) Not configured (1) Configured

FLEXCURVE D STATUS User curve D: (0) Not configured (1) Configured

Green Zone Memory internal status

Yellow Zone Memory internal status

Orange Zone Memory internal status

Red Zone Memory internal status

UpTime System Time

Autocheck Internal States (Not available)

TIMER STATUS Real time clock autocheck (not available)

GRAPHIC STATUS Graphic display status (not available)

ALARM TEXT ARRAY Text display status (not available)

Note: It is advisable to use the critical alarms to raise an event or to light a warning led for maintenance purposes. See the
example below, the Board X Status depends on the relay model.

Figure A–1: PROTECTION ALARM SIGNAL
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VIRTUAL OUTPUT 000 Configurable logic output 000

VIRTUAL OUTPUT 001 Configurable logic output 001

... ...

VIRTUAL OUTPUT 511 Configurable logic output 511

Operation Bits (24 elements)

OPERATION BIT 1
Operation bit 001: (0) the configured time expires or 
when success conditions are met;(1) operation 1 is 
executed and interlocks are fulfilled. 

OPERATION BIT 2
Operation bit 002: (0) the configured time expires or 
when success conditions are met;(1) operation 2 is 
executed and interlocks are fulfilled. 

... ...

OPERATION BIT 24
Operation bit 024: (0) the configured time expires or 
when success conditions are met;(1) operation 24 is 
executed and interlocks are fulfilled. 
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Control Event Bits (128 elements)

CONTROL EVENT 1 Control Event 1 Activation Bit

CONTROL EVENT 2 Control Event 2 Activation Bit

... ...

CONTROL EVENT 128 Control Event 128 Activation Bit

Latched Virtual Inputs (32 elements)

LATCHED VIRT IP 1 Latched virtual input 1

LATCHED VIRT IP 2 Latched virtual input 2

... ...

LATCHED VIRT IP 32 Latched virtual input 32

Self Reset Virtual Inputs (32 elements)

SELF-RST VIRT IP 1 Self reset virtual input 1

SELF-RST VIRT IP 2 Self reset virtual input 2

... ...

SELF-RST VIRT IP 32 Self reset virtual input 32

Contact Inputs Type 1Board

CONT IP_X_CC1 Input 1 (CC1) in Board X

CONT IP_X_CC2 Input 2 (CC2) in Board X

... ...

CONT IP_X_CC16 Input 16 (CC16) in Board X

Contact Inputs Type 2 Board 

CONT IP_X_CC1 Input 1 (CC1) in Board X

CONT IP_X_CC2 Input 2 (CC2) in Board X

... ...

CONT IP_X_CC8 Input 8 (CC8) in Board X

CONT IP_X_CC9 
(Va_COIL1)

Contact Input 09 (Va_COIL1) for slot X. Input voltage 
(Va) detected, Circuit 1. Complete circuit supervised

CONT IP_X_CC10 
(Vb_COIL1)

Contact Input 10 (Vb_COIL1) for slot X. Input voltage 
(Vb) detected, Circuit 1. Complete circuit supervised

CONT IP_X_CC11 
(Va_COIL2)

Contact Input 11 (Va_COIL2) for slot X. Input voltage 
(Va) detected, Circuit 1. Complete circuit supervised

CONT IP_X_CC12 
(Vb_COIL2)

Contact Input 12 (Vb_COIL2) for slot X. Input voltage 
(Vb) detected, Circuit 2. Complete circuit supervised

CONT IP_X_CC13 
(O7_SEAL)

Contact Input 13 (07_SEAL) for slot X. Current detected. 
Contact output associated with current flow > 100 mA 
latched 

CONT IP_X_CC14 
(O8_SEAL)

Contact Input 14 (08_SEAL) for slot X. Current detected. 
Contact output associated with current flow > 100 mA 
latched

CONT IP_X_CC15 
(SUP_COIL1)

Contact Input 15 (SUP_COIL1) for slot X. Output for 
circuit 1 supervision element 

CONT IP_X_CC16 
(SUP_COIL2)

Contact Input 16 (SUP_COIL2) for slot X. Output for 
circuit 2 supervision element
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Contact Inputs Type 4 Board

CONT IP_X_CC1 Input 1 (CC1) in Board X

CONT IP_X_CC2 Input 2 (CC2) in Board X

... ...

CONT IP_X_CC32 Input 32 (CC32) in Board X

Contact Inputs Type 5 Board (Digital Values)

CONT IP_X_CC1 Input 1 (CC1) in Board X

CONT IP_X_CC2 Input 2 (CC2) in Board X

... ...

CONT IP_X_CC16 Input 16 (CC16) in Board X

Contact Inputs Type 5 Board (Analog Values)

ANALOG_INP_X_01 Analog Input 01 in Board X

ANALOG_INP_X_02 Analog Input 02 in Board X

ANALOG_INP_X_03 Analog Input 03 in Board X

... ...

ANALOG_INP_X_08 Analog Input 08 in Board X

Contact Outputs Type 1 & 2 Board  Activation 
signals

CONT OP OPER_X_01 Logic signal for Output 1 activation. Board X

CONT OP OPER_X_02 Logic signal for Output 2 activation. Board X

... ...

CONT OP OPER_X_08 Logic signal for Output 8 activation. Board X

Contact Outputs Type 1 & 2 Board  Reset signals

CONT  RESET_X_01 board X, 01 latched output reset

CONT  RESET_X_02 board X, 02 latched output reset

... ...

CONT  RESET_X_08 board X, 08 latched output reset

Contact Outputs Type 1 & 2 Board  Status

CONT OP_X_01 Contact output 1 Board X operation

CONT OP_X_02 Contact output 2 Board X operation

... ...

CONT OP_X_8 Contact output 8 Board X operation

Board Status BOARD X STATUS
Board X status: (0) Inactive - There is no communication 
with the board  (1) Active - There is communication with 
the board

Switchgear status (16 elements)

SWITCH 1 A INPUT Contact input type A to switchgear Function 1

SWITCH 1 B INPUT Contact input type B to switchgear Function 1

SWITCH 2 A INPUT Contact input type A to switchgear Function 2

SWITCH 2 B INPUT Contact input type B to switchgear Function 2

... ...

SWITCH 16 A INPUT Contact input type A to switchgear Function 16

SWITCH 16 B INPUT Contact input type B to switchgear Function 16
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Switchgear outputs (16 elements)

SWITCH 1 A STATUS Contact logic output type A from switchgear Function 1 

SWITCH 1 B STATUS Contact logic output type B from switchgear Function 1 

SWITCH 2 A STATUS Contact logic output type A from switchgear Function 2 

SWITCH 2 B STATUS Contact logic output type B from switchgear Function 2 

... ...

SWITCH 16 A STATUS Contact logic output type A from switchgear Function 16 

SWITCH 16 B STATUS Contact logic output type B from switchgear Function 16 

Switchgear states (16 elements)

SWITCH 1 OPEN switchgear 1 open

SWITCH 1 CLOSED switchgear 1 closed

SWITCH 1 00_ERROR Error 00 switchgear 1 (contact A = 0, contact B = 0)

SWITCH 1 11_ERROR Error 11 switchgear 1 (contact A = 1, contact B = 1)

SWITCH 2 OPEN Switchgear 2 open

SWITCH 2 CLOSED Switchgear 2 closed

SWITCH 2 00_ERROR Error 00 switchgear 2 (contact A = 0, contact B = 0)

SWITCH 2 11_ERROR Error 11 switchgear 2 (contact A = 1, contact B = 1)

... ...

SWITCH 16 OPEN Switchgear 16 open

SWITCH 16 CLOSED Switchgear 16 closed

SWITCH 16 00_ERROR Error 00 switchgear 16 (contact A = 0, contact B = 0)

SWITCH 16 11_ERROR Error 11 switchgear 16 (contact A = 1, contact B = 1)

Switchgear Open-Close Initializing States

SWITCH 1 OPEN INIT Switchgear 1 opening initiation

SWITCH 1 CLOSE INIT Switchgear 1 closing initiation

SWITCH 2 OPEN INIT Switchgear 2 opening initiation

SWITCH 2 CLOSE INIT Switchgear 2 closing initiation

... ...

SWITCH 16 OPEN INIT Switchgear 16 opening initiation

SWITCH 16 CLOSE INIT Switchgear 16 closing initiation

Switchgear Fail States

SWGR 1 FAIL TO OPEN Failure to open Switchgear 1

SWGR 2 FAIL TO OPEN Failure to open Switchgear 2

... ...

SWGR 16 FAIL TO 
OPEN Failure to open Switchgear 16

SWGR 1 FAIL TO 
CLOSE Failure to close Switchgear 1

SWGR 2 FAIL TO 
CLOSE Failure to close Switchgear 2

... ...

SWGR 16 FAIL TO 
CLOSE Failure to close Switchgear 16
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LEDS HMI (16 Elements)

READY LED
Ready LED: (0-Red) Relay out of service, protection 
OUT OF ORDER (1-Green) Relay in service; protection 
READY

LED 1
Programmable LED 1 status:  Red colour. Latched by 
hardware. Reset by hardware (ESC) and programmable 
(LED RESET INPUT)

LED 2
Programmable LED 2 status:  Red colour. Latched by 
hardware. Reset by hardware (ESC) and programmable 
(LED RESET INPUT)

LED 3
Programmable LED 3 status:  Red colour. Latched by 
hardware. Reset by hardware (ESC) and programmable 
(LED RESET INPUT)

LED 4
Programmable LED 4 status:  Red colour. Latched by 
hardware. Reset by hardware (ESC) and programmable 
(LED RESET INPUT)

LED 5
Programmable LED 5 status:  Red colour. Latched by 
hardware. Reset by hardware (ESC) and programmable 
(LED RESET INPUT)

LED 6
Programmable LED 6 status:  Orange colour. Not 
latched. Latching possibility via PLC. Reset by hardware 
(ESC)  and programmable (LED RESET INPUT)

LED 7
Programmable LED 7 status:  Orange  colour. Not 
latched. Latching possibility via PLC. Reset by hardware 
(ESC)  and programmable (LED RESET INPUT)

LED 8
Programmable LED 8 status:  Orange colour. Not 
latched. Latching possibility via PLC. Reset by hardware 
(ESC)  and programmable (LED RESET INPUT)

LED 9
Programmable LED 9 status:  Orange  colour. Not 
latched. Latching possibility via PLC. Reset by hardware 
(ESC)  and programmable (LED RESET INPUT)

LED 10
Programmable LED 10 status:  Orange colour. Not 
latched. Latching possibility via PLC. Reset by hardware 
(ESC)  and programmable (LED RESET INPUT)

LED 11
Programmable LED 11 status:  Green colour. Not 
latched. Latching possibility via PLC. Reset by hardware 
(ESC)  and programmable (LED RESET INPUT)

LED 12
Programmable LED 12 status:  Green  colour. Not 
latched. Latching possibility via PLC. Reset by hardware 
(ESC)  and programmable (LED RESET INPUT)

LED 13
Programmable LED 13 status:  Green colour. Not 
latched. Latching possibility via PLC. Reset by hardware 
(ESC)  and programmable (LED RESET INPUT)

LED 14
Programmable LED 14 status:  Green  colour. Not 
latched. Latching possibility via PLC. Reset by hardware 
(ESC)  and programmable (LED RESET INPUT)

LED 15
Programmable LED 15 status:  Green colour. Not 
latched. Latching possibility via PLC. Reset by hardware 
(ESC)  and programmable (LED RESET INPUT)

LEDs reset input (programmable) LED RESET INPUT Programmable input for remote LED reset
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I Key I key operation (Programmable signal via PLC)

O Key O key operation (Programmable signal via PLC)

Programmable Keypad Status (HMI) */F3 Key */F3 key operation (Programmable signal via PLC)

F1 Key F1 key operation (Programmable signal via PLC)

F2 Key F2 key operation (Programmable signal via PLC)

LOCAL/REMOTE Operation status LEDs

LOCAL OPERATION 
MODE

Local/remote status for operations 1 = Local, 0 = 
Remote. Selectable through the front pushbutton 
(Hardware) and also through communications 
(software).

OPERATIONS 
BLOCKED

Operations OFF status (1) Command execution block 
(operations blocked both in local and remote 
mode).Selectable through the front pushbutton 
(Hardware) and also through communications 
(software). 

LOCAL/REMOTE/OFF Selection

CHANGE LOCAL-
REMOTE Changing local-remote status by communications

CHANGE OP BLOCKED Operations Block-Unblock signal

HMI Tab Order Selection (Swithgear selection 
status in HMI)

HMI Tab Order 01 HMI element 1 selection. 0 = Not selected, 1 =Selected. 
The selection is performed through the SEL front key. 
When the element 1 has it selection enabled, it can be 
commanded through the O and I front keys.

HMI Tab Order 02 HMI element 2 selection. 0 = Not selected, 1 =Selected. 
The selection is performed through the SEL front key. 
When the element 2 has it selection enabled, it can be 
commanded through the O and I front keys.

... ...

HMI Tab Order 16 HMI element 16 selection. 0 = Not selected, 1 
=Selected. The selection is performed through the SEL 
front key. When the element 16 has it selection enabled, 
it can be commanded through the O and I front keys.

HMI Backlight

HMI BACKLIGHT ON "Switching on backlignt" signal (the display is switched 
on by communications

HMI BACKLIGHT OFF "Switching off backlignt" signal (the display is switched 
off by communications



GEK-113000Z F650 Digital Bay Controller A-9

APPENDIX A A.1 LOGIC OPERANDS

A
OPERANDS - F650 - MODEL FX - GX

INTERNAL SYSTEM STATUS (CONT.)

Oscillography States

OSC DIG CHANNEL 1 Oscillography Digital channel 1 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 2 Oscillography Digital channel 2 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 3 Oscillography Digital channel 3 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 4 Oscillography Digital channel 4 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 5 Oscillography Digital channel 5 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 6 Oscillography Digital channel 6 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 7 Oscillography Digital channel 7 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 8 Oscillography Digital channel 8 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 9 Oscillography Digital channel 9 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 10 Oscillography Digital channel 10: (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 11 Oscillography Digital channel 11 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 12 Oscillography Digital channel 12 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 13 Oscillography Digital channel 13 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 14 Oscillography Digital channel 14 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 15 Oscillography Digital channel 15 : (1) Active ; (0) Not 
Active

OSC DIG CHANNEL 16 Oscillography Digital channel 16 : (1) Active ; (0) Not 
Active

OSCILLO TRIGGER Oscillo trigger activation (1) Active ; (0) Not active

Fault Report (Fault locator)
FAULT REPORT TRIGG Fault report trigger (1) Active ; (0) Not active

CLEAR FAULT 
REPORTS

Fault report removal from HMI and ModBus (volatile 
memory)

Energy Counters

FREEZE ENERGY CNT Energy counter freeze

UNFREEZE ENERGY 
CNT Energy counter unfreeze

RESET ENERGY CNT Energy counter reset

Demand Inputs
DEMAND TRIGGER INP Demand trigger (for Block interval algorithm)

DEMAND RESET INP Demand reset
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GROUP 1 ACT ON Group 1 activation, and deactivation of groups 2 & 3 

GROUP 2 ACT ON Group 2 activation, and deactivation of groups 1 & 3

GROUP 3 ACT ON Group 3 activation, and deactivation of groups 1 & 2

Setting Groups SETT GROUPS BLOCK Group change input blocked

GROUP 1 BLOCKED Settings Group 1 blocked

GROUP 2 BLOCKED Settings Group 2 blocked

GROUP 3 BLOCKED Settings Group 3 blocked
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Phase IOC High

PH IOC1 HIGH A BLK Phase instantaneous overcurrent element block Group 1 
phase A

PH IOC1 HIGH B BLK Phase instantaneous overcurrent element block Group 1 
phase B

PH IOC1 HIGH C BLK Phase instantaneous overcurrent element block Group 1 
phase C

PH IOC1 HIGH A PKP Phase instantaneous overcurrent element pickup high 
level Group 1 phase A

PH IOC1 HIGH A OP Phase instantaneous overcurrent element operation 
(trip) high level Group 1 phase A

PH IOC1 HIGH B PKP Phase instantaneous overcurrent element pickup high 
level Group 1 phase B

PH IOC1 HIGH B OP Phase instantaneous overcurrent element operation 
(trip) high level Group 1 phase B

PH IOC1 HIGH C PKP Phase instantaneous overcurrent element pickup high 
level Group 1 phase C

PH IOC1 HIGH C OP Phase instantaneous overcurrent element operation 
(trip) high level Group 1 phase C

PH IOC1 HIGH PKP Phase instantaneous overcurrent element pickup high 
level Group 1 any phase

PH IOC1 HIGH OP Phase instantaneous overcurrent element operation 
(trip) high level Group 1 any phase

PH IOC2 HIGH A BLK Phase instantaneous overcurrent element block Group 2 
phase A

PH IOC2 HIGH B BLK Phase instantaneous overcurrent element block Group 2 
phase B

PH IOC2 HIGH C BLK Phase instantaneous overcurrent element block Group 2 
phase C

PH IOC2 HIGH A PKP Phase instantaneous overcurrent element pickup high 
level Group 2 phase A

PH IOC2 HIGH A OP Phase instantaneous overcurrent element operation 
(trip) high level Group 2 phase A

PH IOC2 HIGH B PKP Phase instantaneous overcurrent element pickup high 
level Group 2 phase B

PH IOC2 HIGH B OP Phase instantaneous overcurrent element operation 
(trip) high level Group 2 phase B

PH IOC2 HIGH C PKP Phase instantaneous overcurrent element pickup high 
level Group 2 phase C

PH IOC2 HIGH C OP Phase instantaneous overcurrent element operation 
(trip) high level Group 2 phase C

PH IOC2 HIGH PKP Phase instantaneous overcurrent element pickup high 
level Group 2 any phase

PH IOC2 HIGH OP Phase instantaneous overcurrent element operation 
(trip) high level Group 2 any phase

PH IOC3 HIGH A BLK Phase instantaneous overcurrent element block Group 3 
phase A

PH IOC3 HIGH B BLK Phase instantaneous overcurrent element block Group 3 
phase B
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Phase IOC High

PH IOC3 HIGH C BLK Phase instantaneous overcurrent element block Group 3 
phase C

PH IOC3 HIGH A PKP Phase instantaneous overcurrent element pickup high 
level Group 3 phase A

PH IOC3 HIGH A OP Phase instantaneous overcurrent element operation 
(trip) high level Group 3 phase A

PH IOC3 HIGH B PKP Phase instantaneous overcurrent element pickup high 
level Group 3 phase B

PH IOC3 HIGH B OP Phase instantaneous overcurrent element operation 
(trip) high level Group 3 phase B

PH IOC3 HIGH C PKP Phase instantaneous overcurrent element pickup high 
level Group 3 phase C

PH IOC3 HIGH C OP Phase instantaneous overcurrent element operation 
(trip) high level Group 3 phase C

PH IOC3 HIGH PKP Phase instantaneous overcurrent element pickup high 
level Group 3 any phase

PH IOC3 HIGH OP Phase instantaneous overcurrent element operation 
(trip) high level Group 3 any phase
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Phase IOC Low

PH IOC1 LOW A BLK Phase instantaneous overcurrent element block Low 
level Group 1 phase A

PH IOC1 LOW B BLK Phase instantaneous overcurrent element block Low 
level Group 1 phase B

PH IOC1 LOW C BLK Phase instantaneous overcurrent element block Low 
level Group 1 phase C

PH IOC1 LOW A PKP Phase instantaneous overcurrent element pickup low 
level Group 1 phase A

PH IOC1 LOW A OP Phase instantaneous overcurrent element operation 
(trip) low level Group 1 phase A

PH IOC1 LOW B PKP Phase instantaneous overcurrent element pickup low 
level Group 1 phase B

PH IOC1 LOW B OP Phase instantaneous overcurrent element operation 
(trip) low level Group 1 phase B

PH IOC1 LOW C PKP Phase instantaneous overcurrent element pickup low 
level Group 1 phase C

PH IOC1 LOW C OP Phase instantaneous overcurrent element operation 
(trip) low level Group 1 phase C

PH IOC1 LOW PKP Phase instantaneous overcurrent element pickup low 
level Group 1 any phase

PH IOC1 LOW OP Phase instantaneous overcurrent element operation 
(trip) low level Group 1 any phase

PH IOC2 LOW A BLK Phase instantaneous overcurrent element block Low 
level Group 2 phase A

PH IOC2 LOW B BLK Phase instantaneous overcurrent element block Low 
level Group 2 phase B

PH IOC2 LOW C BLK Phase instantaneous overcurrent element block Low 
level Group 2 phase C

PH IOC2 LOW A PKP Phase instantaneous overcurrent element pickup low 
level Group 2 phase A

PH IOC2 LOW A OP Phase instantaneous overcurrent element operation 
(trip) low level Group 2 phase A

PH IOC2 LOW B PKP Phase instantaneous overcurrent element pickup low 
level Group 2 phase B

PH IOC2 LOW B OP Phase instantaneous overcurrent element operation 
(trip) low level Group 2 phase B

PH IOC2 LOW C PKP Phase instantaneous overcurrent element pickup low 
level Group 2 phase C

PH IOC2 LOW C OP Phase instantaneous overcurrent element operation 
(trip) low level Group 2 phase C

PH IOC2 LOW PKP Phase instantaneous overcurrent element pickup low 
level Group 2 any phase

PH IOC2 LOW OP Phase instantaneous overcurrent element operation 
(trip) low level Group 2 any phase

PH IOC3 LOW A BLK Phase instantaneous overcurrent element block Low 
level Group 3 phase A
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Phase IOC Low

PH IOC3 LOW B BLK Phase instantaneous overcurrent element block Low 
level Group 3 phase B

PH IOC3 LOW C BLK Phase instantaneous overcurrent element block Low 
level Group 3 phase C

PH IOC3 LOW A PKP Phase instantaneous overcurrent element pickup low 
level Group 3 phase A

PH IOC3 LOW A OP Phase instantaneous overcurrent element operation 
(trip) low level Group 3 phase A

PH IOC3 LOW B PKP Phase instantaneous overcurrent element pickup low 
level Group 3 phase B

PH IOC3 LOW B OP Phase instantaneous overcurrent element operation 
(trip) low level Group 3 phase B

PH IOC3 LOW C PKP Phase instantaneous overcurrent element pickup low 
level Group 3 phase C

PH IOC3 LOW C OP Phase instantaneous overcurrent element operation 
(trip) low level Group 3 phase C

PH IOC3 LOW PKP Phase instantaneous overcurrent element pickup low 
level Group 3 any phase

PH IOC3 LOW OP Phase instantaneous overcurrent element operation 
(trip) low level Group 3 any phase

 Neutral IOC

NEUTRAL IOC1 BLOCK Neutral instantaneous overcurrent element block Group 
1

NEUTRAL IOC1 PKP Neutral instantaneous overcurrent element pickup Group 
1

NEUTRAL IOC1 OP Neutral instantaneous overcurrent element operation 
(trip) Group 1

NEUTRAL IOC2 BLOCK Neutral instantaneous overcurrent element block Group 
2

NEUTRAL IOC2 PKP Neutral instantaneous overcurrent element pickup Group 
2

NEUTRAL IOC2 OP Neutral instantaneous overcurrent element operation 
(trip) Group 2

NEUTRAL IOC3 BLOCK Neutral instantaneous overcurrent element block Group 
3

NEUTRAL IOC3 PKP Neutral instantaneous overcurrent element pickup Group 
3

NEUTRAL IOC3 OP Neutral instantaneous overcurrent element operation 
(trip) Group 3
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Ground IOC

GROUND IOC1 BLOCK Ground instantaneous overcurrent element block Group 
1

GROUND IOC1 PKP Ground instantaneous overcurrent element pickup 
Group 1

GROUND IOC1 OP Ground instantaneous overcurrent element operation 
(trip) Group 1

GROUND IOC2 BLOCK Ground instantaneous overcurrent element block Group 
2

GROUND IOC2 PKP Ground instantaneous overcurrent element pickup 
Group 2

GROUND IOC2 OP Ground instantaneous overcurrent element operation 
(trip) Group 2

GROUND IOC3 BLOCK Ground instantaneous overcurrent element block Group 
3

GROUND IOC3 PKP Ground instantaneous overcurrent element pickup 
Group 3

GROUND IOC3 OP Ground instantaneous overcurrent element operation 
(trip) Group 3

Sensitive Ground IOC

SENS GND IOC1 BLK Sensitive ground instantaneous overcurrent element 
block Group 1

SENS GND IOC1 PKP Sensitive ground instantaneous overcurrent element 
pickup Group 1

SENS GND IOC1 OP Sensitive ground instantaneous overcurrent element 
operation (trip) Group 1

SENS GND IOC2 BLK Sensitive ground instantaneous overcurrent element 
block Group 2

SENS GND IOC2 PKP Sensitive ground instantaneous overcurrent element 
pickup Group 2

SENS GND IOC2 OP Sensitive ground instantaneous overcurrent element 
operation (trip) Group 2

SENS GND IOC3 BLK Sensitive ground instantaneous overcurrent element 
block Group 3

SENS GND IOC3 PKP Sensitive ground instantaneous overcurrent element 
pickup Group 3

SENS GND IOC3 OP Sensitive ground instantaneous overcurrent element 
operation (trip) Group 3



A-16 F650 Digital Bay Controller GEK-113000Z

A.1 LOGIC OPERANDS APPENDIX A 

A
OPERANDS - F650 - MODEL FX - GX

INTERNAL SYSTEM STATUS (CONT.)

Isolated Ground

ISOLATED GND1 BLK Isolated ground instantaneous overcurrent element 
block Group 1

ISOLATED GND1 PKP Isolated ground instantaneous overcurrent element 
pickup Group 1

ISOLATED GND1 OP Isolated ground instantaneous overcurrent element 
operation (trip) Group 1

ISOLATED GND2 BLK Isolated ground instantaneous overcurrent element 
block Group 2

ISOLATED GND2 PKP Isolated ground instantaneous overcurrent element 
pickup Group 2

ISOLATED GND2 OP Isolated ground instantaneous overcurrent element 
operation (trip) Group 2

ISOLATED GND3 BLK Isolated ground instantaneous overcurrent element 
block Group 3

ISOLATED GND3 PKP Isolated ground instantaneous overcurrent element 
pickup Group 3

ISOLATED GND3 OP Isolated ground instantaneous overcurrent element 
operation (trip) Group 3
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 Phase TOC High

PH TOC1 HIGH A BLK Phase timed overcurrent element block Group 1 phase A

PH TOC1 HIGH B BLK Phase timed overcurrent element block Group 1 phase B

PH TOC1 HIGH C BLK Phase timed overcurrent element block Group 1 phase 
C

PH TOC1 HIGH A PKP Phase timed overcurrent element pickup Group 1 phase 
A

PH TOC1 HIGH A OP Phase timed overcurrent element operation (trip) Group 
1 phase A

PH TOC1 HIGH B PKP Phase timed overcurrent element pickup Group 1 phase 
B

PH TOC1 HIGH B OP Phase timed overcurrent element operation (trip) Group 
1 phase B

PH TOC1 HIGH C PKP Phase timed overcurrent element pickup Group 1 phase 
C

PH TOC1 HIGH C OP Phase timed overcurrent element operation (trip) Group 
1 phase C

PH TOC1 HIGH PKP Phase timed overcurrent element pickup Group 1 any 
phase

PH TOC1 HIGH OP Phase timed overcurrent element operation (trip) Group 
1 any phase

PH TOC2 HIGH A BLK Phase timed overcurrent element block Group 2 phase A

PH TOC2 HIGH B BLK Phase timed overcurrent element block Group 2 phase B

PH TOC2 HIGH C BLK Phase timed overcurrent element block Group 2 phase 
C

PH TOC2 HIGH A PKP Phase timed overcurrent element pickup Group 2 phase 
A

PH TOC2 HIGH A OP Phase timed overcurrent element operation (trip) Group 
2 phase A

PH TOC2 HIGH B PKP Phase timed overcurrent element pickup Group 2 phase 
B

PH TOC2 HIGH B OP Phase timed overcurrent element operation (trip) Group 
2 phase B

PH TOC2 HIGH C PKP Phase timed overcurrent element pickup Group 2 phase 
C

PH TOC2 HIGH C OP Phase timed overcurrent element operation (trip) Group 
2 phase C

PH TOC2 HIGH PKP Phase timed overcurrent element pickup Group 2 any 
phase

PH TOC2 HIGH OP Phase timed overcurrent element operation (trip) Group 
2 any phase

PH TOC3 HIGH A BLK Phase timed overcurrent element block Group 3 phase A

PH TOC3 HIGH B BLK Phase timed overcurrent element block Group 3 phase B

PH TOC3 HIGH C BLK Phase timed overcurrent element block Group 3 phase 
C
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Phase TOC High

PH TOC3 HIGH A PKP Phase timed overcurrent element pickup Group 3 phase 
A

PH TOC3 HIGH A OP Phase timed overcurrent element operation (trip) Group 
3 phase A

PH TOC3 HIGH B PKP Phase timed overcurrent element pickup Group 3 phase 
B

PH TOC3 HIGH B OP Phase timed overcurrent element operation (trip) Group 
3 phase B

PH TOC3 HIGH C PKP Phase timed overcurrent element pickup Group 3 phase 
C

PH TOC3 HIGH C OP Phase timed overcurrent element operation (trip) Group 
3 phase C

PH TOC3 HIGH PKP Phase timed overcurrent element pickup Group 3 any 
phase

PH TOC3 HIGH OP Phase timed overcurrent element operation (trip) Group 
3 any phase

Phase TOC Low

PH TOC1 LOW A BLK Phase timed overcurrent element block Low level Group 
1 phase A

PH TOC1 LOW B BLK Phase timed overcurrent element block Low level Group 
1 phase B

PH TOC1 LOW C BLK Phase timed overcurrent element block Low level Group 
1 phase C

PH TOC1 LOW A PKP Phase timed overcurrent element pickup low level Group 
1 phase A

PH TOC1 LOW A OP Phase timed overcurrent element operation (trip) low 
level Group 1 phase A

PH TOC1 LOW B PKP Phase timed overcurrent element pickup low level Group 
1 phase B

PH TOC1 LOW B OP Phase timed overcurrent element operation (trip) low 
level Group 1 phase B

PH TOC1 LOW C PKP Phase timed overcurrent element pickup low level Group 
1 phase C

PH TOC1 LOW C OP Phase timed overcurrent element operation (trip) low 
level Group 1 phase C

PH TOC1 LOW PKP Phase timed overcurrent element pickup low level Group 
1 any phase

PH TOC1 LOW OP Phase timed overcurrent element operation (trip) low 
level Group 1 any phase

PH TOC2 LOW A BLK Phase timed overcurrent element block Low level Group 
2 phase A

PH TOC2 LOW B BLK Phase timed overcurrent element block Low level Group 
2 phase B

PH TOC2 LOW C BLK Phase timed overcurrent element block Low level Group 
2 phase C

PH TOC2 LOW A PKP Phase timed overcurrent element pickup low level Group 
2 phase A

PH TOC2 LOW A OP Phase timed overcurrent element operation (trip) low 
level Group 2 phase A

PH TOC2 LOW B PKP Phase timed overcurrent element pickup low level Group 
2 phase B
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Phase TOC Low

PH TOC2 LOW B OP Phase timed overcurrent element operation (trip) low 
level Group 2 phase B

PH TOC2 LOW C PKP Phase timed overcurrent element pickup low level Group 
2 phase C

PH TOC2 LOW C OP Phase timed overcurrent element operation (trip) low 
level Group 2 phase C

PH TOC2 LOW PKP Phase timed overcurrent element pickup low level Group 
2 any phase

PH TOC2 LOW OP Phase timed overcurrent element operation (trip) low 
level Group 2 any phase

PH TOC3 LOW A BLK Phase timed overcurrent element block Low level Group 
3 phase A

PH TOC3 LOW B BLK Phase timed overcurrent element block Low level Group 
3 phase B

PH TOC3 LOW C BLK Phase timed overcurrent element block Low level Group 
3 phase C

PH TOC3 LOW A PKP Phase timed overcurrent element pickup low level Group 
3 phase A

PH TOC3 LOW A OP Phase timed overcurrent element operation (trip) low 
level Group 3 phase A

PH TOC3 LOW B PKP Phase timed overcurrent element pickup low level Group 
3 phase B

PH TOC3 LOW B OP Phase timed overcurrent element operation (trip) low 
level Group 3 phase B

PH TOC3 LOW C PKP Phase timed overcurrent element pickup low level Group 
3 phase C

PH TOC3 LOW C OP Phase timed overcurrent element operation (trip) low 
level Group 3 phase C

PH TOC3 LOW PKP Phase timed overcurrent element pickup low level Group 
3 any phase

PH TOC3 LOW OP Phase timed overcurrent element operation (trip) low 
level Group 3 any phase

Neutral TOC

NEUTRAL TOC1 
BLOCK Neutral timed overcurrent element block Group 1

NEUTRAL TOC1 PKP Neutral timed overcurrent element pickup Group 1

NEUTRAL TOC1 OP Neutral timed overcurrent element operation (trip) Group 
1

NEUTRAL TOC2 
BLOCK Neutral timed overcurrent element block Group 2

NEUTRAL TOC2 PKP Neutral timed overcurrent element pickup Group 2

NEUTRAL TOC2 OP Neutral timed overcurrent element operation (trip) Group 
2

NEUTRAL TOC3 
BLOCK Neutral timed overcurrent element block Group 3

NEUTRAL TOC3 PKP Neutral timed overcurrent element pickup Group 3

NEUTRAL TOC3 OP Neutral timed overcurrent element operation (trip) Group 
3
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Ground TOC

GROUND TOC1 BLOCK Ground timed overcurrent element block Group 1

GROUND TOC1 PKP Ground timed overcurrent element pickup Group 1

GROUND TOC1 OP Ground timed overcurrent element operation (trip) Group 
1

GROUND TOC2 BLOCK Ground timed overcurrent element block Group 2

GROUND TOC2 PKP Ground timed overcurrent element pickup Group 2

GROUND TOC2 OP Ground timed overcurrent element operation (trip) Group 
2

GROUND TOC3 BLOCK Ground timed overcurrent element block Group 3

GROUND TOC3 PKP Ground timed overcurrent element pickup Group 3

GROUND TOC3 OP Ground timed overcurrent element operation (trip) Group 
3

Sensitive Ground TOC

SENS GND TOC1 
BLOCK

Sensitive ground timed overcurrent element block Group 
1

SENS GND TOC1 PKP Sensitive ground timed overcurrent element pickup 
Group 1

SENS GND TOC1 OP Sensitive ground timed overcurrent element operation 
(trip) Group 1

SENS GND TOC2 
BLOCK

Sensitive ground timed overcurrent element block Group 
2

SENS GND TOC2 PKP Sensitive ground timed overcurrent element pickup 
Group 2

SENS GND TOC2 OP Sensitive ground timed overcurrent element operation 
(trip) Group 2

SENS GND TOC3 
BLOCK

Sensitive ground timed overcurrent element block Group 
3

SENS GND TOC3 PKP Sensitive ground timed overcurrent element pickup 
Group 3

SENS GND TOC3 OP Sensitive ground timed overcurrent element operation 
(trip) Group 3

Negative Sequence TOC

NEG SEQ TOC1 BLOCK Negative sequence timed overcurrent element block 
Group 1

NEG SEQ TOC1 PKP Negative sequence timed overcurrent element pickup 
Group 1

NEG SEQ TOC1 OP Negative sequence timed overcurrent element operation 
Group 1

NEG SEQ TOC2 BLOCK Negative sequence timed overcurrent element block 
Group 2

NEG SEQ TOC2 PKP Negative sequence timed overcurrent element pickup 
Group 2

NEG SEQ TOC2 OP Negative sequence timed overcurrent element operation 
Group 2

NEG SEQ TOC3 BLOCK Negative sequence timed overcurrent element block 
Group 3

NEG SEQ TOC3 PKP Negative sequence timed overcurrent element pickup 
Group 3

NEG SEQ TOC3 OP Negative sequence timed overcurrent element operation 
Group 3
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Thermal Image

THERMAL1 BLOCK Thermal image block Group 1

THERMAL1 A RST Thermal image phase A Group 1 element reset

THERMAL1 B RST Thermal image phase B Group 1 element reset

THERMAL1 C RST Thermal image phase C Group 1 element reset

THERMAL1 ALARM Thermal image element alarm any phase Group 1

THERMAL1 OP Thermal image element operation any phase Group 1

THERMAL1 A ALRM Thermal image element alarm phase A Group 1

THERMAL1 A OP Thermal image element operation phase A Group 1

THERMAL1 B ALRM Thermal image element alarm phase B Group 1

THERMAL1 B OP Thermal image element operation phase B Group 1

THERMAL1 C ALRM Thermal image element alarm phase C Group 1

THERMAL1 C OP Thermal image element operation phase C Group 1

THERMAL2 BLOCK Thermal image block Group 2

THERMAL2 A RST Thermal image phase A Group 2 element reset

THERMAL2 B RST Thermal image phase B Group 2 element reset

THERMAL2 C RST Thermal image phase C Group 2 element reset

THERMAL2 ALARM Thermal image element alarm any phase Group 2

THERMAL2 OP Thermal image element operation any phase Group 2

THERMAL2 A ALRM Thermal image element alarm phase A Group 2

THERMAL2 A OP Thermal image element operation phase A Group 2

THERMAL2 B ALRM Thermal image element alarm phase B Group 2

THERMAL2 B OP Thermal image element operation phase B Group 2

THERMAL2 C ALRM Thermal image element alarm phase C Group 2

THERMAL2 C OP Thermal image element operation phase C Group 2

THERMAL3 BLOCK Thermal image block Group 3

THERMAL3 A RST Thermal image phase A Group 3 element reset

THERMAL3 B RST Thermal image phase B Group 3 element reset

THERMAL3 C RST Thermal image phase C Group 3 element reset

THERMAL3 ALARM Thermal image element alarm any phase Group 3

THERMAL3 OP Thermal image element operation any phase Group 3

THERMAL3 A ALRM Thermal image element alarm phase A Group 3

THERMAL3 A OP Thermal image element operation phase A Group 3

THERMAL3 B ALRM Thermal image element alarm phase B Group 3

THERMAL3 B OP Thermal image element operation phase B Group 3

THERMAL3 C ALRM Thermal image element alarm phase C Group 3

THERMAL3 C OP Thermal image element operation phase C Group 3
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Phase Directional

PHASE DIR1 BLK INP Phase directional block Group 1

PHASE DIR1 BLOCK A Phase directional element block Group 1 Phase A

PHASE DIR1 A OP Phase directional element operation Group 1 Phase A

PHASE DIR1 BLOCK B Phase directional element block Group 1 Phase B

PHASE DIR1 B OP Phase directional element operation Group 1 Phase B

PHASE DIR1 BLOCK C Phase directional element block Group 1 Phase C

PHASE DIR1 C OP Phase directional element operation Group 1 Phase C

PHASE DIR2 BLK INP Phase directional block Group 2

PHASE DIR2 BLOCK A Phase directional element block Group 2 Phase A

PHASE DIR2 A OP Phase directional element operation Group 2 Phase A

PHASE DIR2 BLOCK B Phase directional element block Group 2 Phase B

PHASE DIR2 B OP Phase directional element operation Group 2 Phase B

PHASE DIR2 BLOCK C Phase directional element block Group 2 Phase C

PHASE DIR2 C OP Phase directional element operation Group 2 Phase C

PHASE DIR3 BLK INP Phase directional block Group 3

PHASE DIR3 BLOCK A Phase directional element block Group 3 Phase A

PHASE DIR3 A OP Phase directional element operation Group 3 Phase A

PHASE DIR3 BLOCK B Phase directional element block Group 3 Phase B

PHASE DIR3 B OP Phase directional element operation Group 3 Phase B

PHASE DIR3 BLOCK C Phase directional element block Group 3 Phase C

PHASE DIR3 C OP Phase directional element operation Group 3 Phase C

 Neutral Directional

NEUTRAL DIR1 BLK 
INP Neutral directional element block input signal Group 1

NEUTRAL DIR1 BLOCK Neutral directional element blocked Group 1

NEUTRAL DIR1 OP Neutral directional element operation Group 1

NEUTRAL DIR2 BLK 
INP Neutral directional element block input signal Group 2

NEUTRAL DIR2 BLOCK Neutral directional element blocked Group 2

NEUTRAL DIR2 OP Neutral directional element operation Group 2

NEUTRAL DIR3 BLK 
INP Neutral directional element block input signal Group 3

NEUTRAL DIR3 BLOCK Neutral directional element blocked Group 3

NEUTRAL DIR3 OP Neutral directional element operation Group 3
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Ground Directional

GROUND DIR1 BLK INP Ground directional element block input signal Group 1

GROUND DIR1 BLOCK Ground directional element blocked Group 1

GROUND DIR1 OP Ground directional element operation Group 1

GROUND DIR2 BLK INP Ground directional element block input signal Group 2

GROUND DIR2 BLOCK Ground directional element blocked Group 2

GROUND DIR2 OP Ground directional element operation Group 2

GROUND DIR3 BLK INP Ground directional element block input signal Group 3

GROUND DIR3 BLOCK Ground directional element blocked Group 3

GROUND DIR3 OP Ground directional element operation Group 3

Sensitive Ground Directional

SENS GND DIR1 BLK IP Sensitive ground directional element block input Group 1

SENS GND DIR1 
BLOCK Sensitive Ground directional element block Group 1

SENS GND DIR1 OP Sensitive Ground directional element operation Group 1

SENS GND DIR2 BLK IP Sensitive ground directional element block input Group 2

SENS GND DIR2 
BLOCK Sensitive Ground directional element block Group 2

SENS GND DIR2 OP Sensitive Ground directional element operation Group 2

SENS GND DIR3 BLK IP Sensitive ground directional element block input Group 3

SENS GND DIR3 
BLOCK Sensitive Ground directional element block Group 3

SENS GND DIR3 OP Sensitive Ground directional element operation Group 3

Fuse failure VT FUSE FAILURE Fuse failure operation

Phase UV 

PHASE UV1 BLOCK Phase undervoltage element block Group 1

PHASE UV1 A PKP Undervoltage element pickup AG Group 1

PHASE UV1 A OP Undervoltage element operation AG Group 1

PHASE UV1 B PKP Undervoltage element pickup BG Group 1

PHASE UV1 B OP Undervoltage element operation BG Group 1

PHASE UV1 C PKP Undervoltage element pickup CG Group 1

PHASE UV1 C OP Undervoltage element operation CG Group 1

PHASE UV1 AB PKP Undervoltage element pickup AB Group 1

PHASE UV1 AB OP Undervoltage element operation AB Group 1

PHASE UV1 BC PKP Undervoltage element pickup BC Group 1

PHASE UV1 BC OP Undervoltage element operation BC Group 1

PHASE UV1 CA PKP Undervoltage element pickup CA Group 1
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Phase UV

PHASE UV1 CA OP Undervoltage element operation CA Group 1

PHASE UV1 PKP Pickup of any of the above mentioned elements

PHASE UV1 OP Operation of any of the above mentioned elements

PHASE UV2 BLOCK Phase undervoltage element block Group 2

PHASE UV2 A PKP Undervoltage element pickup AG Group 2

PHASE UV2 A OP Undervoltage element operation AG Group 2

PHASE UV2 B PKP Undervoltage element pickup BG Group 2

PHASE UV2 B OP Undervoltage element operation BG Group 2

PHASE UV2 C PKP Undervoltage element pickup CG Group 2

PHASE UV2 C OP Undervoltage element operation CG Group 2

PHASE UV2 AB PKP Undervoltage element pickup AB Group 2

PHASE UV2 AB OP Undervoltage element operation AB Group 2

PHASE UV2 BC PKP Undervoltage element pickup BC Group 2

PHASE UV2 BC OP Undervoltage element operation BC Group 2

PHASE UV2 CA PKP Undervoltage element pickup CA Group 2

PHASE UV2 CA OP Undervoltage element operation CA Group 2

PHASE UV2 PKP Pickup of any of the above mentioned elements

PHASE UV2 OP Operation of any of the above mentioned elements

PHASE UV3 BLOCK Phase undervoltage element block Group 3

PHASE UV3 A PKP Undervoltage element pickup AG Group 3

PHASE UV3 A OP Undervoltage element operation AG Group 3

PHASE UV3 B PKP Undervoltage element pickup BG Group 3

PHASE UV3 B OP Undervoltage element operation BG Group 3

PHASE UV3 C PKP Undervoltage element pickup CG Group 3

PHASE UV3 C OP Undervoltage element operation CG Group 3

PHASE UV3 AB PKP Undervoltage element pickup AB Group 3

PHASE UV3 AB OP Undervoltage element operation AB Group 3

PHASE UV3 BC PKP Undervoltage element pickup BC Group 3

PHASE UV3 BC OP Undervoltage element operation BC Group 3

PHASE UV3 CA PKP Undervoltage element pickup CA Group 3

PHASE UV3 CA OP Undervoltage element operation CA Group 3

PHASE UV3 PKP Pickup of any of the above mentioned elements

PHASE UV3 OP Operation of any of the above mentioned elements
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Phase OV

PHASE OV1 BLOCK Phase overvoltage element block Group 1

PHASE OV1 AB PKP Overvoltage element pickup AB Group 1

PHASE OV1 AB OP Overvoltage element operation AB Group 1

PHASE OV1 BC PKP Overvoltage element pickup BC Group 1

PHASE OV1 BC OP Overvoltage element operation BC Group 1

PHASE OV1 CA PKP Overvoltage element pickup CA Group 1

PHASE OV1 CA OP Overvoltage element operation CA Group 1

PHASE OV1 PKP Pickup of any of the above mentioned elements

PHASE OV1 OP Operation of any of the above mentioned elements

PHASE OV2 BLOCK Phase overvoltage element block Group 2

PHASE OV2 AB PKP Overvoltage element pickup AB Group 2

PHASE OV2 AB OP Overvoltage element operation AB Group 2

PHASE OV2 BC PKP Overvoltage element pickup BC Group 2

PHASE OV2 BC OP Overvoltage element operation BC Group 2

PHASE OV2 CA PKP Overvoltage element pickup CA Group 2

PHASE OV2 CA OP Overvoltage element operation CA Group 2

PHASE OV2 PKP Pickup of any of the above mentioned elements

PHASE OV2 OP Operation of any of the above mentioned elements

PHASE OV3 BLOCK Phase overvoltage element block Group 3

PHASE OV3 AB PKP Overvoltage element pickup AB Group 3

PHASE OV3 AB OP Overvoltage element operation AB Group 3

PHASE OV3 BC PKP Overvoltage element pickup BC Group 3

PHASE OV3 BC OP Overvoltage element operation BC Group 3

PHASE OV3 CA PKP Overvoltage element pickup CA Group 3

PHASE OV3 CA OP Overvoltage element operation CA Group 3

PHASE OV3 PKP Pickup of any of the above mentioned elements

PHASE OV3 OP Operation of any of the above mentioned elements
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Neutral OV High

NEUTRAL OV1 HIGH 
BLK Neutral overvoltage element block high level Group 1

NEUTRAL OV1 HIGH 
PKP Neutral overvoltage element pickup high level Group 1

NEUTRAL OV1 HIGH 
OP

Neutral overvoltage element operation high level Group 
1

NEUTRAL OV2 HIGH 
BLK Neutral overvoltage element block high level Group 2

NEUTRAL OV2 HIGH 
PKP Neutral overvoltage element pickup high level Group 2

NEUTRAL OV2 HIGH 
OP

Neutral overvoltage element operation high level Group 
2

NEUTRAL OV3 HIGH 
BLK Neutral overvoltage element block high level Group 3

NEUTRAL OV3 HIGH 
PKP Neutral overvoltage element pickup high level Group 3

NEUTRAL OV3 HIGH 
OP

Neutral overvoltage element operation high level Group 
3

Neutral OV Low

NEUTRAL OV1 LOW 
BLK Neutral overvoltage element block low level Group 1

NEUTRAL OV1 LOW 
PKP Neutral overvoltage element pickup low level Group 1

NEUTRAL OV1 LOW 
OP Neutral overvoltage element operation low level Group 1

NEUTRAL OV2 LOW 
BLK Neutral overvoltage element block low level Group 2

NEUTRAL OV2 LOW 
PKP Neutral overvoltage element pickup low level Group 2

NEUTRAL OV2 LOW 
OP Neutral overvoltage element operation low level Group 2

NEUTRAL OV3 LOW 
BLK Neutral overvoltage element block low level Group 3

NEUTRAL OV3 LOW 
PKP Neutral overvoltage element pickup low level Group 3

NEUTRAL OV3 LOW 
OP Neutral overvoltage element operation low level Group 3

Auxiliary UV

AUXILIARY UV1 BLOCK Auxiliary undervoltage element block Group 1

AUXILIARY UV1 PKP Auxiliary undervoltage element pickup Group 1

AUXILIARY UV1 OP Auxiliary undervoltage element operation Group 1

AUXILIARY UV2 BLOCK Auxiliary undervoltage element block Group 2

AUXILIARY UV2 PKP Auxiliary undervoltage element pickup Group 2

AUXILIARY UV2 OP Auxiliary undervoltage element operation Group 2

AUXILIARY UV3 BLOCK Auxiliary undervoltage element block Group 3

AUXILIARY UV3 PKP Auxiliary undervoltage element pickup Group 3

AUXILIARY UV3 OP Auxiliary undervoltage element operation Group 3
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Auxiliary OV

AUXILIARY OV1 BLOCK Auxiliary overvoltage element block Group 1

AUXILIARY OV1 PKP Auxiliary Overvoltage element pickup Group 1

AUXILIARY OV1 OP Auxiliary overvoltage element operation Group 1

AUXILIARY OV2 BLOCK Auxiliary overvoltage element block Group 2

AUXILIARY OV2 PKP Auxiliary Overvoltage element pickup Group 2

AUXILIARY OV2 OP Auxiliary overvoltage element operation Group 2

AUXILIARY OV3 BLOCK Auxiliary overvoltage element block Group 3

AUXILIARY OV3 PKP Auxiliary Overvoltage element pickup Group 3

AUXILIARY OV3 OP Auxiliary overvoltage element operation Group 3

Negative Sequence OV

NEG SEQ OV1 BLOCK Negative sequence overvoltage element block Group 1

NEG SEQ OV1 PKP Negative sequence overvoltage element pickup Group 1

NEG SEQ OV1 OP Negative sequence overvoltage element operation 
Group 1

NEG SEQ OV2 BLOCK Negative sequence overvoltage element block Group 2

NEG SEQ OV2 PKP Negative sequence overvoltage element pickup Group 2

NEG SEQ OV2 OP Negative sequence overvoltage element operation 
Group 2

NEG SEQ OV3 BLOCK Negative sequence overvoltage element block Group 3

NEG SEQ OV3 PKP Negative sequence overvoltage element pickup Group 3

NEG SEQ OV3 OP Negative sequence overvoltage element operation 
Group 3

Overfrequency 

OVERFREQ1 BLOCK Overfrequency element block Group 1

OVERFREQ1 PKP Overfrequency element pickup Group 1

OVERFREQ1 OP Overfrequency element operation Group 1

OVERFREQ2 BLOCK Overfrequency element block Group 2

OVERFREQ2 PKP Overfrequency element pickup Group 2

OVERFREQ2 OP Overfrequency element operation Group 2

OVERFREQ3 BLOCK Overfrequency element block Group 3

OVERFREQ3 PKP Overfrequency element pickup Group 3

OVERFREQ3 OP Overfrequency element operation Group 3
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Underfrequency 

UNDERFREQ1 BLOCK Underfrequency element block Group 1

UNDERFREQ1 PKP Underfrequency element pickup Group 1

UNDERFREQ1 OP Underfrequency element operation Group 1

UNDERFREQ2 BLOCK Underfrequency element block Group 2

UNDERFREQ2 PKP Underfrequency element pickup Group 2

UNDERFREQ2 OP Underfrequency element operation Group 2

UNDERFREQ3 BLOCK Underfrequency element block Group 3

UNDERFREQ3 PKP Underfrequency element pickup Group 3

UNDERFREQ3 OP Underfrequency element operation Group 3

Frequency rate of change 

FREQ RATE1 BLOCK Frequency rate of change element block Group 1

FREQ RATE1 PKP Frequency rate of change element pickup Group 1

FREQ RATE1 OP Frequency rate of change element operation Group 1

FREQ RATE2 BLOCK Frequency rate of change element block Group 2

FREQ RATE2 PKP Frequency rate of change element pickup Group 2

FREQ RATE2 OP Frequency rate of change element operation Group 2

FREQ RATE3 BLOCK Frequency rate of change element block Group 3

FREQ RATE3 PKP Frequency rate of change element pickup Group 3

FREQ RATE3 OP Frequency rate of change element operation Group 3

 Broken Conductor

BROKEN CONDUCT1 
BLK Broken conductor block Group 1

BROKEN CONDUCT1 
PKP Broken conductor element Pickup Group 1

BROKEN CONDUCT1 
OP Broken conductor element operation Group 1

BROKEN CONDUCT2 
BLK Broken conductor block Group 2

BROKEN CONDUCT2 
PKP Broken conductor element Pickup Group 2

BROKEN CONDUCT2 
OP Broken conductor element operation Group 2

BROKEN CONDUCT3 
BLK Broken conductor block Group 3

BROKEN CONDUCT3 
PKP Broken conductor element Pickup Group 3

BROKEN CONDUCT3 
OP Broken conductor element operation Group 3
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Forward Power (32FP)

FWD PWR1 BLOCK Forward power element block Group 1

FWD PWR1 STG1 PKP Forward Power element pickup level 1 Group 1

FWD PWR1 STG1 OP Forward Power element operation level 1 Group 1

FWD PWR1 STG2 PKP Forward Power element pickup level 2 Group 1

FWD PWR1 STG2 OP Forward Power element operation level 2 Group 1

FWD PWR2 BLOCK Forward power element block Group 2

FWD PWR2 STG1 PKP Forward Power element pickup level 1 Group 2

FWD PWR2 STG1 OP Forward Power element operation level 1 Group 2

FWD PWR2 STG2 PKP Forward Power element pickup level 2 Group 2

FWD PWR2 STG2 OP Forward Power element operation level 2 Group 2

FWD PWR3 BLOCK Forward power element block Group 3

FWD PWR3 STG1 PKP Forward Power element pickup level 1 Group 3

FWD PWR3 STG1 OP Forward Power element operation level 1 Group 3

FWD PWR3 STG2 PKP Forward Power element pickup level 2 Group 3

FWD PWR3 STG2 OP Forward Power element operation level 2 Group 3

KI2t PHASE A ALARM K·I2t phase A Alarm

KI2t PHASE B ALARM K·I2t phase B Alarm

KI2t PHASE C ALARM K·I2t phase C Alarm

Breaker Maintenance BKR OPENINGS 
ALARM Maximum Breaker openings alarm

BKR OPEN 1 HOUR 
ALRM Maximum Breaker openings in one hour alarm 

RESET KI2t 
COUNTERS KI2t Breaker ageing counter reset 

RESET BKR 
COUNTERS Breaker openings and closings counters reset 

 Breaker Status

BREAKER OPEN Breaker Opened

BREAKER CLOSED Breaker closed

BREAKER UNDEFINED Breaker undefined (52a and 52b have the same status) 

Breaker Failure

BKR FAIL INITIATE Breaker failure initiation

BKR FAIL NO 
CURRENT Breaker failure without current

BKR FAIL 
SUPERVISION Breaker failure 1st level (supervision – retrip)

BKR FAIL HISET Breaker failure 2nd level (high level)

BKR FAIL LOWSET Breaker failure 3rd level (low level)

INTERNAL ARC Internal arc

BKR FAIL 2nd STEP Breaker failure second step
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Synchrocheck

Synchrocheck BLK INP Synchronism element block

Synchrocheck OP Synchronsim condition (Dv, Dj and Df are within the set 
range)

SYNCHK CLOSE PERM Closing permission for the synchronism element: 
(SYNCHK OP) OR (SYNCHK CON OP)

Synchrocheck COND 
OP

Active if when it is set, any of the three following 
conditions is met:

DL-DB OPERATION Dead line – dead bus condition

DL-LB OPERATION Dead line – live bus condition

LL-DB OPERATION Live line – dead bus condition

SLIP CONDITION Slip conditions are met

BUS FREQ > LINE 
FREQ Bus Frequency higher than line frequency 

BUS FREQ < LINE 
FREQ Bus Frequency lower than line frequency

Autorecloser

AR LEVEL BLOCK Recloser element block by level 

AR PULSE BLOCK Recloser element block by pulse

AR PULSE UNBLOCK Recloser element unblock by pulse

AR INITIATE Reclose initiate

AR CONDS INPUT Reclose permission condition in input to Function 1 = 
there are conditions 

AR CLOSE BREAKER Closing permission for the recloser 

AR OUT OF SERVICE Recloser out of service

AR READY Recloser READY

AR LOCKOUT Recloser in LOCKOUT

AR BLOCK Recloser BLOCKed

AR RCL IN PROGRESS Recloser – Cycle in progress

AR LCK BY ANOMALY Recloser – LOCKOUT by anomaly (reclosing command 
during cycle in progress)

AR LCK BY FAIL OPEN Recloser – LOCKOUT by failure to open

AR LCK BY FAIL CLOSE Recloser – LOCKOUT by failure to close

AR LCK BY USER Recloser – LOCKOUT by external operation (e.g.: 
manual opening with cycle in progress)

AR LCK BY CONDS Recloser – LOCKOUT by lack of reclosing conditions 

AR LCK BY TRIPS Recloser – LOCKOUT by number of trips

AR LCK BY SHOTS Recloser – LOCKOUT by number of shots

AR BLK AFTER 1 SHOT Recloser – Block after first shot

AR BLK AFTER 2 SHOT Recloser – Block after second shot

AR BLK AFTER 3 SHOT Recloser – Block after third shot

AR BLK AFTER 4 SHOT Recloser – Block after fourth shot
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Autorecloser
AR BLOCK BY LEVEL Recloser – Block by level

AR BLOCK BY PULSE Recloser – Block by command (pulse)

Default Channel (not used) Default Channel Channel not used

Directional Power

DIR PWR1 BLOCK Directional power element block Group 1

DIR PWR1 STG1 PKP Directional Power element pickup level 1 Group 1

DIR PWR1 STG1 OP Directional Power element operation level 1 Group 1

DIR PWR1 STG2 PKP Directional Power element pickup level 2 Group 1

DIR PWR1 STG2 OP Directional Power element operation level 2 Group 1

DIR PWR1 STG PKP Directional power element pickup Group 1

DIR PWR1 STG OP Directional Power element operation Group 1

DIR PWR2 BLOCK Directional power element block Group 2

DIR PWR2 STG1 PKP Directional Power element pickup level 1 Group 2

DIR PWR2 STG1 OP Directional Power element operation level 1 Group 2

DIR PWR2 STG2 PKP Directional Power element pickup level 2 Group 2

DIR PWR2 STG2 OP Directional Power element operation level 2 Group 2

DIR PWR2 STG PKP Directional power element pickup Group 2

DIR PWR2 STG OP Directional Power element operation Group 2

DIR PWR3 BLOCK Directional power element block Group 3

DIR PWR3 STG1 PKP Directional Power element pickup level 1 Group 3

DIR PWR3 STG1 OP Directional Power element operation level 1 Group 3

DIR PWR3 STG2 PKP Directional Power element pickup level 2 Group 3

DIR PWR3 STG2 OP Directional Power element operation level 2 Group 3

DIR PWR3 STG PKP Directional power element pickup Group 3

DIR PWR3 STG OP Directional Power element operation Group 3

Locked Rotor

LOCKED ROTOR1 BLK Locked rotor element block Group 1

LOCKED ROTOR1 PKP Locked rotor element pickup Group 1

LOCKED ROTOR1 OP Locked rotor element operation Group 1

LOCKED ROTOR2 BLK Locked rotor element block Group 2

LOCKED ROTOR2 PKP Locked rotor element pickup Group 2

LOCKED ROTOR2 OP Locked rotor element operation Group 2

LOCKED ROTOR3 BLK Locked rotor element block Group 3

LOCKED ROTOR3 PKP Locked rotor element pickup Group 3

LOCKED ROTOR3 OP Locked rotor element operation Group 3
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INTERNAL SYSTEM STATUS (CONT.)

Pulse Counters

PulseCntr Value 1 Pulse counter element value Group 1

PulseCntr Value 2 Pulse counter element value Group 2

... ...

PulseCntr Value 8 Pulse counter element value Group 8

PulseCntr Freeze 1 Pulse counter element freeze value Group 1

PulseCntr Freeze 2 Pulse counter element freeze value Group 2

... ...

PulseCntr Freeze 8 Pulse counter element freeze value Group 8

Analog comparators

Analog Level 01 Analog comparator element level Group 1

Analog Level 02 Analog comparator element level Group 2

... ...

Analog Level 20 Analog comparator element level Group 20

Load Encroachment

LOAD ENCR1 BLK Load Encroachment element block Group 1

LOAD ENCR1 PKP Load Encroachment element pickup Group 1

LOAD ENCR1 OP Load Encroachment element operation Group 1

LOAD ENCR2 BLK Load Encroachment element block Group 2

LOAD ENCR2 PKP Load Encroachment element pickup Group 2

LOAD ENCR2 OP Load Encroachment element operation Group 2

LOAD ENCR3 BLK Load Encroachment element block Group 3

LOAD ENCR3 PKP Load Encroachment element pickup Group 3

LOAD ENCR3 OP Load Encroachment element operation Group 3
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INTERNAL SYSTEM STATUS (CONT.)

wattmetric Ground Fault High (Logic Operands)

32N1 HIGH BLOCK wattmetric Ground Fault Element Block High Level 
Group 1

32N1 HIGH PKP wattmetric Ground Fault Element Global Pickup (current, 
voltage and power) High Level Group 1

32N1 HIGH OC PKP wattmetric Ground Fault Element Overcurrent Pickup  
High Level Group 1

32N1 HIGH OP wattmetric Ground Fault Element Operation High Level 
Group 1

32N2 HIGH BLOCK wattmetric Ground Fault Element Block High Level 
Group 2

32N2 HIGH PKP wattmetric Ground Fault Element Global Pickup (current, 
voltage and power) High Level Group 2

32N2 HIGH OC PKP wattmetric Ground Fault Element Overcurrent Pickup  
High Level Group 2

32N2 HIGH OP wattmetric Ground Fault Element Operation High Level 
Group 2

32N3 HIGH BLOCK wattmetric Ground Fault Element Block High Level 
Group 3

32N3 HIGH PKP wattmetric Ground Fault Element Global Pickup (current, 
voltage and power) High Level Group 3

32N3 HIGH OC PKP wattmetric Ground Fault Element Overcurrent Pickup  
High Level Group 3

32N3 HIGH OP wattmetric Ground Fault Element Operation High Level 
Group 3

wattmetric Ground Fault High (Power 
Measurements)

32N1 HIGH POWER wattmetric Ground Fault Element High Level Group 1 
Power Value (watts)

32N2 HIGH POWER wattmetric Ground Fault Element High Level Group 2 
Power Value (watts)

32N3 HIGH POWER wattmetric Ground Fault Element High Level Group 3 
Power Value (watts)
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INTERNAL SYSTEM STATUS (CONT.)

wattmetric Ground Fault Low (Logic Operands)

32N1 LOW BLOCK wattmetric Ground Fault Element Block Low Level 
Group 1

32N1 LOW PKP wattmetric Ground Fault Element Global Pickup (current, 
voltage and power) Low Level Group 1

32N1 LOW OC PKP wattmetric Ground Fault Element Overcurrent Pickup  
Low Level Group 1

32N1 LOW OP wattmetric Ground Fault Element Operation Low Level 
Group 1

32N2 LOW BLOCK wattmetric Ground Fault Element Block Low Level 
Group 2

32N2 LOW PKP wattmetric Ground Fault Element Global Pickup (current, 
voltage and power) Low Level Group 2

32N2 LOW OC PKP wattmetric Ground Fault Element Overcurrent Pickup  
Low Level Group 2

32N2 LOW OP wattmetric Ground Fault Element Operation Low Level 
Group 2

32N3 LOW BLOCK wattmetric Ground Fault Element Block Low Level 
Group 3

32N3 LOW PKP wattmetric Ground Fault Element Global Pickup (current, 
voltage and power) Low Level Group 3

32N3 LOW OC PKP wattmetric Ground Fault Element Overcurrent Pickup  
Low Level Group 3

32N3 LOW OP wattmetric Ground Fault Element Operation Low Level 
Group 3

wattmetric Ground Fault Low  (Power 
Measurements)

32N1 LOW POWER wattmetric Ground Fault Element Low Level Group 1 
Power Value (watts)

32N2 LOW POWER wattmetric Ground Fault Element Low Level Group 2 
Power Value (watts)

32N3 LOW POWER wattmetric Ground Fault Element Low Level Group 3 
Power Value (watts)
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INTERNAL SYSTEM STATUS (CONT.)

Remote Outputs

DNA 1 1 output on. Remote Output DNA 1 Operation (GSSE/
GOOSE)

DNA 2 1 output on. Remote Output DNA 2 Operation (GSSE/
GOOSE)

... ...

DNA 32 1 output on. Remote Output DNA 32 Operation (GSSE/
GOOSE)

User St 1 1 output on. Remote Output UserSt 1 Operation (GSSE/
GOOSE)

User St  2 1 output on. Remote Output UserSt 2 Operation (GSSE/
GOOSE)

... ...

User St 64 1 output on. Remote Output UserSt 64 Operation 
(GSSE/GOOSE)

Rem GOOSE Dig Out 1 1 output on. Remote Output GOOSE 1 Operation 
(GOOSE)

Rem GOOSE Dig Out 2 1 output on. Remote Output GOOSE 2 Operation 
(GOOSE)

... ...

Rem GOOSE Dig Out 32 1 output on. Remote Output GOOSE 32 Operation 
(GOOSE)

Remote Inputs

Remote Input 1 Flag is set, logic =1 

Remote Input 2 Flag is set, logic =1 

... ...

Remote Input 32 Flag is set, logic =1 

Remote Devices

Remote Device 1 Flag is set, logic =1 

Remote Device 2 Flag is set, logic =1 

... ...

Remote Device 16 Flag is set, logic =1 

GOOSE DIG INPUTS

Rem GOOSE Dig Input 1 Flag is set, logic = 1

Rem GOOSE Dig Input 2 Flag is set, logic =1 

... ...

Rem GOOSE Dig Input 
32 Flag is set, logic =1 

GOOSE Analog Inputs (FLOAT AND INTEGER)

Rem Ana Inp FLOAT 1 Analog Input 1 (Float type)

Rem Ana Inp FLOAT 2 Analog Input 2 (Float type)

... ...

Rem Ana Inp FLOAT 8 Analog Input 8 (Float type)

Rem Ana Inp INT 1 Analog Input 1 (Integer type)

Rem Ana Inp INT 2 Analog Input 2 (Integer type)

... ...

Rem Ana Inp INT 8 Analog Input 8 (Integer type)
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APPENDIX B FACTORY DEFAULT LOGICB.1 FACTORY DEFAULT LOGIC

OR3
10

OR3
11

LEDS AND OUTPUTS BOOLEANS

PICKUPS

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VO_050_50PL_PKP
42

VO_051_50PH_PKP
43

VO_053_51P_PKP
44

PH IOC1 LOW PKP
102

PH IOC2 LOW PKP
103

PH IOC3 LOW PKP
104

PH IOC1 HIGH PKP
105

PH IOC2 HIGH PKP
106

PH IOC3 HIGH PKP
107

PH TOC1 HIGH PKP
108

PH TOC2 HIGH PKP
109

PH TOC3 HIGH PKP
110

THERMAL1 ALARM
186

THERMAL2 ALARM
187

THERMAL3 ALARM
188

OR3
189

OR3

inOR1

inOR2

inOR3

200

OR3

outOR1

201

NEUTRAL IOC1 PKP
202

NEUTRAL IOC2 PKP
203

NEUTRAL IOC3 PKP
204

NEUTRAL TOC1 PKP
205

NEUTRAL TOC2 PKP
206

VO_004_50N_PKP
207

VO_005_51N_PKP
208

VO_001_THERMAL_ALARM
214

VO_050_50PL_PKP
215

VO_051_50PH_PKP
216

VO_053_51P_PKP
217

VO_007_PHASE_OVERCURRENT_PKP
218

OR

inOR1

inOR2

219
VO_005_51N_PKP
220

inOR3

VO_004_50N_PKP

outOR1

221 VO_008_NEUTRAL_OVERCURRENT_PKP
222

inOR1

inOR2

inOR3

outOR1

OR3
310

PH TOC1 LOW PKP
320

PH TOC2 LOW PKP
321

PH TOC3 LOW PKP
322

OR6
323

OVERCURRENT
PICKUPS

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

inOR4

inOR5

inOR6

outOR1

NEUTRAL TOC3 PKP
405

GE Power Management F650_F2G1_6_1_V340.aut (MAIN) EnerVista 650 Setup
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B

OR3
0

OR3
1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

OVERCURRENT
PICKUPS

VO_048_50G_PKP
40

VO_049_51G_PKP
41

GROUND IOC1 PKP
96

GROUND IOC2 PKP
97

GROUND IOC3 PKP
98

GROUND TOC1 PKP
99

GROUND TOC2 PKP
100

GROUND TOC3 PKP
101

OR3
175

VO_043_50IG_PKP
176ISOLATED GND1 PKP

177

ISOLATED GND2 PKP
178

ISOLATED GND3 PKP
179

OR3
190

OR3
191

SENS GND IOC1 PKP
192

SENS GND IOC2 PKP
193

SENS GND IOC3 PKP
194

SENS GND TOC1 PKP
195

SENS GND TOC2 PKP
196

SENS GND TOC3 PKP
197

VO_002_50SG_PKP
198

VO_003_51SG_PKP
199

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

OR3
209NEG SEQ TOC1 PKP

210

NEG SEQ TOC2 PKP
211

NEG SEQ TOC3 PKP
212

VO_006_I2_TOC_PKP
213

OR
223

VO_049_51G_PKP
224

VO_009_GROUND_OVERCURRENT_PK
225

VO_048_50G_PKP
226

VO_002_50SG_PKP
227

VO_003_51SG_PKP
228

VO_043_50IG_PKP
229

OR3
230

VO_010_SENSITIVE_GROUND_
231

inOR1

VO_007_PHASE_OVERCURRENT_PKP

inOR2

233

VO_008_NEUTRAL_OVERCURRENT_PKP

inOR3

outOR1

234

235

inOR1

inOR2

inOR3

outOR1

OR6
312

inOR1 outOR1

GE Power Management F650_F2G1_6_1_V340.aut (MAIN) EnerVista 650
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B

OR3
2

OR3
3

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VOLTAGE
PICKUPS

VO_045_27P_PKP
38

VO_046_59P_PKP
39

PHASE UV1 PKP
90

PHASE UV2 PKP
91

PHASE UV3 PKP
92

PHASE OV1 PKP
93

PHASE OV2 PKP
94

PHASE OV3 PKP
95

OR3
238NEUTRAL OV1 HIGH PKP

239

NEUTRAL OV2 HIGH PKP
240

NEUTRAL OV3 HIGH PKP
241

NEUTRAL OV1 LOW PKP
242

NEUTRAL OV2 LOW PKP
243

NEUTRAL OV3 LOW PKP
244

AUXILIARY UV1 PKP
245

AUXILIARY UV2 PKP
246

AUXILIARY UV3 PKP
247

AUXILIARY OV1 PKP
248

AUXILIARY OV2 PKP
249

AUXILIARY OV3 PKP
250

NEG SEQ OV1 PKP
251

NEG SEQ OV2 PKP
252

NEG SEQ OV3 PKP
253

OR3
254

OR3
255

OR3
256

OR3
257

VO_012_59NH_PKP
258

VO_013_59NL_PKP
259

VO_014_27X_PKP
260

VO_015_59X_PKP
261

VO_016_V2_OV_PKP
262

VO_017_ALL_VOLTAGE_PKP
263

VO_012_59NH_PKP
264

VO_013_59NL_PKP
265

VO_014_27X_PKP
266

267

VO_045_27P_PKP
269

VO_046_59P_PKP
270

OR7
271

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

InOR1

InOR2

InOR3

InOR4

InOR5

OutOR1
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OR3
25

OR3
26

FREQUENCY
PICKUPS

VO_054_81O_PKP
45

inOR1

VO_055_81U_PKP

inOR2

46

inOR3

VO_054_81O_PKP

outOR1

47

VO_055_81U_PKP
48

inOR1

VO_056_ALL_FREQUENCY_PKP
49

inOR2

inOR3

outOR1

OVERFREQ1 PKP
111

OVERFREQ2 PKP
112

OVERFREQ3 PKP
113

UNDERFREQ1 PKP
114

UNDERFREQ2 PKP
115

UNDERFREQ3 PKP
116

BROKEN
CONDUCTOR

OR3
273BROKEN CONDUCT1 PKP

274

BROKEN CONDUCT2 PKP
275

BROKEN CONDUCT3 PKP
276

VO_018_BROKEN_CONDUCTOR_PKP
277

inOR1

inOR2

inOR3

outOR1

OR6
346

FWD PWR1 STG1 PKP
347

FWD PWR1 STG2 PKP
348

FWD PWR2 STG1 PKP
349

FWD PWR2 STG2 PKP
350

inOR1

FWD PWR3 STG1 PKP

inOR2

351

inOR3

FWD PWR3 STG2 PKP

inOR4

inOR5

352 inOR6

VO_023_FORWARD_POWER_PKP
outOR1

353

FORWARD
POWER

DIRECTIONAL
POWER

VO_025_DIRECTIONAL_POWER_PKP
370

DIR PWR2 STG PKP
371

DIR PWR3 STG PKP
372

OR3
373

inOR1

inOR2

inOR3

outOR1

DIR PWR1 STG PKP
390

OR3
409

FREQ RATE1 PKP
410

FREQ RATE2 PKP
411

FREQ RATE3 PKP
412

VO_052_81DF-DT PKP
413

OR3
414

VO_052_81DF-DT PKP
415

inOR1

inOR2

inOR1

inOR3

outOR1

inOR2

inOR3

outOR1

WATTIMETRIC
GROUND

FAULT
OVERCURRENT

PKP

OR3
454

OR3
455

VO_094_32N_HIGH_OC_PKP
456

VO_095_32N_LOW_OC_PKP
457

32N1 HIGH OC PKP
458

32N2 HIGH OC PKP
459

32N3 HIGH OC PKP
460

32N1 LOW OC PKP
461

32N2 LOW OC PKP
462

32N3 LOW OC PKP
463

inOR1

inOR2

inOR3

outOR1

AUXILIARY SIGNALS (NOT INCLUDED IN GENERAL POWER PKP)

inOR1

inOR2

inOR3

outOR1
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B

VO_085_GENER
89

VO_011_ALL_OVERCURRENT_PKP
278

VO_017_ALL_VOLTAGE_PKP
279

VO_056_ALL_FREQUENCY_PKP
280

VO_018_BROKEN_CONDUCTOR_PKP
281

GENERAL
PICKUP

VO_023_FORWARD_POWER_PKP
374

VO_025_DIRECTIONAL_POWER_PKP
375

POWER

VO_026_POWER_PK
377

VO_026_POWER_PKP
378

LOCKED
ROTOR

OR3
392

LOCKED ROTOR1 PKP
393

LOCKED ROTOR2 PKP
394

LOCKED ROTOR3 PKP
395

VO_029_LOCKED_ROTO
396

inOR1

inOR2

inOR3

outOR1

VO_029_LOCKED_ROTOR_PKP
404

LOAD
ENCROACHMENT

PICKUP

OR3
417

LOAD ENCR1 PKP
418

LOAD ENCR2 PKP
419

LOAD ENCR3 PKP
420

VO_031_LOAD_ENCROAC
421

VO_031_LOAD_ENCROACHMENT_PKP
422

OR7InOR1

InOR2

InOR3

423

InOR4

InOR5

InOR6

InOR7

inOR1

OutOR1

inOR2

inOR3

outOR1

WATTIMETRIC
GROUND

FAULT PKP

OR3
443

32N1 HIGH PKP
444

32N2 HIGH PKP
445 inOR1

32N3 HIGH PKP
inOR2

inOR3

outOR1

446

32N1 LOW PKP
447

32N2 LOW PKP
448

32N3 LOW PKP
449

OR3
450

VO_092_32N_HIGH_PKP
451

VO_093_32N_LOW_PKP
inOR1

inOR2

inOR3

outOR1

452
WATTIMETRIC

GROUND
FAULT PKP

VO_092_32N_HIGH_PKP
466

VO_093_32N_LOW_PKP
467

OR4inOR1

inOR2

inOR3

inOR4

outOR1

468
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OR3
7

OR3
8

OR
9

OR3
12

OR3
13

inOR1

inOR2

TRIPS

inOR3

OR3

outOR1

inOR1

inOR2

31

inOR3

OVERCURRENT
TRIPS

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VO_057_51P_TRIP
50

VO_058_50PH_TRIP
51

VO_059_50PL_TRIP
52

VO_062_THERMAL_TRIP
54

VO_064_50N_TRIP
55

VO_065_51N_TRIP
56

VO_066_NEUTRAL_OVERCURRENT_TRIP
57VO_064_50N_TRIP

58

59

PH TOC1 HIGH OP
117

PH TOC2 HIGH OP
118

PH TOC3 HIGH OP
119

PH IOC1 HIGH OP
120

PH IOC2 HIGH OP
121

PH IOC3 HIGH OP
122

PH IOC1 LOW OP
123

PH IOC2 LOW OP
124

PH IOC3 LOW OP
125

THERMAL1 OP
129

THERMAL2 OP
130

THERMAL3 OP
131

NEUTRAL IOC1 OP
132

NEUTRAL IOC2 OP
133

NEUTRAL IOC3 OP
134

NEUTRAL TOC1 OP
135

NEUTRAL TOC3 OP
136
NEUTRAL TOC2 OP
137

VO_019_PHASE_OVERCURRENT_TRIP
283VO_057_51P_TRIP

284

VO_058_50PH_TRIP
285

VO_059_50PL_TRIP
286

OR3
311

OR6
316

PH TOC1 LOW OP
317

PH TOC2 LOW OP
318

PH TOC3 LOW OP
319

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

inOR4

inOR5

inOR6

outOR1
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OR3
4

inOR1

inOR2

inOR3

outOR1

OR3
15

OR
16

OR3
17

OR3
18

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VO_061_I2_TOC_TRIP
53

VO_068_50G_TRIP
61

VO_069_GROUND_OVERCURRENT
62VO_067_51G_TRIP

63

VO_068_50G_TRIP
64

VO_070_51SG_TRIP
65

VO_071_50SG_TRIP
66

VO_072_SENSITIVE_GROU
67VO_070_51SG_TRIP

68

VO_071_50SG_TRIP
69

NEG SEQ TOC1 OP
126

NEG SEQ TOC2 OP
127

NEG SEQ TOC3 OP
128

GROUND IOC1 OP
138

GROUND IOC2 OP
139

GROUND IOC3 OP
140

SENS GND IOC1 OP
144

SENS GND IOC2 OP
145

SENS GND IOC3 OP
146

SENS GND TOC1 OP
147

SENS GND TOC2 OP
148

SENS GND TOC3 OP
149

OR3
174

OR3
180ISOLATED GND1 OP

181

ISOLATED GND2 OP
182

ISOLATED GND3 OP
183

VO_044_50IG_TRIP
184

VO_044_50IG_TRIP
185

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VO_020_ALL_OVERCURREN
287

VO_019_PHASE_OVERCURRENT_TRIP
288

VO_066_NEUTRAL_OVERCURRENT_TRIP
289

VO_069_GROUND_OVERCURRENT_TRIP
290

VO_072_SENSITIVE_GROUND_TRIP
291

VO_061_I2_TOC_TRIP
292

OR6
314

VO_062_THERMAL_TRIP
315

inOR1

inOR2

inOR3

inOR4

inOR5

inOR6

outOR1

OVERCURRENT
TRIPS
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OR3
5

OR3
6

inOR1

inOR2

inOR3

outOR1

OR3

inOR1

inOR2

19

inOR3

OR3

outOR1

20

OR3
21

OR3
22

VOLTAGE
TRIPS

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VO_073_27P_TRIP
70

VO_074_59P_TRIP
71

VO_075_59NH_TRIP
72

VO_076_59NL_TRIP
73

VO_077_59X_TRIP
74

VO_078_27X_TRIP
75

76

VO_073_27P_TRIP
77

VO_074_59P_TRIP
78

VO_075_59NH_TRIP
79

80

VO_078_27X_TRIP
82

PHASE UV1 OP
150

PHASE UV2 OP
151

PHASE UV3 OP
152

PHASE OV1 OP
153

PHASE OV2 OP
154

PHASE OV3 OP
155

NEUTRAL OV1 HIGH OP
156

NEUTRAL OV2 HIGH OP
157

NEUTRAL OV3 HIGH OP
158

NEUTRAL OV1 LOW OP
159

NEUTRAL OV2 LOW OP
160

NEUTRAL OV3 LOW OP
161

AUXILIARY OV1 OP
162

AUXILIARY OV2 OP
163

AUXILIARY OV3 OP
164

AUXILIARY UV1 OP
165

AUXILIARY UV2 OP
166

AUXILIARY UV3 OP
167

OR3
293NEG SEQ OV1 OP

294

NEG SEQ OV2 OP
295

NEG SEQ OV3 OP
296

VO_021_V2_OV_TRIP
297

OR7
299

inOR1

inOR2

inOR3

outOR1

InOR1

InOR2

InOR3

InOR4

I OR5

OutOR1
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OR3
33

FREQUENCY
TRIPS

OR3
36

inOR1

inOR2

inOR3

outOR1

inOR1

inOR2

inOR3

outOR1

VO_080_81O_TRIP
83

VO_081_81U_TRIP
84

VO_082_ALL_FREQUENCY_TRIP
85

VO_080_81O_TRIP
86

VO_081_81U_TRIP
87

OVERFREQ1 OP
168

OVERFREQ2 OP
169

OVERFREQ3 OP
170

UNDERFREQ1 OP
171

UNDERFREQ2 OP
172

UNDERFREQ3 OP
173

BROKEN
CONDUCTOR

OR3
301BROKEN CONDUCT1 OP

302

BROKEN CONDUCT2 OP
303

BROKEN CONDUCT3 OP
304

VO_022_BROKEN_CONDUCTOR_
305

inOR1

inOR2

inOR3

outOR1

FORWARD
POWER

OR6
356

FWD PWR1 STG1 OP
357

FWD PWR1 STG2 OP
358

FWD PWR2 STG1 OP
359

FWD PWR2 STG2 OP
360

FWD PWR3 STG1 OP
361

FWD PWR3 STG2 OP

inOR1

inOR2

362

inOR3

VO_024_FORWARD_POWER_

inOR4

inOR5

363

inOR6

outOR1

DIRECTIONAL
POWER

DIR PWR1 STG OP
380

DIR PWR2 STG OP
381

DIR PWR3 STG OP
382

OR3
383

VO_027_DIRECTIONAL_POWE
384

inOR1

inOR2

inOR3

outOR1

OR3
427

OR3
428

inOR1
FREQ RATE1 OP

inOR2

inOR3

429

FREQ RATE2 OP
outOR1430

FREQ RATE3 OP
431

VO_060_81DF-DT OP
432

inOR1

VO_060_81DF-DT OP
inOR2

inOR3

outOR1

433

OR3
470

32N1 HIGH OP
471

32N2 HIGH OP
472 inOR1

VO_096_32N_HIGH_TRIP
outOR1

474

GE Power Management F650_F2G1_6_1_V340.aut (MAIN) EnerVista 6



B-10 F650 Digital Bay Controller GEK-113000Z

B.1 FACTORY DEFAULT LOGIC APPENDIX B 

B

GENERAL
TRIP

VO_083_GENERAL_
88

VO_020_ALL_OVERCURRENT_TRIP
306

VO_022_BROKEN_CONDUCTOR_TRIP
307

VO_079_ALL_VOLTAGE_TRIP
308

VO_082_ALL_FREQUENCY_TRIP
309

POWER

VO_024_FORWARD_POWER_TRIP
386

VO_027_DIRECTIONAL_POWER_TRIP
387

VO_028_POWER_TRIP
388

VO_028_POWER_TRIP
389

LOCKED
ROTOR

OR3
398

LOCKED ROTOR1 OP
399

LOCKED ROTOR2 OP
400

LOCKED ROTOR3 OP
401

VO_030_LOCKED_ROTOR_TR
402

VO_030_LOCKED_ROTOR_TRIP
403

inOR1

inOR2

inOR3

outOR1

LOAD
ENCROACHMENT

TRIP

LOAD ENCR1 OP
435

LOAD ENCR2 OP
436

LOAD ENCR3 OP
437

OR3
438

VO_032_LOAD_ENCROACHM
439

OR7

inOR1

inOR2

inOR3

outOR1

440

InOR1

VO_032_LOAD_ENCROACHMENT_TRIP

InOR2

InOR3

441

InOR4

InOR5

InOR6

InOR7

OutOR1

VO_096_32N_HIGH_TRIP
480

VO_097_32N_LOW_TRIP
481

OR4inOR1

inOR2

inOR3

inOR4

outOR1

482
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APPENDIX C FACTORY DEFAULT CONFIGURATIONC.1 FACTORY DEFAULT SETTINGS

PRODUCT SETUP>COMMUNICATION SETTINGS >SERIAL PORTS

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Baud rate for COM1 COM1 Baud Rate 19200 N/A [300 : 115200]

Baud rate for COM2 COM2 Baud Rate 19200 N/A [300 : 115200]

Parity for COM1 COM1 Parity NONE N/A [NONE:ODD:EVEN]

Parity for COM2 COM2 Parity NONE N/A [NONE:ODD:EVEN]

PRODUCT SETUP>COMMUNICATION SETTINGS >NETWORK (ETHERNET)

NETWORK (ETHERNET)1 > NETWORK (ETHERNET)2

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

1st octet of IP address IP Address Oct1 0 N/A [0 : 255]

2nd octet of IP address IP Address Oct2 0 N/A [0 : 255]

3rd octet of IP address IP Address Oct3 0 N/A [0 : 255]

4th octet of IP address IP Address Oct4 0 N/A [0 : 255]

1st octet of Netmask Netmask Oct1 0 N/A [0 : 255]

2nd octet of Netmask Netmask Oct2 0 N/A [0 : 255]

3rd octet of Netmask Netmask Oct3 0 N/A [0 : 255]

4th octet of Netmask Netmask Oct4 0 N/A [0 : 255]

1st octet of Gateway Gateway IP Oct1 0 N/A [0 : 255]

2nd octet of Gateway Gateway IP Oct2 0 N/A [0 : 255]

3rd octet of Gateway Gateway IP Oct3 0 N/A [0 : 255]

4th octet of Gateway Gateway IP Oct4 0 N/A [0 : 255]

PRODUCT SETUP>COMMUNICATION SETTINGS >MODBUS PROTOCOL

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Slave address for COM1 Modbus Address 
COM1 254 N/A [1 : 255]

Slave address for COM2 Modbus Address 
COM2 254 N/A [1 : 255]

Modbus port number for Modbus TCP/
IP Modbus Port Number 502 N/A [0 : 65535]
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PRODUCT SETUP>COMMUNICATION SETTINGS >DNP3 SLAVE

DNP3 SLAVE 1 > DNP3 SLAVE 2 > DNP3 SLAVE 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Communications port assigned to the 
DNP protocol Physical Port NONE N/A [COM1:COM2:NETWORK]

DNP slave address Address 255 N/A [0 : 65534]

1st Octect of IP address of DNP 
master 1 IP Addr Client1 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 1 IP Addr Client1 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 1 IP Addr Client1 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 1 IP Addr Client1 Oct4 0 N/A [0 : 255]

1st Octect of IP address of DNP 
master 2 IP Addr Client2 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 2 IP Addr Client2 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 2 IP Addr Client2 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 2 IP Addr Client2 Oct4 0 N/A [0 : 255]

1st Octect of IP address of DNP 
master 3 IP Addr Client3 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 3 IP Addr Client3 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 3 IP Addr Client3 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 3 IP Addr Client3 Oct4 0 N/A [0 : 255]

1st Octect of IP address of DNP 
master 4 IP Addr Client4 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 4 IP Addr Client4 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 4 IP Addr Client4 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 4 IP Addr Client4 Oct4 0 N/A [0 : 255]

1st Octect of IP address of DNP 
master 4 IP Addr Client5 Oct1 0 N/A [0 : 255]

2nd Octect of IP address of DNP 
master 4 IP Addr Client5 Oct2 0 N/A [0 : 255]

3nd Octect of IP address of DNP 
master 4 IP Addr Client5 Oct3 0 N/A [0 : 255]

4th Octect of IP address of DNP 
master 4 IP Addr Client5 Oct4 0 N/A [0 : 255]

TCP/UDP port number for DNP over 
Ethernet TCP/UDP Port 20000 N/A [0 : 65535]

Unsolicited responses permission Unsol Resp Function DISABLED N/A [DISABLED – ENABLED]

Time out to confirm an unsolicited 
response Unsol Resp TimeOut 5 1 s [0 : 60]

Number of retransmissions of an unsol 
resp w/o confirmation Unsol Resp Max Ret 10 N/A [0 : 255]

Address to which all unsolicited 
responses are sent Unsol Resp Dest Adr 200 N/A [0 : 65519]

Scale for currents Current Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]

Scale for voltages Voltage Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]
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PRODUCT SETUP>COMMUNICATION SETTINGS >DNP3 SLAVE (CONT.)

DNP3 SLAVE 1 > DNP3 SLAVE 2 > DNP3 SLAVE 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Scale for power Power Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]

Scale for energy Energy Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]

Other Scale factor Other Scale Factor 1 N/A [0.00001-0.0001-0.001-
0.01-0.1-1-10-100-1000]

Default deadband for Current Analog 
Input points to trigger unsolicited 
responses

Current Deadband 30000 N/A [0 : 65535]

Default deadband for Voltage Analog 
Input points to trigger unsolicited 
responses

Voltage Deadband 30000 N/A [0 : 65535]

Default deadband for Power Analog 
Input points to trigger unsolicited 
responses

Power Deadband 30000 N/A [0 : 65535]

Default deadband for Energy Analog 
Input points to trigger unsolicited 
responses

Energy Deadband 30000 N/A [0 : 65535]

Default deadband for Other Analog 
Input points to trigger unsolicited 
responses

Other Deadband 30000 N/A [0 : 65535]

Size (in bytes) for message 
fragmentation Msg Fragment Size 240 1 byte [30 : 2048]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 1 CTL EVENTS 1-16 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 2 CTL EVENTS 17-32 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 3 CTL EVENTS 33-48 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 4 CTL EVENTS 49-64 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 5 CTL EVENTS 65-80 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 6 CTL EVENTS 81-96 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 7 CTL EVENTS 97-

112 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 8 CTL EVENTS 113-

128 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 9 SWITCHGEAR 1-8 N/A [See DNP note2]

Size customization and change of 
DNP Binary Inputs point list Binary Input Block 10 SWITCHGEAR 9-

16 N/A [See DNP note2]

DNP NOTES

Note 1: Scale Factor Note that a scale factor of 0.1 is equivalent to a multiplier of 10 (i.e. the value will be 10 times 

Note 2: Binary Input Block Selection:
[NOT USED, CTL EVENTS 1-16, CTL EVENTS 17-32, CTL EVENTS 33-48,CTL EVENTS 49-
64, CTL EVENTS 65-80, CTL EVENTS 81-96, CTL EVENTS 97-112, CTL EVENTS 113-128, 
SWITCHGEAR 1-8, SWITCHGEAR 9-16]
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PRODUCT SETUP>COMMUNICATION SETTINGS >IEC 870-5-104

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Enable or disable the protocol 
operation Function DISABLED N/A [DISABLED – ENABLED]

Listening TCP port in the relay TCP Port 2404 N/A [0 : 65535]

Address in the ASDU header Common Addr of 
ASDU 255 N/A [0 : 65535]

Number of seconds for instantaneous 
metering Cyclic Meter Period 0 1 s [0 : 3600]

Not implemented Synchronization Event 0 N/A [0 : 3600]

IEC 870-5-104 NOTES

Note 1: Cyclic Meter Period 0 value means no spontaneous metering

PRODUCT SETUP>COMMUNICATION SETTINGS > SNTP

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Port used UDP port 123 1 [1 : 65535]

IP Address OCT 1 Server IP Oct 1 0 1 [1 : 255]

IP Address OCT 2 Server IP Oct 2 0 1 [1 : 255]

IP Address OCT 3 Server IP Oct 3 0 1 [1 : 255]

IP Address OCT 4 Server IP Oct 4 0 1 [1 : 255]

PRODUCT SETUP>COMMUNICATION SETTINGS >PROCOME

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Serial Remote Com Port selection COMM Port NONE [NONE – COM1]

Slave number for procome Slave Number 0 [0 : 254]
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SETPOINT > PRODUCT SETUP > MODBUS USER MAP

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Address 00 for Modbus user map Address 00 0 N/A [0000 : FFFF]

Address 01 for Modbus user map Address 01 0 N/A [0000 : FFFF]

... ... ...

Address 254 for Modbus user map Address 254 0 N/A [0000 : FFFF]

Address 255 for Modbus user map Address 255 0 N/A [0000 : FFFF]

SETPOINT > PRODUCT SETUP > FAULT REPORT

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Positive sequence impedance module Pos Seq Module 3.00 0.01 Ohm [0.01 : 250.00]

Positive sequence impedance angle Pos Seq Angle 75 1 Deg [25 : 90]

Zero sequence impedance module Zero Seq Module 9.00 0.01 Ohm [0.01 : 750.00]

Zero sequence impedance angle Zero Seq Angle 75 1 Deg [25 : 90]

Line length Line Length 100.0 0.1 [0.0 : 2000.0]

Display fault on HMI Show Fault On HMI DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PRODUCT SETUP > OSCILLOGRAPHY

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function Permission Function ENABLED N/A [DISABLED – ENABLED]

Prefault Trigger Position 30 1% [5 : 95]

Samples per cycle Samples/Cycle 64 N/A [4 – 8 – 16 –32 – 64]

Maximum number of oscillos Max. Number Osc. 4 1 oscillo [1 : 20]

Automatic oscillography overwrite Automatic Overwrite DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PRODUCT SETUP > DATA LOGGER

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Data logger Rate Data Logger Rate 1 s N/A [1 s, 5 min, 10 min, 15 min, 
20 min, 30 min, 60 min.]

Data Logger analog channels X Data Logger Chnl X None N/A [1 to 16]
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SETPOINT > PRODUCT SETUP > DEMAND

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Demand Function DISABLED N/A [DISABLED – ENABLED]

Demand method for current values CRNT Demand 
Method

THERMAL 
EXPONENTIAL N/A

[BLOCK INTERVAL -

ROLLING DEMAND -

THERMAL 
EXPONENTIAL]

Demand method for Power values POWER Demand 
Method

THERMAL 
EXPONENTIAL N/A

[BLOCK INTERVAL -

ROLLING DEMAND -

THERMAL 
EXPONENTIAL]

Demand interval Demand Interval 5 Minutes N/A [5 – 10 – 15 – 20– 30–60]

Trigger Enabled Trigger Enabled DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > SYSTEM SETUP > GENERAL SETTINGS

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Phase CT ratio Phase CT Ratio 1.0 0.1 [1.0 : 6000.0]

Ground CT ratio Ground CT Ratio 1.0 0.1 [1.0 : 6000.0]

Sensitive ground CT ratio Stv Ground CT Ratio 1.0 0.1 [1.0 : 6000.0]

Phase VT ratio Phase VT Ratio 1.0 0.1 [1.0 : 6000.0]

Phase VT connection Phase VT Connection WYE N/A [WYE – DELTA]

Rated voltage Nominal Voltage 100.0 0.1 [1.0 : 250.0]

Rated Frequency Nominal Frequency 50 Hz Hz [50-60]

Phase rotation Phase Rotation ABC N/A [ABC – ACB]

Frequency reference Frequency Reference VI N/A [VI-VII-VIII]

Auxiliary Voltage Auxiliary Voltage VX N/A [VX – VN]

Snapshot Event generation Snapshot Events DISABLED N/A [DISABLED – ENABLED]

RELAY Out of service STATUS RELAY OOS STATUS ENABLED N/A DISABLED-ENABLED

SETPOINT > SYSTEM SETUP > FLEX CURVES

FLEX CURVES A > FLEX CURVES B> FLEX CURVES C > FLEX CURVES D

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Values for reset points 0.00 pkp Time 0.00xPKP [RST] 0.000 0.001 s [0.000 : 65.535]

Values for reset points 0.05 pkp Time 0.05xPKP [RST] 0.000 0.001 s [0.000 : 65.535]

… … … 0.001 s [0.000 : 65.535]

Values for reset points 0.97 pkp Time 0.97xPKP [RST] 0.000 0.001 s [0.000 : 65.535]

Values for reset points 0.98 pkp Time 0.98xPKP [RST] 0.000 0.001 s [0.000 : 65.535]

Values for operation points 1.03 pkp Time 1.03xPKP [OP] 0.000 0.001 s [0.000 : 65.535]

Values for operation points 1.05 pkp Time 1.05xPKP [OP] 0.000 0.001 s [0.000 : 65.535]

… … … 0.001 s [0.000 : 65.535]

Values for operation points 19.50 pkp Time 19.50xPKP [OP] 0.000 0.001 s [0.000 : 65.535]

Values for operation points 20.00 pkp Time 20.00xPKP [OP] 0.000 0.001 s [0.000 : 65.535]
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SETPOINT > SYSTEM SETUP > BREAKER > BREAKER SETTINGS

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Number of Switchgear selected as 
breaker Number of Switchgear 1 1 [1 : 16]

Maximum value of KI2t Maximum KI2t 9999.99 0.01(KA)2 
s [0.00 : 9999.99]

KI2t integration time KI2t Integ. Time 0.03 0.01s [0.03 : 0.25]

Maximum number of openings Maximum Openings 9999 1 [0 : 9999]

Maximum Openings in one hour Max.Openings 1 hour 40 1 [1 : 60]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > SYSTEM SETUP > BREAKER > BREAKER MAINTENANCE

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

KI2t Counter Phase A KI2t BKR Ph A Cnt 0.00 0.01 (KA)2 
s [0.00 : 9999.99]

KI2t Counter Phase B KI2t BKR Ph B Cnt 0.00 0.01 (KA)2 
s [0.00 : 9999.99]

KI2t Counter Phase C KI2t BKR Ph C Cnt 0.00 0.01 (KA)2 
s [0.00 : 9999.99]

Openings counter BKR Openings Cnt 0 1 [0 : 9999]

Closings counter BKR Closings Cnt 0 1 [0 : 9999]

SETPOINT > SYSTEM SETUP > SWITCHGEAR

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Snapshot Event generation for 
switchgear #1

Snapshot Events 
SWGR 1 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #2

Snapshot Events 
SWGR 2 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #3

Snapshot Events 
SWGR 3 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #4

Snapshot Events 
SWGR 4 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #5

Snapshot Events 
SWGR 5 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #6

Snapshot Events 
SWGR 6 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #7

Snapshot Events 
SWGR 7 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #8

Snapshot Events 
SWGR 8 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #9

Snapshot Events 
SWGR 9 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #10

Snapshot Events 
SWGR 10 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #11

Snapshot Events 
SWGR 11 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #12

Snapshot Events 
SWGR 12 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #13

Snapshot Events 
SWGR 13 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #14

Snapshot Events 
SWGR 14 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #15

Snapshot Events 
SWGR 15 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation for 
switchgear #16

Snapshot Events 
SWGR 16 DISABLED N/A [DISABLED – ENABLED]
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SETPOINT > PROTECTION ELEMENTS > PHASE CURRENT >

> PHASE TOC HIGH > PHASE TOC HIGH 1> PHASE TOC HIGH 2 > PHASE TOC HIGH 3

> PHASE TOC LOW > PHASE TOC LOW 1 > PHASE TOC LOW 2 > PHASE TOC LOW 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Input type Input PHASOR(DFT) N/A [PHASOR – RMS]

Pickup level Pickup Level 1.00 0.01 A [0.05 : 160.00]

Curve shape Curve IEEE Ext Inv N/A [See list of curves]

Time Dial TD Multiplier 1.00 0.01 s [0.00 : 900.00]

Reset type Reset INSTANTANEOUS N/A [INSTANTANEOUS – 
LINEAR]

Voltage Restraint Voltage Restraint DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > PHASE CURRENT >

> PHASE IOC HIGH > PHASE IOC HIGH 1> PHASE IOC HIGH 2 > PHASE IOC HIGH 3

> PHASE IOC LOW > PHASE IOC LOW 1 > PHASE IOC LOW 2 > PHASE IOC LOW 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Input type Input PHASOR(DFT) N/A [PHASOR – RMS]

Pickup level Pickup Level 30.00 0.01 A [0.05 : 160.00]

Trip time Trip Delay 0.00 0.01 s [0.00 : 900.00]

Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > PHASE CURRENT > PHASE DIRECTIONAL >

PHASE DIRECTIONAL 1> PHASE DIRECTIONAL 2 > PHASE DIRECTIONAL 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Maximum Torque Angle MTA 45 1 Deg [-90 : +90]

Operation Direction Direction FORWARD N/A [FORWARD – REVERSE]

Block logic Block Logic PERMISSION N/A [BLOCK – PERMISSION]

Polarization voltage threshold Pol V Threshold 40 1 V [0 : 300]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > PHASE CURRENT > THERMAL MODEL >

THERMAL MODEL 1> THERMAL MODEL 2 > THERMAL MODEL 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Heating constant Heat Time Constant 6.0 0.1 min [3.0 : 600.0]

Cooling constant Cool Time Constant 2.00
0.01 times 
Heat Time 
Ct.

[1.00 : 6.00]

Pickup level Pickup Level 1.00 0.01 A [0.05 : 160.00]

Alarm level Alarm Level 80.0 0.10% [1.0 : 110.0]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]



GEK-113000Z F650 Digital Bay Controller C-9

APPENDIX C C.1 FACTORY DEFAULT SETTINGS

C

SETPOINT > PROTECTION ELEMENTS > NEUTRAL CURRENT > NEUTRAL TOC

NEUTRAL TOC 1> NEUTRAL TOC 2 > NEUTRAL TOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Pickup level Pickup Level 1.00 0.01 A [0.05 : 160.00]

Curve shape Curve IEEE Ext Inv N/A [See list of curves]

Time Dial TD Multiplier 1.00 0.01 s [0.00 : 900.00]

Reset type Reset INSTANTANEOUS N/A [INSTANTANEOUS – 
LINEAR]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > NEUTRAL CURRENT > NEUTRAL IOC

NEUTRAL IOC 1> NEUTRAL IOC 2 > NEUTRAL IOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Pickup level Pickup Level 30.00 0.01 A [0.05 : 160.00]

Trip time Trip Delay 0.00 0.01 s [0.00 : 900.00]

Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > NEUTRAL CURRENT > NEUTRAL DIRECTIONAL >

NEUTRAL DIRECTIONAL 1> NEUTRAL DIRECTIONAL 2 > NEUTRAL DIRECTIONAL 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Maximum Torque Angle MTA -45 1 Deg [-90 : +90]

Operation Direction Direction FORWARD N/A [FORWARD – REVERSE]

Polarization type Polarization VO N/A [V0 – IP – V0+IP – V0*IP ]

Block logic type Block Logic PERMISSION N/A [BLOCK – PERMISSION]

Polarization voltage threshold Pol V Threshold 10 1 V [0 : 300]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > GROUND CURRENT > GROUND TOC

GROUND TOC 1> GROUND TOC 2 > GROUND TOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Input type Input PHASOR(DFT) N/A [PHASOR – RMS]

Pickup level Pickup Level 1.00 0.01 A [0.05 : 160.00]

Curve shape Curve IEEE Ext Inv N/A [See list of curves]

Time Dial TD Multiplier 1.00 0.01 s [0.00 : 900.00]

Reset type Reset INSTANTANEOUS N/A [INSTANTANEOUS – 
LINEAR]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > PROTECTION ELEMENTS > GROUND CURRENT > GROUND IOC

GROUND IOC 1> GROUND IOC 2 > GROUND IOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Input type Input PHASOR(DFT) N/A [PHASOR – RMS]

Pickup level Pickup Level 30.00 0.01 A [0.05 : 160.00]

Trip time Trip Delay 0.00 0.01 s [0.00 : 900.00]

Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > GROUND CURRENT > GROUND DIRECTIONAL >

GROUND DIRECTIONAL 1> GROUND DIRECTIONAL 2 > GROUND DIRECTIONAL 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Maximum Torque Angle MTA -45 1 Deg [-90 : +90]

Operation Direction Direction FORWARD N/A [FORWARD – REVERSE]

Polarization type Polarization VO N/A [V0 – IP – V0+IP – V0*IP ]

Block logic type Block Logic PERMISSION N/A [BLOCK – PERMISSION]

Polarization voltage threshold Pol V Threshold 10 1 V [0 : 300]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > SENSITIVE GROUND CURRENT > SENSITIVE GROUND TOC

SENSITIVE GROUND TOC 1> SENSITIVE GROUND TOC 2 > SENSITIVE GROUND TOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Input type Input PHASOR(DFT) N/A [PHASOR – RMS]

Pickup level Pickup Level 0.050 0.001 A [0.005 : 16.000]

Curve shape Curve IEEE Ext Inv N/A [See list of curves]

Time Dial TD Multiplier 1.00 0.01 s [0.00 : 900.00]

Reset type Reset INSTANTANEOUS N/A [INSTANTANEOUS – 
LINEAR]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > PROTECTION ELEMENTS > SENSITIVE GROUND CURRENT > SENSITIVE GROUND IOC

SENSITIVE GROUND IOC 1> SENSITIVE GROUND IOC 2 > SENSITIVE GROUND IOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Input type Input PHASOR(DFT) N/A [PHASOR – RMS]

Pickup level Pickup Level 0.100 0.001 A [0.005 : 16.000]

Trip time Trip Delay 0.00 0.01 s [0.00 : 900.00]

Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > SENSITIVE GROUND CURRENT > ISOLATED GROUND IOC

ISOLATED GROUND IOC 1> ISOLATED GROUND IOC 2 > ISOLATED GROUND IOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function Permission Function DISABLED N/A [DISABLED – ENABLED]

High Voltage level Vh Level 20 1 V [2 : 70]

Low Current level Il LEVEL 0.005 0.001 A [0.005 : 0.400]

Low Voltage level Vl LEVEL 2 1 V [2 : 70]

High Current level Ih LEVEL 0.025 0.001 A [0.005 : 0.400]

Operation time Delay 0.00 0.01 s [0.00 : 900.00]

Deviation time to instantaneous Time to inst 0.00 0.01 s [0.00 : 900.00]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > SENSITIVE GROUND CURRENT > SENSITIVE GROUND DIRECTIONAL >

SENSITIVE GROUND DIRECTIONAL 1> SENSITIVE GROUND DIRECTIONAL 2 > SENSITIVE GROUND DIRECTIONAL 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Maximum Torque Angle MTA -45 1 Deg [-90 : +90]

Operation Direction Direction FORWARD N/A [FORWARD – REVERSE]

Block logic type Block Logic PERMISSION N/A [BLOCK – PERMISSION]

Polarization voltage threshold Pol V Threshold 10 1 V [0 : 300]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > NEGATIVE SEQUENCE CURRENT > NEGATIVE SEQUENCE TOC >

NEGATIVE SEQUENCE TOC 1> NEGATIVE SEQUENCE TOC 2 > NEGATIVE SEQUENCE TOC 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Pickup level Pickup Level 1.00 0.01 A [0.05 : 160.00]

Curve shape Curve IEEE Ext Inv N/A [See list of curves]

Time Dial TD Multiplier 1.00 0.01 s [0.00 : 900.00]

Reset type Reset INSTANTANEOUS N/A [INSTANTANEOUS – 
LINEAR]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > PROTECTION ELEMENTS > VOLTAGE ELEMENTS > PHASE UV >

PHASE UV 1> PHASE UV 2 > PHASE UV 3 

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Input mode Mode PHASE-PHASE N/A [PHASE-PHASE, PHASE-
GROUND]

Pickup Level Pickup Level 10 1 V [3 : 300]

Curve shape Curve DEFINITE TIME N/A [DEFINITE TIME – 
INVERSE TIME]

Time Dial Delay 10.00 0.01 s [0.00 : 900.00]

Minimum Voltage Threshold Minimum Voltage 5 1 V [0 : 300]

Operation logic Logic ANY PHASE N/A [ANY PHASE – TWO 
PHASES – ALL PHASES]

Supervision by breaker status Supervised by 52 DISABLED N/A [DISABLED – ENABLED]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > VOLTAGE ELEMENTS > PHASE OV >

PHASE OV 1> PHASE OV 2 > PHASE OV 3 

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Pickup Level Pickup Level 10 1 V [3 : 300]

Trip time Trip Delay 10.00 0.01 s [0.00 : 900.00]

Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]

Operation logic Logic ANY PHASE N/A [ANY PHASE – TWO 
PHASES – ALL PHASES]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > VOLTAGE ELEMENTS >

>NEUTRAL OV HIGH > NEUTRAL OV HIGH 1> NEUTRAL OV HIGH 2 > NEUTRAL OV HIGH 3

>NEUTRAL OV LOW > NEUTRAL OV LOW 1> NEUTRAL OV LOW 2 > NEUTRAL OV LOW 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Pickup Level Pickup Level 10 1 V [3 : 300]

Trip time Trip Delay 10.00 0.01 s [0.00 : 900.00]

Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > VOLTAGE ELEMENTS>NEGATIVE SEQUENCE OV >

NEGATIVE SEQUENCE OV 1> NEGATIVE SEQUENCE OV 2 > NEGATIVE SEQUENCE OV 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Pickup Level Pickup Level 10 1 V [3 : 300]

Trip time Trip Delay 10.00 0.01 s [0.00 : 900.00]

Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > PROTECTION ELEMENTS >VOLTAGE ELEMENTS>AUXILIARY OV

AUXILIARY OV 1> AUXILIARY OV 2 > AUXILIARY OV 3 

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Pickup Level Pickup Level 10 1 V [3 : 300]

Trip Time Trip Delay 10.00 0.01 s [0.00 : 900.00]]

Reset Time Reset Delay 0.00 0.01 s [0.00 : 900.00]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS >VOLTAGE ELEMENTS>AUXILIARY UV

AUXILIARY UV 1> AUXILIARY UV 2 > AUXILIARY UV 3 

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Pickup Level Pickup Level 10 1 V [3 : 300]

Curve shape Curve DEFINITE TIME N/A [DEFINITE TIME – 
INVERSE TIME]

Time Dial Delay 10.00 0.01 s [0.00 : 900.00]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > PROTECTION ELEMENTS > POWER > FORWARD POWER

FORWARD POWER 1> FORWARD POWER 2 > FORWARD POWER 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Block from off-line Blk Time After Close 0.00 0.01 s [0.00 : 900.00]

Pickup level for stage 1 Stage 1 Tap 10.00 0.01MW [0.00 : 10000.00]

Trip time for stage 1 Stage 1 Time 60.00 0.01 s [0.00 : 900.00]

Pickup level for stage 2 Stage 2 Tap 20.00 0.01MW [0.00 : 10000.00]

Trip time for stage 2 Stage 2 Time 60.00 0.01 s [0.00 : 900.00]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > PROTECTION ELEMENTS > POWER > DIRECTIONAL POWER>

DIRECTIONAL POWER 1> DIRECTIONAL POWER 2 > DIRECTIONAL POWER 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Block from off-line Blk Time After Close 0.00 0.01 s [0.00 : 900.00]

Directional Angle for stage 1 Dir Power Angle 1 0.00 0.01 Deg [0.00 : 359.99]

Pickup level for stage 1 Stage 1 Tap 10.00 0.01MW [-10000.00 : 10000.00]

Trip time for stage 1 Stage 1 Time 60.00 0.01 s [0.00 : 900.00]

Directional Angle for stage 2 Dir Power Angle 2 0.00 1 Deg [0.00 : 359.99]

Pickup level for stage 2 Stage 2 Tap 20.00 0.01MW [-10000.00 : 10000.00]

Trip time for stage 2 Stage 2 Time 60.00 0.01 s [0.00 : 900.00]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > CONTROL ELEMENTS > SETTING GROUP

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Setting Grouping Permission Function DISABLED N/A [DISABLED – ENABLED]

Active Group Active Group GROUP 1 N/A [GROUP 1 – GROUP 2 – 
GROUP 3]

Snapshot Event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > CONTROL ELEMENTS > UNDERFREQUENCY

UNDERFREQUENCY 1 > UNDERFREQUENCY 2 > UNDERFREQUENCY 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Pickup level Pickup Level 49.50 0.01 Hz [20.00 : 65.00]

Trip time Trip Delay 0.00 0.01 s [0.00 : 900.00]

Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]

Minimum voltage threshold Minimum Voltage 30 1 V [20 : 300]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > CONTROL ELEMENTS > OVERFREQUENCY

OVERFREQUENCY 1 > OVERFREQUENCY 2 > OVERFREQUENCY 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Pickup level Pickup Level 50.50 0.01 Hz [20.00 : 65.00]

Trip time Trip Delay 0.00 0.01 s [0.00 : 900.00]

Reset time Reset Delay 0.00 0.01 s [0.00 : 900.00]

Minimum voltage threshold Minimum Voltage 30 1 V [20 : 300]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > CONTROL ELEMENTS > SYNCHROCHECK

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Dead bus voltage level Dead Bus Level 10.00 0.01 V [0.00 : 300.00]

Live bus voltage level Live Bus Level 50.00 0.01 V [0.00 : 300.00]

Dead line voltage level Dead Line Level 10.00 0.01 V [0.00 : 300.00]

Live line voltage level Live Line Level 50.00 0.01 V [0.00 : 300.00]

Voltage Difference Max Volt Difference 10.00 0.01 V [2.00 : 300.00]

Angle Difference Max Angle Difference 10.0 0.1 Deg [2.0 : 80.0]

Frequency Slip Max Freq Difference 20 10 mHz [10 : 5000]

Breaker Closing time Time 0.50 0.01 s [0.01 : 600.00]

Dead Line – Dead Bus Function 
permission DL-DB Function DISABLED N/A [DISABLED – ENABLED]

Live Line – Dead Bus Function 
permission LL-DB Function DISABLED N/A [DISABLED – ENABLED]

Dead Line – Live Bus Function 
permission DL-LB Function DISABLED N/A [DISABLED – ENABLED]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > CONTROL ELEMENTS > AUTORECLOSE

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Maximum Number of shots Max Number Shots 1 N/A [1 : 4]

Dead time 1 Dead Time 1 0.00 0.01 s [0.00 : 900.00]

Dead time 2 Dead Time 2 0.00 0.01 s [0.00 : 900.00]

Dead time 3 Dead Time 3 0.00 0.01 s [0.00 : 900.00]

Dead time 4 Dead Time 4 0.00 0.01 s [0.00 : 900.00]

Reclaim time or reset lockout delay Reclaim Time 0.00 0.01 s [0.00 : 900.00]

Reclose conditions permission Cond. Permission DISABLED N/A [DISABLED – ENABLED]

Hold time Hold Time 0.00 0.01 s [0.00 : 900.00]

Reset time Reset Time 0.00 0.01 s [0.00 : 900.00]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > CONTROL ELEMENTS > BREAKER FAILURE

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Supervision (retrip) pickup level Supervision Pickup 1.00 0.01 A [0.05 : 160.00]

Hiset pickup level Hiset Pickup 5.00 0.01 A [0.05 : 160.00]

Lowset pickup level Lowset Pickup 2.00 0.01 A [0.05 : 160.00]

Internal arc pickup level Internal Arc Pickup 0.10 0.01 A [0.05 : 160.00]

Internal arc time delay Internal Arc Delay 10.00 0.01 s [0.00 : 900.00]

Retrip time delay Supervision Delay 10.00 0.01 s [0.00 : 900.00]

Hiset time delay HiSet Delay 10.00 0.01 s [0.00 : 900.00]

Lowset time delay LowSet Delay 10.00 0.01 s [0.00 : 900.00]

Second stage time delay 2nd Step Delay 10.00 0.01 s [0.00 : 900.00]

WITHOUT current element time delay No Current Delay 10.00 0.01 s [0.00 : 900.00]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > CONTROL ELEMENTS > VT FUSE FAILURE)

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > CONTROL ELEMENTS > BROKEN CONDUCTOR

BROKEN CONDUCTOR 1 >BROKEN CONDUCTOR 2 >BROKEN CONDUCTOR 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Tap Level in percentage of I2/I1 Tap 20 0.10% [20.0 : 100.0]

Trip Time Trip Delay 60 0.01 s [0.00 : 900.00]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

Current Inhibition Level setting Operation Threshold 0.005 0.001 A [0.000 : 1.000]

SETPOINT > CONTROL ELEMENTS > LOCKED ROTOR

LOCKED ROTOR 1 >LOCKED ROTOR 2 >LOCKED ROTOR 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED – ENABLED]

Input type Input PHASOR(DFT)  N/A [PHASOR – RMS]

Full load current Full Load Current 0.50 KA [0.10 : 10.00]

Pickup level Pickup Level 1.01  N/A [1.01 : 109.00]

Trip time Trip Delay 0.00 s [0.00 : 900.00]

Reset time Reset Delay 0.00 s [0.00 : 900.00]

Snapshot event generation Snapshot Events ENABLED  N/A [DISABLED – ENABLED]
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SETPOINT > CONTROL ELEMENTS > PULSE COUNTERS

SETTING DESCRIPTION NAME DEFAULT VALUE STEP  RANGE USER 
VALUE

Pulse counter enabling setting CntPulses Enabled X DISABLED N/A [DISABLED – ENABLED]

Name of the pulse counter CntPulses Name X Pulse Counter 1 N/A N/A

Multiplier factor for the pulse counter CntPulses Factor X 1.000 0.001 [0.000 : 65000.000]

Overflow value for the pulse counter CntPulses Overflow X 65535 1 [0 : 1000000]

Board selection for the pulse counter CntPulses Board 
Origin X F N/A [F,G,H,I]

Input index inside the selected board CntPulses Input Origin 
X 1 1 [1 : 32]

Note: X is the pulse counter index, up to 8. 

SETPOINT > CONTROL ELEMENTS > ANALOG COMPARATORS

SETTING DESCRIPTION NAME DEFAULT VALUE STEP  RANGE USER 
VALUE

Generic Analog Function Permission Analog Function DISABLED N/A [DISABLED – ENABLED]

Generic Snapshot Events Generation Analog Snapshot 
Events DISABLED N/A [DISABLED – ENABLED]

Analog Input Value Selection Analog Input X None N/A [All available analog values]

Analog Maximum Threshold Value Analog Maximum X 1.000 0.001 [-100000.000 : 100000.000]

Analog Minimum Threshold Value Analog Minimum X 1.000 0.001 [-100000.000 : 100000.000]

Analog Delay for Activation Signal Analog Delay X 0.00 0.01 s [0.00 : 900.00]

Analog Hysteresis for the Deadband Analog Hysteresis X 1.0 0.1 [0.0 : 50.0]

Analog Direction for Activation Inside 
or Outside the Deadband Analog Direction X OUT N/A [IN-OUT]

Note: X is the analog comparator index, up to 20

SETPOINT > CONTROL ELEMENTS > FREQUENCY RATE OF CHANGE

FREQUENCY RATE OF CHANGE 1 > FREQUENCY RATE OF CHANGE 2 > FREQUENCY RATE OF CHANGE 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP  RANGE USER 
VALUE

Function Permission Function DISABLED N/A [DISABLED – ENABLED]

Direction of the frequency change Freq. Rate Trend INCREASING N/A
[INCREASING - 
DECREASING - BI-
DIRECTIONAL]

Operation Value in Hz/s Freq. Rate Pickup 0.50 0.01 Hz/s [0.10 : 10.00]

Minimum required voltage in % 
nominal voltage Freq. Rate OV Supv 40.00 0.01% [0.00 : 110.00]

Minimum Frequency Threshold Freq. Rate Min 45.00 0.01 Hz [20.00 : 80.00]

Maximum Frequency Threshold Freq. Rate Max 65.00 0.01 Hz [20.00 : 80.00]

Frequency rate Trip Delay Freq. Rate Delay 0.00 0.01 s [0.00 : 60.00]

Snapshot Events Generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]

SETPOINT > CONTROL ELEMENTS > LOAD ENCROACHMENT

LOAD ENCROACHMENT 1 > LOAD ENCROACHMENT 2 > LOAD ENCROACHMENT 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP  RANGE USER 
VALUE

Function Permission Function DISABLED N/A [DISABLED – ENABLED]

Minimum positive-sequence voltage 
required Min. Voltage 25.00 0.01 V [0.00 : 300.00]

Impedance reach of the element Reach 1.00 0.01 Ohm [0.02 : 250.00]

Angle (Size of the blocking region) Angle 5 1 Deg [5 : 50]

Trip Time Pickup Delay 0.000 0.001 s [0.000 : 65.535]

Reset Time Reset Delay 0.000 0.001 s [0.000 : 65.535]

Snapshot Events Generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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SETPOINT > CONTROL ELEMENTS >POWER

WATT GND FLT HIGH 1> WATT GND FLT HIGH 2 > WATT GND FLT HIGH 3
WATT GND FLT LOW 1> WATT GND FLT LOW 2 > WATT GND FLT LOW 3

SETTING DESCRIPTION NAME DEFAULT VALUE STEP  RANGE USER 
VALUE

Function permission Function DISABLED N/A [DISABLED-ENABLED]

Supervision minimum voltage Voltage Pickup Level 2 0.01 V [2.00 : 70.00]

Source of operating current. Current selection IN N/A [IN-IG]

Pickup Level for Overcurrent OC Pickup Level 0,005 0.001A [0.005 : 0.400]

Pickup Delay for Overcurrent OC Pickup Delay 0,2 0.01 s [0.00 : 600.00]

Pickup Level for operating Power Power Pickup 0,01 0.01 W [0.01 : 4.50]

Max torque angle MTA 0 1 Deg [0 : 360]

Pickup Delay for Operating Power Power Pickup Delay 0,2 0.01 s [0.00 : 600.00]

Curve shape Curve DEFINITE TIME N/A [DEFINITE TIME - 
INVERSE TIME - USER 
CURVE A - USER CURVE 
B - USER CURVE C - 
USER CURVE D]

Multiplier Multiplier 1 0.01 s [0.02 : 2.00]

Snapshot event generation Snapshot Event DISABLED N/A [DISABLED-ENABLED]
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SETPOINT > INPUTS/OUTPUTS > CONTACT I/O >

BOARD F > BOARD G >BOARD H>BOARD J

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

I/O board type (available only for CIO 
modules)

I/O Board Type_X NONE N/A [NONE,
16 INP + 8OUT,
8 INP + 8OUT + SUPV
32 INP
16 INP + 8 ANA]

Input activation voltage threshold 
Group A

Voltage Threshold 
A_X

80 1 V [10 : 230]

Input activation voltage threshold 
Group B

Voltage Threshold 
B_X

80 1 V [10 : 230]

Input activation voltage threshold 
Group C

Voltage Threshold 
C_X

80 1 V [10 : 230]

Input activation voltage threshold 
Group D

Voltage Threshold 
D_X

80 1 V [10 : 230]

Debounce time for Group A Debounce Time A_X 15 1 ms [1 : 50]

Debounce time for Group B Debounce Time B_X 15 1 ms [1 : 50]

Debounce time for Group C Debounce Time C_X 15 1 ms [1 : 50]

Debounce time for Group D Debounce Time D_X 15 1 ms [1 : 50]

Input type Input Type_X_CCY 
(CCY)

POSITIVE N/A [POSITIVE-EDGE,
NEGATIVE-EDGE,
POSITIVE,
NEGATIVE]

Input signal time delay Delay Input 
Time_X_CCY (CCY)

0 1 ms [0 : 60000]

Output logic type Output Logic_X_0Z POSITIVE N/A [POSITIVE,
NEGATIVE]

Output type Output Type_X_0Z NORMAL N/A [NORMAL,
PULSE,
LATCH]

Output pulse length Pulse Output 
Time_X_0Z

10000 1 ms [0 : 60000]

Analog Inputs Range Range_X_0Z NONE N/A [NONE,
-1 to 0mA,
0 to 1 mA,
-1 to 1 mA,
0 to 5 mA,
0 to 10 mA]

Minimum Value Min_Value_X_0Z 0.00 0.01 [ -9999.99 : 9999.99]

Maximum Value Max_Value_X_0Z 0.00 0.01 [ -9999.99 : 9999.99]

Snapshot event generation Snapshot Events ENABLED N/A [DISABLED – ENABLED]
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NOTE 2: DESCRIPTION OF X, Y AND Z IN INPUT/OUTPUT BOARDS

X 
F,  G, H or J, the I/O board name, depending on the Relay model.

F and G are internal Relay boards, and H and J are additional boards available in CIO modules 
(remote Bus CAN I/O module)

For the I/O board selection in the relay 
model:

I/O BOARD TYPE

ASSOCIATED DIGIT
ENERVISTA 650 
SETUP BOARD 
SETTINGS

BOARD TYPE

0 NONE None

1 16 INP+ 8 OUT Mixed 

2 8 INP +8 OUT 
+SUPV Supervision 

4 32 INP 32 digital inputs 

5 16 INP + 8 ANA 16 digital inputs + 8 analog inputs 

CCY

Is the name used for inputs in I/O boards

Mixed, 16 digital inputs: CC1….CC16

Supervision: 8 digital inputs: CC1,..., CC8

32 INP: 32 digital inputs; CC1,...,CC32

0Z Is the name used for the different outputs in I/O boards, 8 outputs available for any of the two 
types of board (01,…., 08)

SETPOINT > INPUTS/OUTPUTS > REMOTE COMMS

SETTING DESCRIPTION NAME DEFAULT VALUE STEP RANGE USER 
VALUE

Remote comms selection Remote Comms NONE N/A [NONE – GSSE – GOOSE]

SETTING DESCRIPTION FOR GOOSE

Remote comms selection Remote Comms GSSE N/A [NONE – GSSE – GOOSE]

Device Identification 650 ID F650 N/A

Hold time signal send by the 
transmiting device Hold Time 10000 1 ms [1000 : 60000]

Snapshot Events Generation Snapshot Events 
Remote Out DISABLED N/A [DISABLED – ENABLED]

Remote Device Description Remote Device X Remote Device X N/A

Bit Pair Selection Bit Pair X None N/A [DNA-1 to DNA-32 – 
UserSt-1 to UserSt-64]

Default Value Selection Default Value X OFF N/A [OFF –  ON – LATEST OFF 
– LATEST ON]

Note: X is the Remote Device index, up to 32

LIST OF TIME OVERCURRENT CURVES AVAILABLE IN 
F650

IEEE extremely/very/moderately inverse

IEC Curve A/B/C/Long-Time Inverse/ Short-Time Inverse

IAC extremely/very/normally/moderately inverse

ANSI extremely/very/normally/moderately inverse

I2t

Definite time

Rectifier curve

User Curve - FlexCurve™ A/B/C/D
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C.2FACTORY DEFAULT CONFIGURATION

 

      

NOTE:
SOURCE COLUMN:
This columns allow selecting the simple or complex (OR signal or Virtual output) operand that actives the selected
elements on relay configuration
If more than one operands are selected, the relay performs an OR gate with them to activate the selected element.
SIGNAL LOGIC COLUMN:
Refers to each individual signal selected on its left. NOT legend means that the refered signal is inverted
SOURCE LOGIC COLUMN:
Refers to the whole SOURCE  signal selected on its left. NOT legend means that SOURCE signal is inverted
If more than one operand were selected, the OR gate output is inverted

SETPOINT>RELAY CONFIGURATION>OUTPUTS 

OUTPUT SOURCE SOURCE LOGIC LOGIC

CONT OP OPER_F_01 VO_000_PROTECTION_ALARM -

CONT OP OPER_F_02
VO_046_59P_PKP -

VO_045_27P_PKP -

CONT OP OPER_F_03 VO_048_50G_PKP -

CONT OP OPER_F_04 VO_049_51G_PKP -

CONT OP OPER_F_05
VO_051_50PH_PKP -

VO_050_50PL_PKP -

CONT OP OPER_F_06 VO_053_51P_PKP -

CONT OP OPER_F_07
OPERATION BIT 1 -

AR CLOSE BREAKER -

CONT OP OPER_F_08
OPERATION BIT 2 -

VO_083_GENERAL_TRIP -

SETPOINT>RELAY CONFIGURATION>LEDS

LED SOURCE SOURCE LOGIC LOGIC LED NAME 

LED01 VO_000_PROTECTION ALARM - PROT ALARM

LED02 VO_083_GENERAL_TRIP - TRIP

LED03 VO_019_PHASE_OVERCURRENT_TRIP - 50/51P TRIP

LED04 VO_069_GROUND_OVERCURRENT_TRIP - 50/51G TRIP

LED05
VO_074_59P_TRIP

- - 27/59 TRIP
VO_073_27P_TRIP

LED06 VO_085_GENERAL_PKP - PICKUP

LED07 VO_007_PHASE_OVERCURRENT_PKP - 50/51P PICKUP

LED08 VO_009_GROUND_OVERCURRENT_PKP - 50/51G PICKUP

LED09 VO_045_27P_PKP - 27 PICKUP

LED10 VO_046_59P_PKP - 59 PICKUP

LED11 AR READY - 79 READY

LED12 AR RCL IN PROGRESS - 79 IN-PROG

LED13 AR BLOCK - 79 BLOCK

LED14 AR CONDS INPUT NOT 79 INHIBIT

LED15 AR LOCKOUT - 79 LOCKOUT

SETPOINT>RELAY CONFIGURATION>PROTECTION ELEMENTS

PROTECTION ELEMENT SOURCE SIGNAL LOGIC SOURCE LOGIC

LED RESET INPUT OPERATION BIT 3

CHANGE LOCAL-
REMOTE Not Configured

CHANGE OP BLOCKED Not Configured
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HMI BACKLIGHT ON Not Configured

HMI BACKLIGHT OFF Not Configured

PH IOC1 HIGH A BLK

GROUP 1 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR1 A OP NOT

LATCHED VIRT IP 1

PH IOC1 HIGH B BLK

GROUP 1 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR1 B OP NOT

LATCHED VIRT IP 1

PH IOC1 HIGH C BLK

GROUP 1 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR1 C OP NOT

LATCHED VIRT IP 1

PH IOC2 HIGH A BLK

GROUP 2 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR2 A OP NOT

LATCHED VIRT IP 1

PH IOC2 HIGH B BLK

GROUP 2 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR2 B OP NOT

LATCHED VIRT IP 1

PH IOC2 HIGH C BLK

GROUP 2 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR2 C OP NOT

LATCHED VIRT IP 1

PH IOC3 HIGH A BLK

GROUP 3 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR3 A OP NOT

LATCHED VIRT IP 1

PH IOC3 HIGH B BLK

GROUP 3 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR3 B OP NOT

LATCHED VIRT IP 1

PH IOC3 HIGH C BLK

GROUP 3 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR3 C OP NOT

LATCHED VIRT IP 1

PH IOC1 LOW A BLK

GROUP 1 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR1 A OP NOT

LATCHED VIRT IP 2

PH IOC1 LOW B BLK

GROUP 1 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR1 B OP NOT

LATCHED VIRT IP 2

SETPOINT>RELAY CONFIGURATION>PROTECTION ELEMENTS

PROTECTION ELEMENT SOURCE SIGNAL LOGIC SOURCE LOGIC
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PH IOC1 LOW C BLK

GROUP 1 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR1 C OP NOT

LATCHED VIRT IP 2

PH IOC2 LOW A BLK

GROUP 2 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR2 A OP NOT

LATCHED VIRT IP 2

PH IOC2 LOW B BLK

GROUP 2 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR2 B OP NOT

LATCHED VIRT IP 2

PH IOC2 LOW C BLK

GROUP 2 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR2 C OP NOT

LATCHED VIRT IP 2

PH IOC3 LOW A BLK

GROUP 3 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR3 A OP NOT

LATCHED VIRT IP 2

PH IOC3 LOW B BLK

GROUP 3 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR3 B OP NOT

LATCHED VIRT IP 2

PH IOC3 LOW C BLK

GROUP 3 BLOCKED

CONT IP_F_CC2 (50P BLOCK)(CC2)

PHASE DIR3 C OP NOT

LATCHED VIRT IP 2

NEUTRAL IOC1 BLOCK
GROUP 1 BLOCKED

NEUTRAL DIR1 OP NOT

NEUTRAL IOC2 BLOCK
GROUP 2 BLOCKED

NEUTRAL DIR2 OP NOT

NEUTRAL IOC3 BLOCK
GROUP 3 BLOCKED

NEUTRAL DIR3 OP NOT

GROUND IOC1 BLOCK

GROUP 1 BLOCKED

CONT IP_F_CC5 (50G BLOCK)(CC5)

GROUND DIR1 OP NOT

LATCHED VIRT IP 3

GROUND IOC2 BLOCK

GROUP 2 BLOCKED

CONT IP_F_CC5 (50G BLOCK)(CC5)

GROUND DIR2 OP NOT

LATCHED VIRT IP 3

GROUND IOC3 BLOCK

GROUP 3 BLOCKED

CONT IP_F_CC5 (50G BLOCK)(CC5)

GROUND DIR3 OP NOT

LATCHED VIRT IP 3

SENS GND IOC1 BLK

GROUP 1 BLOCKED

SENS GND DIR1 OP NOT

LATCHED VIRT IP 4

SETPOINT>RELAY CONFIGURATION>PROTECTION ELEMENTS

PROTECTION ELEMENT SOURCE SIGNAL LOGIC SOURCE LOGIC
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SENS GND IOC2 BLK

GROUP 2 BLOCKED

SENS GND DIR2 OP NOT

LATCHED VIRT IP 4

SENS GND IOC3 BLK

GROUP 3 BLOCKED

SENS GND DIR3 OP NOT

LATCHED VIRT IP 4

PH TOC1 HIGH A BLK

GROUP 1 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR1 A OP NOT

LATCHED VIRT IP 5

PH TOC1 HIGH B BLK

GROUP 1 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR1 B OP NOT

LATCHED VIRT IP 5

PH TOC1 HIGH C BLK

GROUP 1 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR1 C OP NOT

LATCHED VIRT IP 5

PH TOC2 HIGH A BLK

GROUP 2 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR2 A OP NOT

LATCHED VIRT IP 5

PH TOC2 HIGH B BLK

GROUP 2 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR2 B OP NOT

LATCHED VIRT IP 5

PH TOC2 HIGH C BLK

GROUP 2 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR2 C OP NOT

LATCHED VIRT IP 5

PH TOC3 HIGH A BLK

GROUP 3 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR3 A OP NOT

LATCHED VIRT IP 5

PH TOC3 HIGH B BLK

GROUP 3 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR3 B OP NOT

LATCHED VIRT IP 5

PH TOC3 HIGH C BLK

GROUP 3 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR3 C OP NOT

LATCHED VIRT IP 5

NEUTRAL TOC1 BLOCK
GROUP 1 BLOCKED

NEUTRAL DIR1 OP NOT

NEUTRAL TOC2 BLOCK
GROUP 2 BLOCKED

NEUTRAL DIR2 OP NOT

NEUTRAL TOC3 BLOCK
GROUP 3 BLOCKED

NEUTRAL DIR3 OP NOT

SETPOINT>RELAY CONFIGURATION>PROTECTION ELEMENTS

PROTECTION ELEMENT SOURCE SIGNAL LOGIC SOURCE LOGIC
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GROUND TOC1 BLOCK

GROUP 1 BLOCKED

CONT IP_F_CC6 (51G BLOCK)(CC6)

GROUND DIR1 OP NOT

LATCHED VIRT IP 7

GROUND TOC2 BLOCK

GROUP 2 BLOCKED

CONT IP_F_CC6 (51G BLOCK)(CC6)

GROUND DIR2 OP NOT

LATCHED VIRT IP 7

GROUND TOC3 BLOCK

GROUP 3 BLOCKED

CONT IP_F_CC6 (51G BLOCK)(CC6)

GROUND DIR3 OP NOT

LATCHED VIRT IP 7

SENS GND TOC1 BLOCK

GROUP 1 BLOCKED

SENS GND DIR1 OP NOT

LATCHED VIRT IP 8

SENS GND TOC2 BLOCK

GROUP 2 BLOCKED

SENS GND DIR2 OP NOT

LATCHED VIRT IP 8

SENS GND TOC3 BLOCK

GROUP 3 BLOCKED

SENS GND DIR3 OP NOT

LATCHED VIRT IP 8

PHASE UV1 BLOCK GROUP 1 BLOCKED

PHASE UV2 BLOCK GROUP 2 BLOCKED

PHASE UV3 BLOCK GROUP 3 BLOCKED

NEG SEQ OV1 BLOCK GROUP 1 BLOCKED

NEG SEQ OV2 BLOCK GROUP 2 BLOCKED

NEG SEQ OV3 BLOCK GROUP 3 BLOCKED

THERMAL1 BLOCK GROUP 1 BLOCKED

THERMAL2 BLOCK GROUP 2 BLOCKED

THERMAL3 BLOCK GROUP 3 BLOCKED

PHASE DIR1 BLK INP

GROUP 1 BLOCKED

CONT IP_F_CC4 (67P BLOCK)(CC4)

LATCHED VIRT IP 9

PHASE DIR2 BLK INP

GROUP 2 BLOCKED

CONT IP_F_CC4 (67P BLOCK)(CC4)

LATCHED VIRT IP 9

PHASE DIR3 BLK INP

GROUP 3 BLOCKED

CONT IP_F_CC4 (67P BLOCK)(CC4)

LATCHED VIRT IP 9

NEUTRAL DIR1 BLK INP GROUP 1 BLOCKED

NEUTRAL DIR2 BLK INP GROUP 2 BLOCKED

NEUTRAL DIR3 BLK INP GROUP 3 BLOCKED

GROUND DIR1 BLK INP
GROUP 1 BLOCKED

LATCHED VIRT IP 10

GROUND DIR2 BLK INP
GROUP 2 BLOCKED

LATCHED VIRT IP 10

GROUND DIR3 BLK INP
GROUP 3 BLOCKED

LATCHED VIRT IP 10

SETPOINT>RELAY CONFIGURATION>PROTECTION ELEMENTS

PROTECTION ELEMENT SOURCE SIGNAL LOGIC SOURCE LOGIC
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NEUTRAL OV1 HIGH BLK
GROUP 1 BLOCKED

LATCHED VIRT IP 12

NEUTRAL OV2 HIGH BLK
GROUP 2 BLOCKED

LATCHED VIRT IP 12

NEUTRAL OV3 HIGH BLK
GROUP 3 BLOCKED

LATCHED VIRT IP 12

NEUTRAL OV1 LOW BLK GROUP 1 BLOCKED

NEUTRAL OV2 LOW BLK GROUP 2 BLOCKED

NEUTRAL OV3 LOW BLK GROUP 3 BLOCKED

AUXILIARY UV1 BLOCK GROUP 1 BLOCKED

AUXILIARY UV2 BLOCK GROUP 2 BLOCKED

AUXILIARY UV3 BLOCK GROUP 3 BLOCKED

PHASE OV1 BLOCK
GROUP 1 BLOCKED

LATCHED VIRT IP 11

PHASE OV2 BLOCK
GROUP 2 BLOCKED

LATCHED VIRT IP 11

PHASE OV3 BLOCK
GROUP 3 BLOCKED

LATCHED VIRT IP 11

AUXILIARY OV1 BLOCK GROUP 1 BLOCKED

AUXILIARY OV2 BLOCK GROUP 2 BLOCKED

AUXILIARY OV3 BLOCK GROUP 3 BLOCKED

NEG SEQ TOC1 BLOCK GROUP 1 BLOCKED

NEG SEQ TOC2 BLOCK GROUP 2 BLOCKED

NEG SEQ TOC3 BLOCK GROUP 3 BLOCKED

OVERFREQ1 BLOCK GROUP 1 BLOCKED

OVERFREQ2 BLOCK GROUP 2 BLOCKED

OVERFREQ3 BLOCK GROUP 3 BLOCKED

UNDERFREQ1 BLOCK GROUP 1 BLOCKED

UNDERFREQ2 BLOCK GROUP 2 BLOCKED

UNDERFREQ3 BLOCK GROUP 3 BLOCKED

SETT GROUPS BLOCK Not Configured

BROKEN CONDUCT1 
BLK GROUP 1 BLOCKED

BROKEN CONDUCT2 
BLK GROUP 2 BLOCKED

BROKEN CONDUCT3 
BLK GROUP 3 BLOCKED

ISOLATED GND1 BLK
GROUP 1 BLOCKED

SENS GND DIR1 OP NOT

ISOLATED GND2 BLK
GROUP 2 BLOCKED

SENS GND DIR2 OP NOT

ISOLATED GND3 BLK
GROUP 3 BLOCKED

SENS GND DIR3 OP NOT

SENS GND DIR1 BLK IP GROUP 1 BLOCKED

SENS GND DIR2 BLK IP GROUP 2 BLOCKED

SENS GND DIR3 BLK IP GROUP 3 BLOCKED

FWD PWR1 BLOCK GROUP 1 BLOCKED

FWD PWR2 BLOCK GROUP 2 BLOCKED

FWD PWR3 BLOCK GROUP 3 BLOCKED

SETPOINT>RELAY CONFIGURATION>PROTECTION ELEMENTS

PROTECTION ELEMENT SOURCE SIGNAL LOGIC SOURCE LOGIC
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PH TOC1 LOW A BLK

GROUP 1 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR1 A OP NOT

LATCHED VIRT IP 6

PH TOC1 LOW B BLK

GROUP 1 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR1 B OP NOT

LATCHED VIRT IP 6

PH TOC1 LOW C BLK

GROUP 1 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR1 C OP NOT

LATCHED VIRT IP 6

PH TOC2 LOW A BLK

GROUP 2 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR2 A OP NOT

LATCHED VIRT IP 6

PH TOC2 LOW B BLK

GROUP 2 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR2 B OP NOT

LATCHED VIRT IP 6

PH TOC2 LOW C BLK

GROUP 2 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR2 C OP NOT

LATCHED VIRT IP 6

PH TOC3 LOW A BLK

GROUP 3 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR3 A OP NOT

LATCHED VIRT IP 6

PH TOC3 LOW B BLK

GROUP 3 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR3 B OP NOT

LATCHED VIRT IP 6

PH TOC3 LOW C BLK

GROUP 3 BLOCKED

CONT IP_F_CC3 (51P BLOCK)(CC3)

PHASE DIR3 C OP NOT

LATCHED VIRT IP 6

DIR PWR1 BLOCK GROUP 1 BLOCKED

DIR PWR2 BLOCK GROUP 2 BLOCKED

DIR PWR3 BLOCK GROUP 3 BLOCKED

LOCKED ROTOR1 BLK GROUP 1 BLOCKED

LOCKED ROTOR2 BLK GROUP 2 BLOCKED

LOCKED ROTOR3 BLK GROUP 3 BLOCKED

FREQ RATE1 BLOCK GROUP 1 BLOCKED

FREQ RATE2 BLOCK GROUP 2 BLOCKED

FREQ RATE3 BLOCK GROUP 3 BLOCKED

LOAD ENCR1 BLOCK GROUP 1 BLOCKED

LOAD ENCR2 BLOCK GROUP 2 BLOCKED

LOAD ENCR3 BLOCK GROUP 3 BLOCKED

SETPOINT>RELAY CONFIGURATION>PROTECTION ELEMENTS

PROTECTION ELEMENT SOURCE SIGNAL LOGIC SOURCE LOGIC
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32N1 HIGH BLOCK GROUP 1 BLOCKED

32N2 HIGH BLOCK GROUP 2 BLOCKED

32N3 HIGH BLOCK GROUP 3 BLOCKED

32N1 LOW BLOCK GROUP 1 BLOCKED

32N2 LOW BLOCK GROUP 2 BLOCKED

32N3 LOW BLOCK GROUP 3 BLOCKED

THERMAL1 A RST OPERATION BIT 4

THERMAL1 B RST OPERATION BIT 4

THERMAL1 C RST OPERATION BIT 4

THERMAL2 A RST OPERATION BIT 4

THERMAL2 B RST OPERATION BIT 4

THERMAL2 C RST OPERATION BIT 4

THERMAL3 A RST OPERATION BIT 4

THERMAL3 B RST OPERATION BIT 4

THERMAL3 C RST OPERATION BIT 4

Synchrocheck BLK INP Not Configured

AR LEVEL BLOCK
CONT IP_F_CC8 (79 BLOCK)(CC8)

LATCHED VIRT IP 14

AR PULSE BLOCK Not Configured

AR PULSE UNBLOCK Not Configured

AR INITIATE

VO_083_GENERAL_TRIP

CONT IP_F_CC7 (79 INITIATE)(CC7)

LATCHED VIRT IP 13

AR CONDS INPUT
SYNCHK CLOSE PERM NOT

NOT
LATCHED VIRT IP 15

BKR FAIL INITIATE Not Configured

GROUP 1 ACT ON Not Configured

GROUP 2 ACT ON Not Configured

GROUP 3 ACT ON Not Configured

FAULT REPORT TRIGG VO_083_GENERAL_TRIP

CLEAR FAULT REPORTS Not Configured

DEMAND TRIGGER INP Not Configured

DEMAND RESET INP OPERATION BIT 7

FREEZE ENERGY CNT Not Configured

UNFREEZE ENERGY 
CNT Not Configured

RESET ENERGY CNT OPERATION BIT 6

RESET KI2t COUNTERS OPERATION BIT 5

RESET BKR COUNTERS OPERATION BIT 5

SETPOINT>RELAY CONFIGURATION>OSCILLOGRAPHY

DIGITAL CHANNEL NAME SOURCE SIGNAL LOGIC SOURCE LOGIC

DIG_CHANNEL#1 TRIP VO_083_GENERAL_TRIP

DIG_CHANNEL#2 50/51P TRIP VO_019_PHASE_OVERCURRENT_TRIP

DIG_CHANNEL#3 50/51G TRIP VO_069_GROUND_OVERCURRENT_T
RIP

DIG_CHANNEL#4 27 TRIP VO_073_27P_TRIP

DIG_CHANNEL#5 59 TRIP VO_074_59P_TRIP

DIG_CHANNEL#6 PICKUP VO_085_GENERAL_PKP

SETPOINT>RELAY CONFIGURATION>PROTECTION ELEMENTS

PROTECTION ELEMENT SOURCE SIGNAL LOGIC SOURCE LOGIC
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DIG_CHANNEL#7 50/51P PICKUP VO_007_PHASE_OVERCURRENT_PKP

DIG_CHANNEL#8 50/51G PICKUP VO_009_GROUND_OVERCURRENT_P
KP

DIG_CHANNEL#9 27 PICKUP VO_045_27P_PKP

DIG_CHANNEL#10 59 PICKUP VO_046_59P_PKP

DIG_CHANNEL#11 79 READY AR READY

DIG_CHANNEL#12 79 IN-PROG AR RCL IN PROGRESS

DIG_CHANNEL#13 79 BLOCK AR BLOCK 

DIG_CHANNEL#14 79 INHIBIT AR CONDS INPUT NOT

DIG_CHANNEL#15 79 LOCKOUT AR LOCKOUT

DIG_CHANNEL#16 Not Configured

OSCILLO TRIGGER OSCILLO TRIGGER
OPERATION BIT 8

VO_083_GENERAL_TRIP

SETPOINT>RELAY CONFIGURATION>OPERATIONS

OPERATION OPERATION TEXT SETTINGS VALUE/SOURCE

Operation1 CLOSE BREAKER 

INTERLOCK(LOGIC) SYNCHK CLOSE PERM 

FINAL STATES AND LOGIC BREAKER CLOSED 

FRONT KEY I Key 

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 1000 

CHANNELS ALL 

Operation2 OPEN BREAKER 

INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) BREAKER OPEN 

FRONT KEY O Key 

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 1000 

CHANNELS ALL 

Operation3 LEDS RESET

INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 500

CHANNELS ALL

Operation4 THERMAL RESET

INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 500

CHANNELS ALL

SETPOINT>RELAY CONFIGURATION>OSCILLOGRAPHY

DIGITAL CHANNEL NAME SOURCE SIGNAL LOGIC SOURCE LOGIC
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Operation5 BRK COUNTERS 
RESET

INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 500

CHANNELS ALL

Operation6 ENERGY RESET

INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 500

CHANNELS ALL

Operation7 DEMAND RESET

INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured
INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 500

CHANNELS ALL

Operation8  TRIGGER OSCILLO

INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT 500

CHANNELS ALL

Operation9 Not configured

INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT Not configured

CHANNELS Not configured

..... ......

INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT Not configured

CHANNELS Not configured

Operation24 Not configured

INTERLOCK(LOGIC) Not configured

FINAL STATES AND(LOGIC) Not configured

FRONT KEY Not configured

INPUT Not configured

VIRTUAL OUTPUT Not configured

TIMEOUT Not configured

CHANNELS Not configured

SETPOINT>RELAY CONFIGURATION>OPERATIONS

OPERATION OPERATION TEXT SETTINGS VALUE/SOURCE
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SETPOINT>RELAY CONFIGURATION>EVENTS

EVENT NAME SOURCE SIGNAL LOGIC SOURCE LOGIC

EV1 Not Configured

EV2 Not Configured

... ...

EV128 Not Configured

SETPOINT>RELAY CONFIGURATION>SWITCHGEAR

SWITCHGEAR SETTING VALUE/SOURCE SIGNAL LOGIC SOURCE LOGIC

SWITCHGEAR 1

CONTACTS 52b

OPENING TIME 1000

CLOSING TIME 1000

CONTACT A SOURCE N/A

CONTACT B SOURCE CONT IP_F_CC1 (52b)(CC1)

OPEN TEXT 52 OPEN

ALARM NO

CLOSED TEXT 52 CLOSE

ALARM NO

ERROR 00 TEXT 52 ERROR

ALARM N/A

ERROR 11 TEXT 52 UNDEFINED

ALARM N/A

OPENING INIT OPERATION BIT 2

CLOSING INIT OPERATION BIT 1

SWITCHGEAR 2

CONTACTS Not Configured

OPENING TIME Not Configured

CLOSING TIME Not Configured

CONTACT A SOURCE Not Configured

CONTACT B SOURCE Not Configured

OPEN TEXT Not Configured

ALARM Not Configured

CLOSED TEXT Not Configured

ALARM Not Configured

ERROR 00 TEXT Not Configured

ALARM Not Configured

ERROR 11 TEXT Not Configured

ALARM Not Configured

OPENING INIT Not Configured

CLOSING INIT Not Configured

... ... ... ... ...

SETPOINT>RELAY CONFIGURATION>OPERATIONS

OPERATION OPERATION TEXT SETTINGS VALUE/SOURCE
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SWITCHGEAR 16

CONTACTS Not Configured

OPENING TIME Not Configured

CLOSING TIME Not Configured

CONTACT A SOURCE Not Configured

CONTACT B SOURCE Not Configured

OPEN TEXT Not Configured

ALARM Not Configured

CLOSED TEXT Not Configured

ALARM Not Configured

ERROR 00 TEXT Not Configured

ALARM Not Configured

ERROR 11 TEXT Not Configured

ALARM Not Configured

OPENING INIT Not Configured

CLOSING INIT Not Configured

SETPOINT>RELAY CONFIGURATION>SWITCHGEAR

SWITCHGEAR SETTING VALUE/SOURCE SIGNAL LOGIC SOURCE LOGIC
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APPENDIX D MISCELLANEOUS D.1GE MULTILIN WARRANTY

GE MULTILIN RELAY WARRANTY

GE Power Management, S.A. (GE Multilin) warrants each relay it manufactures to be free from defects in
material and workmanship under normal use and service for a period of 24 months from date of shipment from
factory.

In the event of a failure covered by warranty, GE Multilin will undertake to repair or replace the relay providing
the warrantor determined that it is defective and it is returned with all transportation charges prepaid to an
authorized service center or the factory. Repairs or replacement under warranty will be made without charge.

Warranty shall not apply to any relay, which has been subject to misuse, negligence, accident, incorrect
installation, or use not in accordance with instructions nor any unit that has been altered outside a GE Multilin
authorized factory outlet.

GE Multilin is not liable for special, indirect or consequential damages or for loss of profit or for expenses
sustained as a result of a relay malfunction, incorrect application or adjustment.

For complete text of Warranty (including limitations and disclaimers), refer to GE Multilin Standard Conditions
of Sale.
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	Q1. Does the F650 support DNP and ModBus over the Ethernet port?
	A1. F650 units support both protocols over both the asynchronous serial ports and the Ethernet LAN synchronous port using TCP/IP and UDP/IP layers over the Ethernet.
	Q2. Does this equipment support dual IP access?
	A2. Yes, it supports two independent IP addresses in aliasing mode. Those address go in the communications settings Network0 and Network1.
	Q3. Is the protocol IEC 870-103 supported by the F650?
	A3. Yes, IEC 870-103 is supported by the F650 in firmware version 5.00 and higher.
	Q4. Can the F650 be used as a DNP master station?
	A4. Not at this moment. It works as a slave IED station for all protocols.
	Q5. How many communication ports are included in the F650?
	A5. The equipment has 2 different boards, one for asynchronous serial ports and another for a high-speed synchronous Ethernet port. The first board has 2 comm ports, COM1 and COM2. COM2 is multiplexed with the front serial RS232 port, whereas the COM...
	Q6. Are there one or two Ethernet ports?
	A6. The equipment has only 1 Ethernet port. For redundant fiber optic versions, redundancy is done at the physical level (fiber optic) but there is just one port.
	Q7. How many different communication Ethernet sessions can be opened through the LAN port?
	A7. ModBus TCP/IP: 4 sockets
	Q8. May I use the cooper 10/100 BaseTX connection included in the basic model with all protocols?
	A8. Yes, it may be used with all protocols. In noisy substation environments and/or long distances, it is recommended to use fiber optic options due to much better EMC performance and immunity. For fiber optic models, it is necessary to adjust an int...
	Q9. Remote I/O CAN bus. Does it support DeviceNet protocol?
	A9. No it does not support DeviceNet.
	Q10. Which functions are available in the relay web server?
	A10. Currently, it includes several functions for viewing measures and retrieving information.
	Q11. Q11 May I use URPC to program the relay?
	A11. Only oscillography records may be viewed with URPC once downloaded to a file using the ENERVISTA 650 Setup software.
	Q12. May I connect URs and F650s to the same Ethernet?
	A12. Yes, either in cable as in fiber, or even mix them.
	Q13. How do I connect with fiber 10-BASE-FL UR relays with 100-BASE-FX F650 relays?
	A13. Take into account that an UR is never connected directly to a F650 (neither two UR nor two F650 with each other) but they are always connected through a hub or switch. The hub or switch where the URs are connected must be 10-BASE-FL and the hub ...
	Q14. How do I connect with cable 10_BASE-T UR relays with 10/100-BASE-TX F650 relays?
	A14. The answer to this question is as described before but also in this case there is an advantage added, because the hub 10-BASE-TX port is able to understand a 10-BASE-T port. This means that a hub 10-BASE-T port may be connected to an UR or a F65...
	Q15. What happens with fiber optic connectors compatibility, because the hub that I have has a different connector to the one of the F650, although both are 100-BASE-FX?
	A15. Just buy fiber cables with the appropriate male connectors. For the UR and F650 side we need the same connectors, ST type, for the hub side, the correspondent ones. And in what concerns to the fiber type, it is used the same for 10 as for 100, i...
	Q16. What is the difference between a hub and a switch?
	A16. In a repeater type hub (shared hub), one unit talks and the rest listen. If all the units are talking at the same time there may be collisions in the messages, what may produce certain communication delays.
	Q17. Why do we have 10/100 compatibility for cable but not for fiber?
	A17. The cable has some advantages that the fiber does not have, and it is that the signal attenuation in short and medium distances, is worthless and this is truth for low and high frequency signals. By the contrary, the light in one fiber optic is ...

	PROTECTION
	Q1. Does the F650 support IRIG-B signals? Which type and accuracy? How many units may be connected to the same source?
	A1. Yes, the F650 includes an IRIG-B input for all models, including the basic ones.
	Q2. Does the equipment work with dry inputs in both AC and DC?
	A2. The equipment works only with DC inputs.
	Q3. Is it oscillography programmable?
	A3. Yes, the sampling rate is programmable (4, 8, 16, 32 or 64 samples per input). The depth will depend on the sampling rate.
	Q4. Do I have to select a different model for 1 or 5 A?
	A4. No. The same model is able to work with either /1 A or /5 A rated secondary currents. There are high accuracy sensing transformers that allow the use of any current input through the same terminals to reduce the spares and simplify wiring.
	Q5. In my installation, several digital inputs become active when I energize the transformer. How can I reduce sensitivity?
	A5. By selecting debounce time and/or voltage threshold, the relay may adapt its sensitivity to different applications. Please select the maximum voltage threshold and debounce time (recommended 15 ms) to minimize AC coupling effects.

	CONTROL AND HMI
	Q1. What is the difference between Get/Send info from/to relay and Upload/Download info files to/from relay?
	A1. Get/Send are used for settings and configuration storage that although both are in a unique file, are sent separately in two times. Upload/Download are used for project or PLC files group storage. These files are the setting_configuration file so...
	Q2. Could I program interlocks?
	A2. Yes, via ENERVISTA 650 Setup interlocks may be programmed from very simple to advanced schemes.
	Q3. Can we rotate the display 90 degrees to show feeders vertically?
	A3. No. The product has been designed to view it in horizontal mode (landscape) due to the following reasons:
	Q4. Do I need a laptop or handheld to program the unit?
	A4. No, all main operations can easily be performed with just the incorporated HMI. Handheld or laptops may be required to download large quantities of information (such as oscillograms, etc.) but they are not mandatory for a conventional user that j...
	Q5. Is there password security for protection and control?
	A5. Yes, there are two passwords. An independent password for protection changes and control operations is available since version 1.44
	Q6. Is it possible to have a remote HMI installed in the front of the panel with the rest of the relay in the rear side?
	A6. Not in the present version.
	Q7. Is it possible to program a default screen for the HMI?
	A7. In graphic display versions the user may program a custom screen with the single-line diagram, measurements, etc. In text display models, there is a choice of logo, measurements, or scrolling both screens.
	Q8. May I force inputs and outputs to ease commissioning and testing?
	A8. Yes.
	Q9. How can I disable the rotary knob buzzer?
	A9. Press ESC key for more than 3 seconds and then press the knob during a short pulse.
	Q10. Why do appear strange texts on the display when switching on the relay?
	A10. You will have pressed any button and the HMI has entered in a test mode.

	RELAY CONFIGURATION
	Q1. Does the "Service" contact on the Power Supply board cover all possible failures or do I have to create an output on the I/O board that includes all the internal errors I can access in the logic?
	A1. The power supply ready contact only monitor hardware failures in the power supply, to monitor the internal error of the unit it is necessary to configure a virtual output to and the assign it to the device desired (contact output, LED, etc.).
	Q2. I set an output contact as "Latched". If I do not set a "reset" condition, will it reset from the "ESC" key?
	A2. No, you have to configure the contact output reset signal (in Setpoint>Relay Configuration>Outputs).
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